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INTRODUCTION

Today, the fact that computers have made a big impact on many aspects of our
lives can hardly be questioned. They have opened up an entire world of knowledge
and information that is readily accessible. Thus, information about computers—
right from the first mechanical adding machine to the latest microprocessors—has
become imperative for students as well as anybody who has something to do with
a computer system.

Today, we are using the fifth generation of computers. The term ‘generation’
is used to distinguish between varying hardware and software technologies. The
hardware by itself cannot do any calculation or manipulation of data without being
instructed what to do and how to do it. Thus, there is a need of software in a
computer system. The software used in a computer system is grouped into
applications software, system software and utility software.

We have tried to familiarize students with the basic components of a computer
system, which include the control unit, memory and processor, input and output
devices. Input devices are used to transfer information into the memory unit of a
computer. Output devices are electromechanical devices that accept data from
the computer and translate it into a form that can be understood by the outside
world. Different concepts related to the processor (CPU); such as bus structures,
general register organization are also discussed. The differences among the various
types of computers, such as notebooks computer, personal computers, mainframe
computers and supercomputer are also discussed.

An operating system is the most essential part of any computer system. It is
the software that acts as an interface between the user and the computer. The
main purpose of an operating system is to provide an environment in which a user
can execute programs in a convenient and efficient manner. A computer system
consists of two major segments: the hardware and the software. The hardware
comprises all the machines/equipment associated with the computing environment.
The major components include the Central Processing Unit (CPU), the memory
and the Input/output (I/O) devices. The software comprises of system and
application programs, such as compilers, text editors, Word processors,
spreadsheets, database systems and so on.

The term ‘Microsoft office’ refers to all tools and methods that are applied
to office activities which make it possible to process written, visual and audio data
in a computer aided manner. They process data, store information, solve complex
mathematical problems, track inventory and even control temperature and lighting
in office buildings. All this can be done with the help of various computer office
application programs/software, such as Microsoft Word, Microsoft Excel and
Microsoft PowerPoint. Microsoft Office 2007 supports ‘Ribbon Interface’ which
provides GUI features for menu bar. Microsoft Office Word, a Word processor,
was designed by Microsoft. Creating and editing document features are very helpful
in Microsoft Word 2007 and hence used frequently. Microsoft Excel 2007 is an
electronic spreadsheet that runs on a personal computer. A workbook is the
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Microsoft Excel file in which you enter and store related data. You can also use it
to perform mathematical calculations quickly. Microsoft PowerPoint 2007 allows
for creation of professional, effective and creative business presentations that can
be used for corporate or sales presentations and trainings.

The study of computer networks and the Internet becomes essential to
know more about computing techniques and communication technologies. It is
now inevitable for everybody, from high-tech company professionals to beginners,
to have a good insight of the principles of computer networks to become aware of
how it can be used in the growth of networking and thereafter Internet which has
influenced almost every aspect of life. Conveniences like ATM services, Internet,
wireless telephony and electronic mail could not have been possible without
computer networks.

This book, Computer Applications, follows the SIM format wherein each
Unit begins with an Introduction to the topic followed by an outline of the
‘Objectives’. The detailed content is then presented in a simple and an organized
manner, interspersed with ‘Check Your Progress’ questions to test the
understanding of the students. A ‘Summary’ along with a list of ‘Key Terms’ and a
set of ‘Self-Assessment Questions and Exercises’ is also provided at the end of
each unit for effective recapitulation.
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UNIT 1 COMPUTER APPRECIATION
AND ORGANIZATION

Structure
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1.1 Objectives
1.2 History of the Development of Computers
1.3 Concepts of Computer Systems

1.3.1 Capabilities and Limitations of Computers
1.4 Generations of Computers
1.5 Types of Computers

1.5.1 Analog
1.5.2 Digital
1.5.3 Hybrid
1.5.4 General Purpose
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1.5.7 Personal Computers

1.6 Computer Basics
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1.6.2 Hardware and Software of a Computer System
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1.7.2 Memory Location and Address

1.8 Central Processing Unit
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1.10 Answers to ‘Check Your Progress’
1.11 Summary
1.12 Key Terms
1.13 Self-Assessment Questions and Exercises
1.14 Further Reading

1.0 INTRODUCTION

Early computers were meant to be used only for calculations. Simple manual
instruments like the abacus have aided people in doing calculations since ancient
times. Early in the Industrial Revolution, some mechanical devices were built to
automate long tedious tasks, such as guiding patterns for looms. Modern computers
can perform generic sets of operations known as programs. These programs enable
computers to perform a wide range of tasks. The first computers were used primarily
for numerical calculations. However, as any information can be numerically encoded,
people soon realized that computers are capable of general calculations.

A computer is a machine that can store and process information. Computer
is a fast electronic calculating machine which accepts digital input, processes it.
Most computers rely on a binary system that uses two variables, 0 and 1, to
complete tasks such as storing data, calculating algorithms, and displaying
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information. Computers comes in many different shapes and sizes, from handheld
smartphones to supercomputers weighing more than 300 tons. The most powerful
computers can perform extremely complex tasks, such as simulating nuclear weapon
experiments and predicting the development of climate change. The development
of quantum computers, machines that can handle a large number of calculations
through quantum parallelism (derived from superposition), would be able to do
even more complex tasks. Computer Organization includes the high level aspects
of a design, such as memory system, the bus structure and the design of the internal
CPU. Computer Types. A computer system is like any other system, consists of
an inter-related set of components. The system is best characterized in terms of
structure-the way in which they are interconnected and function-operation of
individual component.

In this unit, you will learn about the history of development of computers,
capabilities and limitations of computer systems, various generations of computers,
different types of computers, main components of computer, hardware of a computer,
different types of computer software, basic I/O devices and computer organization.

1.1 OBJECTIVES

After going through this unit, you will be able to:

 Discuss the history of development of computers

 Understand the capabilities and limitations of computer systems

 Describe the various generations of computers

 Explain the different types of computers

 Discuss the main components of computer

 Define the term hardware of a computer

 Understand the different types of computer software

 Explain the different types of  I/O devices

 Describe the functions of scanners and its types

 Understand the purpose and functions of CRT terminals

 Define non-CRT displays

 Understand the functions of a printer, its types as well as the working of
impact and non-impact printers

 Analyze the computer organization

 Explain bus structure and different bus organizations

 Elaborate on the memory location and address

 Define central processing unit

 Discuss the general register organization
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1.2 HISTORY OF THE DEVELOPMENT OF
COMPUTERS

The first mechanical adding machine was invented by Blaise Pascal in 1642. Later,
in 1671, Baron Gottfried Wilhelm von Leibniz of Germany invented the first
calculator. Around this time, Herman Hollerith came up with the concept of punched
cards, which were extensively used as an input medium in mechanical adding
machines.

Charles Babbage, a 19th century professor at Cambridge University, is
considered the father of the modern digital computer. During this period,
mathematical and statistical tables were prepared by a group of clerks. However,
utmost care and precautions, could not eliminate human errors.

In 1842, Babbage came up with his new idea of the Analytical Engine,
which was intended to be completely automatic. This machine was capable of
performing basic arithmetic functions. But, these machines were difficult to
manufacture because the precision engineering required to manufacture them was
not available at that time.

The following is a brief description of the various generations of computers.

 Mark I Computer (1937-44): This was the first fully automatic
calculating machine designed by Howard A. Aiken and the design of
which was based on the technique of punching card machinery. In this
technique, both mechanical and electronic components were used.

 Atanasoff-Berry Computer (1939-42): This computer was developed
by Dr. John Atanasoff to solve certain mathematical equations. It used
forty-five vacuum tubes for internal logic and capacitors for storage.

 ENIAC (1943-46): The Electronic Numerical Integrator and Computer
(ENIAC) was the first electronic computer developed for military
requirements and was used for many years to solve ballistic problems.

 EDVAC (1946-52): One of the drawbacks of ENIAC was that its
programs were wired on boards, which made it difficult to change them.
To overcome the drawbacks of ENIAC, the Electronic Discrete Variable
Automatic Computer (EDVAC) was designed. The basic idea behind
this concept was that sequences of instructions could be stored in the
memory of the computer for automatically directing the flow of
operations.

 EDSAC (1947-49): Professor Maurice Wilkes developed the Electronic
Delay Storage Automatic Calculator (EDSAC), by which addition and
multiplication operations could be accomplished.

 UNIVAC I (1951): The UNIVersal Automatic Computer (UNIVAC)
was the first digital computer to be installed in the Census Bureau in
1951 and was used continuously for 10 years. In 1952, International
Business Machines (IBM) introduced the 701 commercial computers.
These computers could be used for scientific and business purposes.
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1.3 CONCEPTS OF COMPUTER SYSTEMS

A computer is a programmable machine designed to automatically process a
sequence of various arithmetic or logical operations. The interface between the
computer and the human operator is known as the user interface. A computer
consists of memory which stores information and data in the form of text, images
and graphics, and audio and video files. CPU or Central Processing Unit performs
the arithmetic and logic operations with the help of sequencing, and control unit
that can change the order of operations based on the information that has been
stored in memory. Peripheral devices allow information to be entered from an
external source and allow the results of operations to be sent out. A Central
Processing Unit or CPU executes a series of instructions to read, manipulate and
store the data. The control unit, Arithmetic Logic Unit or ALU, memory registers
and basic Input/Output or I/O devices are collectively known as a Central
Processing Unit or CPU. Devices that provide input or output to the computer are
known as peripherals. On a Personal Computer or PC, peripherals include input
devices, such as the keyboard and mouse, and output devices, such as visual
display unit or monitor and printer. Hard disk drives, floppy disk drives and optical
disk drives serve as memory devices. A graphics processing unit is used to display
3-Dimensional or 3-D graphics. Modern desktop computers contain various smaller
computers that assist the main CPU in performing I/O operations. Memory refers
to the physical devices which are used to store programs, sequences of instructions
or data, such as programs in a computer. Data is stored either in hard disk or in
secondary memory devices, such as tape, magneticdisks and optical disks,
Compact Disk Read Only Memory or CD-ROM and Digital Versatile/Video Disc
or DVD-ROM. Memory is associated with addressable semiconductor memory,
i.e., integrated circuits consisting of silicon based transistors.

Basic Functions of a Computer

There are three basic functions of a computer are as follows:

 Data Processing: A computer must be able to process data.

 Data Storage: A computer must be able to store data. Even if data is
supplied to a computer on the fly, for processing and producing the result
immediately, the computer must be able to store that data temporarily. Apart
from short term data storage, it is equally important for a computer to perform
a long term storage function to store different files.

 Data Movement: A computer must be able to move data between itself
and the outside world. The computer operating environment consists of
devices that serve as data sources or destinations. When data is received
from or delivered to a machine that is directly linked to a computer, the
process is known as input/output and the devices used for this purpose are
referred as input/output devices. When data moves over longer distances
to or from a remote machine the process is known as data communication.
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1.3.1 Capabilities and Limitations of Computers

The increasing popularity of the computer has proved that it is a powerful and
useful tool. Its usefulness is due to its following features:

 Speed: Computers are very fast. They can process millions of instructions
every second. The speed is related to the amount of data it processes and
the time it takes to complete the processing task.

 Storage: Computers can store vast amounts of information in the form of
files, which can be recalled at any time. These files help in easy and speedy
retrieval of information. This type of storage is known as electronic storage
system.

 Accuracy: In addition to being fast, computers are also accurate. The degree
of accuracy for a particular computer depends upon its design. Most errors
in computers are non-technical. Generally, programmers are responsible for
these errors.

 Diligence: Computers are diligent as they can perform any complicated
task accurately without making any error. Computers do not suffer from
carelessness, boredom or tiredness. Moreover, their efficiency does not
decrease with age.

 Versatility: Computers perform various tasks depending upon the
instructions fed into them and their hardware characteristics. They are
capable of performing any task, provided the task is reduced to a series of
logical steps. A computer can be used to prepare a Word document and in
between called to search for another document that is stored in its memory.
It can perform both tasks simultaneously.

 No IQ: Computers do not have their own intelligence and their I.Q.
(Intelligence Quotient) is zero. Hence, the user can and has to decide what
tasks a computer should perform.

 No Feelings: Computers have no feelings because they are machines. They
cannot make judgements as they process on the basis of a set of instructions,
called programs, provided by the users.

Though computers can do better than human beings in terms of accuracy, speed
and memory, but even then there are certain limitations of computer systems because
they depend on human beings for their operations and functions. The following are
some of the limitations of computers:

 Human beings program them for efficient, accurate and fast functioning.

 Computers cannot think intelligently and work independently like human
beings.

 They follow instructions given by programs or by users.

 They can neither take decisions nor can correct wrong instructions.

 Programmers or users maintain and update them.

 As with many other modern appliances, computers also need electric power
to run.
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1.4 GENERATIONS OF COMPUTERS

Table 1.1 will help you understand the generation of computers.

Table 1.1 Generation of Computers

Generation Time Hardware Software Features  Examples 

I 1942-
1955 

Vacuum Tubes Machine 
Language 
(Binary 
Language) 

High-speed electronic switching 
device; memory type was 
electromagnetic; bulky in size; 
generated a large amount of heat; 
frequent technical faults; required 
constant maintenance; used for 
scientific purposes; air-conditioning 
required   

ENIAC, 
EDVAC, 
EDSAC, 
UNIVAC I 

II 1955-
1964 

Transistors High-level 
languages 
 
FORTRAN, 
COBOL, 
ALGOL, 
SNOBOL 

Better electronic switching devices 
than vacuum tubes; made of 
germanium semiconductors; 
memory type was magnetic cores; 
powerful and more reliable; easy to 
handle; much smaller than vacuum 
tubes; generated less heat as 
compared to vacuum tubes; used for 
business and industries for 
commercial data processing; air-
conditioning required   

Livermore 
Atomic 
Research 
Computer 
(LARC), 
IBM 

III 1964-
1975 

Integrated 
Circuits (ICs) 
made up of 
transistors, 
resistors and 
capacitors fixed on 
single silicon chip 

High-level 
languages 
 
PL/1, 

PASCAL, 

BASIC, 
VISUAL 
BASIC, C, C++, 
C#, Java 
 

ICs were smaller than transistors; 
consumed less power; dissipated less 
heat as compared to transistors; 
more reliable and faster than earlier 
generations; capable of performing 
about 1 million instructions per 
second; large storage capacity; used 
for both scientific and commercial 
purposes; air-conditioning required   

Mainframe, 
Minicomputers 

IV 1975-
1989 

Microprocessor 
made up of Large 
Scale Integration 
Circuits (LSI) and 
Very Large Scale 
Integration 
Circuits (VLSI)  

Advanced Java 
(J2EE, JDO, 
JavaBeans), 
PHP, HTML, 
XML, SQL 

 

Microprocessor had control on 
logical instructions and memory; 
semiconductor memories; personal 
computers were assembled; used in 
LAN and WAN to connect multiple 
computers at a time; used graphical 
user interface; smaller, more reliable 
and cheaper than third-generation 
computers; larger primary and 
secondary storage memories; had 
Computer Supported Cooperative 
Working (CSCW); air-conditioning 
not required 

Personal 
Computers 
(PCs), 

LAN, 
WAN, 
CSCW 

V 1989-
Present 

Ultra Large Scale 
Integration (ULSI), 
Optical Disks 

Artificial 
Intelligence, 
PROLOG, 
OPS5, 

Mercury 

PCs were assembled – portable and 
non-portable, powerful desktop PCs 
and workstations; less prone to 
hardware failure; user-friendly 
features – Internet, e-mailing; air-
conditioning not required 

Portable PCs, 
Palmtop 
Computers, 
Laptop 

 

1.5 TYPES OF COMPUTERS

Computers can be classified on the basis of their size, processing speed and cost.
The various types of computers are:

 Personal computers
 Workstations
 Notebook/laptop computers
 Tablet PC
 PDA
 Mainframe computers
 Supercomputers
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1.5.1 Analog

Analog computers are generally used in industrial process controls and to measure
physical quantities, such as pressure, temperature, etc. An analog computer does
not operate on binary digits to compute. It works on continuous electrical signal
inputs and the output is displayed continuously. Its memory capacity is less and
can perform only certain type of calculations. However, its operating speed is
faster than the digital computer as it works in a totally different mode.

Analog computers perform computations using electrical resistance, voltage,
etc. The use of electrical properties signifies that the calculations can be performed
in real time or even faster at a significant fraction of the speed of light. Typically, an
analog computer can integrate a voltage waveform using a capacitor which ultimately
accumulates the charge. The basic mathematical operations performed in an electric
analog computer are summation, inversion, exponentiation, logarithm, integration
with respect to time, differentiation with respect to time, multiplication and division.
Hence in the analog computers, an analog signal is produced which is composed
of DC and AC magnitudes, frequencies and phases. The starting operations in an
analog computer are done in parallel. Data is represented as a voltage that is a
compact form of storage.

1.5.2 Digital

Digital computers are commonly used for data processing and problem solving
using specific programs. A digital computer stores data in the form of digits
(numbers) and processes. It is in the discrete form from one state to the next.
These processing states involve binary digits which acquire the form of the existence
or nonexistence of magnetic markers in a standard storage devices, on-off switches
or relays. In a digital computer, letters, words, symbols and complete texts are
digitally represented, i.e., using only two digits 0 and 1. It processes data in discrete
form and has a large memory to store huge quantity of data.

The functional components of a typical digital computer system are input-
output devices, main memory, control unit and arithmetic logic unit. The processing
of data in a digital computer is done with the help of logical circuits, which are also
termed as digital circuits. All the circuits processing data in side a computer function
in an extremely synchronized mode; which is further controlled using a steady
oscillator acting as the computer’s ‘clock’. The clock rate of a typical digital
computer ranges from several million cycles per second to several hundred million
cycles, whereas the clock rate of fastest digital computers are about a billion cycles
per second. Hence, the digital computers operate on very high speed and are able
to perform trillions of logical or arithmetic operations per second to provide quick
solution to problems, which is not possible for a human being to do manually.

1.5.3 Hybrid

Hybrid computers are the combination of digital and analog computers. A hybrid
computer uses the best features of digital and analog computers. It helps the user
to process both continuous and discrete data. Hybrid computers are generally
used for weather forecasting and industrial process control.
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The digital component basically functions as a controller to provide logical
operations, whereas the analog component functions as a solver to provide solutions
of differential equations. Remember that the hybrid computers are different from
hybrid systems. The hybrid system is a digital computer equipped with an analog-
to-digital converter for input and a digital-to-analog converter for output. The
term ‘hybrid computer’ signifies a mixture of different digital technologies to process
specific applications with the help of various specific processor technologies.

1.5.4 General Purpose

Workstations are high-end, general-purpose computers designed to meet the
computing needs of engineers, architects and other professionals who need
computers with greater processing power, larger storage and better graphic display
facilities. These are commonly used for Computer-Aided Design (CAD) and for
multimedia applications such as creating special audio-visual effects for television
programmes and movies. A workstation looks like a PC and can be used by only
one person at a time. The characteristics of a workstation, which are often used to
differentiate it from a PC are as follows:

 Display facility: Most workstations have a large-screen monitor (21 inches
or more) capable of displaying high-resolution graphics as compared to
PCs, which have a small-screen monitor (19 inches or less).

 Storage capacity: Workstations have a larger main memory than PCs,
which have only a few hundred MB of main memory. The hard disk capacity
of workstations is also more than that of PCs.

 Processing power: The processing power of workstations is several times
greater than that of PCs.

 Operating system: PCs can run any of the five major operating systems—
MS-DOS, MS-Windows, Windows-NT, Linux and Unix—but all
workstations generally run the Unix operating system or a variation of it
such as AIX (used in IBM workstations), Solaris (used in SUN
workstations) and HPUX (used in HP workstations).

 Processor design: PCs normally use CPUs based on the Complex
Instruction Set Computer (CISC) technology, whereas workstation CPUs
are based on the Reduced Instruction Set Computer (RISC) technology.

1.5.5 Special Purpose

A special purpose computer is a digital or an analog computer specifically designed
to perform desired specific task. These are high-performance computing systems
with special hardware architecture, which is dedicated to solve a specific problem.
This is performed with the help of specially programmed FPGA chips or custom
VLSI chips. They are used for special applications, for example, astrophysics
computations, GRAPE-6 (for astrophysics and molecular dynamics), Hydra (for
playing chess), MDGRAPE-3 (for protein structure computations), etc.
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1.5.6 Micro, Mini, Mainframe and Supercomputers

Microcomputers

Microcomputers are developed from advanced computer technology. They are
commonly used at home, classroom and in the workplace. Microcomputers are
called home computers, personal computers, laptops, personal digital assistants,
etc. They are powerful and easy to operate. In recent years, computers were
made portable and affordable. The major characteristics of a microcomputer are
as follows:

 Microcomputers are capable of performing data processing jobs and solving
numerical programs. Microcomputers work rapidly like minicomputers.

  Microcomputers have reasonable memory capacity which can be measured
in megabytes.

 Microcomputers are reasonably priced. Varieties of microcomputers are
available in the market which can be as per the requirement of smaller
business companies and educational institutions.

 Processing speed of microcomputers is measured in megahertz. A
microcomputer running at 90MHz works approximately at 90 MIPS.

 Microcomputers have drives for floppy disk, compact disk and hard disks.

 Only one user can operate a microcomputer at a time.

 Microcomputers are usually dedicated to one job. Millions of people use
microcomputers to increase their personal productivity.

 Useful accessory tools, such as clock, calendar, calculator, daily schedule
reminders, scratch pads, etc., are available in a microcomputer.

 Laptop computers, also called notebook computers, are microcomputers.
They use the battery power source. Laptop computers have a keyboard,
mouse, floppy disc drive, CD drive, hard disk drive and monitor. Laptop
computers are expensive in comparison to personal computers.

Minicomputers

Minicomputers are a scaled-down version of mainframe computers. The processing
power and cost of a minicomputer are less than that of the mainframe. The
minicomputers have big memory sizes and faster processing speed compared to
the microcomputer. Minicomputers are also called workgroup systems because
they are well suited to the requirements of the minor workgroups within an
organization. The major characteristics of a minicomputer are as follows:

 Minicomputers have extensive problem solving capabilities.

 Minicomputers have reasonable memory capacity which can be measured
in megabytes or gigabytes.

 Minicomputers have quick processing speeds and operating systems
facilitated with multitasking and network capabilities.

 Minicomputers have drives for floppy disk, magnetic tape, compact disk,
hard disks, etc.
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 Minicomputers can serve as network servers.

 Minicomputers are used as a substitute of one mainframe by big
organizations.

Mainframe Computers

Mainframe computers are generally used for handling the needs of information
processing of organizations like banks, insurance companies, hospitals and railways.
This type of system is placed in a central location with several user terminals
connected to it. The user terminals act as access stations and may be located in
the same building Figure 1.1.

Fig. 1.1 Mainframe Computer

Mainframe computers are bigger and more expensive than workstations.
They look like a row of large file cabinets and need a large room with closely
monitored humidity and temperature levels. A mainframe system of lower
configuration is often referred to as a minicomputer system. The various
components of a mainframe computer are as follows:

 Host, front-end and back-end computers: A mainframe system
consists of several computers, such as a host computer that carries out
most of the computations and has direct control over all other computers.
The front-end portion is used for handling communications to and from
all the user terminals connected to the mainframe computer. The back-
end portion is used to handle data input/output operations. The host
computer and other computers are located in the systems room, to which
entry is restricted to system administrators and maintenance staff only.

 Consoles: Console terminals are directly connected to the host computer
and are mainly used by the system administrator to perform certain
administrative tasks like installing new software on the system, taking
system backups and changing the configuration of the system.

 Storage devices: A mainframe computer has several magnetic disk
drives directly connected to the back-end computer. The host computer,
via the back-end computer, accesses all data to and from these magnetic
disks. In addition, a mainframe computer also has a few tape drives and
a magnetic tape library (located in the systems room) for restoration
and backup of data. The tape drives are located in the users’ room, so
that users’ tapes can be used for input and output.

 User terminals: User terminals are used to access the required stations,
which may be located at different locations. Since mainframe computers
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support multiprogramming with time-sharing, they can run different
operating systems and can be accessed by multiple users simultaneously.

 Output devices: A mainframe computer has several output devices like
printers and plotters, connected to the back-end computer, so that these
devices are accessible to the user for taking their outputs. A plotter is a
device that prints vector graphics on paper using ink pens and pencils
on mechanical arms mainly used for large size printouts of architectural
and engineering drawings.

Supercomputers
Supercomputers are the most powerful and expensive computers available today.
They are primarily used for processing complex scientific applications that involve
tasks with highly complex calculations and solving problems with mechanical
physics, such as weather forecasting and climate research systems, nuclear weapon
simulation and simulation of automated aircrafts. Military organizations, major
research and development centres, universities and chemical laboratories are major
users of supercomputers.

Supercomputers use multiprocessing and parallel processing technologies
to solve complex problems promptly. They use multiprocessors, which enable the
user to divide a complex problem into smaller problems. A parallel program is
written in a manner that can break up the original problem into smaller computational
modules. Supercomputers also support multiprogramming, which allows
simultaneous access to the computer by multiple users. Some of the manufacturers
of supercomputers are IBM, Silicon Graphics, Fujitsu and Intel.

1.5.7 Personal Computers
A PC (Personal Computers) is a small single-user microprocessor-based computer
that sits on your desktop and is generally used at homes, offices, and schools. As
the name implies, PCs were mainly designed to meet the personal computing needs
of individuals. Personal computers are used for preparing normal text documents,
spreadsheets with predefined calculations and business analysis charts, database
management systems, accounting systems and also for designing office stationary,
banners, bills and handouts. Children and youth love to play games and surf the
Internet, communicate with friends via e-mail and net telephony and do many
other entertaining and useful tasks.

The configuration varies from one PC to another depending on its usage.
However, it consists of a CPU or system unit, a monitor, a keyboard and a mouse.
It has a main circuit board or motherboard (consisting of the CPU and the memory),
hard disk storage, floppy disk drive, CD-ROM drive and some special add-on
cards (like Network Interface Card) and ports for connecting peripheral devices
like printers.

PCs are available in two models—desktop and tower. In the desktop model,
the monitor is positioned on top of the system unit, whereas in the tower model the
system unit is designed to stand by the side of the monitor or even on the floor to
save desktop space. Due to this feature, the tower model is very popular

Some popular operating systems for PCs are MS-DOS, MS-Windows,
Windows-NT, Linux and Unix. Most of these operating systems have the capability
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of multitasking, which eases operation and saves time when a user has to switch
between two or more applications while performing a job. Some leading PC
manufacturers are IBM, Apple, Compaq, Dell, Toshiba and Siemens.

Types of personal computers

Notebook/laptop computers

Notebook computers are battery-operated personal computers. Smaller than the
size of a briefcase, these are portable computers and can be used in places like
libraries, in meetings or even while travelling. Popularly known as laptop computers,
or simply laptops, they weigh less than 2.5 kg and can be only 3 inches thick.
Notebook computers are usually more expensive as compared to desktop computers
though they have almost the same functions, but since they are sleeker and portable
they have a complex design and are more difficult to manufacture. These computers
have large storage space and other peripherals such as serial port, PC card, modem
or network interface card, CD-ROM drive and printer. They can also be connected
to a network to download data from other computers or to the Internet. A notebook
computer has a keyboard, a flat screen with Liquid Crystal Colour (LCD) display
(Refer Figure 1.2), and can also have a trackball and a pointing stick.

Foldable flat screen

Fig. 1.2 Laptop Computer

A notebook computer uses the MS-DOS or WINDOWS operating system.
It is used for making presentations as it can be plugged into an LCD projection
system. The data processing capability of a notebook computer is as good as an
ordinary PC because both use the same type of processor, such as an Intel Pentium
processor. However, a notebook computer generally has lesser hard disk storage
than a PC.

Tablet PC

Tablet PC is a mobile computer that looks like a notebook or a small writing slate
but uses a stylus pen or your finger tip to write on the touch screen. It saves
whatever you scribble on the screen with the pen, as shown in picture in the same
way as you have written it. The same picture can than be converted to text with
the help of a HR (hand recognition) software.
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PDA

A Personal Digital Assistant (PDA) is a small palm sized hand-held computer
which has a small colour touch screen with audio and video features. They are
nowadays used as smart phones, web enabled palmtop computers, portable media
players or gaming devices.

Most PDAs today typically have a touch screen for data entry, a data storage/
memory card, bluetooth, Wi-Fi or an infrared connectivity and can be used to
access the Internet and other networks.

Check Your Progress

1. What was the new idea that Charles Babbage came up with in 1842?

2. What are arithmetic logic units?

3. What is the function of the control unit?

4. Define the term Tablet PC.

1.6 COMPUTER BASICS

Computers have undergone great transformation over the past decade; however,
the basic logical structure remains the same. A computer primarily constitutes of
three integral components, viz. input devices, Central Processing Unit (CPU) and
output devices. The CPU constitutes of the main memory, the arithmetic logic unit
and the control unit.

Apart from these three basic components, computers have secondary storage
devices known as auxiliary storage or backing storage that store data and instructions
on a long-term basis.

The following are the primary functions of a computer:
 Inputting: The process in which the user specify a set of commands

to process data into the computer system.
 Storing: The process of recording data and information so that it

can be retrieved for use whenever required.
 Processing: This process implies performing arithmetic or logical

operations on data to convert them into useful information. Arithmetic
operations include addition, subtraction, multiplication and division,
and logical operations include comparisons, such as equal to, less
than and greater than, etc.

 Outputting: This is the process of providing results to the user.
These can be in the form of visual display and/or printed reports.

 Controlling: This refers to directing the sequence and the manner
in which all the previous functions are carried out.

A detailed description of the components that perform these tasks is as
follows.
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1. Input Unit

Programs and data are required to be present in a computer system before any
operation can be performed. A program denotes the set of instructions which the
computer has to carry out and data is the information on which these instructions
are to be operated. If the task is to rearrange a list of telephone subscribers in
alphabetical order, the sequence of instructions that will guide the computer through
this operation is the program, while the list of names to be sorted is the data.

The input unit is responsible for transferring data and instructions from the
external environment into the computer system. Instructions and data enter the
input unit through the particular input device used (keyboard, scanner, card reader,
etc.).  These instructions and data are then converted into binary codes (computer
acceptable form) and sent to the computer system for further processing.

2. Central Processing Unit

The central processing unit is known as the brain of the computer. It is an important
part of the computer and includes the control unit, the ALU and the primary memory
that are described as follows:

 Main Memory (Primary Storage): The main memory or the primary
storage of the computer system is responsible for storing all the instructions
and data. The data is then transferred to the Arithmetic Logical Unit (ALU)
for processing. After this, the final output is again stored back in the primary
storage, until it is further sent to the output device.

The primary storage also temporarily stores any intermediate result generated
by the ALU. So data and instructions move frequently between the ALU
and the primary storage before the processing is complete. It should be
noted that no processing occurs within the primary storage.

 Arithmetic Logic Unit: In addition to the basic four arithmetic operations,
viz. addition, subtraction, multiplication and division, the ALU also performs
logic comparison operations including equal to, lesser than or greater than.

 Control Unit: The function of the control unit is to ensure that according to
the stored instructions, the right operation is done on the right data at the
right time. The control unit receives instructions and commands from the
programs in the primary memory, processes them and ensures that the
commands are executed in the desired order by all the other units of the
computer system. In effect, the control unit is comparable to the central
nervous system of the human body.

3. Output Unit

Computers understand, process data and return the output in a binary form. The
basic function of the output unit is to convert these results into a human readable
form before providing the output through various output devices, such as terminals
and printers.
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The storage capacity of the primary memory of the computer is limited.
Often, it is necessary to store large amounts of data. So, additional memory, called
secondary storage or auxiliary memory, is used in most computer systems.

Secondary storage is storage other than the primary storage. These are
peripheral devices connected to and controlled by the computer to allow permanent
storage of data and programs. Usually, hardware devices like magnetic tapes and

magnetic disks fall in this category.

1.6.1 Parts of a Computer System

In order to transfer data to the memory of the computer input devices are used.
The Arithmetic Logic Unit (ALU) is responsible for calculations, to which this data
from the memory is stored. Once the calculations are done, the data is transferred
back to the memory. The memory is responsible for storing data, according to
which different functions are carried out. This memory is also known as the main
memory or the Immediate Access Store (IAS).

The control unit is responsible for controlling various computer operations,
which involves accepting instructions, interpreting and processing of this information
in the correct parts of the computer. The main function of the control unit is to
make sure that the instructions are correctly followed and all operations are done
exactly according to the correct instructions at the correct time. This process leads
to outcomes that are stored in memory. Figure 1.3 displays a computer system.

Fig. 1.3 A Computer System

(i) Motherboard

The main PCB (Printed Circuit Board) is sometimes alternatively known as a
logical board or a main board of a Personal Computer. In fact, any complex
electronic system is known as a motherboard. It includes a flat fibreglass platform
which hosts the CPU (Central Processing Unit), the main electronic components,
device controller chips, main memory slots, slots for attaching the storage devices
and other subsystems. Figure 1.4 displays a motherboard.
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Fig. 1.4 A Motherboard

(ii) Sockets and Ports

 Main Power Socket: The top part of the rear of the computer locates the
main power cable socket, which supplies power from the electric mains to
the computer system. This socket is the part of the main power supply unit
of the computer.

 Monitor Power Socket: The socket that supplies the power from the
computer system to the computer monitor and is located below the main
power cable socket. However, you might not find this socket in all computers
and you can plug in the monitor directly in main power supply.

 PS/2 Mouse Port: Next you will find a small, round, green colored port
with seven holes and a small logo of the mouse printed next to it. This is
where your PS/2 mouse will be plugged in.

 PS/2 Keyboard Port: Right next to it you will find another similar purple
colored port with the keyboard logo printed next to it. This is where your
PS/2 keyboard will be plugged in.

 Fan Housings: You will notice two fan housings at the back of your
computer. One fan housing is a part of the power supply unit and the other
will be somewhere below it to cool off the heat generated by the CPU.

 Serial Ports: It is a 9-pin connector normally used to attach the old serial
port mouse, hand-held scanners, modems, joysticks, game pads and other
such devices.

 Parallel Port:  It is a 25-pin connector used to attach parallel port printers,
modems, external hard disk drives, etc.
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 Audio Jacks: There are three audio jacks in your computer system. One
jack is used for connecting your speakers or headphones, the second is
used to connect the microphone and the third to connect to another audio
device, such as a music system.

 LAN Port: The LAN port is where the RJ45 connector of your LAN
cable is plugged in to connect your computer to other computers or the
Internet.

 USB Ports: The USB port is designed to connect multiple peripheral devices
in a single standardized interface and has a plug and play option that allows
devices to be connected and disconnected without having to restart or turning
off the computer.  It has replaced many serial and parallel port devices,
such as mouse, printers, modems, joysticks, game pads, scanners, digital
cameras and other such devices.

 VGA Port: This is a 15-pin connector that connects the signal cable of the
monitor to the computer.

Figure 1.5 displays monitor and CPU power cables and sockets.

Monitor Cable

Cable Socket

Mouse Cable

Keyboard Cable

Monitor Power Cable

Cable Socket

Cable Socket

Cable Socket

Fig. 1.5 Monitor and CPU Power Cable and Sockets
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Figure 1.6 displays a LAN cable and a printer cable and its socket.

LAN Cable 

Cable 

Printer Cable and Socket

Fig. 1.6 LAN Cable and Printer Cable with Socket

CPU

The primary function of the computer is executing programs. The programs or the set
of instructions are stored in the computer's main memory and are executed by the
CPU. The CPU processes the set of instructions along with any calculations and
comparisons to complete the task. Additionally, the CPU controls and activates various
other functions of the computer system. It also activates the peripherals to perform
input and output functions. Figure 1.7 displays major components of the CPU.

Arithmetic Logic
Unit (ALU) 

Memory Unit 

Control Unit

Fig. 1.7 Major Components of a CPU

Memory

Storage and retrieval of instructions and data in a computer system is the
responsibility of the memory. In order to store data and instructions, the CPU
constitutes many registers, though these are capable of storing very few bytes. All
computers need storage space for temporarily storing instruction and data during
the execution of the program as the CPU can process data at a speed that is much
faster than the speed at which data can be transferred from disks to registers. This
could lead to the CPU remaining free most of the time if the data was located in
secondary storage including magnetic tapes and disks. The primary or the main
memory is the temporary storage located in the computer hardware. Secondary
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storage or auxiliary memory constitutes devices that can give backup storage,
such as magnetic tapes and disks. The memory is classified as follows:

(i) Internal Processor Memory: A small set of high-speed registers placed
inside a processor and used for storing temporary data while processing.

(ii) Primary Storage Memory: The main memory of the computer which
communicates directly with the processor. This memory is large in size and
fast, but not as fast as the internal memory of the processor. It comprises a
couple of integrated chips mounted on a printed circuit board plugged directly
on the motherboard. Random Access Memory (RAM) is an example of
primary storage memory.

(iii) Secondary Storage Memory: This stores all the system software and
application programs and is basically used for data backups. It is much larger
in size and slower than primary storage memory. Hard disk drives, floppy
disk drives and flash drives are a few examples of secondary storage memory.

(iv) Memory Capacity: Capacity, in computers, refers to the number of bytes
that it can store in its main memory. This is usually stated in terms of Kilobytes
(KB) which is 1024 bytes or Megabytes (MB) which is equal to 1024 KB
(10,48,576 bytes). The rapidly increasing memory capacity of computer
systems has resulted in defining the capacity in terms of Gigabytes (GB)
which is 1024 MB (1,07,37,41,824 bytes). Thus a computer system having
a memory of 256 MB is capable of storing (256 × 1024 × 1024)
26,84,35,456 bytes or characters.

Processors Used in PCs
The most significant part of the computer is the Central Processing Unit or the
CPU. The CPU is mostly a microprocessor-based chip located on a single or
sometimes a multiple printed circuit boards and is an internal component of the
system. It is directly connected to the motherboard; however, the compatibility of
the mother board and the CPU depends on the specific series of the latter.  Due to
the tremendous amount of heat generated by the CPU, it contains a heat sink and
a cooling fan.

Popular microprocessors include Intel and AMD, which manufacture IBM
compatible CPUs.

The brands of CPUs listed are not the only differentiating factors, between
different processors. There are various technical aspects to these processors which
allow us to differentiate between CPUs of different power, speed and processing
capability. Accordingly, each of these manufacturers sells numerous product lines
offering CPUs of different architecture, speed, price range, etc. The following are
the most common aspects of modern CPUs that enable us to judge their quality or
performance:

 32 or 64-Bit Architecture: A bit is the smallest unit of data that a
computer processes. 32 or 64-bit architecture refers to the number of
bits that the CPU can process at a time.

 Clock Rate: The speed at which the CPU performs basic operations,
measured in Hertz (Hz) or in modern computers Megahertz – MHz or
Gigahertz – GHz.
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 Number of Cores: CPUs with more than one core are essentially
multiple CPUs running in parallel to enable more than one operation to
be performed simultaneously. Current ranges of CPUs offer up to eight
cores. Currently, the Dual core (i.e., two cores) CPU is most commonly
used for standard desktops and laptops and Quad core (i.e., four cores)
is popular for entry level servers.

 Additional Technology or Instruction Sets: These refer to unique
features that a particular CPU or range of CPUs offer to provide
additional processing power or reduced running temperature. These
range from Intel’s MMX, SSE3 and HT to AMD’s 3DNOW and Cool
n Quiet.

hese technical factors are the basic way to judge how a CPU will perform.
It is important to consider multiple factors when looking at a CPU rather than just
the clock speed or any one specification on its own. It is easy for a single-core
processor to run music videos, Internet applications or games individually, but
when multiple applications are run together, it starts to slow down. A system running
on a dual-core processor would be able to multitask better then a single-core
processor, while it is very easy for an 8-core processor to run all these applications
plus a lot more without showing any signs of slowing down. However, Intel's 4-
core processors are actually two dual-core processors combined in a single
processor, whereas AMD's 4-core processors are actually four processors built
in a single chip.

A combination of the above mentioned specifications, along with the operating
systems that the processor supports and the specific purpose for which the
computer is to be used, are the factors to be considered when deciding which
CPU is the most suitable for your needs.

1.6.2 Hardware and Software of a Computer System

Computer hardware refers to the physical components that make up a computer
system. They are the building blocks of personal computers. These are typically
installed into a computer case, or attached to it by a cable or through a port. In the
latter case, they are also referred to as peripherals. Various hardware components
are as follows:

1. Case: A computer case (also known as a computer cabinet, tower,  system
unit or simply case) is the box that contains most of the components of a
computer (excluding the monitor, keyboard and mouse).

2. Power Supply Unit (PSU): It converts AC electric power to low voltage
DC power for the internal components of the computer. A power supply
unit provides regulated power at the several voltages required by the
motherboard and accessories, such as disk drives and cooling fans.

3. Motherboard: The motherboard is the main component inside the case. It
connects the other parts of the computer including the CPU, the RAM, the
disk drives (CD, DVD, hard disk, etc.) as well as any peripherals connected
via the ports or the expansion slots. Components directly attached to the
motherboard include:
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 CPU: It performs most of the calculations which enable a computer
to function. It is also known as brain of the computer.

 Chipset: It mediates communication between CPU and other
components of system.

 RAM: RAM stands for Random Access Memory. It stores the data
and commands that is actively used by CPU.

 ROM: ROM stands for Read Only Memory. It stores the BIOS
(Basic Input Output System) instructions. It includes process of booting
of the system.

 Buses: Bus connects the CPU to other internal components and also
to expansion cards slot for graphics and sound card.

 Ports: It is used for connecting external peripherals.

Secondary Storage Devices

Computer data storage refers to computer components and recording media that
retain digital data.

Fixed Media

 Hard Disk Drives: A Hard Disk Drive (HDD) is a device for storing and
retrieving digital information, primarily computer data. It consists of one or
more rigid rapidly rotating discs, coated with magnetic material and with
magnetic heads arranged to write data to the surfaces and read it from
them.

 RAID Array Controller: It is a device to manage several internal or external
hard disks and optionally some peripherals in order to achieve performance
or reliability improvement in what is called a RAID array.

Removable Media

 Optical Disc Drives: Optical disc drives are used for reading from and
writing to various kinds of optical media, including Compact Discs, such as
CD-ROMs, DVDs, DVD-RAMs and Blu-ray Discs. Optical discs are the
most common way of transferring digital video, and are popular for data
storage as well.

 Floppy Disk Drives: Floppy disk drives are used for reading and writing
to floppy disks, an outdated storage media consisting of a thin disk of a
flexible magnetic storage medium.

 Zip Drives: They are an outdated medium-capacity removable disk storage
system, for reading from and writing to Zip disks.

 USB: USB flash drives are plugged into a USB port and do not require a
separate drive. USB flash drive is a small, lightweight, removable and
rewritable flash memory data storage device integrated with a USB interface.

 Memory Card Readers:  They are used for reading from and writing to
memory card. Memory card is a flash memory data storage device used to
store digital information.

 Tape Drives: They are drives to read and write data on a magnetic tape
and are used for long term storage and backups.
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Software of a Computer System

A computer cannot operate without any instructions and is based on a logical
sequence of instructions in order to perform a function. These instructions are
known as a ‘computer program’, and constitute the computer software. The
sequences of instructions are based on algorithms that provide the computer with
instructions on how to perform a function. Thus, it is impossible for a computer to
process without software, a term attributed to John W. Tukey in 1958.

Different kinds of software designs have been developed for particular
functions. Popular computer software include interpreter, assembler, compiler,
operating systems, networking, word processing, accounting, presentation,
graphics, computer games, etc. The computer software is responsible for converting
the instructions in a program into a machine language facilitating their execution.

Software engineers develop computer software depending on basic
mathematical analysis and logical reasoning. Before implementation, the software
undergoes a number of tests. Thus, the programming software allows you to develop
the desired instruction sequences, whereas in the application software the instruction
sequences are predefined. Computer software can function from only a few
instructions to millions of instructions; for example, a word processor or a Web
browser. Figure 1.8 shows how software interacts between user and computer
system.

Users 

Application Software 

Operating System Software 

Hardware System 

Fig. 1.8 Interaction of Software between User and a Computer System

On the functional basis, software is categorized as follows:

 System Software: It helps in the proper functioning of computer hardware.
It includes device drivers, operating systems, servers and utilities.

 Programming Software: It provides tools to help a programmer in writing
computer programs and software using various programming languages. It
includes compilers, debuggers, interpreters, linkers, text editors and an
Integrated Development Environment (IDE).

 Application Software: It helps the end users to complete one or more
specific tasks. The specific applications include industrial automation,
business software, computer games, telecommunications, databases,
educational software, medical software and military software.
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Types of Computer Software

Today, software is a significant aspect of almost all fields including business,
education, medicine, etc. The basic requirement for software is a distinct set of
procedures. Thus, software can be used in any domain that can be described in
logical and related steps and every software is developed with the aim of catering
to a particular objective, such as data processing, information sharing,
communication, etc. Software is based on the type of applications that are as
follows:

 System Software: This type of software is involved managing and
controlling the operations of a computer system. System software is a group
of programs rather than one program and is responsible for using computer
resources efficiently and effectively. Operating system, for example, is system
software, which controls the hardware, manages memory and multitasking
functions and acts as an interface between applications programs and the
computer.

 Real-Time Software: This is based on observing, analysing and controlling
real life events as they occur. Manually, a real-time system guarantees a
response to an external event within a specified period of time. The real-
time software, for instance, is used for navigation in which the computer
must react to a steady flow of new information without interruption. Most
defence organizations all over the world use real time software to control
their military hardware.

 Business Software: This kind of software is functional in the domain of
management and finance. The basic aspect of a business system comprises
payroll, inventory, accounting and software that permits users to access
relevant data from the database. These activities are usually performed with
the help of specialized business software that facilitates efficient framework
in the business operation and in management decisions.

 Engineering and Scientific Software: This software has developed as a
significant tool used in the research and development of next generation
technology. Applications, such as study of celestial bodies, study of
undersurface activities and programming of orbital path for space shuttle,
are heavily dependent on engineering and scientific software. This software
is designed to perform precise calculations on complex numerical data that
are obtained during real-time environment.

 Artificial Intelligence (AI) Software: Certain problem solving techniques
are non-algorithmic in nature and primarily require this type of software.
The solutions to such problems normally cannot be arrived at using
computation or straightforward analysis. Such problems need particular
problem solving techniques including expert system, pattern recognition and
game playing. Also, it constitutes various kinds of searching techniques,
such as the application of heuristics. The function of AI is to add certain
degree of intelligence into the mechanical hardware to have the desired
work done in an agile manner.
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 Web-based Software: This category of software performs the function of
an interface between the user and the Internet. There are various forms in
which data is available online, such as text, audio or video format, linked
with hyperlinks. For the retrieval of Web pages from the Internet a Web
browser is used, which is a Web-based software. The software incorporates
executable instructions written in special scripting languages, such as
Common Gateway Interface (CGI) or Active Server Page (ASP). Apart
from providing navigation on the Web, this software also supports additional
features that are useful while surfing the Internet.

 Personal Computer (PC) Software: This software is primarily designed
for personal use on a daily basis. The past few years have seen a marked
increase in the personal computer software market from normal text editor
to word processor and from simple paintbrush to advance image editing
software. This software is used mostly in almost every field, whether it is
database management system, financial accounting package or a multimedia
based software. It has emerged as a versatile tool for daily life applications.

Software can also be classified in terms of the relationship between software users
or software purchasers and software development.

 Commercial Off-The-Shelf (COTS): This comprises the software without
any committed user before it is put up for sale. The software users have less
or no contact with the vendor during development. It is sold through retail
stores or distributed electronically. This software includes commonly used
programs, such as word processors, spreadsheets, games, income tax
programs, as well as software development tools, such as software testing
tools and object modelling tools.

 Customized or Bespoke: This software is designed for a specific user,
who is bound by some kind of formal contract. Software developed for an
aircraft, for example, is usually done for a particular aircraft making company.
They are not purchased ‘off-the-shelf’ like any word processing software.

 Customized COTS: In this classification, a user can enter into a contract
with the software vendor to develop a COTS product for a special purpose,
that is, software can be customized according to the needs of the user.
Another growing trend is the development of COTS software components—
the components that are purchased and used to develop new applications.
The COTS software component vendors are essentially parts stores which
are classified according to their application types. These types are listed as
follows:

 Stand-Alone Software: A software that resides on a single
computer and does not interact with any other software installed in
a different computer.

 Embedded Software: A software that pertains to the part of unique
application involving hardware like automobile controller.

 Real-Time Software: In this type of software the Operations are
executed within very short time limits, often microseconds, e.g., radar
software in air traffic control system.
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 Network Software: In this type of software, software and its
components interact across a network.

Figure 1.9 illustrates the various types of customized COTS.

Fig. 1.9 Types of Customized COTS

System Software

System software constitutes all the programs, languages and documentation
provided by the manufacturer in the computer. These programs provide the user
with an access to the system so that he can communicate with the computer and
write or develop his own programs. The software makes the machine user-friendly
and makes an efficient use of the resources of the hardware. Systems software are
permanent programs on a system and reduce the burden of the programmer as
well as aid in maximum resource utilization. MS DOS (Microsoft Disk Operating
System) was one of the most widely used systems software for IBM compatible
microcomputers. Windows and its different versions are popular examples of
systems software. Systems software are installed permanently on a computer system
used on a daily basis.

Operating System

An Operating System (OS) is the main control program for handling all other
programs in a computer. The other programs, usually known as ‘application
programs’, use the services provided by the OS through a well-defined Application
Program Interface (API). Every computer necessarily requires some type of
operating system that instructs the computer about operations and use other
programs installed in the computer. The role of an OS in a computer is similar to
the role of the manager in an office for the overall management of the college.
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Any computer system can be broadly classified in terms of four component
dimensions:

(i) Hardware
(ii) Operating system
(iii) Application programs (like MS Word, Games, Calculator).
(iv) Users (people who work on the computer).

Figure 1.10 displays the various components of the computer system.
 

  . . . . . . . . . . 

 

Calculator Games MS Word 
Application Programs 

Hardware

OPERATING SYSTEM
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Fig. 1.10 Components of a Computer System

Application Software

Users install specific software programs based on their requirements; for instance,
accounting software (like Tally) used in business organizations and designing
software used by architects. All programs, languages and utility programs constitute
software. With the help of these programs, users can design their own software
based on individual preferences. Software programs aid in achieving efficient
application of computer hardware and other resources.

1. Licensed Software

Although there is a large availability of open source or free software online, not all
software available in the market is free for use. Some software falls under the
category of Commercial Off-The-Shelf (COTS). COTS is a term used for
software and hardware technology which is available to the general public for
sale, license or lease. In other words, to use COTS software, you must pay its
developer in one way or another.

Most of the application software available in the market need a software
license for use.

Software is licensed in different categories. Some of these licenses are based
on the number of unique users of the software while other licenses are based on
the number of computers on which the software can be installed. A specific
distinction between licenses would be an Organizational Software License, which
grants an organization the right to distribute the software or application to a certain
number of users or computers within the organization, and a Personal Software
License which allows the purchaser of the application to use the software on his or
her computer only.

2. Free Domain Software

To understand this, let us distinguish between the commonly used terms  Freeware
and Free Domain software. The term ‘freeware’ has no clear accepted definition,



Computer Appreciation
and Organization

NOTES

Self - Learning
Material 29

but is commonly used for packages that permit redistribution but not modification.
This means that their source code is not available. Free domain software is software
that comes with permission for anyone to use, copy, and distribute, either verbatim
or with modifications, either gratis or for a fee. In particular, this means that the
source code must be available. Free domain software can be freely used, modified,
and redistributed but with one restriction: the redistributed software must be
distributed with the original terms of free use, modification and distribution. This is
known as ‘copyleft’. Free software is a matter of freedom, not price. Free software
may be packaged and distributed for a fee. The ‘Free’ here refers to the ability of
reusing it — modified or unmodified, as a part of another software package. The
concept of free software is the brainchild of Richard Stallman, head of the GNU
project. The best known example of free software is Linux, an operating system
that is proposed as an alternative to Windows or other proprietary operating
systems. Debian is an example of a distributor of a Linux package.

Free software should, therefore, not be confused with freeware, which is a
term used for describing software that can be freely downloaded and used but
which may contain restrictions for modification and reuse.

A few types of application programs that are widely accepted these days, are:

1. Word Processing

A word processor is an application program used for the production of any type
of printable text document including composition, editing, formatting and printing.
It takes the advantage of a Graphical User Interface (GUI) to present data in a
required format. It can produce any arbitrary combination of images, graphics and
text. Microsoft Word is the most widely used word processing system.

Microsoft Word can be used for the simplest to the most complex word
processing applications. Using Word, you can write letters and reports, prepare
bills and invoices, prepare office stationery, such as letterheads, envelopes and
forms, design brochures, pamphlets, newsletters and magazines, etc.

2. Spreadsheet

Excel is ideal for a task that needs a number of lists, tables, financial calculations,
analysis and graphs. Excel is good for organizing different kinds of data, however
it is numerical data that is best suited. Thus, Excel can be used when you not only
need a tool for storing and managing data, but also analysing and querying it. In
addition to providing simple database capabilities, Excel also allows you to create
documents for the World Wide Web (WWW).

The menus, toolbars and icons of MS Excel are very similar (though not the
same) to MS Word. This is in keeping with Microsoft’s much hyped philosophy
and strategy of offering users a totally integrated office suite pack. From the user’s
point of view, this means less time spent in learning the second package once you
know the first, and almost effortless and seamless exchange of data between various
components.

3. Presentation Graphics

PowerPoint is a presentation tool that helps create eye-catching and effective
presentations in a matter of minutes. A presentation comprises of individual slides
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arranged in a sequential manner. Normally, each slide covers a brief topic. The
term ‘Free’ software specifies the freedom of using the software by various
computer users (private individuals as well as organizations and companies) granting
them freedom and control in running and adapting the computing and data
processing as per their needs. The key objective of free software is to grant freedom
rights to users so that the users are free to run, copy, distribute, study, change and
improve the software. For example, you can use PowerPoint software for preparing
presentations and adding notes to the specific slides. Similarly, you have the option
of either printing the slides—in case you want to use an overhead projector—or
simply attach your computer to an LCD display panel that enlarges the picture
several times and shows the output on a screen.

You have three options for creating a new presentation:
(i) Begin by working with a wizard (called the AutoContent Wizard)

that helps you determine the theme, contents and organization of
your presentation by using a predefined outline, or

(ii) Start by picking out a PowerPoint Design Template which
determines the presentation’s colour scheme, fonts and other design
features, or

(iii) Begin with a completely blank presentation with the colour scheme,
fonts and other design features set to default values.

If you decide to choose the third option, PowerPoint designers have
provided a wide assortment of predefined slide formats and Clip Art graphics
libraries. Through these predefined slide formats, you can quickly create slides
based on standard layouts and attributes.

PowerPoint shares a common look and feel with other MS Office
components, and having once mastered Word and Excel, learning PowerPoint is
almost like playing a game. And it is also easy to pick up data from Word and
Excel directly into a PowerPoint presentation and vice versa.

Database Management Software

Nowadays, all large businesses require database management. When managing a
large customer base, it is important to examine  vital  information like the busying
pattern, cheap suppliers and the number of orders being received. In order to
efficiently manage all these functions, MS Access is required.

As a first step, plan and create your database structure, identifying the
required fields based on the type of data (numbers, alphanumeric, data, etc.), and
the maximum width of each field. After determining the structure, you can create a
table either in the design mode (which is customized) or you can use the table
wizard and any of the predefined tables, with the required modifications.

Creating the tables through the table wizard is much faster and easier than
through the design mode. However, if you use wizards you are somewhat restricted
with the predefined settings already available.

Once you have created the table you can then use the form’s wizard to
create user friendly and aesthetically pleasing layouts for data entry. Creating forms
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for data entry also ensures that the user inputs only the right kind of information
and both data entry errors as well as typing work is minimized.

Once the forms have been created and relevant data has been entered,
using these you can then use the report wizard to generate any kind of report.
Using reports, you can not only organize and present your data in a more meaningful
manner, but you can also use various standard functions like subtotals, totals,
sorting to summarize your data.

Now to really fine-tune this Access application, you can create data access
pages to enable people spread over a large geographical area to share and compile
information using the Internet.

Computer Languages
A computer language essentially implies a language that is understandable to the
computer. It is the computer’s native language. Computer languages serve the
same purpose as human languages. They are a means of communication.  Let us
understand the similarities and differences between computer languages and human
languages.

Languages that we speak daily, such as English, Hindi, French or German
are known as material or human languages. It constitutes words and rules known
as lexicon and syntax, respectively. These words are joined to make meaningful
phrases according to the rules of the syntax. A computer language also consists of
lexicon and syntax, i.e., characters, symbols and rules of usage that allow the user
to communicate with the computer.

The primary difference between a natural language and computer language
is that natural languages have a large set of words (vocabulary) to choose from
while computer languages have a limited or restricted set of words. Thus, fewer
words but more rules characterize a computer language.

All problems to be solved by the computer needs to be broken down into
discrete logical steps before the computer can execute them. The process of writing
such instructions in a computer or programming language is called programming
or coding.

Since as computer hardware has improved over the years, programming
languages have also moved from machine-oriented languages (that used strings of
binary 0s and 1s) to problem-oriented languages (that use common English terms).
All computer languages can, however, be classified under the following categories:

 Machine Language (First Generation Language).

 Assembly Language (Second Generation Language).

 High-Level Language (Third Generation Language).

Classification of Computer Languages

Computer languages are classified as follows:

The computer can understand only a binary-based language. This is a combination
of 0s and 1s. Instructions written using sequences of 0s and 1s constitute a are
known as machine language. First-generation computers used programs written in
machine language.
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A major drawback of machine language is that it is highly complex and
difficult to use. Also, it consumes a lot of time and requires a substantial effort on
the part of the programmer. Thousands of machine language instructions are needed
to carry out simple tasks, such as listing a few addresses for mails. Any instruction
in machine language is divided into two components:

(i) Command: Also called the ‘operation code’ or opcode including addition,
multiplication, etc.

(ii) Operand: Refers to the address of the date on which the function has to be
performed.

A general machine language instruction is presented as follows:

OP Code Operand

001 010001110

The number of operands varies with each computer and is therefore computer
dependent.

It can be concluded that in order to develop computer programs in machine
language, the programmer will be required to remember a lot of operation codes
and addresses of the data items based on the storage location and also information
regarding the internal structure of the computer. Thus, using machine language can
be highly complicated and liable to errors. Identifying these errors and introducing
changes had become increasingly difficult leading programmers to seek better
options.

Assembly Language

The development of assembly language marked the beginning of the evolution of
programming languages. In assembly language mnemonics (symbolic codes) were
used to present operation codes as well as strings of characters to represent
addresses. Instructions in assembly language may appear as follows:

Opration Opration address

READ M

ADD L

Certain important facts about assembly language are as follows:

 Assembly language was designed to replace each machine code by an
understandable mnemonic and each address with a simple alphanumeric
string. It was matched to the processor structure of a particular computer
and was therefore (once again) machine dependent. This meant that programs
written for a particular computer model could not be executed on another
one. In other words, an assembly language program lacked portability.

 A program written in assembly language needs to be translated into machine
language before the computer can execute it. This is done by a special
program called ‘Assembler’ which takes every assembly language program
and translates it into its equivalent machine code.

 The assembly language program is known as the source program, while the
equivalent machine language program is known as the object program. It
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may be useful to know that the assembler is a system program supplied by
the computer manufacturer. Second-generation computers used assembly
language.

 The lack of portability of programs (written using machine or assembly
languages) between various computer systems led to the development of
high level languages. Since they allowed a programmer to overlook a lot of
low-level particulars of the hardware of the computer system, they were
called high level language programs.

 It was obvious that if the syntax, mnemonics and rule and regulations of the
programming language were closer to the natural language, it would be
easier for the programmer to program and the lesser the possibility of
introducing errors (or bugs) into the program. Hence, third generation
languages, which were algorithmic and procedural, came into being in the
mid-1950s. They were designed to solve a particular problem. They
contained commands that are particularly suited to one type of application.
For example, a number of languages were designed to process scientific or
mathematical problems. Others emphasized on commercial applications.
These languages varied very little between different computer systems, unlike
machine or symbolic languages. But a complier or an interpreter program
was required to translate these machine codes. Once again, the high level
program is called the source code while its equivalent machine language
program is referred to as the object code.

 Easy-to-learn feature, machine independence, easier maintenance and
portability contributed to the popularity of high level languages. Slow program
execution was the main disadvantage since programs needed to be converted
into machine language (by an interpreter or a compiler) before they could
be executed.

The assembly language program is known as the source program, while the
equivalent machine language program is known as the object program. It may be
useful to know that the assembler is a system program supplied by the computer
manufacturer. Second generation computers used assembly language.

The lack of portability of programs (written using machine or assembly
languages) between various computer systems led to the development of high
level languages. Since they allowed a programmer to overlook a lot of low-level
particulars of the hardware of the computer system, they were called high level
language programs. And it was obvious that if the syntax, mnemonics and rule and
regulations of the programming language were closer to the natural language, it
would be easier for the programmer to program and the lesser the possibility of
introducing errors (or bugs) into the program. Hence, third generation languages,
which were algorithmic and procedural, came into being in the mid-1950s. They
were designed to solve a particular problem. They contained commands that are
particularly suited to one type of application, for example, a number of languages
were designed to process scientific or mathematical problems. Others emphasized
on commercial applications. These languages varied very little between different
computer systems, unlike machine or symbolic languages. But a complier or an
interpreter program was required to translate these machine codes. Once again,
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the high level program is called the source code while its equivalent machine language
program is referred to as the object code.

Easy-to-learn features, machine independence, easier maintenance and
portability contributed to the popularity of high level languages. Slow program
execution was the main disadvantage since programs needed to be converted into
machine language (by an interpreter or a compiler) before they could be executed.

High Level Languages
Some of the high level languages have been discussed as follows:

The third generation programming language (3GL) is a refinement of a second
generation programming language. The 3GL made the languages more
programmers friendly. High level language is a synonym for third generation
programming language. First introduced in the late 1950s, FORTRAN (FORmula
TRANslation), ALGOL (ALGOrithmic Language) and COBOL (COmmon
Business Oriented Language) are early examples of 3GL. Most of popular and
general purpose languages today, such as C, C++, C#, Java, BASIC and Pascal
are also third generation languages. Most 3GLs support structured programming.
The following are the examples of 3GL.

1. FORTRAN

FORTAN (FORmula TRANslation) was the first high -level language developed
by John Backus at IBM in 1956.

FORTRAN has a number of versions with FORTRAN IV being one of the
earlier popular versions. In 1977, the American National Standards Institute (ANSI)
published standards for FORTRAN with a view to standardizing the form of the
language used by manufacturers. This standardized version is called FORTRAN 77.

2. COBOL

COBOL (COmmon Business Oriented Language), the first language used for
commercial applications, was developed under the leadership of Grace Hopper,
a US Navy programmer, with a group of computer manufacturers and users in
1959. The maintenance and further growth of the language was handed over to a
group called CODASYL (COnference on DAta SYstems Languages).

It is written using statements that resemble simple English and can be
understood easily; for example, to add two numbers (stored in variables A and
B), a simple statement in COBOL would be: ADD A TO B GIVING C.

COBOL was standardized by ANSI in 1968 and in 1974. COBOL became
the most widely used programming language for business and data processing
applications.

3. BASIC

BASIC (Beginner's All-purpose Symbolic Instruction Code) was developed as a
teaching tool for undergraduate students in 1966 by John Kemeny and Thomas
Kurtz, two professors at Dartmouth College. Eventually BASIC was used as the
main language amongst the personal computer users.
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A minimum version of BASIC was standardized by ANSI and is so simple
that it has been incorporated in every subsequent version of BASIC. Some versions
of BASIC include MBASIC (Microsoft BASIC) and CBASIC (Compiler based
BASIC).

One of the newer versions of BASIC, commonly known as Visual Basic,
has also evolved from the original BASIC language. It contains various statements
and functions that can be used to create applications for a Windows or GUI
environment.

4. PASCAL

PASCAL was designed by Nicholas Wirth, a Swiss professor, in 1971. It was
developed as a more structured language used for teaching which Wirth named
after the French mathematician Blaise Pascal, who also designed the first successful
mechanical calculator. His primary aim was to provide a language that supported
beginners learning good problem solving and programming techniques.

In addition to manipulation of numbers, PASCAL supports manipulation of
vectors, matrices, strings of characters, records, files and lists, thereby supporting
non-numeric programming. Hence, it has proved to be an attractive language for
professional computer scientists.

PASCAL has been standardized by ISO (International Standards
Organization) and ANSI.

5. PL/1

PL/1 (Programming Language 1) was developed by IBM in the 1960s and was
the first language that was attempted to be used for a variety of applications rather
than one particular area like business or science or artificial Intelligence.

6. LISP

LISP was developed in the early 1950s but was implemented in the 1959 by John
McCarthy at the Massachusetts Institute of Technology. It became a standard
language with the artificial intelligence community and was a program that could
easily handle recursive.

7. C

This language was developed by Dennis Ritchie of Bell Laboratories in order to
implement the operating system UNIX.

8. C ++

This language was developed by the Bjarne Stroustrup of Bell Laboratories by
enhancing C. C++ is also used to write procedural programs like C but the reason
for its increased popularity is perhaps because of its capability to handle the rigours
of object-oriented programming. C and C++ are the most extensively used general-
purpose languages amongst programming experts.

9. JAVA

Java is again an object-oriented language like the C++ but is a simplified version
with extra features. It is less prone to programming errors. It was developed for
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writing programs that could be safely and easily executed through the Internet. It
is free from any kind of common virus threats. It is basically a network-oriented
language that can develop Website pages with enhanced multimedia features using
small java programs known as java applets, Java is a secure to use over the
Internet and is a platform independent language.

Generation of Computer Languages
Computer languages have changed with every changing generation of computers.
Some of these new languages are:

1. Fourth Generation Languages (4 GL)

These are non-procedural languages, which suggests that they present the objective
but not the procedure to achieve it. The main features of fourth generation languages
are as follows:

 They constitute simple instructions.

 They are user-friendly, enabling the user to write programs and achieve the
desired goal.

 They eliminate the need of a professional programmer for writing programs.

FORTH, was the first fourth generation language and was developed by Charles
Morre, an American astronomer, in 1970.

Its main application is in the industrial and scientific control applications.
Another example of fourth generation language is FOCUS.

2. Fifth Generation Languages (5 GL)

Fifth generation languages have developed as a result of research in the area of
artificial intelligence. They are, however, early stage.

(i) PROLOG (PROgramming LOGic): It is a general purpose logic
programming language. PROLOG is often associated with artificial
intelligence and computational linguistics. It has a purely logical subset, called
pure Prolog, as well as a number of extralogical features.

Prolog was developed in the early 1970s by two French computer scientists,
Alain Colmerauer and Philippe Roussel.

Some of other popular languages include:

(ii) GPSS (General Purpose System Simulator): Used for modelling physical
and environmental events.

(iii) SNOBOL (String Oriented Symbolic Language): Designed for pattern
matching and list processing.

(iv) LOGO (a version of LISP): Developed in the 1960s to help children
learn about computers.

(v) PILOT (Programmed Instruction Learning, Or Testing): Used in writing
instructional software.
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1.6.3 Input/Output Devices

The computer system is a dumb and a useless machine if it is not capable of
communicating with the outside world. It is very important for a computer system
to have the ability to communicate with the outside world, i.e., receive and send
data and information.

Computers have an input output subsystem, referred to as I/O subsystem,
which provides an efficient mode of communication between the central system
and the outside world. Programs and data must be entered into the computer
memory for processing, and results obtained from computations must be displayed
or recorded for the user’s benefit. This can be explained with a very common
scenario where the average marks of a student need to be calculated based on the
marks obtained in various subjects. The marks would typically be available in the
form of a document containing the student’s name, roll number and marks scored
in each subject. This data must first be stored in the computer’s memory after
converting it into machine-readable form. The data will then be processed (average
marks calculated) and sent from the memory to the output unit, which will present
the data in a form that can be read by users.

The I/O devices that provide a means of communication between the
computer and the outside world are known as peripheral devices. This is because
they surround the CPU and the memory of a computer system. While input devices
are used to enter data from the outside world into the primary storage, output
devices are used to provide the processed results from primary storage to users.

Input Devices

Input devices are used to transfer user data and instructions to the computer. The
most commonly used input devices can be classified into the following categories:

 Keyboard devices (general and special purpose, key-to-tape, key-to-disk,
key-to-diskette).

 Point-and-draw devices (mouse, trackball, joystick, light pen, touch screen).

 Scanning devices (optical mark recognition, magnetic ink character
recognition, optical barcode reader, digitizer, electronic-card reader).

 Voice recognition devices.

 Vision-input devices (Webcam, video camera).

Keyboard

Keyboard devices allow input into the computer system by pressing a set of keys
mounted on a board, connected to the computer system. Keyboard devices are
typically classified as general-purpose keyboards and special-purpose keyboards.

General-Purpose Keyboard

The most familiar means of entering information into a computer is through a
typewriter like keyboard that allows a person to enter alphanumeric information
directly.



Computer Appreciation
and Organization

NOTES

Self - Learning
38 Material

Fig. 1.11 QWERTY Keyboard Layout

The most popular keyboard used today is the 101 key with a traditional
QWERTY layout, with an alphanumeric keypad, 12 function keys, a variety of
special function keys, numeric keypad, and dedicated cursor control keys. It is so
called because the arrangement of its alphanumeric keys in the upper-left row (as
shown in the Figure 1.11).

 Alphanumeric Keypad: This contains keys for the English alphabets, 0 to
9 numbers, special characters like *, +, –, /, [, ], etc.

 12 Function Keys: These are keys labelled F1, F2 ... F12 and are a set of
user- programmable function keys. The actual function assigned to a function
key differs from one software package to another. These keys are also
called soft keys since their functionality can be defined by the software.

 Special Function Keys: Special functions are assigned to each of these
keys. The enter key, for example, is used to send the keyed-in data into the
memory. Other special keys include:

 Shift used to enter capital letters or special characters defined above
the number keys.

 Spacebar used to enter a space at the cursor location.
 Ctrl used in conjunction with other keys to provide added functionality

on the keyboard.
 Alt like Ctrl, used to expand the functionality of the keyboard.
 Tab used to move the cursor to the next tab position defined.
 Backspace used to move the cursor a position to the left and also

delete the character in that position.
 Caps Lock used to toggle between the capital letter lock feature –

when ‘on’, it locks the keypad for capital letters input.
 Num Lock used to toggle the number lock feature – when ‘on’, it

inputs numbers when you press the numbers on the numeric keypad.
 Insert used to toggle between the insert and overwrite mode during

data entry – when ‘on’, entered text is inserted at the cursor location.
 Delete used to delete the character at the cursor location.
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 Home used to move the cursor to the beginning of the work area
which could be the line, screen or document depending on the software
being used.

 End used to move the cursor to the end of the work area.
 Page Up used to display the previous page of the document being

currently viewed on screen.
 Page Down used to view the next page of the document being currently

viewed on screen.
 Escape usually used to negate the current command.
 Print Screen used to print what is being currently displayed on the

screen.

 Numeric Keypad: This consists of keys with numbers (0 to 9) and
mathematical operators (+ – * /) defined on them. It is usually located on
the right side of the keyboard and supports quick entry of numerical data.

 Cursor Control Keys: They are defined by the arrow keys used to move
the cursor in the direction indicated by the arrow (top, down, left, right).

Another popular key arrangement, called Dvorak system, was designed for easy
learning and use. It was designed with the most common consonants in one part
and all the vowels on the other part of the middle row of the keyboard. This key
arrangement made the users use alternate keystrokes back and forth between
both the hands. This keyboard was never been commonly used.

Special-Purpose Keyboard

These are standalone data entry systems used for computers deployed for specific
applications. These typically have special-purpose keyboards to enable faster data
entry. A very typical example of such keyboards can be seen at the Automated Teller
Machines (ATMs) where the keyboard is required for limited functionality (support
for some financial transactions) by the customers. Point Of Sale (POS) terminals at
fast food joints and  air/railway reservation counters are some other examples of
special-purpose keyboards. These keyboards are specifically designed for special
types of applications only.

Light Pen

The light pen is a small input device used to select and display objects on a screen.
It functions with a light sensor and has a lens on the tip of a pen shaped device.
The light receptor is activated by pointing the light pen towards the display screen
and it then locates the position of the pen with the help of a scanning beam application
to directly draw on screen. Figure 1.12 shows the function of light pen on the
screen which points to the screen to detect the bright and dim effect for signalling
pulse for video clip.
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Fig. 1.12 Light Pen

Mouse

A mouse is a small input device used to move the cursor on a computer screen to
give instructions to the computer and to run programs and applications. It can be
used to select menu commands, move icons, size windows, start programs, close
windows, etc. Initially, the mouse was a widely used input device for the Apple
computer and was a regular device of the Apple Macintosh. Nowadays, the mouse
is the most important device in the functioning of a Graphical User Interface (GUI)
of almost all computer systems. Figure 1.13 shows the frequently used input device,
i.e., mouse.

 
Fig. 1.13 Mouse

You can click a mouse button, i.e., press and release the left mouse button, to
select an item. You can right click, i.e., press and release the right mouse button to
display a list of commands. You can double click, i.e., quickly press the left mouse
button twice without any time gap between the press of the buttons, to open a
program or a document. You can also drag and drop, i.e., place the cursor over
an item on the screen and than press and hold down the left mouse button. Holding
down the button, move the cursor to where you want to place the item and then
release the button.

Mechanical Mouse: As shown in Figure 1.14(a), in a mechanical mouse,
there is a ball that protrudes under the housing. This ball is rolled across a flat
surface. The ball movement turns a perpendicular pair of shafts inside the housing.
The shafts drive encodes the distance travelled by using an encoder that consists
of a clear plastic wheel with radial lines printed on it. This type of mouse uses LED
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and phototransistor to sense the ball movement and generate pulse corresponding
to mouse movement.

Let us study how this translation exactly takes place. The basic principle
behind the working of a mouse is there is an LED shines that through plastic wheel
fall onto a phototransistor, and as mouse moves there is a variation in the light
reaching the phototransistor is observed. This variation depends on the number of
line it passes on the radial wheel and leads to generation of pulses. This pulse
count will be in proportion to distance moved. The pulse generated can either be
counted in the mouse itself or it can be sent to the computer for counting. Usually
a pair of phototransistors is used so that it can be determined in which direction
the shaft is rotating. Thus according to the distance the mouse covers on the flat
surface, the corresponding cursor position moves on the screen.

Optical Mouse: In an optical mouse, as shown in Figure 1.14(b), we use
a pair of LEDs. These LEDs shine on a special reflective pad which is printed with
a grid of lines having two different colors; generally blue lines run horizontally and
black lines run vertically. Two phototransistors are used to sense the reflected
light. They determine direction in which mouse is moved across the pad. Each
phototransistor is sensitive to one color and is elongated in the particular direction.
Like in mechanical mouse, the distance covered is measured by the count of the
pulse that is resulted from the reflections of the dots. These pulses are either sent
to the computer for counting or the pulses are counted in mouse only and the
count result is sent to the computer.

y roller
x roller

x axis

y axis

Ball touching the rollers 
rotates them via friction

       

Photosens or detects
crossing of grid lines

Mouse pad

    (a) Mechanical Mouse (b) Optical Mouse

Fig. 1.14 Mechanical Mouse and Optical Mouse

The mouse is one of the devices designed solely for the computer industry.
It can send data at the rate of 20 bytes per second. The information is sent to
processor in serial manner, same as in the keyboard.

Working of the trackball is similar to a mechanical mouse. The only difference
is that in trackball, the ball used is typically larger, and the user rolls it with his or
her fingers or hands. The objective of trackball is again the cursor movement.

Joystick

The joystick is a vertical stick that moves the graphic cursor in the direction the
stick is moved. It consists of a spherical ball, which moves within a socket and has
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a stick mounted on it. The user moves the ball with the help of the stick that can be
moved left or right, forward or backward, to move and position the cursor in the
desired location. Joysticks typically have a button on top that is used to select the
option pointed by the cursor.

Video games, training simulators and control panels of robots are some
common uses of a joystick.

Trackball

The trackball is a pointing device that is much like an inverted mouse. It consists of
a ball inset in a small external box or adjacent to, and in the same unit, as the
keyboard of some portable computers.

It is more convenient and requires much less space than the mouse since
here the whole device is not moved (as in the case of a mouse). Trackball comes
in various shapes but supports the same functionality. Typical shapes used are a
ball, a square and a button (typically seen in laptops).

Web Camera

A Web camera is a video capturing device attached to the computer system,
mostly using a USB port used for video conferencing, video security, as a control
input device and also in gaming.

Optical Input Devices

Scanning devices are input devices used for direct data entry from the source
document into the computer system. With the help of the scanner you can capture
your images and documents and convert it into digital formats for easy storage on
your computer. The scanner comprises of two major components, the first
component lights up the page in order to capture the optical image and the second
component converts that captured image into a digital format for viewing and
storing it on your computer system.

Optical Scanners

There are two types of scanners, contact and laser. Both illuminate the image first
to calculate the reflected light and determine the value of the captured image.
Hand-held contact scanners make contact as they are brushed over the printed
matter to be read. Laser-based scanners are more versatile and can read data
passed near the scanning area.

Hand-held scanners are used where the information to be scanned or the
volume of documents to be scanned is very low. They are much cheaper as
compared to the flat-bed scanners. Capturing information using scanners reduces
the possibility of human error typically seen during large data entry. The reduction
in human intervention improves the accuracy of data and provides for timeliness of
the information processed.

Source data automation is the recent development for data input
technologies. Source data automation does not require any manual data entry;
rather it captures the data as a derivative of the routine business activity.
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Optical Mark Recognition (OMR)

The OMR devices can scan marks from a computer readable paper. Such devices
are used by universities and institutes to mark test sheets where the candidate
selects and marks the correct answer from multiple choices given on a special
sheet of paper. These marksheets are not required to be evaluated manually as
they are fed in the OMR and the data is then transferred to the computer system
for further evaluation.

The actual technique used by an OMR device once again involves focussing
a light on the page being scanned, thereby detecting the reflected light pattern for
the marks. Pencil marks made by the user reflect the light determining which
responses are marked.

Magnetic Ink Character Recognition (MICR)

Magnetic Ink Character Recognition or MICR is like an optical mark recognition
device and is  used only in the banking industry. MICR devices scan cheque
numbers directly from the cheque leaflets and then automatically feed them in the
computer systems for further use, doing the job quickly, accurately and efficiently.

Banks using MICR technology print cheque books on special types of paper.
The necessary details of the bank (like the bank’s identification code, relevant
account number and cheque number) are pre-printed on the cheques using an ink
that contains iron oxide particles that can be magnetized.

MICR readers are used to read and sort cheques and deposits. An MICR
reader-sorter reads the data on the cheques and sorts the cheques for distribution
to other banks and customers or for further processing.

Optical Bar Code Reader (OBR)

Data coded in the form of small vertical lines forms the basis of bar coding.
Alphanumeric data is represented using adjacent vertical lines called bar codes.
These are of varying widths and the spacing between them are used to uniquely
identify books, merchandise in stores, postal packages, etc.

The laser beam is moved across the pattern of bars in a bar code. These
bars reflect the beam in different ways. The reflected beam is then sensed by a
light sensitive detector, which then converts the light patterns into electrical pulses,
thereby transmitting them to logic circuits for further conversion to alphanumeric
value. Bar code devices are available as hand-held devices.

Output Devices

The CRT consist of an electron gun with an electron beam controlled with
electromagnetic fields and a phosphate-coated glass display screen structured
into a grid of small dots known as pixels. The image is created with the electron
beam produced by the electron gun, which is thrown on the phosphor coat displayed
by the electromagnetic field. A CRT terminals or TV is readily recognizable by its
bulky form. LCD monitors and plasma television sets, or flat panel displays, use
newer digital technologies. The CRT monitor creates a picture out of many rows
or lines of tiny colored dots. These are technically not the same thing as pixels, but
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the terms are often used interchangeably. The more lines of dots per inch produce
high and clear the resolution. Therefore, 1024 × 768 resolution will be sharper
than 800 × 600 resolution because the former uses more lines creating a denser,
more detailed picture. Higher resolutions are important for displaying the subtle
detail of graphics. For text, resolution is not as critical. Inside a CRT, monitor is a
picture tube that narrows at the rear into a bottleneck. In the bottleneck is a
negative charged filament or cathode enclosed in a vacuum. When electricity is
supplied, the filament heats up and a stream or ray of electrons pours off the
element into the vacuum. The negatively charged electrons are attracted to positively
charged anodes which focus the particles into three narrow beams, accelerating
them to strike the phosphor-coated screen. Phosphor will glow when exposed to
any kind of radiation, absorbing ultraviolet light and emitting visible light of
fluorescent color. Phosphors that emit red, green and blue light are used in a color
monitor, arranged as stripes made up of dots of color. The three beams are used
to excite the three colors in combinations needed to create the various hues that
form the picture

Non-CRT Terminals

Non-CRT displays include LED, LCD and plasma displays, which are frequently
used in microprocessor based industrial controls, instruments etc., where a small
amount of data is perpetually exchanged. CRT screen display is used if long amount
of data are to be displayed. CRT screen display is used if large amount of data are
to be displayed. In portable battery powered instruments, usually LCD displays
are used because it consumes low power. For example, in LCD, a liquid crystalline
material is used, whereas in LED displays, display and keyboard interfacing chip
Intel 8279 is used, which is a programmable keyboard and display device. The
non-CRT displays drives the alphanumeric displays or indicator lights. The types
of non-CRT terminals are as follows:

Light-Emitting Diode (LED) Display

The three frequently types of LED displays are known as 7-segment displays,
18-segment displays and 5 × 7 dot matrix display.  These types of display are
easily available in the market. The 7-segment display is very simple amongst others.
It helps in displaying only digits and hexadecimal alphabets. Since 7-segment
displays being simple and hence they are widely used. Various types of drivers
and decoders are used in 7-segment displays and are available in Integrated Circuit
(IC) form. The displays are interfaced to microprocessors and activated through
drivers and decoders. The role of port is very important because all types of LED
displays with buffers can also be directly connected to the processors with it.
These codes are stored in the memory. For example, the 24-inch LED cinema
display is designed precisely for the new MacBook Pro, MacBook Air and new
Mac desktops. And, with a built-in iSight camera, speakers and MagSafe charger,
it does not just expand the screen. LED screens are specifically designed for
indoor or outdoor use. There are two main factors that differentiate an indoor
screen from an outdoor screen. The first is weather durability. Outdoor screens
are designed to function properly in extreme weather conditions, while indoor
screens are not built to the same environmental standards. Outdoor led screens
use LEDs that are designed to be bright enough for outdoor environment. Figure
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1.15 illustrates that distance and character size will be recognized and understood
the content of an electronic sign.

Fig. 1.15 Viewing Distance of LED Display

Figure 1.15 shows how viewing distance is one of the most important factors
needed to determine the correct size of most indoor LED screen. A general rule is
specified that 1 inch of text is viewable up to 50 feet away or 25mm of text is
viewable upto 15m away. LEDs emit light allowing the content to be visible further
away than the same content on standard reflective surfaces. Other factors, such as
content size, traffic, distractions, weather, lighting conditions, etc. will affect the
time required. Each square meter of the LED display can contain from 1,024
pixels (32×32 pixels) upto 9,216 pixels (96×96 pixels) depending on the models.
The number of pixels can vary on the same surface because of pixel pitch. The
pixel pitch of an LED display defines the distance between the pixels, expressed in
millimeters. This is a defining factor of a LED screen’s viewing distance. The closer
the pixels are the closer the minimum distance but higher the screen cost per area.
The further away the minimum viewing distance is and the lower the screen cost
per area. Therefore, the pitch determines the image definition and cost of the
display. Low pixel pitch equals higher definition and cost, whereas high pixel pitch
equals lower definition and cost.

LCD and Plasma Display

Liquid Crystal Display (LCD) was first introduced in the 1970s in digital clocks
and watches, and is now widely being used in computer display units. The Cathode
Ray Tube (CRT) was replaced with the LCD making it slimmer and more compact.
But the image quality and the image color capability got comparatively poorer.

The main advantage of LCD is its low energy consumption. It finds its most
common usage in portable devices where size and energy consumption are of
main importance.

In plasma type of displays, ionized gas is used. This gas is filled between
two glass plates. It starts to work when current is passed through one horizontal
and one vertical wire to cause the gas to flow at the intersection of the wires. If
problem occurred in LCD, the plasma displays can overcome the problem. Plasma
display is brighter than LCD. It can be seen from a wide angle, i.e., 160 degrees.
Gas plasma display screen can easily be made larger than 40 inches diagonal.
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Simplified circuits are used in plasma screen. Cathode ray tubes produce vibrant
images and they are bulky. In order to increase the screen width in a CRT set, you
also have to increase the length of the tube to give the scanning electron gun room
to reach all parts of the screen. Consequently, any big-screen CRT television
weighs a ton and takes up a sizable chunk of a room. Therefore, a new alternative
has popped up on store shelves, i.e., the plasma flat panel display. These displays
have wide screens, comparable to the largest CRT sets, but they are only about 6
inches (15 cm) thick. The plasma displays are based on the information in a video
signal and it lights up thousands of tiny dots (called pixels) with a high-energy
beam of electrons. In most systems, there are three pixel colors Red, Green and
Blue (RGB), which are evenly distributed on the screen. By combining these colors
in different proportions, the television can produce the entire color spectrum. The
basic idea of a plasma display is to illuminate tiny colored fluorescent lights to form
an image. Each pixel is made up of three fluorescent lights with RGB combination.
It is like a CRT television, the plasma display varies the intensities of the different
lights to produce a full range of colors. The central element in a fluorescent light is
plasma, a gas made up of free-flowing ions (electrically charged atoms) and
electrons (negatively charged particles). In plasma display, an electrical current
running through it in which, negatively charged particles rush toward the positively
charged area of the plasma and positively charged particles are rushing toward
the negatively charged area. A gas is mainly made up of uncharged particles. That
is, the individual gas atoms include equal number of protons and electrons. Protons
are positively charged particles in the atom’s nucleus. The negatively charged
electrons perfectly balance the positively charged protons, so the atom has a net
charge of zero. If you introduce many free electrons into the gas by establishing an
electrical voltage across it, the situation changes very quickly. The free electrons
collide with the atoms, knocking loose other electrons. With a missing electron, an
atom loses its balance. It has a net positive charge, making it an ion. The xenon
and neon gas in a plasma display is contained in hundreds of thousands of tiny
cells positioned between two plates of glass. Long electrodes are also sandwiched
between the glass plates, on both sides of the cells. The address electrodes sit
behind the cells, along the rear glass plate. The transparent display electrodes,
surrounded by an insulating dielectric material and covered by a magnesium oxide
protective layer, are mounted above the cell and along the front glass plate.

Fig. 1.16 Surface Discharge on Base Screen
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Figure 1.16 shows how set of electrodes extend across the entire screen. The
display electrodes are arranged in horizontal rows along the screen and the address
electrodes are arranged in vertical columns. As you can see in the Figure 1.17, the
vertical and horizontal electrodes form a basic grid.

Fig. 1.17 Setting of Vertical and Horizontal Electrodes in Plasma Display

To ionize the gas in a particular cell, the plasma display’s computer charges the
electrodes that intersect at that cell. It does this thousands of times in a small
fraction of a second, charging each cell in turn. The intersecting electrodes are
charged with a voltage difference between them, the electric current flows between
the cells. And, the current creates a rapid flow of charged particles, which stimulates
the gas atoms to release ultraviolet photons. The released ultraviolet photons interact
with phosphor material coated on the inside wall of the cell. Phosphors are
substances that give off light when they are exposed to other light. If ultraviolet
photon hits a phosphor atom in the cell, one of the phosphor’s electrons jumps to
a higher energy level and the atom heats up. When the electron falls back to its
normal level, it releases energy in the form of a visible light photon.

Fig. 1.18 (1) Display Electrode, (2) Glass Substrate (Front), (3) Discharge
Region, (4) Phosphor, (5) Address Electrode and (6) Glass Substrate (Rear)

Figure 1.18 shows the phosphors in a plasma display give off colored light when
they are heated. Every pixel is made up of three separate subpixel cells, each with
different colored phosphors. One subpixel has a red light phosphor, one subpixel
has a green light phosphor and one subpixel has a blue light phosphor. These
colors blend together to create the overall color of the pixel. By varying the pulses
of current flowing through the different cells, the control system can increase or
decrease the intensity of each subpixel color to create hundreds of different
combinations of red, green and blue. In this way, the control system can produce



Computer Appreciation
and Organization

NOTES

Self - Learning
48 Material

colors across the entire spectrum. The main advantage of plasma display technology
is that you can produce a very wide screen using extremely thin materials. And
because each pixel is lit individually, the image is very bright and looks good from
almost every angle. The image quality is not quite up to the standards of the best
cathode ray tube sets, but it certainly meets most people’s expectations.

Thin Film Transistor (TFT)

A thin film transistor is comprised of a semiconductor layer. It insulates a gate
layer and a gate electrode. The role of semiconductor layer is to add polysilicon
layer whose electron mobility is 100 times higher than that of an amorphous silicon
layer. This type of transistor is used as switching devices in flat display panels,
such as Organic Light Emitting Diodes (OLEDs) or LCDs. A LCD is one of the
most widely used flat panel displays since it is lightweight and occupies less space
than conventional CRT displays. The applications for liquid crystal displays are
extensive, such as mobile phones, digital cameras, video cameras, notebooks and
monitors. LCD together with other flat panel type display has become one of the
most researched types of displays. Plasma displays and electro-luminance displays
are the flat panel type display. The thin film transistor array substrate includes gate
lines and data lines, a thin film transistor formed as a switching device at every
crossing of the gate lines and the data lines, a pixel electrode connected to the thin
film transistor substantially defining a liquid crystal cell and an alignment film applied
to the substrate. A thin film transistor is usually fabricated as MOSFET including
an electrically insulating substrate, such as a glass substrate and a thin semiconductor
layer formed on the substrate and acting as an active region. A TFT LCD display
is composed of a thin film transistor array substrate, a color filter array substrate
and a liquid crystal layer, wherein the thin film crystal transistor array substrate is
composed of many thin film transistors arranged in an array and pixel electrodes
corresponding to each thin film transistor to form pixel structures. When a thin film
transistor is used in an active matrix type liquid crystal display device, for instance,
the thin film transistor is designed to be driven by a driver integrated circuit as a
switching device for switching pixels.

Fig. 1.19 Thin Film Transistor

Figure 1.19 shows the cross section of TFT in which a voltage applied at the gate
controls the flow of electrons (resistance) from the source to the drain and a
positive gate voltage attracts electrons to the bottom surface of the semiconductor
layer and creates a conduction channel. If voltage difference is applied between
the two connector wires, electrons enter at one end, i.e., the source and exit at the
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other, i.e., the drain. It results in a current along with the channel. A chemical-
deposition method is used in TFT to produce the uniform films.

Printers

Printers are used for creating paper output. There is a huge range of commercially
available printers today (estimated to be 1500 different types). These printers can
be classified into categories based on:

 Printing technology.

 Printing speed.

 Printing quality.

Printing Technology: Printers can be classified as impact or non-impact printers,
based on the technology they use for producing output. Impact printers work on
the mechanism similar to a manual typewriter where the printer head strikes on the
paper and leaves the impression through an inked ribbon. Dot matrix printers and
character printers fall under this category. Non-impact printers use chemicals,
inks, toners, heat or electric signals to print on the paper and they do not physically
touch the paper while printing.

Printing Speed: This refers to the number of characters printed in a unit of time.
Based on speed, these may be classified as character printer (prints one character
at a time), line printers (prints one line at a time) and page printers (print the entire
page at a time). Printer speeds are, therefore, measured in terms of characters-
per-second for a character printer, lines-per-minute for a line printer and pages-
per-minute or ppm for a page printer.

Printing Quality: It is determined by the resolution of printing and is characterized
by the number of dots that can be printed per linear inch, horizontally or vertically.
It is measured in terms of dots-per-inch or DPI. Printers can be classified as
Near-Letter-Quality (NLQ), Letter-Quality (LQ), Near-Typeset-Quality (NTQ)
and Typeset-Quality (TQ), based on their printing quality. NLQ printers have
resolutions of about 300 DPI, LQ of about 600 DPI, NTQ of about 1200 DPI
and TQ of about 2000 DPI. NLQ and LQ printers are used for ordinary printing
in day-to-day activities, while NTQ and TQ printers are used to produce top-
quality printing, typically required in the publishing industry.

Types of Printers

Following are the different types of printers.

Dot Matrix

Dot matrix printers are the most widely used impact printers in personal computing.
These printers use a print head consisting of a series of small metal pins that strike
on a paper through an inked ribbon, leaving an impression on the paper through
the ink transferred. Characters thus produced are in a matrix format. The shape of
each character, i.e., the dot pattern, is obtained from information held electronically.
Figure 1.20(a) and 1.20(b) shows characters formed using dots and dot matrix
printer respectively.
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Fig. 1.20(a) Characters Formed using Dots Fig. 1.20(b) Dot Matrix Printer

The speed, versatility and ruggedness, combined with low cost, tend to make
such printers particularly attractive in the personal computer market. Typical printing
speeds in case of dot matrix printers range between 40 - 1000 Characters Per
Second (CPS). In spite of all these features in dot matrix printer technology, the
low print quality gives it a major disadvantage.

Inkjet

Inkjet printers are based on the use of a series of nozzles for propelling droplets of
printing ink directly on almost any size of paper. They, therefore, fall under the
category of non-impact printers. The print head of an inkjet printer consists of a
number of tiny nozzles that can be selectively heated up in a few microseconds by
an IC register. When this happens, the ink near it vaporizes and is ejected through
the nozzle to make a dot on the paper placed in front of the print head. The
character is printed by selectively heating the appropriate set of nozzles as the
print head moves horizontally.

Characters are formed as a result of electrically charged or heated ink being
sprayed in fine jets onto the paper. Individual nozzles in the printing head produce
high resolution, up to 400 dots per inch or 400 Dots Per Inch (DPI) dot matrix
characters.

Inkjet printers use color cartridges which combine magenta, yellow and
cyan inks to create color tones. A black cartridge is also used for crisp monochrome
output. This method of printing can generate up to 200 (CPS) and allows for
good quality, cheap color printing.

Laser

Laser printers work on the same printing technology as photocopiers, using static
electricity and heat to print with a high quality powder substance known as toner.

Laser printers are capable of converting computer output into print, page
by page. Since characters are formed by very tiny ink particles, they can produce
very high quality images (text and graphics). They generally offer a wide variety of
character fonts and are silent and fast in use. Laser printers are faster in printing
speed than other printers discussed above. Laser printers can print from 10 pages
to 100 pages per minute, depending upon the make/model. Laser is high quality,
high speed, high volume and non-impact technology that works on almost any
kind of paper. Even though this technology is more expensive than inkjet printers,
it is preferred because of its unmatched features, such as high quality, high speed
printing and noiseless and easy-to-use operations.
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Laser Printers use a laser beam and dry powdered ink to produce a fine
dot matrix pattern. This method of printing can generate about 4 pages of A4
paper per minute.

The standard of print is very good and laser printers can also produce very
good quality printed graphic images too.

Character Printer

The character printers are impact printers. In a character printer, characters are
printed one after the other with the help of a matrix of dots, so it is also known as
serial printer. Only one character can be printed at a time and hence they are
called slow printers. They need less memory as only one character is to be stored
for printing. They are capable of printing at the rate of 30 to 300 CPS. The only
advantage of character printer is that it is a low cost printer and is basically used
with personal computers. The disadvantage of this printer is that it has low speed
and makes lot of noise while printing. Dot matrix printer, thermal dot matrix printer,
daisy wheel-printer and inkjet printer are the examples of character printers.

Daisy-Wheel Printer

Daisy-wheel printer comes in the category of output device and quite similar to
typewriters. It is in the shape of flat and circular printers in which printing elements
contain all text, special characters and number characters. The printed characters
are spin rapidly and hold the position of printing hammer that is to be stricken the
character against ribbon and paper. It was invented in 1969 by David S. Lee at
Diablo Data Systems (DDS). This printer uses interchangeable preformed type
elements having 96 glyphs that are able to generate a good quality of output on the
paper. This printer is used in electronic typewriters to take printouts for documents
which are prepared in the word processors or notepads from the year of 1972.
This printer contains a print head that looks like the wheel of bicycle hence known
as letter quality printer too. This printer radiates the crown of spokes which is
ended in tiny and formed characters if the paper is inserted into this printer for
printing. At the end of each spoke, carved alphabets appear as print outs. Due to
advancement of printing technology, this type of printer is not being used in the big
organization. The desired character spins around the print hammer in which alphabets
and figures are banged into the ribbon that has to be appeared onto the inserted
paper. This printer prints the desired alphabets, documents and special characters
etc. at the speed of 10 to 75 characters per second. This printer employs either a
metal or a plastic print wheel having especially the mounted type of long flexible
fingers or petals. A single print hammer is used to impress the characters on the
paper.

Note: Glyph is considered as elements of writing. It got its name due to wheel around the
printer appeared as a set of print characters to make a typing impression on paper.

Line Printers

Another type of impact printer somewhat similar to the daisy-wheel is the line
printer. However, instead of a print wheel, line printers have a mechanism that
allows multiple characters to be simultaneously printed on the same line. The
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mechanism may use a large spinning print drum or a looped print chain. As the
drum or chain are rotated over the paper’s surface, electromechanical hammers
behind the paper push the paper along with a ribbon onto the surface of the drum
or chain, marking the paper with the shape of the character on the drum or chain.
Because of the nature of the print mechanism, line printers are much faster than
dot-matrix or daisy-wheel printers; however, they tend to be quite loud, have
limited multi-font capability, and often produce lower print quality than more recent
printing technologies. Because line printers are used for their speed, they use special
tractor-fed paper with pre-punched holes along each side. This arrangement makes
continuous unattended high-speed printing possible, with stops only required when
a box of paper runs out.

Page Printer

The page printers are high speed non-impact printers. The printing speed is very
high and the output is a page at a time. The techniques used to design such printers
are called electro-photographic techniques because it was based on paper copier
or Xerox technology. The page printers are capable of producing fast output of
pages similar to a Xerox machine. The example of page printer is laser printers
which print an entire page at once. Laser printers are designed on technology that
includes laser beam and electro-photographic for producing approximately 18,000
lines per minute. Page printers require more memory as compared to character or
line printers because they store each page in memory before printing it. Example
of page printer is as follows:

Thermal Printer

Characters are formed by heated elements being placed in contact with special
heat sensitive paper forming darkened dots when the elements reach a critical
temperature.

Thermal printer paper tends to darken over time due to exposure to sunlight
and heat. The standard of print produced is poor. Thermal printers are widely
used in battery powered equipment such as portable calculators.

Check Your Progress

5. What are the three important parts of a computer system?

6. Which component of the computer is responsible for controlling different
computer operations?

7. What does computer hardware refer?

8. State about the computer software.

9. What are the categories of software on functional basis?

10. What is business software?

11. Write the full form of COTS.

12. What are peripheral devices?

13. What is the purpose of using input devices?
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14. What are scanning devices?

15. Where is a hand-held scanner used?

16. How a picture is created in a CRT monitor?

17. How does a dot-matrix printer operate?

1.7 COMPUTER ORGANIZATION

One of the important jobs of computers is storing and managing data in a retrievable
form as and when required. These days the basic constitutents that make up a
computer system are: one or more processors (CPUs), several device controllers
and the memory. All these components are connected through a common bus that
provides access to shared memory. Each device controller acts as an interface between
a particular I/O device and the operating system. Thus, a device controller plays an
important role in operating a particular device. For example, the disk controller
helps in operating disks, USB controller in operating mouse, keyboard, and printer,
graphics adapter in operating monitor, sound card in operating audio devices, and
so on. In order to access the shared memory, the memory controller is also provided
that synchronizes the access to the memory. The interconnection of various
components via a common bus is shown in Figure 1.21.

 

CPU Memory Device 
Controller 

Device 
Controller 

Device 
Controller 

Device Device Device 

. . . 

System Bus 

Fig. 1.21 Bus Interconnection

Computer System Operation

When the system originally is turned on, it runs a well defined set of initial programs
known as bootstrap program. The bootstrap program is typically stored in Read-
Only Memory (ROM) or electrically Erasable programmable ROM (EEPROM).
During the booting process, all the aspects of the system checking like CPU
registers, device controllers and memory contents are initialized, and then the
operating system is loaded into the memory. Once the operating system is loaded,
the first process such as “init” is executed, and operating system then waits for
some special sequence of events to occur.

The event notification is done with the help of an interrupt that is fired
either by the hardware or the software. When the hardware needs to trigger an
interrupt, it can do so by sending a signal to the CPU via the system bus. When the
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software needs to trigger an interrupt, it can do so with the help of system call (or
monitor call).

Whenever an interrupt is fired, the CPU suspends the current task for the
time being, and jumps to a predefined location in the kernel’s address space,
which contains the starting address of the service routine for the interrupt (known
as interrupt handler). It then executes the interrupt handler, and once the execution
is completed, the CPU resumes the task that it was previously doing.

To quickly handle the interrupts, a table of pointers to interrupt routines is
used. The table contains the addresses of the interrupt handlers for the various
devices, and is generally stored in the low memory (say first 100 locations or so).
The interrupt routine can be called indirectly with the help of this table. This array
of addresses is known as interrupt vector. The interrupt vector is further indexed
by a unique device number, given with the interrupt request, to provide the address
of the interrupt handler for the interrupting device.

Storage Structure

Whenever a program needs to be executed, it must be first loaded into the main
memory (called Random-Access Memory or commonly known by the acronym
RAM) where it is stored. RAM is the only storage area that can be directly
accessed by the CPU. RAM consists of an array of memory words, where each
word has its unique address. The two instructions, namely, load and store are
used to interact with the RAM memory.

 The load instruction is used to move a word from the main memory to the
CPU register.

 The store instruction is used to move the content of the CPU register to the
main memory.

We know that a program is basically a set of instructions that a computer can read
to direct an intended task. The execution of the program instructions takes place
in the CPU registers, which are primarily used as temporary storage areas, and
have restricted storage margin. Usually, an instruction–execution cycle consists of
the following steps.

1. Whenever the CPU needs to execute an instruction, it first fetches it from
the main memory, and stores it in Instruction Register (IR).

2. Once the instruction has been loaded into the IR, the control unit examines
and decodes the fetched instruction.

3. After decoding the instruction, the operands (if required) are fetched from
the main memory and stored in one of the internal registers.

4. The instruction is executed on the operands, and the result is stored back to
the main memory.

Ideally all the programs and data should be stored in the main memory permanently
for fast execution and better system performance because RAM is the only storage
area that allows direct accessibility of the stored data by the CPU,. But, practically
it is not possible because RAM is exorbitantly proceed and offers limited storage
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capacity. Secondly, it is volatile in nature, that is, the information is vanished the
moment the power is switched off.

Therefore, to meet the requirements of sufficient data storage, we need
some storage area that can hold large amount of data permanently. Such a type of
storage is called secondary storage. Secondary storage is non-volatile in nature,
that is, the data are retained even when the power is switched off or if the system
crashes. However, data on the secondary storage devices are not directly accessed
by the CPU as they are used to store the data that are not being concurrently
processed. Therefore, it needs to be transferred to the main memory so that the
CPU can access it. Magnetic disk (generally called disk) is the most widespread
form of secondary storage means for computer. It offers intense storage capacity
for enormous amount of data and easy accessibility. It is used to hold on-line data
for a long term.

In addition to RAM and magnetic disk, some other form of storage devices
also exist, which include cache memory, flash memory, optical discs, and magnetic
tapes. The basic function of all the storage devices is to store the data in an easy
and retrievable form. However, they differ in terms of their speed, cost, storage
capacity, and volatility. On the basis of their characteristics, such as cost per unit
of data and speed with which data can be accessed, they can be arranged in a
hierarchical manner as shown in Figure 1.22.

Fig. 1.22 Memory Hierarchy

I/O Structure

Handling I/O devices and getting all these parts work together is a major problem,
and that is what an operating system does.. The operating system, therefore,
provides an effective link between the components and also clearly outlines how
each component should function with the help of codes. One reason for this is the
varying nature of I/O devices. The operating system must issue commands to the
devices, catch interrupts, handle errors, and provide an interface between the
devices and the rest of the system.
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As already mentioned, a computer system consists of one or more processors
and multiple device controllers that are connected through a common bus. Each
device controller controls a specific type of device, and depending on the device
controller one or more devices may be attached to it. For example, a Small
Computer-System Interface (SCSI) controller may have seven or more devices
attached to it. To perform its job, device controller maintains some local buffer
storage and a set of special-purpose registers. The operating systems usually have
a device driver for each device controller. The device driver acts as an interface
to the device to the rest of the system. This interface should be uniform, that is, it
should be same for all the devices to the extent possible.

To start an I/O operation, the device driver loads the appropriate registers
within the device controller, which in turn examines the contents of registers to
determine the action to be taken. Suppose, the action is to read the data from the
keyboard, the controller starts transferring data from the device to its local buffer.
Upon completion of data transfer, the controller informs the device driver (by
generating an interrupt) that the transfer has been completed. The device driver
then returns the control along with the data or pointer to the data to the operating
system. This form of I/O is interrupt-driven I/O, and this scheme amounts to colossal
wastage of CPU’s time because CPU requests data from the device controller
one byte at a time. This is one of the major drawbacks of this scheme as it is not
feasible to transfer a large amount of data with this scheme.

To solve this problem, another scheme, that is, Direct Memory Access
(DMA) is commonly used. This scheme, after setting up the registers to inform
the controller to know what to transfer and where,, reduces the overhead burden
of CPU and relieves the CPU to perform other tasks. The device controller can
now complete its job, that is, transfer a complete block of data between its local
buffer and memory without CPU intervention. Once the block of data has been
transferred, an interrupt is generated to inform the device driver that the operation
has been successfully executed.

1.7.1 Bus Structures

A shared communication path consisting of one or more connection lines is known
as a bus and the transfer of data through this bus is known as bus transfer.

When data is read from or stored in memory, it is referred to as memory
transfer.

The functional components of a computer must be connected in order to
make a system operational. The CPU communicates with the other components
via a bus. A bus is a set of wires that acts as a shared–but common–data path to
connect multiple subsystems within the computer system. It consists of multiple
lines, allowing the parallel movement of bits. Buses are low cost but very versatile
and help connect devices with each other as well as the system. At any given point
in  time, only one device (be it a register, the ALU, memory or some other
component) may use the bus. However, this sharing often results in a
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communications bottleneck. The speed of the bus is affected by its length as well
as by the number of devices sharing it.

 Data Bus: It is used for the transmission of data. Data lines and the number
of bits in a word are similar.

 Address Bus: It carries the address of the main memory location from
where  data can be accessed.

 Control Bus: It is used to indicate the direction of data transfer and to
coordinate the timing of events during the transfer.

A digital computer consists of many processor registers and the transfer of
information from one register to another is often required. Hence, paths must be
provided so that such transfer operations can take place. Figure 1.23 shows the
transfer among three registers R1, R2 and R3 through six data paths.

R1 R2 R3

Fig. 1.23 Transfer among Three Registers

If different lines are used involving each register, the number of wires will increase
considerably. Hence, a pair of common lines, one line for each bit of the register,
is used for the transfer. This set of common lines through which binary data is
transferred, one at a time, among registers is known as a bus. A common bus
system can be constructed with the help of multiplexers and decoders. The
multiplexer selects the source register whose binary information is then placed on
the bus and the decoder selects one destination register to transfer the information
to, from the bus. The construction of a bus system for four registers is shown in
Figure 1.24. Two multiplexers have been used, one for the low-order significant
bit and one for the high-order significant bit. If the register is of n bits, n multiplexers
are required to produce n bus lines. These n lines in the bus are connected to n
inputs of all the registers.

S
1
 and S

0
 are selection lines connected to selection inputs of all n multiplexers.

The selection lines choose n bits of one register and transfers these to the common
bus n lines. When S

1
 and S

0 
= 00, the 0 data inputs of all n multiplexers are

selected and cause the n bits from register A to transfer to the n-line common bus,
since the output of this register is connected to 0 data inputs of each multiplexer.
Similarly, when S

1
 and S

0 
= 01, the content of register B is transferred into the n-

line common bus and so on. The register that is selected for the four possible
binary values is shown in Table 1.2.
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Load
Register A

Load
Register B

A1An S0 S1

B1Bn

0
1
2
3

4 × 1
MUX
No. 1

0
1
2
3

4 × 1
MUX
No. 1

Load

Load

C1Cn

Register C

Dn D1

Register D

Line No. n
Line No. 1

n common bus lines

Select

Enable
Destination
  Decoder

0 1 2 3

Fig. 1.24 Bus System for Four Registers

Table 1.2 Function Table for Bus as per Figure 1.24

S
1

S
0

Register Selected

0 0 A

0 1 B

1 0 C

1 1 D

The shifting of data from a bus to one of the targeted registers is done with the help
of the load control of that register. The load control of the particular register is
activated by the outputs of the decoder when enabled. If the decoder is not enabled,
no information from the bus will be transferred to the register although the
multiplexers place the information of the source register onto the bus.

In general, for registers of n bits, n multiplexers are needed to construct a
bus of n lines. The size of a multiplexer depends on the number of registers in the
system. If there are K registers, the multiplexer’s size will be K × 1 since it multiplexes
K data lines. To take an example, a general bus of 16 registers of 16 bits each
needs 16 multiplexers of size 16 × 1. Four selection lines are required. Also, the
size of the destination decoder will be 4 × 16.

Consider the statement

C  B
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The control function that enables this transfer must select register B as the source
and register C as the destination registers. The content of register B is located on
the bus and the content of the bus is then transferred to register C by starting its
load control input.

Bus Organization

A bidirectional bus for carrying data between two units is called a data bus.

A unidirectional bus used to carry memory addresses is called memory bus.

The manner in which different buses are connected to form a common bus
so that the CPU, memory and I/O devices can use the common bus, when required,
is called bus organization.

A basic computer consists of a memory unit, a control unit and registers.
There must be a path that can be used to transfer information between the memory
and the registers or among registers. Using a common bus is the most efficient
way of transferring information from source to destination in a system with multiple
registers. Figure 1.25 shows the connection of eight registers and a 4096 × 16
memory unit of a common bus system. The eight registers are the Address Register
(AR), Program Counter (PC), Data Register (DR), Accumulator (AC), Instruction
Register (IR), Temporary Register (TR), Input Register (INPR) and Output Register
(OUTR). Here, a 16-bit common bus has been used.

The outputs of seven registers and memory are linked to the common bus.
The definite output chosen for the bus lines at any time is finalized by the binary
value of the selected lines S

2
, S

1
 and S

0
 as shown in Table 1.3. The numbers along

each output line shows the decimal equivalent of the required binary selection.
When S

2
S

1
S

0
 = 011, the 16-bit outputs of DR are placed on the bus lines.

The lines from the common bus are linked to the input of each register and
the data inputs of the memory. The specific register whose LD (load) input is
allowed gets the information from the bus. The memory gets the information from
the bus when ‘a write input’ is allowed.

The memory puts its results on to the bus when the ‘read input’ is on and
S

2
S

1
S

0
 = 111.

The registers DR, AC, IR and TR are of 16- bits. Two registers, PC and
AR, have 12 bits since they store addresses.

When the contents of AR and PC are placed on the bus, the four most
significant bits are set to 0. When AR and PC receive data from the common bus,
only the 12 least significant bits are transferred to the register.

The input registers INPR and OUTR have 8 bits; hence, they communicate
only with the 8 least significant bits in the bus. INPR is connected to the bus for
providing information. However, OUTR is connected to the bus only for receiving
information from the bus. INPR receives a character from the I/O device, which is
transferred to AC; and OUTR receives a character from AC and delivers it to an
output device. No transfer takes place from OUTR to any of the other registers.
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S0

S1
S2

Memory Unit
4096 × 16

BUS

7

Write Read

AR 1

2

3

4

5

6

LD INR CLR

LD INR CLR

PC

DR

LD INR CLR

AC

16-bit common bus

ClockLD

LD

INR CLR

Adder
and

Logic

E

INPR

IR

LD

LD INR CLR

TR

OUTR

Fig. 1.25 Common Bus Organization

Table 1.3 Function Table

S
2

S
1

S
0

Register

0 0 1 AR

0 1 0 PC

0 1 1 DR

1 0 0 AC

1 0 1 IR

1 1 0 TR

1 1 1 Memory
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The 16-bit common bus receives information from six registers and the
memory unit. In addition, the 16-bit common bus is linked to the inputs of six
registers and the memory unit. Five registers have three control signals—LD (load),
INR (increment) and CLR (clear). Two registers have only LD (load) control
signal connected to the common bus. AR is also connected to the memory address.
Thus, AR always specifies the memory address. During a memory write operation,
the content of any register can be specified for the memory data and similarly
during a memory read operation, any register except AC can receive data from
the memory. The 16-bit AC receives inputs from the adder and logic circuit, which
receives input from three registers. These three registers are 16-bit AC, 16-bit
data register DRand 8-bit inputs, which come from input register INPR. The inputs
from DR and AC are used for arithmetic and logic micro-operations. Table 1.3
shows the binary value of selection line S

2
S

1
S

0
 that selects one of the registers.

For example, in order to transfer the contents of PC to AR (Address
Register), the computer requires the following instructions:

 Set the selection variables S
2
S

1
S

0
 = 010

 Transfer the contents of PC to the bus

 Enable LD input of AR

 Transfer contents of bus into AR

Multiple Bus Organization

A two-bus structure used to connect the registers and the ALU of a processor is
shown in Figure 1.26. All general-purpose registers are connected to both buses
A and B to form a two-bus organization. The two operands required by the ALU
are routed in one clock cycle; hence, the execution of instruction becomes faster
since the ALU does not wait for the second operand, as is the case with single bus
organization. Information passed on to the bus may be from general-purpose
registers or special-purpose registers. In addition, the special-purpose registers
are divided into two groups—one group at the left of the ALU connected to bus A
and the other group is at the right of the ALU connected to bus B. The data from
two special-purpose registers belonging to the same group cannot be transferred
to the ALU at the same time.

Bus A

R0

R1

R2

R4

R5

R3

General
Purpose

Registers

Bus B

Special
Purpose
Register
Group 1

Special
Purpose
Register
Group 2

ALU

PC

Buffer
Register

MBR

Bus A

R0

R1

R2

R4

R5

R3

General
Purpose

Registers

Bus B

Special
Purpose
Register
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Special
Purpose
Register
Group 2

ALU

PC

Buffer
Register

MBR

Fig. 1.26 Two-Bus Organization of the Data Path
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The output of the ALU may be routed to either general-purpose registers
or special-purpose registers. The ALU does not have any input buffer register and
hence, both buses will be busy in carrying the operands during the binary operations.
Therefore, the output of ALU is first stored in the output register. Transfer of the
required operands and loading of the ALU output buffer register take place in one
clock cycle. The content of the ALU output register is routed to the destination
with the help of either bus A or bus B in the second clock cycle.

The performance of a two-bus organization can be further improved by
adding a third bus C at the output of ALU. The three-bus structure is shown in
Figure 1.27. The addition of a third bus allows the system to perform operation,
such as R3  R1 + R2 in one clock cycle as there are three separate buses in the
system.

Bus A

R0

R1

R2

R4

R5

R3

General
Purpose

Registers

Bus B

Special
Purpose
Register
Group 1

Special
Purpose
Register
Group 2

ALU

PC

MBR

Bus C

Fig. 1.27 Three-Bus Organization of the Data Path

1.7.2 Memory Location and Address

A digital computer system requires the facility for storing digital information. The
information may be instructions, data to be processed, intermediate and final results,
and so on. The digital system that provides this storage facility is known as the
memory.

A memory address is an identifiable name for a memory location where a
computer program or a hardware device stores information. This information or
data can be retrieved when needed.

Computers nowadays are byte-addressable. Each address identifies a single
byte of storage; when the information is very big, it is kept in multiple bytes and is
stored in a sequence of consecutive addresses. Some microprocessors are word-
addressable. Here, the addressable storage unit is bigger than a byte.

An absolute address (also called explicit address or specific address)
specifies an address in memory in a unique way. However, the relative address is
not different and specifies an address that is only relative to some other location
(the base address).
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In both the ROM and RAM, every memory area holds a generic binary
number of some sorts. Its type, interpretation, usage and meaning is dependent on
the context of the instructions. It retrieves and works on it. Each such coded item
has a special physical location which is described by another special binary
number—the address of that single word. A pointer is an address safely kept as
data in some other memory location.

Information stored in memory can not only be interpreted as data, such as
text data, binary or numeric data, but can even be instructions to themselves in a
uniform manner.

The instructions in a storage address are read contextually as command
words to the computer’s main processing unit. Data is then brought back by such
instructions and put in an internal and isolated memory structure known storage
register. Here, the later instruction may use it along with data retrieved from other
internal memory locations (or internal addresses). Registers are the memory
addresses within the the CPU known as the Arithmetic and Logic Unit (ALU).
They respond to binary instructions (machine code) fetched into instruction registers
selecting combinatorial logic and determining which data registers should be added,
subtracted, circulated (shifted), and so on, at the low machine language level of
binary manipulation of data.

Usually, the size of a word depends on the computer. It signifies the number
of bits that a CPU may process at a time. It is put together in multiples of 4 and 8
bits (nibbles and bytes). Therefore, with development in technologies, larger sizes
(4-64) became available.

Sometimes, while referring to the word size of a computer system, one also
describes the size of the address space of that computer, for example, a computer
that is said to be ‘32-bit’ usually allows 32-bit memory addresses. This is rational
and useful as it permits one address to be efficiently stored in one word.

However, this is not always so. Often, computers have memory addresses
that are larger or smaller than their word size; the 16-bit Intel 8086 supports 20-
bit addressing, allowing it to access 1 MiB rather than 64 KiBs of memory. Pentium
processors since the start of Physical Address Extensions (PAE), support 36-bit
physical addresses, while they generally have only a 32-bit word.

With adequate Operating System (OS) support, a modern byte-addressable
64-bit computer has the capacity of addressing 264 bytes (or 16 exbibytes).

An address space clarifies a range of discrete addresses. Every address
may resemble a physical or network host, virtual memory register, peripheral device,
a disk sector or any other rational or physical entity.

Comparable to locating a street in a town, a memory address indicates a
physical area in the computer memory. And as an address points to where you
live, the memory address points to the area where data is kept safely. Similar to a
person’s address, the address space would be an area of locations, such as a
neighbourhood, town/city, state or country. Although numerically the same, two
addresses might refer to different locations if they belong to different address
spaces.
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In order to be able to move a word in and out of the memory, a distinct
address has to be assigned to each word. This address will be utilized to check the
memory location in which a given word is to be stored. This is called a memory
write operation. Similarly, the address will be used to determine the memory location
from which a word is to be retrieved. This is called a memory read operation.
Thus, there are two basic memory operations–memory write and memory read
operations. Both these operations are performed by the CPU.

The following three basic steps are necessary for the CPU to perform a
write operation into a specified memory location:

 The word to be stored in the memory location is first loaded by the CPU
into a specified register called Memory Data Register (MDR).

 The address of the location in which the word is to be stored is loaded by
the CPU into a specified register called Memory Address Register (MAR).

 A signal, called write, is issued by the CPU indicating that the word stored
in the MDR is to be stored in the memory location whose address is loaded
in the MAR.

MDR
7E

MAR
2005

MDR
7E

MAR
2005

(a) Before Execution (b) After Execution

2005

2006
20072008

2009

6F

44 44

7F2005

2006

2008

Fig. 1.28 Memory Write Operation

Figure 1.28 illustrates the operation of writing the word given by 7E (in hex) into
the memory location whose address is 2005. Figure 1.28(a) shows the status of
the registers and memory locations involved in the write operation before the
execution of the operation. Figure 1.28(b) shows the status after the execution of
the operation. MDR and MAR are the registers used exclusively by the CPU and
are not accessible to the programmer.

Similarly, the following three basic steps are needed in order to perform a
memory read operation:

 The address of the location from which the word is to be read is loaded into
the MAR.
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 A signal, called read, is issued by the CPU, indicating that the word whose
address is in the MAR is to be read into the MDR.

 After some time, corresponding to the memory delay in reading the specified
word, the required word will be loaded by the memory into the MDR
ready for use by the CPU.

Figure 1.29 illustrates the operation of reading the word stored in the memory
location whose address is 2010. Figure 1.29(a) shows the status of the registers
and memory locations involved in the read operation before the execution of the
operation. Figure 1.29(b) shows the status after the read operation.

(a) Before execution (b) After execution
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44
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44

Fig. 1.29 Memory Read Operation

1.8 CENTRAL PROCESSING UNIT

Execution of programs is the main function of the computer. The program to be
executed is a set of instructions that is stored in the computer’s memory. Tasks are
completed when the instructions of the program are executed by the Central
Processing Unit (CPU). Also, all the major calculations and comparisons are carried
out inside the CPU. Additionally, the CPU is responsible for activating and
controlling the operations of various units of the computer system. It activates the
peripherals to perform input or output.

The component of the computer that performs data processing operations
in bulk is known as the CPU.

It consists of three main parts, as shown in Figure 1.30:

 Register Set

 Arithmetic and Logic Unit (ALU)

 Control Unit (CU)
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A register set is used to store intermediate results obtained during the
execution of instructions. The ALU performs the arithmetic and logic micro-
operations required for executing these instructions. The control unit instructs the
ALU to perform the desired operation and supervises the transfer of information
among different registers.

CONTROL
UNIT

CPU

Register Set

Arithmetic and
Logic Unit

Fig. 1.30 Central Processing Unit

Control Unit

The control unit is necessary if the CPU is to function efficiently and information/
data is to be transferred between the CPU and other devices. It does not perform
the actual processing of the data, but manages and coordinates the entire computer
system, including the input and, output devices. It retrieves and interprets the
instructions from the program stored in the main memory, and issues signals that
cause the other units of the system to execute them.

It does this through some special purpose registers and a decoder. The
special purpose register called the Instruction register holds the current instruction
to be executed, and the Program control register holds the next instruction to
be executed. The decoder interprets the meaning of each instruction supported by
the CPU. Each instruction is also accompanied by a Microcode, i.e., the basic
directions to tell the CPU how to execute the instruction.

Arithmetic Logic Unit

The Arithmetic Logic Unit or ALU provides arithmetic and logic operations. This
means that when the control unit encounters an instruction that involves an arithmetic
operation (add, subtract, multiply, divide) or a logic operation (equal to, less than,
greater than), it passes control to the ALU. The ALU has the necessary circuitry
to carry out these arithmetic and logic operations.

As an example, a comparison of two numbers (a logical operation) may
require the control unit to load the two numbers in the requisite registers and then
pass on the execution of the ‘compare’ function to the ALU.

Figure 1.31 represents the basic structure of a CPU.
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Fig. 1.31 Basic Structure of a CPU

Instruction Set

The primary function of the processing unit in the computer is to interpret the
instructions given in a program and carry out the instructions. Processors are
designed to interpret a specified number of instruction codes. Each instruction
code is a string of binary digits. All processors have input/output instructions,
arithmetic instructions, logic instructions, branch instructions and instructions to
manipulate characters. The number and type of instructions differ from processor
to processor. The list of specific instructions supported by the CPU is termed as
its Instruction set.

An instruction in the computer should specify the following:

 The task or operation to be carried out by the processor. This is termed
as the opcode.

 The address(s) in memory of the operand(s) on which the data processing
is to be performed.

 The address in the memory that may store the results of the data
processing operation performed by the instruction.

 The address in the memory for the next instruction, to be fetched and
executed.

The next instruction which is executed is normally the next instruction following
the current instruction in the memory. Therefore, no explicit reference to the next
instruction is provided.
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Instruction Representation

An instruction is divided into a number of fields and is represented as a sequence
of bits. Each of the fields constitutes an element of the instruction. A layout of an
instruction is termed as the instruction format (Refer Figure 1.32).

 
Opcode  Operand Address  

4 Bits 12 Bits 

Fig. 1.32 A Sample Instruction Format

In most instruction sets, many instruction formats are used. An instruction is
first read into an Instruction Register (IR), then it is decoded by the CPU which
extracts the required operands on the basis of references made on the instruction
fields, and processes it. Since the binary representation of the instruction is difficult
to comprehend, it is seldom used for representation. Instead, a symbolic
representation is used (Refer Figure 1.33).

Instruction Interpretation Number of
Addresses

ADD A,B,C Operation A = B + C  is executed 3

2

1

ADD A,B A = A + B. In this case the original 
content of operand location is lost

ADD A
 

AC = AC + A. Here A is added to the
accumulator

Fig. 1.33 Examples of Typical Instructions

Typically, CPUs manufactured by different manufacturers have different
instruction sets. This is why machine language programs developed for a particular
CPU do not run on a computer with a different CPU (having a different instruction
set).

Registers

The primary task that the CPU performs is the execution of instructions. It executes
every instruction by means of a number of small operations known as micro-
operations.   Thus, it can be seen that:

• The CPU needs an extremely large main memory

• The speed of the CPU must be as fast as possible

To understand further, let us define two relevant terms:

Memory Cycle Time: Time taken by the CPU to accesse the memory.

Cycle Time of the CPU: The time that the CPU takes for executing the
shortest well-defined micro-operation.

It has been observed that the time taken by the CPU to access the memory
is  about 1–10 times higher than the time that the CPU takes for executing the
shortest well-defined micro-operation. Therefore, CPU registers serve as temporary
storage areas within the CPU. CPU registers are termed as fast memory and can
be accessed almost instantaneously.
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Further, the number of bits a register can store at a time is called the length
of the register. Most CPUs sold today have 32-bit or 64-bit registers. The size of
the register is also called the word size and indicates the amount of data that a
CPU can process at a time. Thus, the bigger the word size, the faster the computer
can process data.

The different types of CPU registers are as follows:

Accumulator (AC): An accumulator register is required for carrying out
operations on data. This register holds the data on which addition, subtraction,
shift and logical operations are to be carried out. The result of an arithmetic and
logical operation is automatically stored in the accumulator. Thus, it is used for
storing results and for performing operations (arithmetic as well as logical) on its
contents.

Program Counter (PC): A program counter deals with the order of
execution of instructions that are in queue for execution. Thus, it acts as a pointer
to the memory location that contains the next instruction to be executed.

Program Counter (PC) contains the address of an instruction to be fetched.
It has 12 bits as it also holds a memory address, i.e., the address of the next
instruction. Programs are usually sequential in nature. The program counter is
updated by the CPU after each instruction is fetched , pointing to the next instruction
to be executed. But a branch or skip instruction will modify the contents of the PC
to some other value.

Temporary Register (TR): This register is used for holding temporary
data generated during processing.

Instruction Register: This register is used for storing instructions.

The instruction fetched from memory is stored in Instruction Register (IR)
where the opcode and operand are analysed (operand can be data itself or it can
be the address of memory location which store data) and accordingly, control
signals are generated by the control unit for the execution of instructions.

Data Register (DR): This register is used to hold data (operand) read
from memory.

It acts as buffer storage between the main memory and the CPU. It also stores the
operand for the instructions, such as ADD DR or AC  AC+DR. In other words,
contents of AC and DR are added by ALU and the results are stored in the
accumulator. Thus, data register can also store one of the input operands.

Address Register (AR): This register is used to hold the address of a
memory word.

It is used to provide address of memory location from where data is to be
retrieved or to which data is to be stored. Memory Address Register (MAR) has
12-bits as it stores the memory address which is of 12-bit in size.

AR and DR play an important role  in the transfer of data between CPU
and the memory, i.e., they act as a buffer when the processor wishes to copy
information from a register to primary storage, or read information from primary
storage to a register. In the computer systems that use a common bus system, AR
is directly connected to address bus, while DR is connected to data bus. DR is
used for interchanging the data among several other registers
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Input Register (INPR): The input register holds/receives data from an
input device.

Output Register (OUTR): It holds data that needs to be sent to output
devices.

1.9 GENERAL REGISTER ORGANIZATION

A bus organization for seven CPU registers is shown in Figure 1.34. The output of
each register is connected to two multiplexers (MUX) to form the two buses A
and B. The selection lines in each multiplexer select one register or input data for
the particular bus. Buses A and B form the inputs to a common ALU. The operation
selected in the ALU determines the arithmetic or logic micro-operations to be
performed. The result of the micro-operation is available for the output data and
also goes into the inputs of these seven registers. The decoder selects the register
that receives the information from the output bus. The decoder activates one of
the register load inputs, thus providing a transfer path between the output data bus
and the inputs of the selected destination register.

Clock Input

R1

R2

R3

R4

R5

R6

R7

(7 lines)
SELA MUX

SELD

OPR

MUX

3 × 8
Decoder A bus B bus

Output

Arithmetic and
Logic Unit (ALU)

SELB

Fig. 1.34 General Register Organization

Let the operation be

R1  R2 + R3

To perform this operation, the control must provide the following:

 SELA: Place the contents of R2 into bus A

 SELB: Place the contents of R3 into bus B
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 ALU operation selector OPR: Provide the arithmetic addition A + B

 SELD: Transfer the contents of the output bus R1

At the beginning of a clock cycle, the four control selection variables generated by
R2 and R3 must be available in the control unit. Two source registers propagate
through the multiplexers and the ALU to the output bus and the input of the
destination register during the clock cycle interval. At the next clock transition,
information from the output bus is transferred to the destination register R1.

Register Transfer

A digital system is a sequential logic system in which flip-flops and gates are
constructed. The register transfer logic methods focus on how adders, decoders
and registers use expressions and statements which resembles the statements used
in programming language. High level language C supports register transfer technique
for executing applications. It encompasses all types of registers, such as shift
registers, counters and memory units. Here, a counter is incremented by one and
the memory unit is considered as a collection of storage registers.

In register transfer operations, the straight forward register transfers the
data from register to another register temporarily. For example, the data is transferred
from register R3 to register R1. It is shown symbolically as follows:

R1  R3

The left arrow () is used to show that data from the right is going to move to the
left side register. In the digital system, registers are attached to each other which
makes it possible that more than one register can be transferred simultaneously.
More registers are separated by comma but they are kept on the same line. It is
done in the following way:

R1  R3, R2  R5

The above statement shows that the contents of register R3 are transferred to
register R1 and the contents of register R5 are transferred to register R2 at the
same time.

Sometimes, register transfer operation depends on certain conditions. For
example, register R1  R3 takes place only if Boolean variable k = 1 is satisfied.
In a programming language, it is coded as follows:

if (k=1) then R1  R3

Inter-register microoperations do not change the information content if the binary
data and information moves from one register to another register. The characteristics
of microoperations are as follows:

 Arithmetic microoperations perform arithmetic or number operations; logic
performs AND, OR, XOR operation; and shift microoperations perform
shift register.

 The register is designated by capital letters and sometimes followed by
numerals, such as R1, R2, IR, etc. The flip-flops of an n-bit register are
numbered from 1 to n (or from 0 to n-1) starting either from the left or from
the right.
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Simple digital system contains the combinational and sequential circuits. They are
characterized as follows:

 The type of registers they contain.

 The operations they perform.

Typically, register transfer focuses on the operations of data which are passed
into different registers. These operations are called microoperations. The main
functions which take place in the register are as follows: Shift, Load, Clear and
Increment.

During one clock pulse, the information which is operated and stored in
different registers is performed under elementary operation. Table 1.4 shows the
transfer functions that are used in transferring registers:

Table 1.4 Transfer Functions that are used in Transferring Registers

Function Name Purpose Prototype 
__gpr_to_d64 
 

Transfer from general purpose register to 
floating point register 

_Decimal64 
__gpr_to_d64 
(long long); 

__gprs_to_d128 
 

Transfer from general purpose register to 
floating point register. Transfers a value from 
a pair of general purpose registers (64-bit 
mode) or four general purpose registers (32-
bit mode). 

_Decimal128 
__gprs_to_d128 
(unsigned long 
long*upper, 
unsigned long 
long*lower); 

 
__d64_to_gpr 
 

Transfer from floating point register to 
general purpose register. Transfers a value 
from a floating point register to a general 
purpose register (64-bit mode) or a general 
purpose register pair (32-bit mode). 

long long 
__d64_to_gpr 
(_Decimal64); 

 
__d128_to_gprs 
 

Transfer from floating point register to 
general purpose register. Transfers a value 
from a pair of floating point registers to a 
pair of general purpose registers (64-bit 
mode) or four general purpose registers (32-
bit mode). 

void 
__d128_to_gprs 
(_Decimal128, 
unsigned long 
long*upper, 
unsigned long 
long*lower); 

In Figure 1.35, f(R,R) function has two parameters which denotes different functions
as follows:

f: shift, load, clear, increment, add, subtract, complement, AND, OR, XOR.

 
 

 

 
Registers

(R)
ALU

1 clock cycle

Fig. 1.35 One Clock Cycle of R  f (R, R)
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Organization of a Digital System

Digital systems contain the set of registers and their functions in the internal
organization of the computer. The main function is that they control signals to
initiate the sequence of microoperations to perform the functions. It maintains the
way of register transfer on any digital system and therefore it is called register
transfer level. The characteristics are as follows:

 It depends on system registers.

 Information/data is transferred on different registers.

Designation of Resistors

Designation of resistors is interrelated with the register transfer facility. It enhances
the transferring rate of data which is stored in registers. The characteristics of
designation of resistors are as follows:

 Registers are represented by capital letters, such as A, R13, IR.

 The variable names indicate the functions which are used as follows:

o MAR indicates Memory Address Register.

o PC indicates Program Counter.

o IR indicates Instruction Register.

Contents of registers are viewed and designated in various ways. Basically, a
register is viewed as a single entity and processes the bits of data it contains.

 
R1 

 Register  

Numbering of bits 

Showing individual bits 

Subfields 

PC(H) PC(L) 
15 8 7 0 

7     6     5     4     3     2     1     0 

R2 
15 0 

Fig. 1.36 Block Diagram of a Register

In Figure 1.36, R2  R1 depicts that the contents of register R2 are copied and
loaded into register R1. It transfers simultaneously from the source register R1 to
the destination register R2 during one clock pulse. This is called non-destructive
method. In this method, the contents of register R1 are not altered during the
operation of copying or loading to register R2. It performs step by step. It first
copies the contents of one register and then transfers to another register. Let us
take another example. A statement is written as follows:

R3  R5

It implies that the data lines move from the source register R5 to the destination
register R3. It loads parallel in the destination register R3. The control lines are
used to perform the operation.

Control Functions of Register Transfer

The control functions of register transfer are as follows:

 If a certain condition is true, microoperation is activated as per requirement.

 In register transfer, control function is similar as ‘if’ statement in a
programming language.
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 Control functions use control signal to perform microoperations. If the
control signal comes as 1, the operation takes place.

The statement is represented as follows:

P: R2  R1

The above statement tells that if P=1, then load the contents of register R1 into
register R2. This statement is written in programming language as follows:

if (P=1) then (R2  R1)

Implementation of Controlled Transfer

The control transfer passes the functions via control circuit. It is represented as
follows:

P: R2  R1
   

Clock  

Transfer occurs here  

R2  

R1 

Control  
Circuit  

 
 

Load  P  

n  

Clock  

Load  

t  t+1  

Fig. 1.37 Block and Timing Diagram

Figure 1.37 shows that the same clock controls the circuits that generate the control
function. It is incremented by one such as t, t+1 and so on and then reaches to the
destination register. The transfer occurs in Load process. Registers are assumed
to use positive edge triggered flip flops.

There are four types of connections or links between components, such as
bus, control, Boolean and miscellaneous. The bus is a general purpose data and
control connection passing synchronized information between components. Control
connections are used to link the control components and also to invoke activity in
other components. Boolean connections are special purpose signals aiding the
execution flow by connecting conditions with decision making control components.
Finally, there exist miscellaneous connections to connect these register transfer
components with external devices.
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Table 1.5 Working Registers

Name Function Bits States

W W-Register 32 –

X X-Register 32 –

Y Y-Register 32 –

A Address Register 12 4096

C Command Instruction Register 6 64

PSN Program Step Number 8 256

ID Information Decoder 10 1024

OSP Output Start Point (Index Register) 5 32

Table 1.5 shows the working registers and their functions.

Following are the properties of register transfer:
 Information transfer from one register to another (transfer of the content of

register R1 into register R2). The content of the source register R1 does not
changes after the transfer.

 The transfer occurs only under a predetermined control condition. The
transfer operation is executed by the hardware only if P=1.

 A comma is used to separate two or more operations (executed at the
same time) 21, 12.

Control Word

The group of binary bits assigned to perform a specified operation is known as
control word.

There are 14 binary selection inputs in the units, and their combined value
specifies a control word. It consists of four fields as shown in Figure 1.38.

SELA SELB SELD OPR 

3 3 3 5

Fig. 1.38 Control Word

Three fields contain three bits each; one field has five bits. The three bits of SELA
select a source register for input A of the ALU. The three bits of SELB select a
register for input B of the ALU. The three bits of SELD select a destination register
using the decoder and its seven load outputs. The five bits of OPR select one of
the operations in the ALU.

The 14-bit control word, when applied to the selection inputs, specifies
particular micro-operations. The encoding of register selection fields is specified
in Table 1.6.
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Table 1.6 Encoding of Register Selection Fields

Binary Code SELA SELB SELD

000 input input none

001 R1 R1 R1

010 R2 R2 R2

011 R3 R3 R3

100 R4 R4 R4

101 R5 R5 R5

110 R6 R6 R6

111 R7 R7 R7

When the 3-bit binary code for SELA or SELB is 000, the respective multiplexer
selects the external input data as shown in Figure 1.38, and when the 3-bit binary
code for SELD = 000, no destination register is selected and the content of the
output bus is for the external output.

The OPR field has five bits. The encoding for the 5-bit OPR field is specified
in Table 1.7.

Table 1.7 Encoding of ALU Operation

OPR Operation Symbol

00000 Transfer A TSFA
00001 Increment A INCA
00010 Addition ADD
00101 Subtract SUB
00110 Decrement A DECA
01000 AND A and B AND
01010 OR A and B OR
01100 XOR A and B XOR
01110 Complement A COMA
10000 Shift Right A SHRA
11000 Shift Left A SHLA

Let the micro-operation given by the statement be

R1  R4  R5

This statement specifies R4 for input A of the ALU, R5 for input  B of the ALU,
and R1 as the destination register. The micro-operation to be performed is the
AND operation between R4 and R5.

SELA

R1
001

SELB

R4
100

SELD

R5
101

OPR

AND
01000

Thus, the control word is 001 100 101 01000

Fetching a Word from Memory

To fetch a word of data from memory, the processor gives the address of the
memory location in which data is stored on the address bus and activates the read



Computer Appreciation
and Organization

NOTES

Self - Learning
Material 77

operation. At this stage, the processor loads the required address in Memory
Address Register (MAR) whose output is connected to the address lines of the
memory bus.

Internal Processor Bus

MDRout MDRin

MDR

Read Write

OE Data WR Address

Memory

MARin

MAR

Fig. 1.39 Process to Fetch a Word from Memory

At the same time, processor sends the read signal of memory control bus to
indicate the read operation. When requested data is received from the memory
it is stored into the Memory Data Register (MDR) from where it can be
transferred to other processor registers. MDR is the register of the computer’s
control unit which contains the data to be stored in the computer storage
(RAM) or the data after fetching from the computer storage. Figure 1.39 shows
the interface between processor and memory through MAR and MDR registers.
The MDR register has four signals in which MDR

in
 and MDR

out
 control the

connection to the internal processor data bus and signals Read and Write
control the connection to the memory data bus. The MAR register has one
control signal. The signal MAR

in
 controls the connection to the internal processor

address bus. Control signals Read and Write from the processor control the
operations read and write respectively. Let us assume that the address of the
memory word to be read is in the register R2 and we have to transfer data
word from that location to the register R3. This operation can be indicated by
instruction MOVE R

3
, R

2. 
The actions needed to execute this instruction are as

follows:

 MAR[R
2
]

 Activate the control signal to perform the Read operation. If memory is
slow then wait for Memory Function Complete (MFC).

 Load MDR from the memory bus.

 [R
3
] MAR
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Let us see the various control signals which are necessary to activate for performing
the given actions at each step:

 R2
out

, MAR
in
, Read

 WMFC

 MDR
out

, R
3 in

Storing a Word in Memory
The five string data transfer instructions are LODS, STOS, MOVS, INS and
OUTS. Each string instruction allows data transfers that are either a single byte,
word or doubleword (or if repeated, a block of bytes, words or doublewords).
Before the string instructions are presented, the operation of the D flag bit
(direction), DI and SI must be understood as they apply to the string instructions.

The Direction Flag
The direction flag (D) (located in the flag register) selects the auto increment
(D = 0) or the auto decrement (D = 1) operation for the DI and SI registers during
string operations. The direction flag is used only with the string instructions. The
CLD instruction clears the D flag (D = 0) and the STD instruction sets it (D = 1).
Therefore, the CLD instruction selects the auto increment mode (D = 0) and STD
selects the auto decrement mode (D = 1).

Whenever a string instruction transfers a byte, the contents of DI and/or SI
increment or decrement by 1. If a word is transferred, the contents of DI and/or
SI increment or decrement by 2. Doubleword transfers cause DI and/or SI to
increment or decrement by 4. Only the actual registers used by the string instruction
increment or decrement. For example, the STOSB instruction uses the DI register
to address a memory location. When STOSB executes, only DI increments or
decrements without affecting SI. The same is true of the LODSB instruction which
uses the SI register to address memory data. LODSB only increments/decrements
SI without affecting DI.

DI and SI
During the execution of a string instruction, memory accesses occur through either
or both of the DI and SI registers. The DI offset address accesses data in the
extra segment for all string instructions that use it. The SI offset address accesses
data, by default, in the data segment. The segment assignment of SI may be changed
with a segment override prefix. The DI segment assignment is always in the extra
segment when a string instruction executes. This assignment cannot be changed.
The reason that one pointer addresses data in the extra segment and the other in
the data segment is that the MOVS instruction can move 64 Kbytes of data from
one segment of memory to another.

LODS
The LODS instruction loads AL, AX or EAX with data stored at the data
segment offset address indexed by the SI register. (Note that only the 80386
and above use EAX). After loading AL with a byte, AX with a word or EAX
with a doubleword, the contents of SI increment, if D = 0 or decrement, if D
= 1. A 1 is added to or subtracted from SI for a byte sized LODS, a 2 is added
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or subtracted for a word-sized LODS and a 4 is added or subtracted for a
doubleword sized LODS.

Table 1.8 lists the permissible forms of the LODS instruction. The LODSB
(loads a byte) instruction causes a byte to be loaded into AL, the LODSW (loads
a word) instruction causes a word to be loaded into AX and the LODSD (loads a
doubleword) instruction causes a doubleword to be loaded into EAX. Although
rare, as an alternative to LODSB, LODSW and LODSD, the LODS instruction
may be followed by a byte, word or doubleword sized operand to select a byte,
word or doubleword transfer. Operands are often defined as bytes with DB, as
words with DW, and as doublewords with DD. The DB pseudo operation defines
byte(s), the DW pseudo operation defines word(s) and the DD pseudo operations
define doubleword(s).

Table 1.8 Forms of the LODS Instruction

Assembly Language Operation

LODSB AL = DS:[SI]; SI = SI ±1
LODSW AX = DS:[SI]; SI = SI ±2
LODSD EAX = DS:[SI]; SI = SI ±4
LODS LIST AL = DS:[SI]; SI = SI ±1 (if LIST is a byte)
LODS DATA1 AX = DS:[SI]; SI = SI ±2 (if DATA1 is a word)
LODS FROG EAX = DS:[SI]; SI = SI±4 (if FROG is a doubleword)

Note: The segment can be overridden with a segment override prefix as in LODS ES:DATA4.

Figure 1.40 shows the effect of executing the LODSW instruction if the D flag =
0, SI = l000H and DS = l000H. Here, a 16-bit number stored at memory locations
11000H and 11001H moves into AX. Because D = 0 and this is a word transfer,
the contents of SI increment by 2 after AX loads with memory data.

A 0 3 2EAX

1 0 0 0ESI

EDI

ESP

EBP

1 0 0 0

CS

DS +

A 0

3 2

11001

11000

10000

1100010000

1FFFF
Data Segment

1000

A 0 3 2

Fig. 1.40 Operation of LODSW Instruction



Computer Appreciation
and Organization

NOTES

Self - Learning
80 Material

The operation of the LODSW instruction is executed if DS = 1000H, D = 0,
11000H = 32  and 11001H = A0. This instruction is shown after AX is loaded
from memory, but  before SI increments by 2.

STOS

The STOS instruction stores AL, AX or EAX at the extra segment memory location
addressed by the DI register. (Note that only the 80386–Pentium 4 use EAX and
doublewords). Table 1.9 lists all forms of the STOS instruction. As with LODS,
an STOS instruction may be appended with a B, W or D for byte, word or
doubleword transfers respectively. The STOSB (stores a byte) instruction stores
the byte in AL at the extra segment memory location addressed by DI. The STOSW
(stores a word) instruction stores AX in the extra segment memory location
addressed by DI. A doubleword is stored in the extra segment location addressed
by DI with the STOSD (stores a doubleword) instruction. After the byte (AL),
word (AX) or doubleword (EAX) is stored, the contents of DI increments or
decrements.

Table 1.9 Forms of  STOS Instruction

Assembly Language Operation

STOSB ES:[DI] = AL; DI = DI ± 1

STOSW ES:[DI] = AX; DI = DI ± 2

STOSD ES:[DI]= EAX; DI = DI ± 4

STOS LIST ES:[DI] = AL; DI = DI ± 1 (if list is a byte)

STOS DATA3 ES:[DI] = AX; DI = DI ± 2 (if DATA3 is a word)

STOS DATA4 ES:[DI] = EAX; DI = DI ± 4 (if DATA4 is a doubleword)

STOS with a REP: The repeat prefix (REP) is added to any string data transfer
instruction except the LODS instruction. It does not make any sense to perform a
repeated LODS operation. The REP prefix causes CX to decrement by 1 each
time the string instruction executes. After CX decrements, the string instruction
repeats. If CX reaches a value of 0, the instruction terminates and the program
continues with the next sequential instruction. Thus, if CX is loaded with a 100
and a REP STOSB instruction executes, the microprocessor automatically repeats
the STOSB instruction 100 times. Because the DI register is automatically
incremented or decremented after each datum is stored, this instruction stores the
contents of AL in a block of memory instead of a single byte of memory. The
operands in a program can be modified by using arithmetic or logic operators
such as multiplication (*). Other operators appear in Table 1.10.

Table 1.10 Common Operand Operators

Operator Example Comment

+ MOV AL, 6+3 Copies 9 into AL
– MOV AL, 8–2 Copies 6 into AL
* MOV AL, 4*3 Copies 12 into AL
/ MOV AX, 12/5 Copies 2 into AX (remainder is lost)
MOD MOV AX, 12 MOD 7 Copies 5 into AX (quotient is lost)
AND MOV AX, 12 AND 4 Copies 4 into AX (1100 AND 0100 = 0100)
OR MOV AX, 12 OR 1 Copies 13 into AX (1100 OR 0001 = 1101)
NOT MOV AL, NOT 1 Copies 254 into AL (0000 0001 NOT equals 1111 1110 or 254)
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MOVS

One of the more useful string data transfer instructions is MOVS because it transfers
data from one memory location to another. This is the only memory to memory
transfer allowed in the 8086 Pentium 4 microprocessors. The MOVS instruction
transfers a byte, word or doubleword from the data segment location addressed
by source operand SI to the extra segment location addressed by destination
operand DI. As with the other string instructions, the pointers then increment or
decrement, as dictated by the direction flag. Table 1.11 lists all the permissible
forms of the MOVS instruction. Note that only the Source Operand (SI), located
in the data segment, may be overridden so that another segment may be used. The
DI must always be located in the extra segment.

Table 1.11 Forms of the MOVS Instruction

Assembly Language Operation

MOVSB ES:[DI] = DS:[SI]; DI = DI ± 1; SI = SI ± 1 (byte transferred)

MOVSW ES:[DI] = DS:[SI]; DI = DI ± 2; SI = SI ± 2 (word transferred)

MOVSD ES:[DI] = DS:[SI]; DI = DI ± 4; SI = SI ± 4 (doubleword
transferred)

MOVS BYTE1, BYTE2 ES:[DI] = DS:[SI]; DI = DI ± 1; SI = SI ± 1 (if BYTE1 and
BYTE2 are bytes)

MOVS WORD1, WORD2 ES:[DI] = DS:[SI]; DI = DI ± 2; SI = SI ± 2 (if WORD1 and
WORD2 are words)

MOVS DWORD1, DWORD2 ES:[DI] = DS:[SI]; DI = DI ± 4; SI = SI ± 4 (if DWORD1 and
DWORD2 are doublewords)

INS

The INS (INput String) instruction (not available on the 8086/8088
microprocessors) transfers a byte, word or doubleword of data from an I/O device
into the extra segment memory location addressed by the DI register. The I/O
address is contained in the DX register. This instruction is useful for inputting a
block of data from an external I/O device directly into the memory. One application
transfers data from a disk drive to memory. Disk drives are often considered and
interfaced as I/O devices in a computer system.

Table 1.12 Forms of the INS Instruction

Assembly Language Operation

INSB ES:[DI] = [DX]; DI = DI ± 1 (byte transferred)

INSW ES:[DI] = [DX]; DI = DI ± 2 (word transferred)

INSD ES:[DI] = [DX]; DI = DI ± 4 (doubleword transferred)

INS LIST ES:[DI] = [DX]; DI = DI ± 1 (if LIST is a byte)

INS DATA4 ES:[DI] = [DX]; DI = DI ± 2 (if DATA4 is a word)

INS DATA5 ES:[DI] =  [DX]; DI = DI ± 4 (if DATA5 is a doubleword)

Note: [DX] indicates that DX contains the I/O device address. These intruction are not available on the

8086/8088 microprocessors.

As with the prior string instructions, there are two basic forms of the INS. The
INSB instfuction inputs data from an 8-bit I/O device and stores it in the byte-
sized memory location indexed by SI. The INSW instruction inputs l6-bit I/O
data and stores it in a word-sized memory location. The INSD instruction inputs a
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doubleword. These instructions can be repeated using the REP prefix. This allows
an entire block of input data to be stored in the memory from an I/O device. Table
1.12 lists the various forms of the INS instruction.

OUTS

The OUTS (OUTput String) instruction (not available on the 8086/8088
microprocessors) transfers a byte, word or doubleword of data from the data
segment memory location address by SI to an I/O device. The I/O device is
addressed by the DX register as it was with the INS instruction. Table 1.13
summarizes the variations available for the OUTS instruction.

Table 1.13 Forms of the OUTS Instruction

Assembly Language Operation

OUTSB [DX] = DS:[SI]; SI = SI ± 1 (byte transferred)

OUTSW [DX] = DS:[SI]; SI = SI ± 2 (word transferred)

OUTSD [DX] = DS:[SI]; SI = SI ± 4 (doubleword transferred)

OUTS DATA7 [DX] = DS:[SI]; SI = SI ± 1 (if DATA7 is a byte)

OUTS DATA8 [DX] = DS:[SI]; SI = SI ± 2 (if DATA8 is a word)
OUTS DATA9 [DX] = DS:[SI]; SI = SI ± 4 (if DATA9 is a doubleword)

Note: [DX] indicates that DX contains the I/O device address. These instruction are not available on
the 8086/8088 microprocessors.

Check Your Progress

18. What is a bootstrap program?

19. What do you mean by bus transfer?

20. What do you understand by memory transfer?

21. What is a data bus?

22. What is the use of control bus?

23. What is Memory Address Register (MAR)?

24. What is the use of absolute address?

1.10 ANSWERS TO ‘CHECK YOUR PROGRESS’

1. In 1842, Babbage came up with his new idea of the Analytical Engine,
which was intended to be completely automatic. This machine was capable
of performing basic arithmetic functions.

2. Arithmetic Logic Units (ALUs) are not only capable of performing the basic
four arithmetic operations, i.e., addition, subtraction, multiplication and
division but can also perform logic comparison operations, such as equal
to, lesser than or greater than, etc.

3. The function of the control unit is to ensure that the right operation is done
on the right data at the right time. The control unit receives instructions and
commands from the programs in the primary memory, processes them and
ensures that the commands are executed in the desired order by all the
other units of the computer system.
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4. Tablet PC is a mobile computer that looks like a notebook or a small writing
slate but uses a stylus pen or your fingertip to write on the touch screen. It
saves whatever you scribble on the screen with the pen.

5. A computer primarily constitutes three integral components, viz. input device,
Central Processing Unit (CPU) and output device.

6. The control unit is responsible for the control of various computer operations,
which involves accepting instructions, interpreting and processing of this
information in the correct parts of the computer.

7. Computer hardware refers to the physical components that make up a
computer system. They are the building blocks of personal computers.

8. A computer cannot operate without any instructions and is based on a logical
sequence of instructions in order to perform a function. These instructions
are known as a ‘computer program’, and constitute the computer software.

9. The categories of software on the basis of function are:
(i) System software
(ii) Programming software
(iii) Application software

10. Business software is a kind of software is functional in the domain of
management and finance. The basic aspect of a business system comprises
payroll, inventory, accounting and software that permit users to access
relevant data from the database. These activities are usually performed with
the help of specialized business software that facilitates efficient framework
in the business operation and in management decisions.

11. The full form of COTS is Commercial Off-The Shelf.

12. The I/O devices that provide a means of communication between the
computer and the outside world are known as peripheral devices.

13. Input devices are used to transfer user data and instructions to the computer.

14. Scanning devices are input devices used for direct data entry from the source
document into the computer system.

15. Hand-held scanners are used where the information to be scanned or the
volume of documents to be scanned is very low.

16. The CRT monitor creates a picture out of many rows or lines of tiny colored
dots.

17. Dot matrix printers use a print head consisting of a series of small metal pins
that strike on a paper through an inked ribbon, leaving an impression on the
paper through the ink transferred.

18. When the system originally is turned on, it runs a well-defined set of initial
programs known as bootstrap program. The bootstrap program is typically
stored in Read Only Memory (ROM) or Electrically Erasable Programmable
ROM (EEPROM).

19. A shared communication path consisting of one or more connection lines is
known as a bus and the transfer of data through this bus is known as bus
transfer.
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20. When data is read from or stored in memory, it is referred to as memory
transfer.

21. A bidirectional bus for carrying data between two units is called a data bus.

22. Control bus is used to indicate the direction of data transfer and to coordinate
the timing of events during the transfer.

23. The address of the location in which the word is to be stored is loaded by
the CPU into a specified register called Memory Address Register (MAR).

24. An absolute address specifies an address in memory in a unique way.

1.11 SUMMARY

 The first mechanical adding machine was invented by Blaise Pascal in 1642.
Later, in 1671, Baron Gottfried Wilhelm von Leibniz of Germany invented
the first calculator.

 Herman Hollerith came up with the concept of punched cards, which were
extensively used as an input medium in mechanical adding machines.

 The Electronic Numerical Integrator And Computer (ENIAC) was the first
electronic computer developed for military requirements and was used for
many years to solve ballistic problems.

 The Universal Automatic Computer (UNIVAC) was the first digital computer
to be installed in the Census Bureau in 1951 and was used continuously for
10 years.

 A computer is a programmable machine designed to automatically process
a sequence of various arithmetic or logical operations. The interface between
the computer and the human operator is known as the user interface.

 Peripheral devices allow information to be entered from an external source
and allow the results of operations to be sent out.

 A Central Processing Unit or CPU executes a series of instructions to read,
manipulate and store the data.

 The control unit, Arithmetic Logic Unit or ALU, memory registers and basic
Input/Output or I/O devices are collectively known as a Central Processing
Unit or CPU.

 Computers can be classified on the basis of their size, processing speed
and cost. The various types of computers are personal computers,
workstations, notebook/laptop computers, tablet PC, PDA, mainframe
computers and supercomputers.

 Analog computers are generally used in industrial process controls and to
measure physical quantities, such as pressure, temperature, etc. An analog
computer does not operate on binary digits to compute.

 A digital computer stores data in the form of digits (numbers) and processes.
It is in the discrete form from one state to the next.

 Hybrid computers are the combination of digital and analog computers. A
hybrid computer uses the best features of digital and analog computers. It
helps the user to process both continuous and discrete data.
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 A mainframe system consists of several computers, such as a host computer
that carries out most of the computations and has direct control over all
other computers.

 Computers have undergone great transformation over the past decade;
however, the basic logical structure remains the same.

 Programs and data are required to be present in a computer system before
any operation can be performed.

 The input unit is responsible for transferring data and instructions from the
external environment into the computer system.

 The central processing unit is known as the brain of the computer. It includes
the control unit, the ALU and the primary memory.

 The primary storage also temporarily stores any intermediate result generated
by the ALU.

 Computers understand process data and return the output in a binary form.
The basic function of the output unit is to convert these results into a human-
readable form before providing the output through various output devices,
such as terminals and printers.

 The storage capacity of the primary memory of the computer is limited.
Often, it is necessary to store large amounts of data. So, additional memory,
called secondary storage or auxiliary memory is used in most computer
systems.

 Secondary storage is storage other than the primary storage. These are
peripheral devices connected to and controlled by the computer to allow
permanent storage of data and programs

 Computers are very fast. They can process millions of instructions every
second. The speed is related to the amount of data it processes and the
time it takes to complete the processing task.

 The main PCB (Printed Circuit Board) is sometimes alternatively known as
a logical board or a main board of a Personal Computer.

 The primary function of the computer is executing programs. The programs
or the set of instructions are stored in the computer’s main memory and are
executed by the CPU.

 Computer hardware refers to the physical components that make up a
computer system. They are the building blocks of personal computers. These
are typically installed into a computer case, or attached to it by a cable or
through a port.

 The sequences of instructions are based on algorithms that provide the
computer with instructions on how to perform a function.

 Keyboard devices are typically classified as general-purpose keyboards
and special-purpose keyboards.

 The most familiar means of entering information into a computer is through
a typewriter-like keyboard that allows a person to enter alphanumeric
information directly.



Computer Appreciation
and Organization

NOTES

Self - Learning
86 Material

 The most popular keyboard used today is the 101 key with a traditional
QWERTY layout, with an alphanumeric keypad, 12 function keys, a variety
of special function keys, numeric keypad, and dedicated cursor control
keys. It is so called because the arrangement of its alphanumeric keys in the
upper-left row.

 The trackball is a pointing device that is much like an inverted mouse. It
consists of a ball inset in a small external box or adjacent to, and in the same
unit, as the keyboard of some portable computers.

 A LCD is one of the most widely used flat panel displays since it is lightweight
and occupies less space than conventional CRT displays.

 Characters are formed by heated elements being placed in contact with
special heat sensitive paper forming darkened dots when the elements reach
a critical temperature.

 When the system originally is turned on, it runs a well-defined set of initial
programs known as bootstrap program. The bootstrap program is typically
stored in Read Only Memory (ROM) or Electrically Erasable Programmable
ROM (EEPROM).

 A shared communication path consisting of one or more connection lines is
known as a bus and the transfer of data through this bus is known as bus
transfer.

 When data is read from or stored in memory, it is referred to as memory
transfer.

 A bidirectional bus for carrying data between two units is called a data bus.

 Control bus is used to indicate the direction of data transfer and to coordinate
the timing of events during the transfer.

 The address of the location in which the word is to be stored is loaded by
the CPU into a specified register called Memory Address Register (MAR).

 An absolute address specifies an address in memory in a unique way.

 The program to be executed is a set of instructions that is stored in the
computer’s memory. Tasks are completed when the instructions of the
program are executed by the Central Processing Unit (CPU).

 The control unit is necessary if the CPU is to function efficiently and information/
data is to be transferred between the CPU and other devices. It does not
perform the actual processing of the data, but manages and coordinates the
entire computer system, including the input and, output devices.

 The Arithmetic Logic Unit or ALU provides arithmetic and logic operations.
This means that when the control unit encounters an instruction that involves
an arithmetic operation (add, subtract, multiply, divide) or a logic operation
(equal to, less than, greater than), it passes control to the ALU.

 A digital system is a sequential logic system in which flip-flops and gates are
constructed. The register transfer logic methods focus on how adders,
decoders and registers use expressions and statements which resembles
the statements used in programming language.
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1.12 KEY TERMS

 Personal Digital Assistant: A small palm sized hand-held computer that
has a small colour touch screen with audio and video features.

 Inputting: The process in which the user puts in a set of commands to
process data into the computer system.

 Storing: The process of recording data and information so that it can be
retrieved for use whenever required.

 Processing: This process implies performing arithmetic or logical operations
on data to convert them into useful information.

 Arithmetic Operations: These include addition, subtraction, multiplication
and division, and logical operations include comparisons such as equal to,
less than and greater than, etc.

 Outputting: This is the process of providing results to the user. These can
be in the form of visual display and/or printed reports.

 Controlling: This refers to directing the sequence and the manner in which
all the previous functions are carried out.

 Input Devices: These are the devices used for entering information in the
computer.

 Output Devices: These are the devices used for getting out information
from the computer.

 Joystick: It is a vertical stick that moves the graphic cursor in the direction
the stick is moved.

 Scanning Devices: These are input devices used for direct data entry
from the source document into the computer system.

 Bus Structures: A shared communication path consisting of one or more
connections lines.

 CPU: The unit considered as the brain of a computer and responsible for
the major task of data processing operations in the computer system.

 ALU: The unit that does the arithmetic and logic operations needed for
executing instructions.

1.13 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. Write one drawback of ENIAC.

2. What do you understand by computer generation?

3. What are supercomputers?

4. Define the term notebook and laptop computers.

5. What is a computer?
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6. How the memory is classified?

7. What is computer software and why is it required?

8. Name the types of computer software.

9. What is the database management software?

10. Why does an organization use computers?

11. What is a general-purpose keyboard?

12. How does a mouse work?

13. What is the purpose of CRT terminals?

14. What is the advantage of an LCD display over other displays?

15. Where are impact printers mostly beneficial?

16. What do you mean by interrupt vector?

17. What is an address bus?

18. What is a program counter?

19. What do you mean by instruction set?

Long-Answer Questions

1. Discuss the development of computers with suitable examples.

2. Explain the salient features of fourth- and fifth- generation computers.

3. What do you understand by personal computers? How would you
differentiate a personal computer from a workstation?

4. Describe the basic tasks that can be performed by a computer system.

5. Why is memory required in the computer? Explain.

6. Describe any three computer software and their uses.

7. Describe the advantages of word processing application.

8. Describe the various basic types of input and output devices.

9. Discuss the various special function keys of a keyboard.

10. Explain the significance and applications of scanning devices.

11. Explain the functioning of an optical bar code reader.

12. Describe the working of a plasma display.

13. Explain the various types of printing devices.

14. How is a laser printer different from an inkjet printer? Explain.

15. Explain the general register organization giving appropriate examples.
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2.0 INTRODUCTION

In this unit, you will learn about the basic concepts of operating system. An
Operating System (OS) is software that manages computer hardware resources
and provides common services for computer programs. The operating system is
an essential component of the system software in a computer system. Application
programs usually require an operating system to function. The various types of
operating system are also being discussed in this unit. You will also learn about the
basic concepts of MS Windows and the various commands of DOS.
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2.1 OBJECTIVES

After going through this unit, you will be able to:

 Understand the basic concept of operating system

 Describe the functions of an operating system

 Discuss the various types of operating systems

 Explain the various DOS commands

 Discuss the components of MS Windows

2.2 OPERATING SYSTEM BASICS

An operating system is a set of instructions stored on a storage device, such as hard
disk, Compact Disk Read Only Memory (CD-ROM) or floppy disk. When you
switch on a computer, a set of power-on routine activities is performed. These
power-on routine activities verify the devices attached to the Central Processing
Unit (CPU), such as keyboard, hard disk, floppy disk, CD-ROM and printers for
their proper functioning. The instructions for these power-on routine activities are
stored in the Read Only Memory (ROM). ROM is permanent in nature and stores
the data even when the power is switched off. However, ROM stores only a few
kilobytes of instructions due to its limited size. As a result, the power on routine
activities are stored permanently in the hard disk as operating system and are
transformed from the hard disk into the Random Access Memory (RAM) on booting
the computer.

RAM also called main memory, which is volatile in nature and as a result,
the programs and instructions are temporarily stored in it and are lost on power
failure. Secondary memory, such as hard disk is non-volatile and thus retains
information even in case of power failure. For example, you are working in Microsoft
Word and not saving your content in the main memory, the content will be erased
from the main memory if the computer is switched off. When the contents are
saved in a file, they are transferred into secondary memory.

An operating system is loaded into the computer memory in the following
two ways:

 Loaded from Boot ROM.

 Loaded from the hard disk when the computer is switched on.

2.2.1 Services of an Operating System

An operating system acts as a platform for developing the application programs.
The major services provided by an operating system are as follows:

 It acts as an extended machine.

 It acts as a resource manager.

 It acts as a constant application program interface.

An operating system acts as an extended machine by translating your
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commands into machine language instructions. The CPU executes these machine
language instructions and the operating system retranslates the output back into a
user understandable language.

An operating system acts as a resource manager by controlling and allocating
various hardware and software resources to different users in an optimal and
efficient mode. The task of resource management becomes essential in multiuser
operating systems where different users compete for the same resources. An
operating system manages the resources in the following two ways:

 Time multiplexing

 Space multiplexing

Time multiplexing defines the sharing of resources based on fixed time slices.
For example, the operating system allocates a resource, such as CPU to program
A for a fixed time slice. When the time slice is over, the CPU is allocated to
another program B. If program A needs more CPU attention, then the CPU is
again allocated to program A after the time slice allocated to program B is over.

Space multiplexing defines the concurrent sharing of resources among
different programs. Sharing of a hard disk and main memory are examples of
space multiplexing.

An operating system acts as a constant application program interface that
allows you to develop an application on a computer and execute it on another
computer. It does not produce any dissimilarity if the configuration of the two
computers is different, as the application remains the same. For example, the
Windows 98 operating system provides such kind of flexibility. It can hold different
disk drives, printers and peripherals produced by different vendors. There are
some other functions of an operating system which are as follows:

 It controls the device drivers attached to the computer.

 It acts as a command interpreter.

 It decides the priority of various jobs.

 It performs the allocation and reallocation of memory.

 It performs the Input/Output (I/O) operations.

 It provides security by ensuring controlled access to resources.

 It controls the local and remote files placed on a computer.

 It monitors various jobs running on a computer for their security.

 It allows different processes to communicate with each other through
message passing techniques.

 It performs system accounting that monitors the use of system resources.

2.3 FUNCTIONS OF OPERATING SYSTEM

An operating system manages files, resources and CPU utilization that a user
needs to perform various tasks. An operating system performs the following
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functions:

 Process Management: It is a process that helps in managing processes.
A process is a set of sequential steps for performing a task. In other
words, for an operating system, a process is an instance of a program.
Process management is necessary for proper execution of any program.

 Memory Management: It is a process which manages storage system
of a computer. The organization and management of a computer storage
system is important for an operating system. An operating system
allocates memory to the various processes.

 Resource Management: The I/O subsystem is required to monitor
and manage wide variety of I/O devices. These I/O devices vary with
respect to their functionality, data rate, speed and software support.

2.3.1 Process Management

A process goes through various states for performing several tasks. The transition
of a process from one state to another occurs depending on the flow of the execution
of the process. It is not necessary for a process to undergo all the states. The
various process states are as follows:

 New: It indicates that the process has just been created.

 Ready: It indicates that the process is waiting for a chance to be allocated
the CPU time for execution.

 Running: It indicates that the process has been allocated the CPU time
and is executing the tasks.

 Waiting: It indicates that the process is waiting for the completion of either
another process or for an I/O task, such as reading a file.

 Terminated: It indicates that the process has finished its execution and all
the tasks in the process are complete.

2.3.2 Memory Management

A computer uses two types of storage, main memory and secondary memory. The
main memory stores temporarily the instructions to be executed by the computer.
The CPU of a computer retrieves instructions from main memory for execution. On
the other hand, secondary memory is constituted by various secondary storage devices,
such as magnetic disks and magnetic tapes which store information permanently in
the form of files.

Main memory, RAM, is the temporary read/write memory of a computer
but faster than the secondary storage device. Main memory is a set of locations
defined by sequentially numbered addresses for storing programs for execution
and each location contains a binary number. You can access each byte of RAM
directly without reading the previous bytes sequentially. Each byte in a RAM has
an address. The addresses are usually sequential hexadecimal numbers. Mostly,
the addresses of RAM start from 00000.
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2.3.3 Memory Management Strategies

To improve utilization of the CPU and the speed of the computer’s response to its
users, the system keeps several processes in memory, that is, several processes
share memory. Due to the sharing of memory, there is need of memory management.
There are various strategies that are used to manage memory. All these strategies
allocate memory to the processes using either of following two approaches.

 Contiguous memory allocation

 Noncontiguous memory allocation

Contiguous Memory Allocation

In contiguous memory allocation, each process is allocated a single contiguous part
of the memory. The memory management scheme that is based on this approach is
memory partitioning.

Noncontiguous Memory Allocation

In noncontiguous allocation approach, parts of a single process can occupy
noncontiguous physical addresses.

Paging

In paging, the physical memory is divided into fixed sized blocks called page
frames and logical memory is also divided into fixed size blocks called pages
which are of same size as that of page frames. When a process is to be executed,
its pages can be loaded into any unallocated frames (not necessarily contiguous)
from the disk.

2.3.4 Resource Management
In resource management, the resources of distributed system are divided into two
broad categories, I/O devices and files. Files are the central element in a distributed
system as they provide input to an application for execution and the output of the
execution is also recorded in the files.

For each I/O operation, you need to access the files that are stored on
disks or on specialized servers which are only assigned with the function of managing
file system. In order to achieve a high rate of data transfer and increase
performance, CPU enhances the rate of processing I/O operations of files. As the
client has to access remote files, it becomes critical to access the files in case of a
distributed system.

2.4 CLASSIFICATION OF OPERATING
SYSTEM

All operating systems consist of similar components and perform almost similar
functions, but the methods and procedures for performing these functions are
different. Operating systems are classified into following different categories based
on their distinguishing features:

 Single user operating systems
 Multiuser operating systems
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 Batch processing or job scheduling operating systems
 Multiprogramming operating systems
 Multitasking operating systems
 Parallel operating systems
 Distributed operating systems
 Real time operating systems

2.4.1 Single User Operating Systems

It allows a single user to access a computer at a time. These computers have single
processor and execute single program. The resources, such as CPU and I/O devices
are constantly available to the user in a single user operating system for operating
the system. As a result, the CPU sits idle for most of the time and is not utilized to its
maximum. A single user operating system is divided into two categories:

 Single user, single tasking operating system

 Single user, multitasking operating system

The single user, single tasking operating system allows a single user to execute
one program at a time. MS DOS and Palm OS for Palm handheld computers are
examples of single user, single tasking operating system.

Single user, multitasking operating system allows a single user to operate
multiple programs at the same time. For example, you can perform calculations in
Excel sheet, print a Word document and download a file from the Internet
concurrently. Mac OS, Windows 95, Windows 98, Windows NT Workstation
and Windows 2000 Professional operating systems for desktop and laptop
computers are the examples of single user, multitasking operating system.

A single user operating system executes an application program of a user
through hardware interaction and gives the result back to the user.

2.4.2 Multiuser Operating Systems

It allows various users to access the different resources of a computer simultaneously.
The access is provided using a network that consists of various personal computers
attached to a mainframe computer. These computers send and receive information
to a multiuser mainframe computer. Therefore, the mainframe computer acts as a
server and the other personal computers act as clients for that server. UNIX, Virtual
Memory System or VMS, Multiple Virtual Storage or MVS, Windows 2000 and
Novell NetWare are the examples of multiuser operating systems.

The advantage of using multiuser operating system is that it facilitates the
sharing of data and information among different users. Hardware resources, such
as printers and modems are also shared using the multiuser operating system.

The limitation of using a multiuser operating system is the expensive hardware
required for mainframe computer. Another limitation is that it reduces the
performance of the computer as multiple users work on it.

2.4.3 Batch Processing or Job Scheduling Operating
Systems

The batch processing operating system places the user’s jobs on an input queue and
these jobs are stored as a batch. The batch monitor executes these batches at a
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definite interval of time. The batch monitor accepts the commands for initializing,
processing and terminating a batch. These jobs are executed through interaction
with the hardware and the operating system and gives the output back to different
users. The batch processing operating system automatically executes the next job in
the batch and reduces user intervention during the processing of jobs.

2.4.4 Multiprogramming
Multiprogramming allows multiple users to execute multiple programs using a single
CPU. The multiprogramming operating system executes different processes
concurrently using a time multiplexed CPU by implementing the concept of CPU
slicing between them. CPU time slicing enables operating systems to execute multiple
jobs concurrently. The CPU switching between the programs is so fast that the response
time for users is fractions of seconds. The operating system uses an interactive computer
system that provides shared access to different resources. The operating system stores
multiple jobs in main memory and CPU immediately switches to the next job in sequence,
when the previous executing process comes in wait stage. The previous executing
process comes in wait stage due to an interrupt or requirement of I/O operations.
Therefore, a multiprogramming operating system increases the utilization of CPU by
reducing its idle time. UNIX, Windows 95, Windows NT, OS/2 and Amiga are examples
of multiprogramming operating systems.

2.4.5 Multitasking Operating Systems
Multitasking operating systems support the concept of multitasking. Multitasking is
the ability of a system to handle number of tasks or jobs simultaneously. A multitasking
operating system is also called time sharing system with the multiprogramming feature.
A time sharing system contains multiple user terminals that are connected to the
same system to work simultaneously. The multiprogramming feature of the time
sharing system allows multiple programs to reside in main memory and various
scheduling algorithms are used to allocate CPU time to the processes. The time
interval during which a user process gets the CPU allocation is known as time slice,
time slot or quantum. The CPU executes a process until the allotted time slice
expires.

2.4.6 Parallel Operating Systems
It consists of multiple processors sharing the clock, bus, memory and peripheral
devices. Parallel operating systems are also known as multiprocessor or tightly coupled
operating systems. Multiprocessor systems are divided into following categories:

 Symmetric multiprocessing
 Asymmetric multiprocessing

In symmetric multiprocessing, each processor runs a shared copy of
operating system. The processors can communicate with each other and execute
these copies concurrently. Thus, in a symmetric system all the processors share an
equal amount of load. Encore’s version of UNIX for the Multimax computer is an
example of symmetric multiprocessing system. In this system, various processors
execute copies of UNIX operating system, thereby executing m processes if there
are m processors.

2.4.7 Distributed Operating Systems
In this type of operating system, user requests are processed independently at more
than one location, but with shared and controlled access to some common facilities. A
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system which consists of multiple parts located at or embedded in geographically
dispersed physical locations is called a distributed system. In other words, in a distributed
system the workload is spread between two or more computers linked together by a
communication network.

Different computers communicate with each other using communication links,
such as telephone lines and buses. Heterogeneous computers include computers
with different configurations, such as workstations, microcomputers, minicomputers
and mainframe computers. These computers are referred to as nodes. The
processors in distributed operating system do not share clock, memory and
peripheral devices. Each processor has its own resources. Distributed operating
systems are also known as loosely coupled systems. Amoeba is an example of
distributed operating system which is a collection of workstations in a transparent
distributed system. Amoeba is being widely used in the field of academia, industry
and government for the last five years. It runs on the Scalable Processor
ARChitecture or SPARC, Sun 3/50 and Sun 3/60 operating systems.

The design of distributed operating systems is based on following two models:

 Client-Server model

 Peer-to-Peer model

2.4.8 Real Time Operating Systems

It defines the completion of job within the rigid time constraints otherwise the job
loses its meaning. The human brain works on the principle of real time operating
system. Real time operating systems are used in medical imaging systems, airline
reservation systems, home appliances controller systems and nuclear weapon
systems. Examples of real time operating systems are VxWorks and QNX. Real
time operating systems are divided into following two categories:

 Hard real time systems
 Soft real time systems

2.4.9 Timesharing

A multiprogrammed batch system does not permit real time interaction between users
and computer as the user commands needed for executing jobs are prepared as scripts
of Job Control Language (JCL) and submitted to the batch system. As users are not
permitted to submit the job script input and observe or take output directly, it took
many days to debug and correct the mistakes in program development. The solution
to the above problem was the introduction of Interactive Time Shared
Multiprogramming techniques. This enabled many users to interact with the
computer system simultaneously, each one using a separate terminal keyboard and
monitor connected to the system.

2.5 SOFTWARE

The hardware alone cannot perform any particular calculation or manipulation without
being instructed exactly what to do and how to do it. These set of instructions are as
important, if not more, than the hardware, and are called software. The software
acts as an interface between the user and the computer. Software or a program can
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be defined as a complete set of instructions written by the programmer which enables
the computer to obtain the solution to a problem (with or without the data). Software
is a general term that is used to describe any single program or a group of programs.
The software used by a computer may be classified into application software, system
software and utility software.

(a) System Software

They consists of all the programs, languages and documentation supplied by the
manufacturer with the computer. These programs allow the user to communicate
with the computer and write or develop his own programs. This software makes the
machine easier to use and makes an efficient use of the resources of the hardware
possible. System software are programs held permanently on a machine, which
relieve the programmer from mundane tasks and improve resource utilization. MS
DOS or Microsoft Disk Operating System was one of the most widely used system
software for IBM compatible microcomputers. Windows and its various versions
are popular examples of system software today. System software are installed
permanently on a computer system used for daily routine work.

(b) Application Software

These are software programs installed by users to perform tasks according to
their specific requirements, such as an accounting system used in a business
organization or a designing program used by engineers. They also include all the
programs, languages and other utility programs. These programs enable the user
to communicate with the computer and develop other customized packages. They
also enable maximum and efficient usage of the computer hardware and other
available resources.

Check Your Progress

1. What does single user operating system executes?

2. What is the function of batch processing operating system?

3. What is distributed system?

4. Write an example of a hard real time system.

2.6 INTRODUCTION TO DOS

Microsoft Disk Operating System (MS DOS) is a single user, single tasking operating
system. DOS has a command line, text based/non graphical user interface commonly
referred as Character based User Interface (CUI). When the computer is switched
on, a small program checks all internal devices, electronic memory and peripherals.
Once this process is completed, MS DOS is loaded.

 DOS Prompt: The DOS prompt, known as the command prompt, looks
like C:\> or D:\> where ‘C’,‘D’ represent the hard drives of the computer
system. All commands are typed at the DOS prompt. Enter key is pressed
to view the output of the typed command. If the command is correctly
typed, desired output would be displayed, otherwise an error message (Bad
Command or Filename/Invalid Parameter) is displayed on the screen.
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Limitations of MS DOS
Following are the limitations of MS DOS:

 It has a text based user interface where the commands have to be typed for
each operation that the user wants to perform. The user is expected to
remember the commands as well as their syntax.

 It is a single user, single task operating system and the working is limited to
one megabyte of memory. 640 KB of the memory is used for the application
program.

 It does not allow using long file names. The user is restricted to eight character
file names with three character extensions.

All DOS commands are case insensitive (i.e., there is no difference whether
you type COPY, copy or coPY). The same is true for the attributes, parameters
and filenames. To view the complete description of each command type HELP
followed by the command name, e.g., HELP COPY. Alternatively help can also
be displayed using <command>/? (COPY/?).

2.6.1 DOS Architecture

Monolithic architecture consists of a single layer that performs all the functions of
the operating system. The concept of information hiding is absent altogether in the
monolithic architecture, therefore you are able to observe and call the procedures of
different users. MS DOS and Novell NetWare operating systems are examples of
monolithic architecture.

In monolithic architecture, the operating system provides services to the users
in the form of system calls. These system calls provide functions, such as positioning
of procedural parameters on the stack and executing trap instruction. This instruction
transfers the control to the operating system by swapping the control from user mode
to kernel mode.

The operating system checks the parameters and calls the service procedure
which in turn calls the utilities. Utilities return the control back to the user program
in user mode. The flow of arrows shows the transfer of user program from the
user mode to the kernel mode through system calls. Limitations of an operating
system, using monolithic architecture are as follows:

 Difficult to modify as the whole operating system has to be redesigned.

 Failure of a single program crashes the entire system.

Layered architecture categorizes the operating system into different layers which
communicates using standard function calls. Each new layer is built on the top of an older
layer.

The higher level layers call the set of functions and data structures of lower
layers. The various layers of an operating system are as follows:

 Hardware Layer

 Kernel

 Service Layer

 Applications/Shell
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2.6.2 Internal and External DOS Commands

Simple DOS Commands
Table 2.1 summarizes the list of simple DOS commands.

Table 2.1 List of Simple DOS Commands

Command Syntax Explanation Example Notes 

COMMAND COMMAND Starts a new Window for the DOS 
command interpreter. 

C:\>Command Starts a new Window for the DOS 
command interpreter. 

EXIT EXIT Quits   the   COMMAND.COM   
program (command interpreter). 

C:\>EXIT Quits the command interpreter. 

CLS CLS Clears the screen display completely 
leaving only the DOS prompt. 

C:\>CLS Clears the screen and displays C: 
Prompt at the top of the screen. 

DATE DATE Displays the system’s current date and 
prompts to enter the new date. 

C:\>DATE Current date is Fri 20-01-2012 
Enter new date <mm-dd-yy>: 

TIME TIME Displays the current time and prompts 
the user to enter the new time. 

C:\>TIME Current time is 12:55:25.  
Enter new time <hh-mm-ss> 

VER VER Displays the windows version. C:\>VER Displays the Windows version 
installed on your computer. 

HELP HELP 

<Command 

Name> or 

Command 

Name/? 

Provides complete, information about 
queried MS DOS commands. 

C:\>DATE/? Complete information about the 
DATE command is displayed. 

DOSKEY DOSKEY Edits lines of command, recalls 
commands of MS DOS and creates 
macros. 

C:\>DOSKEY Once the Doskey is installed then 
Up and Down arrow keys can be 
used in the subsequent commands to 
recall the previous commands. 

PROMPT PROMPT 
[Text] 

Changes the MS DOS command 
prompt to the specified text. If the 
command is typed without any 
parameters then the default prompt 

D:\>PROMPT Changes the prompt to the default 
setting. 

PRINT PRINT 
<Filename> 

Prints a text file while other MS DOS 
commands are being used. 

C:\>DATA> 
PRINT 
TEMP.TXT 

Prints ‘TEMP.TXT’ stored in the 
‘DATA’ folder of the C: drive. 

LABEL LABEL Makes, changes or deletes the label of 
volume of a disk. 

C:\>LABEL Displays the current volume label 
and volume serial number. Also 
prompts to enter a new label. 

MEM MEM Displays the amount of and free and 
used memory in your system. 

C:\>MEM Displays the total amount of 
memory, amount of used and free 
memory in the system. 

MORE MORE 
<Filename> 

Displays output on the screen at a time 
for the text files. Useful in cases 
where the content of text file does not 
fit in a single screen. 

C:\DATA> 

MORE 

TEMP.TXT 

Breaks the contents of ‘TEMP.TXT’ 
in multiple screens. Subsequent 
screens can be viewed by pressing 
the ‘Enter’ key. 

ECHO ECHO Displays messages, or turns on or off 
the echoing command. 

C:\>ECHO Displays the current echo setting. 
(‘OFF’ or ‘ON’) 

EDIT EDIT Starts MS DOS editor, which 
produces and changes ASCII files. 

C:\>EDIT Opens the MS DOS Editor. 

SET SET Displays,   sets   or   removes   MS 
DOS environment variables. 

C:\>SET Displays the settings for the current 
environment variables. 

CHKDSK CHKDSK 
<Drive-Name> 

Checks a disk and gives the 
information like how many bytes have 
been used and how many are free and if 
any bad sectors are there on the disk. 

C:\>CHKDSK 
A: 

Checks A: drive and gives 
information about the disk. 

SCANDISK SCANDISK 
<Drive-Name> 

Finds errors from a drive and fixes 
any problem it encounters. 

C:\>SCANDISK 
A: 

Scans the A: drive and repairs the 
disk if any problem is there, like 
damaged area or virus, etc. 

DISKCOPY DISKCOPY Copies the content of one floppy disk 
to another. 

C:\>DISKCOPY 
A: 

Copies the entire content of one 
floppy to another. 

FORMAT FORMAT 
<Drive-Name> 

Formats the specified drive. C:\>Format A: Floppy inserted in the A: drive will 
be formatted. Any information in the 
floppy A: will be erased. 
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2.7 INTRODUCTION TO WINDOWS
OPERATING SYSTEM

Windows XP is a line of proprietary operating systems which was developed by
Microsoft and is meant to be used for general purpose computers, such as home
computers and business desktops, notebook computers and various other types of
media centres. Windows XP succeeds Windows 2000 and Windows ME, and is
the first consumer oriented operating system produced by Microsoft to be built on
the Windows NT kernel and architecture. The most popular operating systems
versions are Windows XP Home Edition which is primarily meant for home users
and Windows XP Professional, which possesses additional features, such as support
for Windows Server domains and dual processors, and is meant for professionals
and other experts. Windows XP Media Center Edition has additional multimedia
features. Windows XP has an edge over the earlier versions of Microsoft Windows
because of enhanced efficiency and better stability.

Windows XP helps you to access and manage your files on the PC using a
Graphical User Interface or GUI. All Programs and files stored on the PC are
represented as pictures that are called icons. These icons are stored on the desktop.

2.7.1 Components of Windows XP

The Windows XP user interface consists of various components and concepts that
help make Windows XP user friendly and intuitive. We will discuss these components
and their uses in Windows XP in this unit. Some important ideas that we will discuss
are:

 Desktop

 Windows

 Start Menu

 Applications

 Taskbar

 Folders

 Icons

 Files

 Recycle Bin

 Control Panel

2.7.2 Windows Explorer — Managing Files and Folders

Windows is responsible for maintaining all your files and subfolders on your disk.
You are aware by now that you store information in individual files. Groups of files
on a common subject can be kept in a specially earmarked place called a Folder.
Similarly in your computer, you have a storage area called the hard disk drive. Again,
theoretically, you can dump all your files into one place. However, this would pose
certain problems. Each time you want to access a particular file, it would take you a
considerable amount of time. Neither it is feasible to open each and every file in
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your system to check whether it pertains to the subject nor could the naming of a file
can describe its content. Therefore, obtaining a particular file could be a difficult if
all your files reside in one place without any file management. Fortunately, there is a
simple way out. You can divide your total hard disk space into a number of smaller
units called folders and subfolders. Now, you can store all the files pertaining to a
particular topic without bothering too much about individual file names. However, it
is still preferable that the file names make some sense with their contents.

Basically, all the files are maintained on your hard disk in the form of an
inverted tree like structure. At the top is the root folder under which there are
subfolders and sub-subfolders. Each of these folders or subfolders may contain one
or many files.

The number of files in a folder or subfolder is limited only by your hard disk
capacity. Another advantage of storing files in separate folders is that if you
inadvertently delete a folder, not all your work is lost. Also, individual folders can be
copied (either within the same hard disk or to another hard disk or to a an external
device), moved and deleted far more easily.

Windows Explorer allows you to do various file and disk management tasks
like copy, rename, move and delete file(s), create folder(s), and subfolder(s) and
format floppies. Windows Explorer is the quickest way to get a complete view of
the contents of your computer. Through it you can quickly get to see where each file
is located.

2.7.3 The Control Panel
The main feature of the Control Panel is adding or removing programs (adding all
programs and changing Windows components). To view this control, following steps
are taken:

 Click on the Start menu and go to Control Panel.

 Select the Add or Remove Programs option by double clicking on it.
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A The screen shown in right will be displayed.

You will see icons in the left panel of the screen that say Change or Remove
Programs, Add New Programs and Add/Remove Windows Components.

Change or Remove Programs

This option allows you to change or remove existing installed programs. To remove
a program do the following:

 Select the program by clicking on it.

 Click once the Remove button shown against the program.
 

 

 

 
 

Add New Programs

To install and/or uninstall additional software programs click on the Add New
Programs buttons.

A The shown window would be displayed. By clicking once on the CD or Floppy
button you can install a new program from either a CD or a floppy.

B You can choose Windows Update to add new Windows features or system
updates from the Internet.
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Adding or Removing Windows Components

For installing and/or uninstalling specific components or subcomponents of Windows,
click on the Add/Remove Windows Components button.

 Click once the Add/Remove Windows Components button.

 Select the required component by clicking once on the check box.

 Click on the Details button. It provides you details of the selected component.
You can add or remove individual subcomponents contained in the selected
component group.

 Click on the Next button to install the component.

2.7.4 Customizing the Desktop
The following steps can be performed to customize the desktop:

 Select the icons you want to display on the Desktop.

 Click here in case you want to change the picture of the selected Desktop
icons.



Operating Systems

NOTES

Self - Learning
106 Material

A Click here to restore the default settings.

B Click here to clean the Desktop.

 Click on OK once to apply the changes.

Fonts

Fonts are like having different handwritings available on your computer. They are
typefaces that you can use to pep up your work and also for changing the appearance
of characters on the screen and as well as on the printed paper. Fonts help you to
express your message more clearly and emphatically. Windows comes bundled with
a large number of fonts which are automatically installed depending upon your monitor
and printer type during the Windows setup installation. You can install additional
fonts from other software also, as and when required.

To work with fonts, do the following:

A Choose Fonts option from the Control Panel.

B A list of all the available fonts would be displayed. To look at a sample of a
font, double click the icon for the desired font.
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Mouse

A mouse is a small handheld device through which you can quickly and easily navigate
different parts of the screen. You can customize various aspects of the mouse to
make it work the way you prefer. You can control the mouse pointer speed, shape,
button configuration, double click speed, etc. You can even swap the functioning of
left and right buttons. If you frequently lose track of where your mouse pointer is,
you can choose to have a mouse trail effect which will make the mouse pointer
more visible. To change any of the above mentioned mouse settings, do the following:

A Choose Mouse option from the Control Panel.

Button Configuration

To customize button configuration follow the steps given below:

 Click on the Buttons tab.

 Click on the check box under the Button configuration option to convert
functioning of your left mouse button into right button and vice versa.

 Drag this button to increase or decrease the clicking speed of the mouse.

 Click on the Apply button to apply the changes that you have made.

 Click on the OK button to continue.

Pointer Configuration

To customize pointer configuration follow the given steps:

 Click on Pointers tab.

 Click on the pull down list to choose the scheme that you want to apply.

A You can choose a scheme from another location by clicking on the Browse
button.

 Click on Apply button to apply the chosen scheme.
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 Click on the OK button to continue.

Motion Configuration

You can also customize the motion configuration of the mouse. To do so follow the
given steps:

 Click on the Pointer Options tab.

 Click on this button to increase or decrease the pointer speed.

 You can also click on the Hide pointer while typing option to hide the
pointer while you are typing.

 Click on the Apply button to apply the changes that you have made.

 Click on the OK button to continue.

Printers and Faxes
Use this option to install new printers. You would need the Windows XP CD or the
Printer Installation CD to run this option. Windows XP installation CD includes
many printer drivers from various well known printer manufacturers. However,
if your printer or its exact model is not listed in the driver’s list provided by Windows
XP you need not worry, you simply need to insert the CD or floppy which must have
come along with the printer and complete the printer installation procedure.

 Choose the Printers and Faxes option from the Control Panel to see the
printers installed.
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A You will get a list of the printers installed on your machine.

Scanners and Cameras

 Choose the Scanners and Cameras option from the Control Panel to see
the imaging devices installed.

B You will get a list of the scanners and cameras installed on your machine.

Taskbar and Start Menu Settings

You can customize your Taskbar and Start Menu, such as the types of items to be
displayed and how they should appear.

 Click on the Taskbar and Start Menu icon from the Control Panel.

A You can change your Taskbar settings here.

B You can also change your Start Menu settings here.
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User Accounts

Change User Account settings and passwords for people who share a computer.

 Click on the  User Accounts icon from the Control Panel.

A You can change your settings from this screen.

2.8.5 Accessories

Microsoft Windows OS contains many accessories, such as media player, calculator,
games, paint, Notepad, etc. You can access these accessories by clicking on Start
menu and choosing Accessories in All Programs.
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Media Player

The Media Player turns your computer into a complete music system with a music
and video player. Using this option, you can not only play music formats like Moving
Picture Expert Group (MPEG) or MP3 but also standard audio/video Compact Disk
or CDs/Digital Versatile/Video Disc or DVDs, that you play on your normal music
CD/ Versatile Compact Disc or VCD/DVD player. Once again, this option will run
only if your computer has multimedia hardware like the DVD/CD ROM drive,
sound card and speakers.

 Go to the Start menu, click on All Programs and then choose Accessories.
From the list that pops up, choose Entertainment. Now select the Windows
Media Player option.

A You will get this dialog box through which you can play your music.

Calculator

Windows XP provides you with a full fledged calculator through which you can
perform various calculations. You have the option of using the scientific (cos, sin,
tan, log, square root, cube root functions, etc.) or the standard calculator having
basic mathematical functions. You can use either the keyboard or the mouse to
enter numbers and operators into the calculator. In case you need the result of your
calculations somewhere in your document, you can use the copy command provided
along with the calculator to copy the result at the desired place.

 Go to the Start menu. From All Programs, choose Accessories and then
select Calculator.

A You can use the calculation shown above as a normal or a scientific calculator.

Paint
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If you have artistic inclinations, you can use the Paint program to draw pictures and
maps on your computer. You can create or ‘assemble’ pictures by drawing straight
or curved lines, using shapes like squares, circles and polygons or by simply free
hand drawing. You can fill different colors and can even erase any portion of your
masterpiece that you are not satisfied with. You can use Paint to create wallpapers
for your Windows desktop or create logos for your company or any free hand drawing
that you wish to insert in Word or Excel.

 From the Start menu, go to All Programs. From the list that displays, choose
Accessories and then select Paint from the given options.

A The Paint window appears as shown in the given figure. You can use Paint
to create, edit and view pictures. You can also paste a picture into another
document you have created or use it as your desktop background.

Games

Windows XP also provides some standard games like FreeCell, Spider Solitaire,
Minesweeper, Hearts and Pinball.

 You can play any of these games by choosing the Games option from the All
Programs menu.

A The screenshot shows the game FreeCell.

The object of this game is to use all the cards in the deck to build up the four
suite stacks from Ace to King. In case you need any help or instructions on how to
play a game, click once on the Help option from the game’s menu bar and you will
find all the information that you need.
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Check Your Progress

5. What do you mean by Microsoft Disk Operating System (MS DOS)?

6. Write one limitation of MS DOS.

7. Define the term icon.

8. What is the main feature of control panel?

2.8 ANSWERS TO ‘CHECK YOUR PROGRESS’

1. A single user operating system executes an application program of a user
through hardware interaction and gives the result back to the user.

2. The batch processing operating system automatically executes the next job
in the batch and reduces user intervention during the processing of jobs.

3. A system which consists of multiple parts located at or embedded in
geographically dispersed physical locations is called a distributed system.

4. An example of a hard real time system is a flight controller system. If the
end user fails to respond an action within the allotted time, it could lead to
an unstable aircraft, which could cause a crash.

5. Microsoft Disk Operating System (MS DOS) is a single user, single tasking
operating system.

6. One limitation of MS DOS is that it has a text based user interface where
the commands have to be typed for each operation that the user wants to
perform. The user is expected to remember the commands as well as their
syntax.

7. All Programs and files stored on the PC are represented as pictures that are
called icons. These icons are stored on the desktop.

8. The main feature of the Control Panel is adding or removing programs (adding
all programs and changing Windows components).

2.9 SUMMARY

 An operating system is a set of instructions stored on a storage device, such
as hard disk, Compact Disk Read Only Memory (CD-ROM) or floppy
disk.

 An operating system acts as a constant application program interface that
allows you to develop an application on a computer and execute it on another
computer. It does not produce any dissimilarity if the configuration of the
two computers is different, as the application remains the same.

 Memory management is a process which manages storage system of a
computer. The organization and management of a computer storage system
is important for an operating system. An operating system allocates memory
to the various processes.
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 A computer uses two types of storage, main memory and secondary memory.
The main memory stores temporarily the instructions to be executed by the
computer. The CPU of a computer retrieves instructions from main memory
for execution.

 The batch processing operating system places the user’s jobs on an input
queue and these jobs are stored as a batch. The batch monitor executes
these batches at a definite interval of time.

 In distributed operating system, user requests are processed independently
at more than one location, but with shared and controlled access to some
common facilities. A system which consists of multiple parts located at or
embedded in geographically dispersed physical locations is called a
distributed system.

 The software acts as an interface between the user and the computer.
Software or a program can be defined as a complete set of instructions
written by the programmer which enables the computer to obtain the
solution to a problem (with or without the data). Software is a general term
that is used to describe any single program or a group of programs. The
software used by a computer may be classified into application software,
system software and utility software.

 Microsoft Disk Operating System (MS DOS) is a single user, single tasking
operating system. DOS has a command line, text based/non graphical user
interface commonly referred as Character based User Interface (CUI).

 Windows XP is a line of proprietary operating systems which was developed
by Microsoft and is meant to be used for general purpose computers, such
as home computers and business desktops, notebook computers and various
other types of media centers.

 Windows is responsible for maintaining all your files and subfolders on your
disk. You are aware by now that you store information in individual files.
Groups of files on a common subject can be kept in a specially earmarked
place called a Folder

 UNIX is a multi-user and multi-tasking operating system. It was developed
in the early 1970s at the AT&T Bell Laboratories. There are several versions
of UNIX which developed from time to time between 1970 and 2000.

 In UNIX, the command interpreter is not integrated with the operating
system; instead it exists as a separate program. The UNIX operating system
provides security for the UNIX users by giving each user his/her own login
name and password to work on the UNIX computer.

2.10 KEY TERMS

 Process Management: It is a process that helps in managing processes.
A process is a set of sequential steps for performing a task.
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 Parallel Operating Systems: It consists of multiple processors sharing
the clock, bus, memory and peripheral devices.

 Microsoft Disk Operating System (MS DOS): It is a single user, single
tasking operating system.

 UNIX : It is a multi-user and multi-tasking operating system.

2.11 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What is an operating system?

2. Write two functions of an operating system.

3. What is contiguous memory allocation?

4. List two categories of parallel operating systems.

5. Name two models of distributed operating systems.

6. What do you mean by real time operating systems?

7. What do you mean by DOS prompt?

8. What is the function of control panel?

Long-Answer Questions

1. Write a detailed note on the functions of operating system.

2. What are the services provided by the operating system? Explain with the
help of examples.

3. Write a detailed note on memory management.

4. Explain the two categories of multiprocessor system.

5. What are various categories of real time operating systems? Explain.

6. Explain the various types of software.

7. Explain the architecture of DOS along with its commands.
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3.0 INTRODUCTION

Almost every computer user has a need for some kind of document preparation
system. In the PC world, word processing is the norm, it involves editing and
manipulating text and producing printed copies of the text, complete with figures,
tables, and other garnishes. Multimedia files, such as digital imagery and video,
have become increasingly popular in today’s business world, but the written word
remains as important as ever. Word processing software is used to manipulate a
text document, such as a resume or a report. You typically enter text by typing,
and the software provides tools for copying, deleting and various types of formatting.

Microsoft Word is a word processing software developed by Microsoft.
Word for Windows is available stand-alone or as part of the Microsoft Office
suite. Word contains rudimentary desktop publishing capabilities and is the most
widely used word processing program on the market. Word files are commonly
used as the format for sending text documents via e-mail because almost every
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user with a computer can read a Word document by using the Word application,

Spreadsheet software is a software application capable of organizing, storing
and analyzing data in tabular form. The application can provide digital simulation
of paper accounting worksheets with these capabilities, spreadsheet software has
replaced many paper-based systems, especially in the business world. Spreadsheet
software has replaced many paper-based systems, especially in the business world.
Originally developed as an aid for accounting and bookkeeping tasks, spreadsheets
are now widely used in other contexts where tabular lists can be used, modified
and collaborated.

Microsoft Excel is a spreadsheet developed by Microsoft for Windows,
mac-OS, Android and i-OS. It features calculation, graphing tools, pivot tables,
and a macro programming language called Visual Basic for Applications (VBA).
It has been a very widely applied spreadsheet for these platforms, especially since
version 5 in 1993, and it has replaced Lotus 1-2-3 as the industry standard for
spreadsheets. Excel forms part of the Microsoft Office suite of software.

3.1 OBJECTIVES

After going through this unit, you will be able to:

 Explain the process of creating and editing documents in MS Word 2007

 Discuss the significance of formatting documents

 Use tools, such as AutoCorrect, spell checking, etc.

 Discuss the significance of table

 Discuss the process of creating and running the macros

 Understand linking and embedding object

 Understand the significance of Microsoft Excel 2007

 Explain selection process in a worksheet

 Work with formulae

 Edit a worksheet

 Create charts in MS Excel 2007

 Create and execute  macro

 Print worksheets data in MS Excel 2007

3.2 TEXT PROCESSING SOFTWARE : MS WORD

The basic elements of an office are people, machines, paper, records, documents,
files and procedures. It involves various activities, such as inflow, storage, shifting,
collation, reformatting and dissemination of information. Thus, an office is basically
a centre for information processing where the following activities are performed:

 Receiving information

 Recording and saving information

 Structuring the information
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 Processing the information

 Providing access to information

The term ‘office automation’ refers to the tools and methods used to perform
various office activities. Office automation provides elements which simplify, improve
and automate the activities of a company or a group of people. It includes the
following activities:

 Exchanging the information.

 Managing the administrative documents.

 Managing numerical data.

 Scheduling and planning management works.

In an office, the following software programs are required to fulfil its needs:

 Word processing

 Spreadsheet package

 Presentation package

 Database

 Scheduler

The significant part of office automation is LAN (Local Area Network) which
permits users to share data across the office network. It includes all the office
functions, such as dictation, typing, filing, copying, fax, Telex, records management,
telephone operations, and so on. Office automation includes the various computer
hardware and software used in electronically creating, collecting, storing and
manipulating office information. The basic activities of office automation are storage
of raw data, electronically transferring the data and managing business information.

3.2.1 Microsoft Office 2007: An Introduction

Microsoft Office 2007 is the latest version of MS Office that runs on Windows
XP SP2 and above. It is packed with many features. It has components such
as Excel (Spreadsheet), Word (Word processor), OneNote and PowerPoint
(for making presentations). Microsoft gives these four programs in Home and
Student Edition. In the initial stage of its development as beta cycle, it was
known as Office 12. It was released on Nov 30, 2006 for volume license
customers and was made available to retail customer in the year 2007 on
January 30. This was released vis-à-vis Windows Vista (Operating System).

New Features at a Glance: There are number of features that Office 2007
contains. It is much improved in comparison to its earlier versions. New GUI
(Graphical User Interface) has been introduced that is known as Fluent User
Interface. This has replaced menus and toolbars and has tabbed tool bars and is
known as Ribbon. These menus and tool bars that were continuing in earlier versions
of Office were dropped. Office 2007 runs on Windows XP SP 2 or above,
Windows Server 2003 SP 1 or above, Windows Vista/7. It is the last version
Office suite on Windows XP Professional 64-bit Edition. This has also incorporated
Office SharePoint Server 2007 which is thought as a major revision for the server
platform using Office applications. This provides support for ‘Excel Services’ having
C/S (Client/Server) architecture that supports Excel workbooks, shared in real
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time mode between many computers.

User Interface: New UI (User Interface) in Office 2007 is now known officially
as Fluent User Interface. This interface got implemented in Excel, Word, Access
and PowerPoint that form the core Office applications. In the item inspector these
are used for creating or editing individual items in MS Outlook.

Office Button: The Office button in 2007 is situated at the top-left corner of the
window and it has replaced File menu. This provides access to functions common
found common in all Office applications such as opening a file, printing file, saving
as well as sharing a file. This is also used for closing applications. A color schemes
can also be chosen by users for the interface.

Ribbon: Ribbon is a panel that houses a fixed arrangement of few icons and
command buttons. This creates organizations for commands that form a set of
tabs that group every relevant command. This can not be customized. Every
application contains a different set of tabs that tells about its functions.

Contextual Tabs: There are certain tabs that show appearance only after making
selection of certain objects. These tabs are known as Contextual Tabs. Such
tabs focus on functions specific to the selected objects only. If you select a picture
then Pictures tab is shown and this gives all options to work with pictures.

Mini Toolbar: This is a new inclusion in Office 2007. It appears automatically as
a context menu when you select a text. This design provides easy access to
formatting commands that are used repeatedly without making use of right button
of the mouse as is done in older versions.

Super Tool Tips: Super tool tips are also known as screen tips. This is capable
of housing formatted text as well as images. These show detailed descriptions
about most buttons and their functions.

Quick Access Toolbar: This tool bar is inside the title bar and is a repository of
functions that are most commonly used. This toolbar can be customized. Any
command can be included to this toolbar and this also includes commands that are
not available in Ribbon and macro.

3.3 MICROSOFT WORD 2007

Microsoft Office Word 2007 enables you to create formal documents by providing
a broad set of tools for crafting and formatting your documents in a new interface.
Rich productive review, remarking content with comments and comparison
capabilities help you to manage feedback from colleagues. Significant sources of
business information stay connected by advanced and improved data integration.

Working in Compatibility Mode

When you open Word 97-2003 document in Microsoft Office Word 2007,
Compatibility Mode is turned on and you see Compatibility Mode in the title bar
of the document window. In Compatibility Mode, you can open, edit and save
Word 97-2003 documents but you will not be able to use any of the new Office
MS Word 2007 features.
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Compatibility Checker

The Compatibility Checker lists elements in your document that are not supported
or will work differently in Word 97-2003 format. In the Compatibility Checker,
you can review a summary of elements that behave differently in previous versions
of Word and then either click Continue to save the document in Word 97-2003
format or click Cancel. Some of these features will be permanently changed and
will not be converted to Microsoft MS Office Word 2007 elements if you convert
the document to Office Word 2007 format.

 Citations and Bibliographies: Citations and bibliographies will be
converted to static text.

 Content Controls: Content controls will be converted to static content.

 Embedded Objects: An embedded object in this document was created
in Microsoft Office Excel 2007. You will not be able to edit the object in
earlier versions of Word.

 Equations: Equations will be converted to images. You will not be able to
edit the equations until the document is converted to a new file format.

 SmartArt Graphics: SmartArt graphics will be converted into a single
object that cannot be edited in previous versions of Word.

 Tabs: Alignment tabs will be converted to traditional tabs.

 Text Boxes: Some text box positioning will change.

 Tracked Moves: Tracked moves will be converted.

Creating and Editing Document in Microsoft Word 2007

The Start button in the lower-left corner of your screen gives you access to all the
programs on your PC and also to MS Word 2007. To start Microsoft Word
2007, click on the Start button and select All Programs. To open this window,
you will need to perform the following steps:
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 Click on the Start button and select Microsoft Office from Programs.

 Select Microsoft Office Word 2007.

The user interface of Microsoft Word 2007 is shown in the screen below.

 

Menus

When you explore Microsoft Word 2007, you will notice  the new look of the
menu bar. Three new features help you to work with MS Word 2007, namely the
Microsoft Office Button, the Quick Access Toolbar and the Ribbon which contain
various functions.

The Microsoft Office Button

The Microsoft Office button is located in the upper-left corner of the MS Word
2007 window. A menu appears when you click on this button. This menu helps in
creating a new document or file, opening an existing document or file, saving a
document or file, printing a document or file, sending the document or file via fax
or e-mail, etc.

The Quick Access Toolbar

The Quick Access Toolbar is right next to the Microsoft Office button. This toolbar
helps you to access the frequently used commands. The default commands which
appear on this toolbar are Save, Undo and Redo. These commands help you to
Save a document or file, Undo an action and Redo an action.
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You can customize this toolbar as per your requirements by clicking on the
expansion button as shown below.

More items can be added to the quick access toolbar by right clicking on
the item which you want to add in the Office Button or the Ribbon and then
clicking on Add to Quick Access Toolbar as shown below:

The Ribbon

The Ribbon is positioned at the top of the screen of the Word window. It includes
seven tabs, namely Home, Insert, Page Layout, References, Mailings,
Review, View and Add-Ins as shown in screen below. Each tab contains various
new and advanced features of Word.

Each tab specifically contains certain tools as follows:

 Home: Clipboard, Font, Paragraph, Styles and Editing

 Insert: Pages, Tables, Illustrations, Links, Header & Footer, Text and
Symbols

 Page Layout: Themes, Page Setup, Page Background, Paragraph and
Arrange

 References: Table of Contents, Footnotes, Citations & Bibliography,
Captions, Index and Table of Authorities

 Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results
and Finish

 Review: Proofing, Comments, Tracking, Changes, Compare and Protect

 View: Document Views, Show/Hide, Zoom, Window and Macros

 Add-Ins: PDF Transformer or any new Add-In program
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The Title Bar
The Title bar is next to the Quick Access Toolbar. It displays the title of the current
document which is in use. The first new document in Word is named as ‘Document1’
as shown below. When you open more new documents, Word automatically names
them as Document2, Document3, Document4, etc. sequentially. The document
can be saved by giving it a proper file name as per the user’s choice.

Word provides various ways through which a user can create a new document,
open an existing document and save a document in Word. To create a new document,
click on the Microsoft Office Button  and then click on New or press CTRL+N
on the keyboard.

You will see that when you click on the Microsoft Office Button and then
click on New, Word provides number of choices about the types of documents
you can create. Select and click on Blank from the list if you want to create a
blank document. 

You can create a document using the option Installed Templates. Select
any one of the templates as per your requirement. You can also browse other
options through the list of choices that appear on the left.

Saving a Document

To save a document, the following are the options available to opt from according
to the user’s choice:
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 Click on the Microsoft Office Button  and click on the Save option.

 The alternate option is to press CTRL+S.

 Another option is to click on the File icon in the Quick Access Toolbar and
click on the Save.

Saving a Document using Save As

To save a document using the Save As option, click on the Microsoft Office Button
 and click on Save As. The Save As option helps you to save a document as a

Word Documents, Word Template, Word 97-2003 Document (earlier versions), Other
Formats, etc.

Renaming a Document

To rename an existing document, you need to perform the following steps:
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 Click on the Office Button  and locate the document you want to

rename.

 Click on the Save As option and then right click on the document name
with the mouse and select Rename from the shortcut menu.

 Type the new name for the document and press the ENTER key.

Working on Multiple Documents

Multiple documents can be simultaneously opened when you need to type or edit
multiple documents at once.  All the documents as opened will be listed in the View tab
of the Ribbon when you will click on Switch Windows.  The current document has a
checkmark beside the file name.  You can select a different document as opened by
simply clicking on the tab.

Opening an Existing Document

To open an existing document, the following steps need to be performed:

 Click on the Microsoft Office Button  and then click on Open.

 The alternate option is to press CTRL+O on the keyboard.

 For recently used document, you can click on the Microsoft Office Button
and then click on the name of the document in the Recent Documents
window.
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Closing a Document

To close a document, the following steps need to be performed:

 Click on the Office Button.

 Click on Close.

Quitting from MS Word 2007

When you work with Word processing, you can either quit or minimize the Word
document. If do not expect to return to it anytime soon, you may just want to quit
the program. If you want to stop work on one document to work on another, you
can close the document and then open another. You can use the Minimize button
to hide Word while you are off doing other things. Following steps are required to
perform quit from Word:

 Choose Exit Word from the Office Button menu.

 Save any files when Word prompts you to do so.

 Click Yes to save your file. You may be asked to give the file a name, if you
have not yet done so.

 Click Cancel to quit Exit Word command and return to Word.



Text Processing and
Spreadsheet Software
Systems

NOTES

Self - Learning
128 Material

If you select quit, Word closes its Window.  Then, you can return to Windows
or some other program.

Text Editing

The process of editing a document involves the following steps:

Typing and Inserting Text

To enter text, just type the text in the Word window. The text will appear at the
location of the blinking cursor. You can move the cursor using the arrow keys on
the keyboard or by positioning the mouse and clicking the left button. The keyboard
shortcuts used for this purpose are as follows:

Move Action Keystroke

Beginning of the line HOME

End of the line END

Top of the document CTRL+HOME

End of the document CTRL+END

To change the current attributes of the text as typed, it needs to be highlighted
first. Select the text by dragging the mouse over the text to be modified while
holding down the left mouse button. An alternate way is to hold down the SHIFT
key on the keyboard and use the arrow buttons to highlight the text. Following are
the shortcuts that are used to select a specific portion of the text:

Selection Technique

Whole word Double click within the word.
Whole paragraph Triple click within the paragraph.
Several words or lines Drag the mouse over the words or hold down the SHIFT

key while using the arrow keys.
Entire document Choose Editing  Select  Select All from the Ribbon

or simply press CTRL+A.

Moving and Copying Text

Moving and copying data are common commands used in many computer programs.
These commands allow us to take information from one document or location and
place them in another without retyping everything. When you move data, you are
actually taking it from the location in which it is currently placed and relocating it to
another area in the document. When you copy data, the original data remains intact
and in addition a copy of that data is placed in another area in the document as
shown in the following screen:
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In MS Word 2007, the commands you need to carry out any move or copy
operation are located on the Home tab within the Clipboard. Following are the
keyboard shortcuts that are also helpful when moving through the text of a document:

Move Action Keystroke

Beginning of the line HOME

End of the line END

Top of the document CTRL+HOME

End of the document CTRL+END

Using Drag and Drop Technique

Text can be inserted in a document at any point using any of the following methods:

 Type Text:  Put your cursor where you want to add/insert the text and
begin typing.

 Copy and Paste Text:  Highlight the text you wish to copy and right click
to view options. Now click on Copy option. Put your cursor where you
want the text to be inserted in the document and right click to view options.
Select Paste to paste the copied text.

 Cut and Paste Text:  Highlight the text you wish to cut and right click to
view options. Now click on Cut option. Put your cursor where you want
the text to be inserted in the document and right click to view the options.
Select Paste to paste the cut text.

 Drag Text:  Highlight the text you wish to move. Click on it and drag it to
the place where you want the text to be inserted in the document.

Using Cut, Copy and Paste Options

To work with Cut, Copy and Paste operations in MS Word 2007, you need to
first select the text which you want to copy and paste as shown in the following
screen. Press right mouse button to get the shortcut key.
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Copy the selected text. Select  Paste option and place the mouse pointer
where you want to paste the selected material. Click on Paste option. The copied
and cut text will be stored in Clipboard application as shown in the following
screen.

For cut operation, you need to select the text. Click on Cut option in shortcut
key. Place the mouse pointer where you want to paste the cut text. Click on Paste
option in shortcut key.

Finding and Replacing Text

The Find and Replace option can be accessed either by selecting CTRL+F or
CTRL+H menu by pressing key combinations for Find and Replace. After
choosing the Find or Replace option, you will get the following screen:
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The special drop-down list drops a variety of options as follows:

The match case provides you to find and replace the word as uppercase or
lowercase. For example, if you check on Match case box and type the word in
capital as ‘TOP’, a dialog box appears with a message ‘The search item was
not found’.

If you remove the check box, the found word is replaced by defined word
as follows:

You can also search the items by using wild card (*) as shown in screen
below:
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Insert/Delete Text

In Microsoft Word 2007, you can create documents by typing them, for example,
if you want to create a report, you open Microsoft Word 2007 and then start to
type. You do not have to do anything when your text reaches the end of a line and
you want to move to a new line, Microsoft Word 2007 automatically moves your
text to a new line.  If you want to start a new paragraph press ENTER key.
Microsoft Word 2007 creates a blank line to indicate the start of a new paragraph.
To capitalize, hold down the SHIFT key while typing the letter you want to
capitalize.  If you make a mistake, you can delete what you typed and then type
your correction. You can use the Backspace key to delete. Each time you press
the Backspace key, Microsoft Word 2007 deletes the character that precedes
the insertion point. The insertion point is the point at which your mouse pointer is
located. You can also delete text by using the Delete [DEL] key. First, you select
the text you want to delete and then you press the Delete key. Let us take an
example, type the following sentence:

I am learning to use Microsoft Word 2007

Delete the word Microsoft and 2007 from the given sentence. Place the cursor
using either the arrow keys or the mouse at the end of the word Microsoft. Press
the Backspace key until the word ‘Microsoft’ is deleted. Similarly delete ‘2007’
from the sentence. The sentence will be as follows:

I am learning to use Word

Insert a word ‘Processor’ at the end of sentence. Place the cursor after the word
‘Word’. Start typing the word ‘Processor’ and save the changes. Similarly insert
a word ‘how’ in between ‘learning’ and ‘to’ in the given sentence. The sentence
will be as follows:

I am learning how to use Word Processor

3.3.1 Formatting Document

Document formatting represents all the types of formatting parts which are applied
to a selected document for making suitable presentation. The page margins can be
modified through the following steps:
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 Click the Page Layout tab on the Ribbon.

 On the Page Setup group, click Margins.

 Click an Normal or Office 2003 Default.

 Or you can also click Custom Margins and complete the dialog box.

Following steps are required to change the Orientation, Size of the page
or Columns:

 Click the Page Layout tab on the Ribbon.
 On the Page Setup Group, Click the Orientation, Size or Columns

drop-down menus.
 Click the appropriate choice.

Apply a Page Border and Color

To apply a page border or color, following steps are required:

 Click the Page Layout tab on the Ribbon.

 On the Page Background Group, click the Page Color or Page Borders
drop-down menus.

Create or Insert a Page Break

To insert a page break, following steps are required:

 Click the Page Layout tab on the Ribbon.

 On the Page Setup Group, click the Breaks, drop-down menu.

 Click Page Break.
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Insert a Cover Page

To insert a cover page, following steps are required:

 Click the Insert tab on the Ribbon.

 Click the Cover Page button on the Pages group.

 Choose a style for the cover page.

Insert a Blank Page

To insert a blank page, following steps are required:

 Click the Insert tab on the Ribbon.

 Click the Blank Page button on the Pages group.
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Font Formatting

You can find Font toolbar on Home tab on the Ribbon.

To change the font typeface, Click on the arrow next to the font name and select
a font.

You can preview how the new font will look by highlighting the text and then
hovering over the new font typeface.

To change the font size, click on the arrow next to the font size and select
the proper size or click on the increase or decrease font size buttons.

Font Styles and Effects

Font styles are predefined formatting options which are used to emphasize specific
text. They include bold, italics and underline. Following are the steps that need to
be followed in order to add these effects:

 Select the text and click on Font Styles as included in the Font group of
the Ribbon.

 The alternate way is to select the text and right click on it to display the font
tools.

Border and Shading

You can add borders, shade paragraphs and even the entire pages. To create a
border around a single paragraph or paragraphs, you need to do the following:
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 Select the area of text where you want the border or that which you want to
shade.

 Click on the Borders button in the Paragraph group on the Home tab.

 Select the Borders and Shading option.

 Select the options as per your choice and requirement.

Inserting Symbols

Microsoft Word 2007 permits you to insert special characters, symbols, pictures,
illustrations, etc. Special characters are punctuation, spacing or typographical
characters that are  generally not available on the standard keyboard. Following
are the steps for inserting symbols and special characters:

 Move your cursor in the document where you want the symbol.

 Click on the Insert tab in the Ribbon.

 Click on the Symbol button in the symbols group.

 Select the symbol as required.

If you want more symbols then click on More Symbols to display the
following dialog box for a list of various symbols in various fonts.
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Changing Case

In Microsoft Word 2007, you can change the capitalization of words, sentences
or paragraphs by doing the following:

 Select the text that you want to change the case of.

 On the Home tab, in the Font group, click Change Case  (as shown in
the screenshot) and then click the capitalization option that you want.

 To capitalize the first letter of a sentence and leave all other letters as
lowercase, click Sentence case.

 To exclude capital letters from your text, click lowercase.

 To capitalize all of the letters, click UPPERCASE.

 To capitalize the first letter of each word and leave the other letters lowercase,
click Capitalize Each Word.

 To shift between two case views, for example, to shift between Capitalize
Each Word and the opposite, cAPITALIZE eACH wORD, click
tOGGLE cASE.

Text Alignment

Paragraph alignment helps in organizing the text according to the way you want it
to appear. To change the alignment, follow the given steps:

 Click on the Home tab.

 Select the appropriate button for alignment in the Paragraph group.
o Align Text Left:  The text is aligned with the left margin.
o Center:  The text is centered within the margins.
o Align Text Right:  The text is aligned with the right margin.
o Justify:  It aligns the text to both the left and right margins.

Insertion of Current Date and Time in a MS Word 2007 Document

In Microsoft Word 2007, use the following shortcut keys to enter the current
system date and time as shown in the screenshot, for example [ALT+SHIFT+D]
key combination is used to insert the current date and [ALT+SHIFT+T] key
combination is used to insert the current time.
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Writing Header and Footer Content

To apply a page border or color, follow the given steps:

 Click on the Page Layout tab in the Ribbon.

 In the Page Background group, click on Page Color or Page Borders to
generate the drop-down menus.

Inserting Common Header and Footer Information

To insert Header and Footer information, such as page numbers, date or title, first
decide  whether you want the information to be in the header, i.e., at the top of the
page or in the Footer, i.e., at the bottom of the page and then follow the given
steps:

 Click on the Insert tab in the Ribbon.

 Click on Header & Footer.

 Select a style.

 The Header & Footer Tools tab will be displayed in the Ribbon.

 Select or type the information that you want to have in the header or footer,
such as date, time, page numbers, etc.
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Bullets and Numbering

Bulleted lists are represented using bullet points, numbered lists are represented
using numbers and outline lists combine together the numbers and letters depending
on the association of the list.

Following are the required steps for adding a list to existing text:
 Select the text for which you wish to make a list.
 From the Paragraph group on the Home tab, click on the Bullets or

Numbering or Multilevel List button as per requirement.

To create a new list following steps are required:
 Move your cursor where you want the list to appear in the document.
 Click the Bullets or Numbering button.
 Start typing.
 Bullets or Numbers will automatically appear when you will press the

ENTER key and go to a new line.

Nested Lists

A nested list is the list which has several levels of indented text. To create a nested
list, do the following steps:

 Create your list following the directions as given above.

 Click on the Increase or Decrease Indent button.

Formatting Lists

The bullet image and the numbering format can be modified using the Bullets or
Numbering dialog box. Following are the steps for formatting a bulleted or a
numbered list:

 Select the entire list to change all the bullets or numbers, or just place the
cursor on one line within the list to change a single bullet.

 Right click.

 Click on the arrow next to the bulleted or numbered list and choose the
bullet or numbering style as required.
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Spelling and Grammar Tool

To check the spelling and grammar of a document, follow the given steps:

 Move the cursor to the beginning of the document or to the beginning of the
section that you want to check.

 Click on the Review tab in the Ribbon.

 Click on the Spelling & Grammar option in the Proofing group. 

 Any error as encountered will be displayed in a dialog box which would
permit you to select a more proper spelling or phrasing as shown below.

If you wish to check the spelling of an individual word, you can right click
on any word that has been underlined by Word and select a proper substitution.

Thesaurus

Thesaurus allows you to view synonyms.  To use the thesaurus, follows the given
steps:

 Click on the Review tab of the Ribbon.

 Click on the Thesaurus button on the Proofing group. 
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 The thesaurus tool appears on the right side of the screen and you can view
the  word options.

3.3.2 Working with Documents

You can perform the following actions on the documents:

Opening Word Application

To open a MS Word 2007 application, you need to select the File  Open
menu as shown in the following screen and then select the file which you want to
open.

After selecting the file, the content of document file is opened on the screen.
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Explanation of Different Parts of Word Window and Views in MS 2007
Word

Following are the various ways available in ‘Document Views’ tab in which a
document can be viewed in Word: 

 Print Layout:  This is a view of the document as it would appear when
printed.  It includes all tables, text, graphics and images as present in the
document.

 Full Screen Reading:  This refers to a full length view of a document.  It
is of utility when you want to view two pages at a time.

 Web Layout:  This is a view of the document as it would appear in a web
browser.

 Outline:  This is an outline of the document in the form of bullets.

 Draft:  This view does not display pictures or layouts. It displays only the
text.

To view a document in various forms, click on any of the document view

shortcuts at the bottom of the screen  or alternatively,,

 Click on the View Tab in the Ribbon.

 Click on the appropriate document view.

Document Printing

Microsoft Word 2007 is considered as standardized software for creating text
documents. In MS Word 2007, you can quickly print a document and can avoid
the Print dialog box which saves your time. To use the Preview and Print functions
in Microsoft Word 2007, follow the given steps.

 Open the document to preview, if you are not currently working on it.

 Click on ‘Microsoft Office Button’ in the top-left corner of your screen.
You will find numerous features here that used to be on the ‘File’ menu in
Microsoft Word 2007.

 Highlight ‘Print’ and then select ‘Print Preview’. You will see the document
on the screen.

Using the Print Function

In Microsoft Office Button, three buttons, such as Print, Quick Print and Print
Preview appear on the screen to perform the printing of the document.
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Following steps are required to use a Print function in Microsoft Word
2007:

 Click the ‘Microsoft Office Button’ again and highlight ‘Print’.

 Select ‘Quick Print’ if your document does not need any changes.

 Choose ‘Print’ if you want more printing options. The ‘Print Dialog Box’
appears.

 Accept the default printer or choose a new one to the right of ‘Name’.

 Click on the ‘Properties’ or ‘Options’ buttons to choose different options
affecting your document’s appearance.

 Select ‘OK’ after you make your choices and the document will print.

Setup Page to Margin, Paper Size, Orientation for Printing

In the ‘Preview mode’, you can change margin setup, page size and orientation,
print options and can also select various other printing features. You can also
directly print the document from the Print preview mode by clicking on Print
button present in the Ribbon. Following screenshot displays the print dialog box
showing various printing options present in MS Word 2007:

Select Properties button if you want to check the margin, paper size and
orientation to print the selected Word document.



Text Processing and
Spreadsheet Software
Systems

NOTES

Self - Learning
144 Material

Print Preview

When working on MS Word 2007 documents for the MS Office 2007 which is
used to edit them while in Print Preview instead of going back into the document.
Print Preview is used to see how the document will look like when it is printed to
paper. You can get into Print Preview mode by clicking the Print Preview icon on
the Quick Access Toolbar or clicking on the Office Start Menu  Print 
Print Preview.

You can also select the Print Preview option in MS Word 2007 from Office
Button as shown in the following screenshot:

After clicking on Print Preview option form Print menu, you can see the
previewed page and can modify the required changes.

3.3.3 Advanced Document Formatting

Styles are predefined text formats that are available in MS Word 2007 that can be
appled on text by performing following steps to utilize Quick Styles:

 Select the text you wish to format. 

 Click the dialog box next to the Styles Group on the Home tab. 

 Click the style you wish to apply.
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The use of Styles in MS Word 2007 will allow you to quickly format a document
with a consistent and professional look.  Styles can be saved for further use in
many documents.

Apply Styles

There are many styles that are already provided in Word and ready for you to use.
To view the available styles, click the Styles dialog box on the Styles group in the
Home tab.  To apply a style:

 Select the text.

 Click the Styles tab.

 Click the Style you want to choose.

Creating New Styles

You can create styles for formatting that you use regularly.  There are two ways to
do this which are known as New Styles or New Quick Styles.

Style Inspector

Following steps are required to determine the style of a particular section of a
document:

 Insert cursor anywhere in the text that you want to explain the style.
 Click the Styles drop-down Menu.
 Click the Style Inspector button.
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Create Links

Creating links in a MS Word 2007 document allows you to put in a Uniform
Resource Locator (URL) that readers can click on to visit a Web page. To insert
a link, following steps can be performed :

 Click the Hyperlink button on the Links group of the Insert Tab. 
 Type in the text in the ‘Text to Display’ box and the Web address in the

‘Address’ box.

Once you click on Hyperlink tool, following screen will appear.

Indention

Indention helps you to set the text within a paragraph at different margins. The
various options for the purpose of indenting text are as follows:

 First Line: Controls the left boundary for the first line of a paragraph.
 Hanging:  Controls the left boundary for every line in a paragraph except

the first one.
 Left:  Controls the left boundary for every line in a paragraph.
 Right:  Controls the right boundary for every line in a paragraph.

Following are the steps that need to be performed for indenting paragraphs

 Click on the Indent buttons to control the indent, i.e., to decrease or to
increase the size of the indent.
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 Open paragraph dialog box by right clicking the selected text.
 Click on the Indents and Spacing Tab.
 Select the indent as required.

Using Tab

Tab stops are frequently used to create easy-to-format documents. You can use
the ruler to set manual tab stops at the left side, middle and right side of your
document. If the horizontal ruler that runs along the top of the document is not
visible then to view it click on the View Ruler button at the top of the vertical
scroll bar. You can quickly set tabs by clicking on the tab selector at the left end of
the ruler until it displays the type of tab that you require and then clicking the ruler
at the location you require. If you want your tab stops at specific positions that you
cannot get by clicking the ruler or if you want to insert a specific character before
the tab, then you can use the Tabs dialog box. Following are the various Tab tools
used for Tab setting and their functions.

Tools Used For Tab Setting Function

A Left Tab stop sets the start position of text that will

then run to the right as you type.

A Center Tab stop sets the position of the middle of the

text. The text centers on this position as you type.

A Right Tab stop sets the right end of the text. As you

type, the text moves to the left.

A Decimal Tab stop aligns numbers around a decimal

point. Independent of the number of digits, the decimal
point will be in the same position. You can align numbers
around a decimal character only and you cannot use
the decimal tab to align numbers around a different
character, such as a hyphen or an ampersand symbol.

A Bar Tab stop does not position text. It inserts a vertical

bar at the tab position.

Check Your Progress

1. List some software that is generally required in an office.

2. What is a ribbon?

3. What is the function of a title bar?

4. What do you mean by document formatting?

5. What is the use of thesaurus?

3.4 TABLES IN MICROSOFT WORD

Tables organize data into rows and columns. They are used for the purpose of
displaying data in a tabular format.
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Create a Table

In Microsoft Word 2007, you can create Tables by following the given steps:

 Point the cursor at the location where you want the new table.

 Click on the Insert tab of the Ribbon.

 Click on the Table button in the Tables group.

 Click on any of the following four ways to add table to your document:

o Create the table by highlighting the grid of the table.

o Click on Insert Table and enter the number of rows and columns.

o Click on Draw Table and manually create your table with as many
numbers of row and column, and format.

o Click on Quick Tables and select any predefined table.

Inserting a Table

MS Word 2007 allows you to insert a table by selecting from a pre-formatted
collection of tables provided by Office Word or by mentioning the exact number
of rows and columns that you need. You can also insert a table into another table
to create a complex table.

1. Using Table Templates
Table templates can also be used to insert a table in your document, which are
pre-formatted tables. Table templates include sample styles of data insertion to
help you visualize the look of the table.

1. Click where you want to insert a table.

2. On the Insert tab, in the Tables group, click Table, point to Quick Tables
and then click the template that you want.

3. Replace the data in the template with the data that you want.

2. Using the Table Menu
Another way to add tables into a Word document is by highlighting the table grid,
i.e., number of rows and columns. But this option has a limit to the number of rows
and columns that can be added, which means the maximum limit is 10×8 table.
Therefore this option can only be used for simple and small tables. Follow the
steps given below to insert a table through table menu:



Text Processing and
Spreadsheet Software

Systems

NOTES

Self - Learning
Material 149

1. Click where you want to insert a table.

2. On the Insert tab, in the Tables group, click Table, and then under Insert
Table, drag to select the number of rows and columns that you want.

Following is the screenshot showing a highlighting table of a 4×4 matrix:

You can also use the Insert Table command to choose the table dimensions and
format before you insert the table into a document.

1. Click where you want to insert a table.

2. On the Insert tab, in the Tables group, click Table, and then click Insert
Table.

3. Under Table size, enter the number of columns and rows.

4. Under AutoFit behavior, choose options to adjust the table size.

Create a Table Manually

In Microsoft Office Word 2007, you can manually create a table by following two
ways:

 By drawing the rows and columns that you want.

 By converting text to a table.
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1. Drawing a Table

MS Word 2007 allows you to draw a complex table, for example, one which
needs to contain cells of different lengths or a varying number of columns or rows
per cell.

 Click where you want to create the table.

 On the Insert tab, in the Tables group, click Table and then click Draw
Table.

After clicking the Draw Table option, the pointer will change into a drawing pencil.

 To define the outer table boundaries, draw a rectangle. Then draw the
column lines and row lines inside the rectangle.

 To insert text in the table, click in a cell and start typing.

2. Converting Text to a Table

Word 2007 allows you to convert text into a table. Add separator characters,
such as commas or tabs, to specify where you want to divide the text into column
and use paragraph marks to specify where you want to divide the text into row.
Follow the steps given below to convert text to a table:

 Select the text you want to convert into table.

 On the Insert tab, in the Tables group, click Table and then click Convert
Text to Table.

 In the Convert Text to Table dialog box, under Separate text at, click
the option for the separator character that you used in the text.

Select any other options that you want.

Selection within Table

Selection within tables is prime operation of Word table because it provides you
to select and perform the desired options, such as finding total marks of a specific
student or merge the headings, etc.
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You can also set the various formatting options for selected table as shown
in the screen.

Insert/Delete Row(s)/Column(s) into Table

To insert rows and columns, you need to select shortcut key in which you are
provided with options, such as Insert Columns to the Left, Insert Columns to
the Right, Insert Rows Above and Insert Rows Below as shown in the following
screen.

After selecting the option, for example Insert Columns to the Right, you will
get extra column in which you can fill the data.
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Applying Borders and Shading in the Table

Borders and shading facilitate you to highlight information in a table. Thus it
enhances the appearance of the text in a table. Word automatically applies a ½
point border and a white background, i.e., no shading to all tables and table cells.
Though, to emphasize definite portions of your table, you can add, remove or
modify table borders or you can add shading to certain cells, rows or columns in
your table. In MS Word 2007, the Ribbon provides quick access to the table
borders and shading features. You can add borders to a table or individual table
cell.

Formatting Data within Table Cells

The Ribbon provides options for changing both the vertical and horizontal alignment
with cells.

 Select the cells you want to format.

 Click the Layout tab under Table Tools on the Ribbon.

 Click on the required button from the Alignment group.

The cell margins allow you to change the gap between the cell contents and
the border of the cell.

 Select the cells you want to format or the entire table.
 Click the Layout tab on the Ribbon.
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 Click the Cell Margins button in the Alignment group.
 The Table Options dialog box appears. Adjust the required margin settings.

Adjust the measurement in the Allow spacing between cells box to change
the spacing between the cells as opposed to within the cell between the content
and its borders. Click OK. Your settings become the default settings for all future
tables.

Table Autoformatting

By selecting certain formatting options, the 2007 Microsoft Office system programs
can automatically format certain kinds of text as you type, such as replacing a
typed hyphen ( - ) with a dash ( – ). Use the AutoFormat As You Type options
to control the automatic formatting that you want. The specific AutoFormat As
You Type options that are available depend on the program that you are using.
The AutoFormat feature, which was a part of Microsoft Office 2003, is not included
in the 2007 Microsoft Office system. There are two ways to use the capabilities of
the AutoFormat feature:

 You can use other features in Microsoft Office Word and Microsoft Office
Outlook. The AutoFormat As You Type Tab includes the most useful
capabilities of the AutoFormat feature.

 In Word, you can add the AutoFormat command to the Quick Access
Toolbar.

Tabular Data Sorting

To sort the data in a table that is based on the contents of a column that includes
more than one word, you must first use characters to separate the data including
data in the header row. For example, if the cells in a column contain both last and
first names, you can use commas to separate the names.

 Select the column that you want to sort.

 Under Table Tools, on the Layout tab, in the Data group, click Sort.

 Under My list has, click Header row or No header row.

 Click Options...

 Under Separate fields at, click the type of character that separates the
words or fields that you want to sort and then click OK.

 Under Sort by, in the Using list, select which word or field you want to
sort by.

 In the first Then by list, enter the column that contains the data that you
want to sort by and then in the Using list, select which word or field you
want to sort by.

 If you want to sort by an additional column, repeat this step in the second
Then by list.

 Click OK.
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Merge/Split Cells

Merging columns and rows are used to prepare the common headings as shown
in the following screen.

Select the columns and also select Merge Cells option. You will get the
following resulted screen in which border of table is not displayed.

Convert Text to Table and Vice Versa

Insert separator characters to convert the text to table or vice versa. These separator
characters you choose to indicate where you want text to separate when you convert
a table to text or where you want new rows or columns to begin when you convert
text to a table, such as commas or tabs to indicate where you want to divide the text
into columns. Use paragraph marks to indicate where you want to begin a new row.
For example, in a list with two words on a line, insert a comma or a tab after the first
word to create a two column table.

 Select the text that you want to convert.

 On the Insert tab, in the Tables group, click Table and then click Convert
Text to Table.
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 In the Convert Text to Table dialog box, under Separate text at, click
the option for the separator character that is in your text:

 In the Number of columns box, check the number of columns.

If you do not see the number of columns that you expect, you may be
missing a separator character in one or more lines of text.

Convert a Table to Text

Following steps are required to convert a table to text.

 Select the rows or table that you want to convert to paragraphs.

 Under Table Tools, on the Layout Tab, in the Data group, click Convert
to Text.

 Under Separate text at, click the option for that you want to use in place
of the column boundaries.

Rows are separated with paragraph marks.

3.5 MACROS

In Microsoft Office Word 2007, you can automate frequently used tasks by creating
macros. A macro is a series of commands and instructions that you group together
as a single command to accomplish a task automatically. Macros are used for the
following reasons:

 To speed up routine editing and formatting.

 To combine multiple commands, for example to insert a table with a specific
size and borders and with a specific number of rows and columns.

 To make an option in a dialog box more accessible.

 To automate a complex series of tasks.

You can use the macro recorder to record a sequence of actions, or you can
create a macro from scratch by entering Visual Basic for Applications or VBA. A
macro language version of Microsoft Visual Basic that is used to program Microsoft
Windows based applications and is included with several Microsoft programs.
Visual Basic Editor supports an environment in which you write new and edit
existing Visual Basic for Applications code and procedures. The Visual Basic Editor
contains a complete debugging toolset for finding syntax, runtime and logic problems
in your code.

 On the Developer tab, in the Code group, click Record Macro. Following
steps are required to change the keyboard shortcut for a macro:

 Begin Recording: To begin recording the macro without assigning it to a
button on the Quick Access Toolbar or to a shortcut key, click OK.

 Create a Button: To assign the macro to a button on the Quick Access
Toolbar, do the following:

o Click on Button.
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o Under Customize Quick Access Toolbar, select the document or all
documents for which you want to add the macro to the Quick Access
Toolbar.

o Under Choose commands from dialog box, click the macro that you
are recording and then click Add.

o To customize the button, click Modify.

o Under Symbol, click the symbol that you want to use for your button.

o In the Display name box, type the macro name that you want to display.

o Click OK twice to begin recording the macro.

Note: To make your macro available in all documents, be sure to click Normal.dotm.

The symbol that you choose is displayed in the Quick Access Toolbar. The name
that you type is displayed when you point to the symbol.

 Assign a Keyboard Shortcut: To assign the macro to a keyboard shortcut,
do the following:

o Click Keyboard.

o In the Commands box, click the macro that you are recording.

o In the Press new shortcut key box, type the key sequence that you
want and then click Assign.

o Click Close to begin recording the macro.

2. Perform the actions that you want to include in the macro.

3. To stop recording your actions, click Stop Recording in the Code group.

Note: When you record a macro, you can use the mouse to click commands and options but
not to select text. You must use the keyboard to select text.

Change the Keyboard Shortcut for a Macro

Following steps are required to change the keyboard shortcut for a macro:

 Click the Microsoft Office Button  and then click Word Options.

 Click Customize.

 Next to Keyboard shortcuts, click Customize.

 In the Categories list, click Macros.

 In the Macros list, click the macro that you want to change.

 In the Press new shortcut key box, type the key combination that you
want to choose.

 Check the Current keys box to make sure that you are not assigning a key
combination that you already use to perform a different task.

 In the Save changes in list, click the option that matches where you want
to run your macro.

 Click Close.

Note: To make your macro available in all the documents, you need to click Normal.dotm.
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To Create and Record a Macro

To create a macro, following steps are required:

 Select View option in menu bar.

 Select ‘Record Macro…’ option to record a macro and do the required
operation as you want to save in recording macro. Type a name for ‘Macro
name:’ bar, for example Macro1 as shown in the screen below.

 Select the macro name and click on Run button as shown in the screen
below. The performed tasks are to be run for selected macro.

To Run a Macro

Following steps are required to run a macro:

 On the Developer tab, in the Code group, click Macros.

 In the list under Macro name, click on the macro name that you want to
run.

 Click Run.
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3.6 LINKING AND EMBEDDING OBJECT

You can insert objects into a Microsoft Word document when you want to include
information from files created in other Microsoft Office programs or in any program
that supports linked objects. An object refers to a table, chart, graphic, equation,
or other form of information. Objects created in one application, for example
spreadsheets, and linked or embedded in another application are Object Linking
and Embedding or OLE objects. Linked object refers to an object that is created
in a source file and inserted into a destination file while maintaining a connection
between the two files. The linked object in the destination file can be updated
when the source file is updated and embedded objects. Once embedded, the
object becomes part of the destination file. Changes you make to the embedded
object are displayed in the destination file.

Difference between Linked Objects and Embedded Objects

The main differences between linked objects and embedded objects are where the
data is stored and how you update the data after you place it in the destination file.

 Linked Objects: When an object is linked, information is updated only if
the source file is modified. Linked data is stored in the source file. The
destination file stores only the location of the source file, and it displays a
representation of the linked data. Use linked objects if file size is a
consideration. Linking is also useful when you want to include information
that is maintained independently, such as data collected by a different
department, and when you need to keep that information up-to-date in a
Word document. When you link to an Excel object, you can use the text
and number formatting from Excel, or you can apply the formats supplied
by Word. If you use the Word formats, you can preserve formatting features
when the data is updated. For example, you can change table layout, font
size and font color without losing those changes once the object in the
source file is updated.

 Embedded Objects: When you embed an object, information in the
destination file does not change if you modify the source file. Embedded
objects become part of the destination file and once inserted are no longer
part of the source file. Because the information is totally contained in one
Word document, embedding is useful when you want to distribute an online
version of your document to people who do not have access to independently
maintained worksheets.

Edit Linked Object

Following steps are required to edit the linked object:

 On the Edit menu, click Links.

 In the Links dialog box, in the list of objects, click the linked object and
then click Open Source. The linked object, an object that is created in a
source file and inserted into a destination file, while maintaining a connection
between the two files. The linked object in the destination file can be updated
when the source file is updated.
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 Make the changes you want to the linked object.

 In the source program, click Exit on the File menu and Save the file. The
source program is used to create a linked object or embedded object. To
edit the object, you must have the source program installed on your computer.

In the above representation, you can see how the OLE object is embedded in
Microsoft Word with the help of Excel source data. If you change source data the
embedded object (in the form of chart) is also changed.

Note: You can preserve formatting changes you make to a Microsoft Excel linked object in
your document by selecting the Preserve formatting after update check box in the Links
dialog box.

Introducing Graphics in Word Document

In MS Word 2007, you can modify objects and including graphics in many ways
to add sparkle to even the most mundane document. You can add drop caps,
group two or more objects into one object and change the layering of overlapping
objects. You can also position graphics anywhere on a page, change text wraps
around an object and modify how objects are aligned relative to each other and to
the page. You can enhance graphic objects with gradient color fills, textures, shadows
and 3-D effects, and by adding a watermark and page border.

MS Word 2007 allows you to insert illustrations and pictures into a
document.  To insert illustrations follow the steps given below:

 Place your cursor in the document where you want the illustration/picture.
 Click the Insert Tab on the Ribbon.

 Click the Clip Art Button.
 The dialog box will open on the screen and you can search for Clip Art.
 Choose the illustration you wish to include.
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To insert a picture following steps are required:
 Place your cursor in the document where you want the illustration/picture.
 Click the Insert tab on the Ribbon.
 Click the Picture button.
 Browse the picture you wish to include.
 Click the Picture.
 Click Insert.

Watermark

Watermark is a translucent image that appears behind the primary text in a
document.  To insert a watermark, following steps are required:

 Click the Page Layout tab in the Ribbon.
 Click the Watermark button in the Page Background Group.
 Click the Watermark you want for the document or click Custom

Watermark and create your own watermark.
 To remove a watermark, follow the steps given above but click Remove

Watermark.
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Insert AutoShapes and Smart Art

MS Word 2007 also permits you to insert SmartArt and AutoShapes into the
document, at the desired location. Following are the steps for the insertion of
illustrations into a document:

SmartArt is a collection of graphics that you can utilize to organize information in
your document. It includes timelines, processes or work flow. The following steps
need to be performed in order to insert SmartArt ino the document:

Move your cursor in the document where you want the illustration/picture to appear.

 Click on the Insert tab in the Ribbon.
 Click on the SmartArt button.
 Click on the SmartArt that you wish to include in your document.
 Click on the arrow on the left side of the graphic to insert text or type the

text in the graphic.

Formatting Graphic Objects using Drawing Toolbar

Following steps are required to format graphic objects using Drawing Toolbar:

 Click on the Insert menu found in the top right portion of the screen.

 Select Picture from the drop-down menu.

 Choose the AutoShapes option.

Once you have completed these steps, the Drawing Toolbar will stay located
under your drop-down menus.

Once you insert an object into the screen, you can format objects as shown
in the screen below.

Check Your Progress

6. What do you understand by Web layout view?

7. What is the use of indention?

8. Why borders and shading are used in documents?

9. List two uses of macros.
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3.7 MICROSOFT EXCEL 2007

Microsoft Excel 2007 is the newest version of spreadsheet software in the Microsoft
2007 Office Suite. This spreadsheet application is specifically developed by
Microsoft for Microsoft Windows and Mac OS X. Technically speaking, MS
Excel 2007 files are referred as spreadsheets. This is a generic term, which
sometimes means a workbook (file) and sometimes means a worksheet (a page
within the file). Data files created with MS Excel 2007 are called workbooks. MS
Excel 2007 files by default contain three blank worksheets. This gives you the
flexibility to store related data in different locations within the same file. More
worksheets can be added and unwanted worksheets can be deleted as per the
user requirement. Thus, MS Excel 2007 is a powerful and most extensively used
tool as spreadsheet application which allows you to store, organize and analyse
numerical, graphic and text data. Spreadsheets allow information to be organized
in rows and tables, and can be analysed using various mathematical, trigonometric,
text, logical, date and time functions. The number of rows is now 1,048,576 (220)
and columns is 16,384 (214). Microsoft Excel 2007 has the basic features of all
spreadsheets, using a grid of cells arranged in numbered rows and letter named
columns to organize data manipulations. Further with Microsoft Excel 2007 you
can analyse, manage and share information quickly and easily to formulate more
knowledgeable decisions. With the new user interface, rich data visualization and
PivotTable views, professional looking charts can be created easily.

The advanced features in Microsoft Excel 2007 include Office themes, more
styles, rich conditional formatting, easy formula writing, Sort & Filter, data validation,
worksheet and workbook protection, Goal Seek, Scenario, PivotTable and
PivotChart. Goal Seek and Scenario are part of What-If Analysis tools. MS Excel
2007 supports charts, graphs or histograms generated from specified groups of
cells. The generated graphic component can either be embedded within the current
sheet or added as a separate object. OLE or Object Linking and Embedding
allow a Windows application to format or calculate data. This may acquire the
form of ‘embedding’ where an application uses another to handle the task, for
example a MS PowerPoint presentation can be embedded in an MS Excel 2007
spreadsheet or vice versa.

You can create a spreadsheet using various formatting and editing features
given in the Ribbon panel. Thus, you can perform calculations using the functions
given in MS Excel 2007 and can sort and filter data as per your requirement. You
can create graphs in the worksheet, insert illustrations, Clip Art, SmartArt, Shapes
and pictures to enhance your worksheet. You can freeze and unfreeze rows and
columns and can also hide and unhide any worksheet.

Worksheet, Workbook and Workspace

A Microsoft Excel 2007 file in which you can enter and store related data is
known as a workbook. A workbook is also identified as a spreadsheet that is a
group of cells on a single sheet where you in fact keep and operate data. Every
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worksheet consists of columns and rows. The columns are lettered A to Z and
then continue with AA, AB, AC, and so on. The rows are numbered from1 to
1,048,576. The number of rows and columns that you can hold in your worksheet
is restricted by computer memory and your system resource.

Cell address is the combination of a column letter and a row number. For
example, if a cell is located in the upper left corner of the worksheet, which is A1,
this means that it is located in column A and row 1. Similarly, cell E10 is situated in
column E on row 10. The data can be entered into the cells present on the worksheet.
N-number of worksheets can be present in a workbook. To work with workspace
you have to perform the following steps:

 Click the Office button. Click Open.

 Click the Files of type: list arrow. Click Workspace.

 Select the workspace file. Click Open.
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Getting Started

As soon as you start MS Excel 2007, you will see that its features are similar to
the previous versions. You will also see that there are many additional features
which help you to work with special effects. Three new features that are included
in MS Excel 2007 are the Microsoft Office Button, the Quick Access Toolbar
and the Ribbon.

Microsoft Office Button

The Microsoft Office Button performs various functions that were found in the
File menu of older versions of MS Excel 2007. This button permits you to create
a new workbook, open an existing workbook, save a workbook using Save and
Save As, Print, Send or Close a workbook.

Ribbon

The Ribbon is the panel at the top portion of the spreadsheet. It includes seven
tabs namely, Home, Insert, Page Layout, Formulas, Data, Review and View.
Add-ins is another option which is automatically displayed on the Ribbon when
you add any new application to the program. Each tab is a collection of features
designed to perform specific functions that you require while creating or editing
MS Excel 2007 spreadsheets.

The frequently used features are displayed on the Ribbon. To view additional
features of each group, click on the arrow at the bottom right corner of each
group.
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 Home:  Clipboard, Fonts, Alignment, Number, Styles, Cells, Editing.
 Insert: Tables, Illustrations, Charts, Links, Text.
 Page Layouts: Themes, Page Setup, Scale to Fit, Sheet Options, Arrange.
 Formulas: Function Library, Defined Names, Formula Auditing,

Calculation.
 Data:  Get External Data, Connections, Sort & Filter, Data Tools, Outline.
 Review:  Proofing, Comments, Changes.
 View: Workbook Views, Show/Hide, Zoom, Window, Macros.

Quick Access Toolbar

The Quick Access Toolbar can be customized as per the user need and contains
commands that you use most frequently. You can place the Quick Access Toolbar
above or below the Ribbon. To change the location of the Quick Access Toolbar,
click on the arrow at the end of the toolbar and click Show Below the Ribbon.

You can also add more items to the Quick Access toolbar. To do this, right
click on any item in the Office Button or the Ribbon and then click on Add to
Quick Access Toolbar. A shortcut will be added there.

Mini Toolbar

Mini Toolbar is a new feature in Microsoft Office 2007. This is a floating toolbar
and is displayed when you select text or right click any text. It displays the common
formatting tools, such as Bold, Italic, Fonts, Font Size and Font Color.
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MS Excel 2007 Options

MS Excel 2007 provides a wide range of customizable options that help you to
create an MS Excel 2007 workbook of required specifications. To access these
customizable options, follow the given steps:

 Click on the Office Button.

 Click on MS Excel 2007 Options which you will get from Quick Access
Toolbar.

Popular

The Popular features helps you to personalize your work environment using the
Mini Toolbar, Color schemes, default options when creating new workbooks and
creating lists for sort and fill sequences. It also helps you to access the Live Preview
feature to preview how a feature affects the document as you hover over different
choices. The choices provide new font size, table style or cell style which can be
applied on a workbook as per requirement.
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Formulas

The Formulas feature permits you to modify the calculation options, to work with
formulas, error checking and error checking rules. Working with formulas provide
four check boxes which are R1C1 reference style, Formula AutoComplete, Use
table names in formulas and Use GetPivotData functions for PivotTable references
as shown in the given screen.

Proofing

The Proofing feature permits you to personalize the options for correcting words
and formats of your text. You will get AutoCorrect option in Proofing feature. You
can customize auto correction settings so that it will ignore certain words or errors
in a document via the Custom Dictionaries...

Save

The Save feature permits you to personalize your workbook when saved. You
can also specify how often you want auto save to run and where to save the
workbooks.
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Advanced

The Advanced feature permits you to specify the options for editing, copying,
pasting, printing as well as displaying formulas, calculations and other general
settings.

Customize

Customize permits you to add specific features to the Quick Access Toolbar. It
adds the tools which you frequently use.
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Opening MS Excel 2007 Application

To open MS Excel 2007 application, following steps are required:

 Click the Office Button, then press right to select Customize Quick Access
Toolbar which provides MS Excel 2007 Options tab.

 Click the Advanced category and scroll down up to the General section.

 In the box for ‘At startup, open all files in’, you might see the name of a
folder and its path. Clear the folder information from that box or go to that
folder and remove the unwanted files. Click OK to close the MS Excel
2007 Options dialog box.

Entering Information in a Worksheet

To enter information in a worksheet, you need to open an empty workbook and
enter the data as shown in the screen, below:

Moving Around Worksheet and Workbook

The arrow keys give you the option to move around your worksheet. With the
help of down arrow key you can move downward one cell at a time. Similarly, the
up arrow key can be used to move upward one cell at a time. You can even move
across the page to the right, one cell at a time by using the Tab key. By holding
hold the SHIFT key and then pressing the Tab key, you can move to the left, one
cell at a time. You even have the right and left arrow keys available by which you
can also move right and left respectively, one cell at a time. The Page Up (Pg Up)
and Page Down (Pg Dn) keys move up and down one page at a time. By pressing
down the CTRL key and simultaneously pressing the Home key, you can move to
the beginning of the worksheet.
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It is convenient to either move or copy the whole worksheet. The term
worksheet refers to the main document that you use in MS Excel 2007 to store
and work with data. There might be a chance that calculations or charts that are
based on worksheet data might turn out to be inaccurate if you shift the worksheet.
You can move or copy worksheet by inserting between sheets that are referred by
a 3-D reference. This reference refers to a range that spans two or more worksheets
in a workbook. Data on that worksheet might be unexpectedly included in the
calculation. Select the worksheets that you want to move or copy as shown in the
screen below.

To move to the next or previous sheet tab, you can also press CTRL + Pg
Up or CTRL + Pg Dn. On the Home tab, in the Cells group, click Format and
then under Organize Sheets, click Move or Copy Sheet.

You can also right click a selected sheet tab and then click Move or Copy. In the
Move or Copy dialog box, in the Before sheet list, do one of the following:

 Click the sheet before which you want to insert the moved or copied
sheets.

 Click move to end to insert the moved or copied sheets after the last
sheet in the workbook and before the Insert Worksheet tab.

To copy the sheets instead of moving them, in the Move or Copy dialog
box, select the Create a copy check box.

Saving a Workbook

To save a workbook, you have two options, Save and Save As. To save a
document, follow the given steps:

 Click on the Microsoft Office Button.

 Click on Save.
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You can also use the Save As feature to save the workbook with a different
name or to save it as earlier versions of MS Excel 2007. The older versions of
MS Excel 2007 cannot be opened in an MS Excel 2007 worksheet unless you
save it as an MS Excel 97-2003 Format. To use the Save As feature, follow the
given steps:

 Click on the Microsoft Office button.
 Click on Save As.
 Give a name for the workbook.
 In the Save as Type box, select Excel 97-2003 workbook.

Closing a Workbook File

To close a workbook file, you need to press CTRL+F4 key combination. You
can close all open workbooks wihout closing MS Excel 2007. For this, you need
to open file menu and select Close All option.

Opening an Existing Workbook File

To open an existing workbook, follow the given steps:

 Click on the Microsoft Office button.
 Click on Open.
 Browse to the workbook.
 Click on the title of the workbook.
 Click on Open.

Quitting From MS Excel 2007

To quit from MS Excel 2007, click on Microsoft Office Button and then select
Exit MS Excel 2007 button.
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You will quit from MS Excel 2007.

 

Check Your Progress

10. What is a spreadsheet?

11. What does advanced feature permit in MS Excel 2007?

12. How will you edit a worksheet in Microsoft Excel 2007?

13. What does a cell address identifies in MS Excel 2007?

3.8 CREATING AND EDITING WORKSHEET

You can create a new worksheet and can edit any existing worksheet as per your
requirements.  To create a worksheet, follow the given steps:

 Click on the Office Button and select New option. It will open the New
Workbook dialog box as shown below. From the Templates group select
‘Blank and recent’ option.

 Now click on ‘Blank Workbook’ and select Create button. A new blank
spreadsheet will be displayed on the screen. Give a name to this worksheet
and save the file with ‘.xlsx’ file name extension.

You can edit a worksheet if any incorrect information has been entered into a cell.
To do so, click on the cell and enter the correct information. Typing replaces
whatever is in the cell. Editing a spreadsheet includes copy, cut, paste, move,
changing column width/row height, cell alignment and formatting, font and number
formatting, inserting and deleting cell(s)/row(s)/column(s), insert/copy/move/
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rename/delete a worksheet.

Copy and Paste

To copy and paste data, follow the given steps:

 Select the cell(s) that you want to copy.
 On the Clipboard group of the Home tab, click on Copy.
 Select the cell(s) where you want to copy the data.
 On the Clipboard group of the Home tab, click on Paste.

Cut and Paste

To cut and paste data, follow the given steps:

 Select the cell(s) that you want to copy.
 On the Clipboard group of the Home tab, click on Cut.
 Select the cell(s) where you want to copy the data.
 On the Clipboard group of the Home tab, click on Paste.

Undo and Redo

To undo or redo the most recent actions, click on Undo or Redo on the Quick
Access Toolbar.

Changing Column Width/Row Height

In MS Excel 2007, you have the option to modify any column width or row height
in your worksheets so that the readability and look of the data can be changed.
For example, if your worksheet contains large numbers, you can enlarge the columns
to make the worksheet less cluttered. It is much more advisable to expand the
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width of the columns that contain cells with truncated text entries or numbers that
MS Excel 2007 shows as ######.

To change the width of a column or the height of a row, follow the given steps:

 Click on the Format button on the Cells group of the Home tab.
 Manually adjust the height and width by clicking on Row Height or Column

Width.
 To use AutoFit, click on AutoFit Row Height or AutoFit Column Width.

Cell Formatting—Font, Alignment and Number

Convert Text to Columns: Sometimes, you may have to split data of one cell
and place them in two or more cells. You can do this by utilizing the Convert Text
to Columns Wizard.

 Highlight the column in which you wish to split the data.
 Click on the Text to Columns button on the Data tab.

 Click on Delimited radio button if you have a comma or tab separating
the data or click fixed widths to set the data separation at a specific size.
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Modify Fonts: Modifying fonts in MS Excel 2007 helps you to emphasize titles
and headings. To modify a font, follow the given steps:

 Select the cell or cells where you want to apply the font.
 On the Font group on the Home tab, select the font type, size, bold,

italics, underline or color.

Format Cells Dialog Box: In MS Excel 2007, you can apply specific
formatting to any cell. To apply formatting to a cell or group of cells, follow the
given steps:

 Select the cell or cells to change the formatting.
 Click on the Dialog Box arrow on the Alignment group of the Home

tab.

There are various tabs on this dialog box that permit you to modify the properties
of the cell or cells. 

 Number:  Allows the display of different number types and decimal places.
 Alignment:  Allows the horizontal and vertical alignment of text, wrap

text, shrink text, merge cells and the direction of the text.
 Font:  Allows control of font, font style, size, color and additional features.
 Border:  Changes border styles and colors.
 Fill:  Fill colors and styles.
 Protection: Locking cells and hiding formulas.
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Adding Borders and Colors to Cells

Borders and colors can be added to cells manually or using the styles. To add
borders manually, follow the given steps:

 Click on the Borders drop-down menu on the Font group of the Home
tab.

 Select the suitable border.

To apply colors manually, follow the given steps:
 Click on the Fill drop-down menu on the Font group of the Home tab.
 Select the proper color.

For applying borders and colors using styles, follow the given steps:
 Click on Cell Styles on the Home tab.
 Select a style or click on New Cell Style.
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Hide or Unhide Rows or Columns: To hide or unhide rows or columns, follow
the given steps:

 Select the row or column you want to hide or unhide.
 Click on the Format button on the Cells group of the Home tab.
 Click on Hide & Unhide.

Inserting and Deleting Cell(s)/Row(s), Column(s)

Inserting Cells, Rows and Columns

To insert cells, rows and columns in MS Excel 2007, follow the given steps:

 Place the cursor in the row below where you want the new row or in the
column to the left of where you want to have the new column.

 Click on the Insert button on the Cells group of the Home tab.

 Click on the proper option Cell, Row or Column.

Delete Cells, Rows and Columns

To delete cells, rows and columns, follow the given steps:

 Place the cursor in the cell, row or column that you want to delete.

 Click on the Delete button on the Cells group of the Home tab.

 Click on the appropriate option  Cell, Row or Column.
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Insert/Copy/Move/Rename/Delete Worksheet

To insert a new worksheet, do any one of the following steps:

 To quickly insert a new worksheet at the end of the existing worksheets,
click the Insert Worksheet tab at the bottom of the screen.

 To insert a new worksheet in front of an existing worksheet, select that
worksheet and then, on the Home tab, in the Cells group, click Insert and
then click Insert Sheet.

 

You can also right click the tab of an existing worksheet and then click
Insert. On the General tab, click Worksheet, and then click OK.

Insert Multiple Worksheets at the Same Time

Hold down SHIFT and then select the same number of existing sheet tabs of the
worksheets that you want to insert in the open workbook. For example, if you
want to add three new worksheets, select three sheet tabs of existing worksheets.
On the Home tab, in the Cells group, click Insert, and then click Insert Sheet.

You can also right click the selected spreadsheet tabs and then click Insert.
On the General tab, click Worksheet and then click OK.

To move to the next or previous sheet tab, press CTRL+Pg Up or
CTRL+Pg Dn. On the Home tab, in the Cells group, click Format and then
under Organize Sheets, click Move or Copy Sheet.

You can also right click a selected sheet tab and then click Move or Copy. In the
Move or Copy dialog box, in the Before sheet list, do one of the following:

 Click the sheet before which you want to insert the moved or copied sheets.

 Click move to end to insert the moved or copied sheets after the last sheet
in the workbook and before the Insert Worksheet tab.

To copy the sheets instead of moving them in the Move or Copy dialog box,
select the Create a copy check box. When you create a copy of the worksheet,
the worksheet is duplicated in the workbook and the sheet name indicates that it is
a copy, for example the first copy that you make of Sheet1 is named Sheet1 (2).

 

To rename the active sheet, one of the following steps can be performed:

 On the Format menu, point to Sheet and then click Rename.
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 On the Sheet tab bar, right click the tab you want to rename and then click
Rename.

Type the new name over the current name.

To delete a worksheet, follow the given steps:
 Open the workbook.
 Click on the Delete button on the Cells group of the Home tab.
 Click on Delete Sheet.

3.8.1 Selection in a Worksheet

To select contiguous columns in the worksheet, do the following task:
 Click to select the first column heading in the desired range and then drag

the pointer to the last column in the desired range. Release the mouse button
to select the columns.

 You can also click to select the first column heading in the desired range.
Scroll the worksheet using the scroll bars at the bottom of the worksheet as
needed to display the last column in the desired range.

 Hold down the SHIFT key and click on the last column heading.

To select the entire worksheet, you need to select the first column heading
and then drag the pointer across all remaining column headings in the worksheet.

 Click to select the first column heading, scroll the worksheet until the last
column is visible.

 Press the SHIFT key and click on the last column heading.

Cell Selection

To select a cell or data to be copied or cut, follow the given steps:

 Click on the cell.

 Click and drag the cursor to select many cells in a range.

Selecting Data Range

Once you have entered your data in Microsoft Office MS Excel 2007, you should
be aware of how to select cells in a worksheet. The cell cursor is made up of black
border that surrounds the active cell and is called the current cell in a worksheet.
In MS Excel 2007, following steps are required to select multiple cells in a
worksheet:
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 To select a single entire column, click a column heading, i.e., the letter or
letters that indicate the column. To select multiple columns, drag across
multiple column headings.

 To select a single entire row, click the row number. To select multiple rows,
drag across multiple row numbers.

 To select sequential cells, click the first cell, hold down the SHIFT key and
click the last cell you want. Optionally, click and drag the mouse over a
group of cells to select a sequential area.

 To select non-sequential cells, click the first cell, hold down the CTRL key
and click each additional cell or row or column you want to select.

Row(s)/Column(s) Selection

To select a row or column, click on the row or column header.

Entire Worksheet Selection

To select the entire worksheet, click the small box located to the left of column A
and above row 1. You can select all cells in a worksheet by pressing CTRL+A
key combination

3.8.2 Formulas and Functions

Formulas, also called functions, are a powerful feature of MS Excel 2007. Formulas
available in MS Excel 2007 are grouped into the following categories:

 Financial: Formulas for calculating depreciation, interest, return on an
investment, loan, payment and mortgage.

 Logical: The logical operators of And, True, False, If, Not and Or.

 Text: Formulas for combining text from various cells with the concatenate
formula, converting text to upper case, lower case or proper case and
trimming extra spaces from text.
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 Date & Time: Formulas for calculating the number of days between two
dates, the current date and day of the week for a given date.

 Lookup & Reference: Formulas for horizontal or vertical lookup, a
hyperlink or getting data from a Pivot Table.

 Math & Trig: Formulas for calculating trigonometric functions, logs, random
numbers, Roman numerals, rounding and truncating.

 Statistical: Formulas for calculating averages, frequency, percentile, quartile
and standard deviation.

 Engineering: Formulas for Bessel functions and conversions between
numbering systems, such as octal to binary.

 Cube: Formulas for working with three dimensional sets.

 Information: Includes formulas which return a true or a false response in
determining if a cell is blank or if the content of the cell is a number or text.

Cell Address

In MS Excel 2007 spreadsheet, the purpose of the cell address is to identify the
position of the cell. The cell address is formed by the combination of column letter
and row number of a cell, such as C4 or D8. Therefore, the column letter followed
by the row number can identify a cell number. Active cell can also be known as
current cell. The active cell is covered with a black border and data can be entered
only in the active cell. In MS Excel 2007, the cell location of cell or group of cells
is indicated by a cell reference. A cell reference consists of a column letter and row
number that intersects at the cell’s location. The cell reference of any active cell is
displayed by the Name Box. Cell references are used in formulas, functions, charts
and other MS Excel 2007 commands.

Operators: Arithmetic, Logical, Relational, String and Reference

Operators specify the type of calculation that you want to perform on the elements of
a formula. There is a default order in which calculations occur, but you can change this
order by using parentheses. There are four different types of calculation operators
which are named as arithmetic, comparison, text concatenation and reference. To
perform basic mathematical operations, such as addition, subtraction or multiplication
and to combine numbers and to produce numeric results, use the arithmetic operators
summarized as follows:

Arithmetic Operator Example

+ (plus sign) Addition (3+3)
– (minus sign) Subtraction (3–1)Negation (–1)
* (asterisk) Multiplication (3*3)
/ (forward slash) Division (3/3)
% (percent sign) Percent (20%)
^ (caret) Exponentiation (3^2)

You can compare two values using the following operators. When two values are
compared by using these operators, the result is a logical value either TRUE or
FALSE as follows:
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Relational Operator Example

= (equal sign) Equal to (A1=B1)
> (greater than sign) Greater than (A1>B1)
< (less than sign) Less than (A1<B1)
>= (greater than or equal to sign) Greater than or equal to (A1>=B1)
<= (less than or equal to sign) Less than or equal to (A1<=B1)
<> (not equal to sign) Not equal to (A1<>B1)

Use the string operator ampersand (&) to join or concatenate, one or more
text strings to produce a single piece of text. The features of string operator is
summarized as follows:

String Operator Example

& (ampersand) It concatenates two values to produce one
continuous text value, such as ‘Information’ &
‘Technology’ produces the result as Information
Technology.

Reference operators are used to combine ranges of cells for calculations. The
following operators are the features of reference:

Reference Operator Example

: (colon) Range operator which produces one reference to all the
cells between two references including the two references
(B5:B15).

, (comma) Union operator which combines multiple references into
one reference (SUM(B5:B15,D5:D15)).

(space) Intersection operator which produces on reference to cells
common to the two references (B7:D7 C6:C8).

Operator Precedence

In Microsoft MS Excel 2007, you can combine several operators in a single formula
to perform the operations in the order shown in the following table. If a formula
contains operators with the same precedence, for example, if a formula contains
both a multiplication and division operator then MS Excel 2007 evaluates the
operators from left to right.

Operator Description 
: (colon)  

(single space) 

, (comma) 

Reference operators 

– Negation (as in –1) 
% Percent 
^ Exponentiation 
* and / Multiplication and Division 
+ and – Addition and Subtraction 
& Connects two strings of text (concatenation) 
= 
< > 
<= 
>= 
<> 

Comparison 
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Use of Parentheses

To change the order of evaluation, enclose in parentheses the part of the formula
to be calculated first. For example, the following formula produces 11 because
MS Excel 2007 calculates multiplication before addition. The formula multiplies 2
by 3 and then adds 5 to the result.

=5+2*3

On the contrary, you can use parentheses to change the syntax as =(5+2)*3.
Now the order of evaluation is changed and MS Excel 2007 will first add 5 and 2
and then multiplies the result by 3 to produce 21. In the example below, the cell
addresses are used instead of numbers. The parentheses around the first part of
the formula force MS Excel 2007 to calculate B4+25 first and then divide the
result by the sum of the values in cells D5, E5 and F5.

=(B4+25)/SUM(D5:F5)

Writing Simple Formulas

A formula is referred as an equation which performs operations on a worksheet
data. In MS Excel 2007, the use of formulas is to basically perform mathematical
operations, namely, addition, subtraction and multiplication. They also have the
ability to compare the worksheet values, taking out the average of a student's test
result, join text, etc. Formulas can refer to other cells on the same worksheet, cells
on other worksheets in the same workbook or cells on worksheets in other
workbooks. The MS Excel 2007 can automatically recalculate the answer in case
you change the data in your spreadsheet, without even re-entering or changing the
formula.

A basic formula format starts with an equals sign (=) which is followed by
one or more operands, which are separated by one or more operators. Operands
can be values, text, cell references, ranges, defined names or function names. The
various symbols that represent the arithmetic and comparison operations are known
as operands.

To enter a formula, follows the given steps:

 Place the cursor in the cell where the formula will appear, i.e., E5.

 Enter an = sign. All MS Excel 2007 formulas start with the equal sign.

 Enter the expression that will produce the result you want. This can consist
of operands, values, variables, and symbols which represent mathematical
procedures, such as + or – to add and subtract respectively, for example
A5+C5.

 When the formula is complete press ENTER key. The result of the formula
will be calculated and displayed in the cell E5.

 You can see the formula in the Formula bar at the top of the screen by
placing the cell pointer on the cell E5.
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If there is an error in a formula, an error message is displayed which will
begin with a # sign.

MS Excel 2007 Formula Error Messages

Sometimes the formulas are not written correctly. It happens unknowingly while
writing formulas. The following are some common error messages:

Error Meaning 

##### The contents of the cell cannot be displayed 
correctly as the cell column is too narrow. 

#REF! Indicates that a cell reference is invalid. This 
message is displayed when you delete cells 
which involved a formula. 

#NAME? MS Excel 2007 cannot recognize text 
contained within a formula. 

 

Copying Formula

One of the big advantages of a spreadsheet is to copy a formula or a text as often
as you need. It is easier and faster to copy a formula than to rewrite it every time
you need it. When you copy a formula by copying and pasting it you must be
aware of cell references, whether they are absolute or relative. When you move a
formula, the cell references within the formula do not change no matter what type
of cell reference that you use. When you copy a formula, the cell references may
change based on the type of cell reference that you use.

Select the cell that contains the formula that you want to copy. On the Home tab,
in the Clipboard group, click Copy. Do one of the following steps:

 To paste the formula and any formatting, on the Home tab, in the Clipboard
group, click Paste.

 To paste the formula only, on the Home tab, in the Clipboard group, click
Paste, click Paste Special and then click Formulas.

You can paste only the formula results. On the Home tab, in the Clipboard group,
click Paste, click Paste Special and then click Values. Verify that the cell
references in the formula produce the result that you want. If necessary, switch the
type of reference by doing the following:

 Select the cell that contains the formula.
 In the formula bar, you can enter or edit values or formulas in cells. It

displays the constant value or formula stored in the active cell, select the
reference that you want to change.

 Press F4 to switch between the combinations.

Cell Referencing

As already discussed, each box on the MS Excel 2007 screen is a cell and each
cell can be located in a spreadsheet by means of its reference termed as cell
reference. Cell on other worksheets in the same workbook and to other workbook
can also be referred by cell references. References to cells in other workbooks
are called links or external references. When cell references are used in formulas,
MS Excel 2007 will calculate the answer using the data located in the referenced
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cells. If that data should later change, MS Excel 2007 will automatically recalculate
the formula and update the answer.

Calling the cells by just their column and row labels, such as ‘A1’ is called
relative referencing. When a formula contains relative referencing you copy it
from one cell to another, MS Excel 2007 will not create an exact copy of the
formula. It will only change the cell addresses relative to the row and column to
which it is moved. For example, for a simple addition the formula in cell D1
=(A1+B1) will be copied to cell D2 as =(A2+B2). It will reflect the new row. This
is called absolute referencing and is accomplished by placing dollar signs ‘$’
within the cell addresses in the formula. Now, the formula in cell D1 will look like
=($A$1+$B$1). Mixed referencing can also be used when only the row and
column is to be fixed. For example, in the formula =(A$1+$B2) the row of cell A1
is fixed and the column of cell B2 is fixed.

Relative Referencing, Absolute Referencing and Mixed Referencing

A reference is a connection to something, that is to say when you type in the
formula =SUM (A1;B1) you refer to the sum of the content of A1 and the content
of B1. The various types of references are discussed below:

Relative Reference: Reference to rows and columns changes when we
copy the formula in another cell. The formula adapts to its environment because
references relate to the distance between the formula and the cells that form the
formula. This is the option MS Excel 2007 offers by default. Consider the following
example:

1

2

3

A

15

= A1 + 2

B

20

30

If we copy cell A2 in B3, because you can move one column to the right
and one row down, the formula will change to: =B2+2. What varies is the reference
to the cell A1 because you have copied the formula in a cell that is in the column to
the right, the name of the column will change from A to B and because we have
gone one row down, 1 will become 2, the result will be =B2+2. This maintains the
formula that adds two to the content of the cell above.

Absolute Reference: References to rows and columns do not change
when you copy the formula to another cell, the formula’s reference to cells are
fixed.

1

2

3

A

15

= $A$1 + 2

B

20

30

If you copy now the cell A2 in B3 even though you have copied it one
column to the right and one row down, the formula will not change. The sign $
before the column and the row indicates that. So, B3 will show =$A$1+2.



Text Processing and
Spreadsheet Software
Systems

NOTES

Self - Learning
186 Material

An important difference in MS Excel 2007 spreadsheets is between absolute
cell references and relative cell references. Open the MS Excel 2007 Spreadsheet
as follows:

In cell B2, you need the following formula:

= A1 + A2

 Click inside cell B2 to highlight it.
 Click on cell B2 with your right mouse button, and select Copy from the

menu that appears.
 Now click into cell B3.
 Again, right click the cell to get the menu. But this time click Paste option.

Your spreadsheet should now look in the following way:

With cell B3 still highlighted, look at the formula bar at the top of MS Excel
2007. You should see this formula:

= A2 + A3

Click into B2 and the formula as follows:

= A1 + A2

The problem is due to cell referencing. When you clicked Copy from the
menu, MS Excel 2007 does not only copy the formula. It took at look at where
the cells were in the formula, relative to the B2 cell and copied this as well. From
B2, the first cell reference (A1) is up one row, and left 1 column (the arrow in
screen).

The second cell reference (A2) is one column to the left of cell B2.

When you clicked into cell B3 and selected Paste from the menu, MS
Excel 2007 was not only pasting the formula, it was pasting this ‘up 1, left 1’.
Start working at cell B3. The first cell reference appears as shown in the screen:
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The second cell reference appears as shown in the screen.

Thus, the first arrow is pointing to cell A2 and the second arrow is point to
cell A3. This is what has been copied. MS Excel 2007 used the following formula
to perform this:

= A2 + A3

But, it will be appeared as follows:

= A1 + A2

If you want the correct answer in cell B3, then you have stop MS Excel
2007 from using this relative cell referencing that it is currently doing.

Absolute cell referencing is placing a dollar symbol ( $ ) before each letter
and number. Click inside of cell B2 on your spreadsheet and change the formula
as follows:

= $A$1 + $A$2

Now copy and paste it over to cell B3 again. You will get the correct answer
by doing so.

MS Excel 2007 will use absolute formula in its calculation.
 If you need to copy and paste formulas use absolute cell references.
 Absolute referencing means typing a dollar symbol before the numbers

and letters of each cell reference. You can mix absolute and relative cell
references also.

Mixed Reference: This is a combination of both references. You may have
relative references for the rows and absolute for the columns or vice versa. Consider
the example given below:

1

2

3

A

15

= $A1 + 2

B

20

30



Text Processing and
Spreadsheet Software
Systems

NOTES

Self - Learning
188 Material

If you copy the cell A2 in B3, the sign $ before the column will mean that the
formula will not change although you move to the right. But not having the sign
before the row when you copy the formula one row down it will change to 2
instead of 1 and the result will be =$A2+2. See the example given below:

1

2

3

A

15

= $1 + 2A

B

20

30

Using Functions in Formulas

A function computes the values provided and shows you the desired results, for
example, a simple function SUM() automatically adds up all the values provided
either in a range or as individual values. Some functions can even check values
and take actions based on what they find. For example, by using IF() function,
you can check whether the current value in a particular cell is greater or less than
100 and based upon the answer it gets, you can ask the function to multiply or
divide this value by a different amount. Some functions can convert numbers or
text to another measure or format, for example, the function LOWER() converts
the text entry in another cell into lower case.

Typically, a function consists of two parts—function name and arguments.
Arguments (or values) may in some cases be mandatory and in some cases optional.
Even within a function, one of the arguments may be mandatory and another optional.

A function is a built-in formula in MS Excel 2007.  A function has a name
and arguments (the mathematical function) in parentheses.  The following is a list
of common functions used in MS Excel 2007.

 Sum():  Adds all cells in the argument.
 Average():  Calculates the average of the cells in the argument.
 Min():  Finds the minimum value.
 Max():  Finds the maximum value.
 Count():  Finds the number of cells that contain a numerical value within a

range of the argument.

To calculate a function, follow the given steps:
 Click the cell where you want to apply the function.
 Click the Insert Function button from Formulas tab.
 Choose the function.
 Click OK.

 Write the address of first cell in the range that you want to calculate in the
Number 1 text box.

 Write the address of last cell in the range that you want to calculate in the
Number 2 text box.
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 Click OK.

Mathematical Functions

In MS Excel’s 2007 mathematical functions can be used to perform common
mathematical operations, such as addition (SUM() function), multiplication (product
function) and rounding numbers (ROUND() function). Other mathematical functions
are discussed as follows:

SQRT()

In MS Excel 2007, the SQRT() function returns the square root of a given number.
The syntax for the SQRT() function is as follows:

=SQRT(Number)

In the above statement, number is a positive number that you wish to return the
square root for. If a negative number is entered in the number parameter, the
SQRT() function will return the #NUM! error.

ROUND()

The ROUND() function in MS Excel 2007 can be used when rounding integers
and decimal numbers to make them easier to work within your spreadsheets. The
syntax for the ROUND() function is as follows:

=ROUND( Number, Num_digits )

SUM()

The SUM() function in MS Excel 2007 provides a quick way to add numbers
together in an MS Excel 2007. The syntax for the SUM() function is as follows:

=SUM (Number1, Number2, ..., Number255)

Up to 255 numbers can be entered into the function.

FACT()

In MS Excel 2007, the FACT() function returns the factorial of a given number.
The syntax for the FACT() function is as follows:

=FACT() (Number)

In the above statement, number is a numeric value.
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INT()

The INT() function is used to round a number downwards towards the next lowest
number. INT() is similar to the ROUNDDOWN() function except that it always
rounds a number down to the nearest whole number completely removing the
decimal portion. The ROUNDDOWN() function will round a number down to a
desired number of decimal places. The syntax for the INT function is as follows:

= INT ( Number)

In the above statement, Number is the value to be rounded.

MOD()

The MOD() function can be used to divide numbers in MS Excel 2007. Unlike
regular division, however, the MOD() function only gives you the remainder as an
answer. The syntax for the MOD() function is as follows:

= MOD() (Number, Divisor)

PI()

In MS Excel 2007, the PI() function returns the mathematical constant which is
equal to 3.14159265358979. The syntax for the PI() function is as follows:

=PI( )

POWER()

Although you can use the caret (^) operator to build a formula that raises a number
to any power, the POWER() function() accomplishes the same thing. For example,
to build a formula that raises 5.9 to the third power, i.e., cubes the number you can
use the exponentiation operator as follows:

=5.9^3

You can have MS Excel 2007 perform the same calculation with the POWER()
function by entering this formula:

=POWER(5.9,3)

In either case, MS Excel 2007 returns the same result as 205.379.

PRODUCT()

The PRODUCT() function provides a quick way to multiple numbers in a MS
Excel 2007. The advantage of using this function becomes apparent if you have
several numbers to multiply together. It is easier than building a long formula. The
syntax for the PRODUCT() function is as follows:

=PRODUCT( Number1, Number2, ... Number255 )

In the above statement, up to 255 numbers can be entered into the function.

Date Functions

There are a number of date functions available in MS Excel 2007. Depending on
your needs, you can use a date function in MS Excel 2007 to return the current
date, the current time or the day of the week. Like all functions in MS Excel 2007,
entering date functions is very straightforward. Just type in the function in the cell
where you want the date or time to appear. The various date functions are discussed
below:
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NOW()

The NOW() function, one of MS Excel 2007’s date and time functions, is used to
add the current time and date to a spreadsheet. The syntax for the NOW() function
is as follows:

= NOW ( )

The NOW() function takes no arguments.

DATE()

The DATE() function, one of MS Excel 2007’s date and time functions has several
uses for adding dates to a spreadsheet. It can be used to combine date elements
from different locations.  It can also be used to convert dates to the computer’s
serial date. It can be used to ensure that imported dates are formatted correctly in
a spreadsheet, such as a date or a number instead of text. The syntax for the
DATE() function is as follows:

= DATE( Year, Month, Day)

TODAY()

The TODAY() function, one of the MS Excel 2007’s date and time functions, is
used to add today’s date to a spreadsheet. The syntax for the TODAY() function
is as follows:

=TODAY( )

The TODAY() function takes no arguments.

DAY()

The DAY() function returns the day of the month.

MONTH()

The function MONTH() takes one argument as MONTH(start_date) where
start_date is the date for which you are trying to find the month. For example,

=MONTH(DATE(2011,3,12)

Above statement will return the value 3.

YEAR()

In MS Excel 2007, the YEAR() function returns a four digit year (a number from
1900 to 9999) given a date value. The syntax for the YEAR() function is as follows:

YEAR() (Date_value)

In the above statement, date_value is a valid date.
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Logical Functions—IF(), AND(), OR(), NOT()

MS Excel 2007 uses seven logical functions, such as AND(), FALSE(), IF(),
IFERROR(), NOT(), OR() and TRUE() which appear on the Logical command
button’s drop-down menu on the Formulas tab of the Ribbon. All the logical functions
return either the logical TRUE or logical FALSE when their functions are evaluated.
Here are the names of the logical functions along with their argument syntax:

 AND(logical1,logical2,...) tests whether the logical arguments are TRUE
or FALSE. If they are all TRUE, the AND function returns TRUE to the
cell. If any are FALSE, the AND function returns FALSE.

 IF(logical_test,value_if_true,value_if_false) tests whether the logical_test
expression is TRUE or FALSE. If TRUE, the IF function returns the
value_if_true argument. If FALSE, the IF function returns the value_if_false
argument.

 IFERROR(value,value_if_error) tests whether the value expression is an
error. IFERROR returns value_if_error if the expression is an error or value
of the expression if it is not an error.

 NOT(logical) tests whether the logical argument is TRUE or FALSE. If
TRUE, the NOT function returns FALSE. If FALSE, the NOT function
returns TRUE.

 OR(logical1,logical2,...) tests whether the logical arguments are TRUE or
FALSE. If any are TRUE, the OR function returns TRUE. If all are FALSE,
the OR function returns FALSE.

 FALSE() takes no argument and simply enters logical FALSE in its cell.
 TRUE() takes no argument and simply enters logical TRUE in its cell.

IF() Function

The IF() function is used to test whether a certain condition is TRUE or FALSE.
Following steps help to get the result of IF() function:

 Enter 36 into cell D1.
 

 

 Select D2 cell and type the statement as ‘=IF(26,100,200)’.
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 After pressing ENTER key, value 100 will appear on D2 because 26 is less
than 36 therefore ‘value_if_true’ condition will be executed.

 Changing the IF() function’s results. Click on cell F5 which is the location of
the result. Click on the Formulas tab. Choose Logical from the Ribbon to
open the drop-down list as shown in screen. Click on IF in the list to bring
up the function’s dialog box.

 

 

 On the Logical_test line in the dialog box, type 26. On the Value_if_true
line of the dialog box, type 100. On the Value_if_false line of the dialog
box, type 200.

 

 

 If you click on cell F5, the complete function ‘= IF(D1<26,100,200)’
appears in the formula bar as shown below:
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Let us take another example to explain the concept of IF() function.

Type a word “Text” in A1 cell. Keep cursor on cell D5. Type the formula
=IF(A1=”Text”, “String”, “Integer”) in cell D5. Press ENTER key. Word ‘String’
will appear in resulted cell D5.

 

 

 If you change the word ‘Word’ instead of ‘Text’ then the value of resulted
cell will contain ‘Integer’ as shown in screen.

 

Nested IF() Function

A nested IF() function is worked when a second IF() function is placed inside the
first in order to test additional conditions. It is possible to nest multiple IF() functions
within one MS Excel 2007 formula. You can nest up to seven IF() functions to
create a complex IF() statement. The syntax for the nested IF() function is as
follows:

IF(condition1, value_if_true1, IF(condition2, value_if_true2,
value_if_false2))

Above statement displays how to nest two IF() functions in which ‘condition1’ or
‘condition2’ is the value that you want to test, ‘value_if_true’ is the value that is
returned if condition evaluates to True and ‘value_if_false’ returns if condition
evaluates to False. Consider an example where using the nested IF() function the
following grades will be displayed:

 A-If the student scores 80 or above.
 B-If the student scores 60 to 79.
 C-If  the student scores 45 to 59.
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 D-If the student scores 30 to 44.
 FAIL-If the student scores below 30.

Use the following nested IF() function to compute and display the result:

=IF(B2>=80, “A”, IF(B2>=60, “B”, IF(B2>=45, “C”, IF(B2 >=30, “D”,
“Fail”) ) ) )

In the above statement, if the answer to the first question is False then
control will go to next IF statement. If it is True then it will display Grade ‘A’ as
shown in result of ‘Student Examination Grade’ spreadsheet.

The approach of nesting IF() function increases the flexibility of the function
by a number of possible results. For example, the deductions from an employee’s
income will follow the approach ‘the higher the income, the higher the deduction
rate’.

Text Functions

Following are the text functions in MS Excel 2007.

LOWER()

In MS Excel 2007, the LOWER() function converts all letters in the specified
string to lowercase.

If there are characters in the string that are not letters, they are unaffected
by this function. The syntax for the LOWER() function is as follows:

=LOWER( Text )

In the above statement, text is the string to convert to lowercase.

UPPER()

In MS Excel 2007, the UPPER() function allows you to convert text to all
uppercase. The syntax for the UPPER function is as follows:

=UPPER( Text )

In the above statement, text is the string that you wish to convert to uppercase.

PROPER()

In MS Excel 2007, the PROPER() function sets the first character in each word
to uppercase and the rest to lowercase. The syntax for the PROPER() function is
as follows:

=PROPER( Text )

In the above statement, text is the string argument whose first character in each
word will be converted to uppercase and all remaining characters converted to
lowercase.
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LEN()

In MS Excel 2007, the LEN() function returns the length of the specified string.
The syntax for the LEN() function is as follows:

=LEN( Text )

In the above statement, text is the string to return the length for.

LEFT()

In MS Excel 2007, the LEFT() function allows you to extract a substring from a
string, starting from the left most character. The syntax for the LEFT() function is as
follows:

=LEFT( Text, number_of_characters )

In the above statement, text is the string that you wish to extract from and the
number_of_characters indicates the number of characters that you wish to extract
starting from the left most character.

RIGHT()

In MS Excel 2007, the RIGHT() function extracts a substring from a string starting
from the right most character. The syntax for the RIGHT() function is as follows:

=RIGHT( Text, number_of_characters )

In the above statement, text is the string that you wish to extract from and
number_of_characters indicates the number of characters that you wish to extract
starting from the right most character.

MID()

In MS Excel 2007, the MID() function extracts a substring from a string (starting
at any position). The syntax for the MID() function is as follows:

=MID( Text, start_position, number_of_characters )

In the above statement, text is the string that you wish to extract from and
start_position indicates the position in the string that you will begin extracting from.
The first position in the string is 1 and number_of_characters indicates the number
of characters that you wish to extract.

REPT()
In MS Excel 2007, the REPT() function returns a repeated text value a specified
number of times. The syntax for the REPT() function is as follows:

=REPT( Text, Number )

In the above statement, text is the text value to repeat and number is the number of
times to repeat the text value.

TRIM()

In MS Excel 2007, the TRIM() function returns a text value with the leading and
trailing spaces removed. The syntax for the TRIM() function is as follows:

=TRIM( Text )

In the above statement, text is the text value to remove the leading and trailing
spaces from.
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Financial Functions (PMT(), PV(), FV(), RATE(), IPMT(), NPER())

Here is the list of financial functions.

Function Description

FV This function returns the future value of an investment.
IPMT This function returns the interest payment for an investment for a given

period.
NPER This function returns the number of periods for an investment.
PMT This function returns the periodic payment for an annuity.
PV This function returns the present value of an investment.
RATE This function returns the interest rate per period of an annuity.

Freeze Panes

A particular portion of a worksheet can be selected to stay static while you are
working on other parts of the sheet. This is done using the Freeze Rows and
Columns Function. To Freeze a row or column, follow the given steps:

 Click on the Freeze Panes button on the View tab.
 Either select the section to be frozen or click on the defaults of top row or

left column.
 To unfreeze, click on the Freeze Panes button.
 Click on Unfreeze.

Check Your Progress

14. Write the keyboard shortcuts used to move up and down one screen in
MS Excel 2007?

15. What is a cell cursor?

16. Define the term cell address.

17. What does MS Excel 2007 function compute?

18. What does FACT() function return?

19. What does LEN() function return?

3.9 CHARTS

Charts help you to present the information of the worksheet in a graphic format.
MS Excel 2007 provides various types of charts which includes Column, Line,
Pie, Bar, Area, Scatter and Other charts. To view the charts click on the
Insert tab on the Ribbon.
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Creating a Chart: To create a chart, follow the given steps:
 Select the cells that contain the data you would like to use in the chart.
 Click on the Insert tab on the Ribbon.
 Click on the Charts, choose the type of chart you want to create.

Moving a Chart: You can modify and move a created chart. To move the chart,
follow the given steps:

 Click on the chart and drag it to the location, you want the chart to insert in
the same worksheet.

 Click on the Move Chart button on the Design tab.
 Select the desired location in the same or another worksheet.

To change the data included in the chart, follow the given steps:
 Click on the chart.
 Click on the Select Data button on the Design tab.

To reverse the data displayed in the rows and columns, follow the given steps:
 Click on the chart.
 Click on the Switch Row/Column button on the Design tab.
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To modify the labels and titles, follow the given steps:
 Click on the chart.
 On the Layout tab, click on the Chart Title or the Data Labels button.
 Modify the title and Press ENTER key.

Chart Tools: The Chart Tools appear on the Ribbon when you click on the chart.
The tools are located on three different tabs that are Design, Layout and
Format. Within the Design tab you can control the chart type data, layout, styles
and location.

The Layout tab controls inserting pictures, shapes and text boxes, labels,
axes, background and analysis.

Within the Format tab you can modify shape styles, word styles, chart
arrangement and alignment, and size of the chart.

Copy a Chart to Word

 Select the chart.
 Click on Copy on the Home tab.
 Go to the Word document where you want the chart to be located.
 Click on Paste on the Home tab.
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Creating an Embedded Chart

An embedded chart is referred as a chart that appears right within the worksheet
so that when you save or print the worksheet, you save or print the chart along
with it. By default, the chart is placed on the worksheet as an embedded chart.
You can also choose to create a chart in its own chart sheet in the workbook at
the time you create it. Embed a chart on worksheet when you want to print the
chart along with its supporting worksheet data. Place a chart on its own sheet
when you intend to print the charts of the worksheet data separately. The steps for
creating an embedded chart are exactly same as for creating a simple chart.

Creating Chart Sheet

By default, when you create a chart, MS Excel 2007 embeds the chart in the
active worksheet. You can move a chart to another worksheet or to a chart sheet.
A chart sheet is a sheet dedicated to a particular chart. By default, MS Excel 2007
names each chart sheet sequentially starting with Chart1. You can change the name
of the chart sheet as per your choice.

Formatting Chart: Title, Gridlines, Legends and Resizing

To add chart, you need to type suitable title for the prepared chart.  Suitable title
is provided to the prepared chart when it is inserted in the worksheet. Subject
names can be displayed on your chart by selecting the tab marked as Data Labels.
Chart’s appearance can be viewed by seeing the previews of the changes you
make when you check or uncheck the property boxes.

Data can be displayed in horizontal and vertical chart gridlines to make it
easier to read and understand. Gridlines extend from any horizontal and vertical
axes across the plot area. In a 2-D chart, the area is bounded by the axes including
all data series. In a 3-D chart, the area is bounded by the axes, including the data
series, category names, tick mark labels and axis titles of the chart. Depth gridlines
can also be displayed in 3-D charts. Note that gridlines cannot be displayed for
those kind of chart types that do not have any axes, such as pie charts and doughnut
charts.
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You can choose the axis along which you want to distinguish your data by
setting the chart legend on that axis. This is a significant way to view values on the
selected axis without rearranging the values in the Outliner. A chart legend can be
set on the X-, Y- or Z-axis. You can also reposition or resize a legend to take
advantage of either the horizontal or vertical space within the chart area.

The following three examples show how the legend are placed on different
axes to alter the appearance and data shown by the same chart. In the first example,
the legend has been set on the X (categories) Axis. In the second example, the
legend has been set on the Y (facts) Axis. In the third example, the legend has
been set on the Z (clusters) Axis:

To set the axis used for a chart legend from the Format menu, follow the given steps:
 Choose Format  Set Legend On.

 The Set Legend On dialog box appears.
 Select the axis on which you want to set the legend and click OK.

To resize a chart, do one of the following:
 To change the size manually, click the chart and then drag the sizing handles

to the size that you want.
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 To use specific height and width measurements, on the Format tab, in the
Size group, enter the size in the Shape Height and Shape Width box.

3.9.1 Changing Chart Types

Any change you can make to a chart that is embedded in a worksheet, you can
also make to a chart sheet. For example, you can change the chart type from a
column chart to a bar chart and for this following steps are required:

 Start Microsoft Excel 2007 and open a workbook from your documents
that contains a chart or you can create a chart from data in an existing
workbook.

 Right click on top of the chart that you want to change to a different type of
chart and click ‘Change Chart Type’. The ‘Change Chart Type’ dialog
box will open in the middle of the screen.

 Click the type of chart you would like to change to on the left side of the
‘Change Chart Type’ dialog box.

 Select the specific chart you would like to change your existing chart to by
clicking it in the right portion of the ‘Change Chart Type’ dialog box. The
chart you have chosen will be highlighted.

 Click the ‘OK’ button to close the ‘Change Chart Type’ dialog box and
to change the selected chart type to the new chart type that you have
specified.

3.10 CREATING AND USING MACROS

Macros are advanced features which speed up editing or formatting in an MS Excel
2007 worksheet. They record the sequences of menu selections selected by you so
that a series of actions can be successfully performed in one step.
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Recording a Macro: To record a Macro, follows the given steps:
 Click on the View tab on the Ribbon.
 Click on Macros.
 Click on Record Macro...
 Enter a name for Macro (without spaces).
 Enter a Shortcut Key.
 Enter a Description and click OK.
 Record the Macro.
 Click on Marcos.
 Click on Stop Recording to stop macro recording.

Assigning a Keyboard Shortcut to a Macro

Macro in MS Excel 2007 is used to record each command and action that is
required to perform task. The created and recorded macro can further be used to
carry out the similar task in a worksheet. You can run the specified Macro for
performing desired action. The simplest way to create a Macro in MS Excel 2007
is to use the Macro recorder. The required steps are as follows:

 Open the workbook where you want to use the Macro.

 Click on View  Record Macro and then select Record New Macro
from the menu.

You will now see the Record Macro dialog box as shown below:

After setting the shortcut key for creating Macro as CTRL+SHIFT+H and
Macro name as Macro1, the given screen will appear which shows the recording
Macro button. This button records all the activities which will be issued by user.
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Type the valuable data in the worksheet. Save the file name as ‘Student.xls’.

Running Macro

To run a Macro from the Keyboard shortcut, simply press the keys that you have
assigned to run the Macro. 

 Click on Macros.

 Click on View Macros.

 Select the Macro and click on Run.

Check Your Progress

20. How does modifying fonts in MS Excel 2007 help?

21. Write the function of Layout tab.

3.11 PRINTING WORKSHEETS

You can choose the spreadsheet you want to print. To print a worksheet, do the
following steps:

 Click Print on the File menu.

 Under Print what, select Entire workbook radio button.

You will get the Print tab where you can set the ‘Print range’, ‘Print
what’, ‘Number of copies:’ options as shown in the screen .
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Previewing Worksheet

To preview worksheet, go to the Office button in which Print option is given. To
view the spreadsheet in Print Preview, follow the given steps:

 Click on the Office button on the Ribbon.
 Select the arrow to the right of Print.
 Choose Print Preview.

The spreadsheet appears on screen as it will be printed. You can proceed to print
the document from here or you can change options and settings to make the
printed output look different. When you select Print Preview option the worksheet
page will look as shown in the screen below:

Page Setup Margin, Paper Size and Orientation Setting

Set Print Titles

The Print Titles function permits you to repeat the column and row headings at the
beginning of each new page to make reading a multiple page sheet easy to read
when printed.  To print titles, follow the given steps:

 Click on the Page Layout tab on the Ribbon.
 Click on the Print Titles button.

 In the Print Titles section, click on the box to select the rows/columns to
be repeated.

 Select the row or column.

 Click on the Select Row/Column Button.

 Click on OK.
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Set Page Margins

To set the page margins, follow the given steps:

 Click on the Margins button on the Page Layout tab.
 Select any one of the given options.
 Click on Custom Margins.
 Complete the boxes to set margins.
 Click on OK.

Changing Page Orientation

To change the page orientation from portrait to landscape, follow the given steps:
 Click on the Orientation button on the Page Layout tab.
 Select Portrait or Landscape.

Printing an Area of a Worksheet

A print area can be defined for specific sections on the worksheet that are printed
frequently. A print area can be defined as one or more selected range of cells that
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are selected for printing so that the entire worksheet does not need to be printed.
Therefore, when print command is executed after selected a print area, only the
selected cells are printed. If required, cells can be added to enlarge the print area.
For printing the entire worksheet, the print area is simply needed to be cleared.

To set a print area, follow the given steps:
 On the worksheet, select the cells that you want to define as the print area.
 On the Page Layout tab, in the Page Setup group, click Print Area and

then click Set Print Area.

The print area that you set is saved when you save the workbook. You can add
cells to an existing print area by performing the following steps:

 On the worksheet, select the cells that you want to add to the existing print
area.

 On the Page Layout tab, in the Page Setup group, click Print Area and
then click Add to Print Area.

A print area can be cleared by performing the following steps:
 Click anywhere on the worksheet for which you want to clear the print

area.
 On the Page Layout tab, in the Page Setup group, click Clear Print

Area.

Printing Worksheet with/without Gridlines

To make a printed worksheet or workbook easier to read, you can print the
worksheet or workbook with gridlines displayed around the cells.

 Select the worksheet or worksheets that you want to print.
 When multiple worksheets are selected, Group  menu appears in the title

bar at the top of the worksheet. To cancel a selection of multiple worksheets
in a workbook, click any unselected worksheet. If no unselected sheet is
visible, right click the tab of a selected sheet and then click Ungroup Sheets
on the shortcut menu.

 On the Page Layout tab, in the Sheet Options group, select the Print
check box under Gridlines.

 Click Microsoft Office Button  and then click Print. You can also

press CTRL+P which are assigned as keyboard shortcut. Worksheets print
faster if you print without gridlines.

Adding Standard/Customized Header and Footer in Worksheet

To create a header or footer in a worksheet, follow the given steps:
 Click on the Header & Footer button on the Insert tab.
 It will display the Header & Footer Design Tools tab.
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 To switch between the Header and Footer, click on the Go to Header or
Go to Footer button.

 To insert text, enter the text in the header or footer.
 To enter preprogrammed data, such as page numbers, date, time, file name

or sheet name, click on the respective button.
 To change the location of data, click on the desired cell.

PivotTable and PivotChart
The PivotTables are interactive tables that allow the user to group and summarize
large amounts of data in a concise, tabular format for easier reporting and analysis.
A PivotChart is the graphical representation of PivotTables. When you create a
PivotTable or PivotChart report and can use several different types of source
data. The source data refers to the list or table that is used to create a PivotTable
or PivotChart report. Source data can be taken from an MS Excel 2007 list or
range, an external database or another PivotTable report. A PivotTable report is
used to summarize, analyse, explore and present summary data. This report is
visualized in the summary data in a PivotTable report and to easily see comparisons,
patterns and trends. Both a PivotTable report and a PivotChart report enable you
to make informed decisions about critical data in your enterprise.

Creating a PivotTable
To create a PivotTable, following steps are required:

 Prepare a suitable data on which you want to create a PivotTable and select
the range in Table/Range: bar as shown in the screen below.

 After clicking on OK button, ‘PivotTable Field List’ appears where you
can choose the selected fields on which you want to prepare the PivotChart.
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 Once you select the desired fields, the PivotTable is prepared as shown in
screen.

 You can create a PivotChart using  tool. This tool will provide ‘Insertt

Chart’ option where you can create a suitable chart to depict the selected
data.
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 Once you select the chart, for example ‘Pie’ chart then the result appears
as follows:

3.12 ESTABLISHING WORKSHEET LINKS

To summarize and report results from separate worksheets, you can consolidate
data from each separate worksheet into a master worksheet. The worksheets can
be in the same workbook as the master worksheet or in other workbooks. When
you consolidate data, you are assembling data so that you can more easily update
and aggregate it on a regular or ad hoc basis. For example, if you have a worksheet
of expense figures for each of your regional offices, you might use a consolidation
to roll up these figures into a corporate expense worksheet. This master worksheet
might contain sales totals and averages, current inventory levels, and highest selling
products for the entire enterprise. To consolidate data, use the Consolidate
command in the Data Tools group on the Data tab. After you have consolidated
data from multiple worksheets, you can change the in which the data is consolidated.
For example, to add worksheets from new regional offices, delete worksheets
from departments that no longer exist or change formulas with 3-D references.
The term ‘3-D reference’ is a range that spans two or more worksheets in a
workbook. You change a consolidation by changing the formulas or by editing the
formulas, such as changing the function or expression. Regarding cell references,
you can do one of the following:

To Change a Consolidation made by Position or Category

You can change the consolidation only if you have not previously selected the
‘Create links to source data’ check box in the Consolidate dialog box. If the
check box is selected, click Close and then recreate the consolidation. Click the
upper left cell in the consolidated data.

 On the Data tab, in the Data Tools group, click on Consolidate.

 The new source range must have either data in the same positions if you
previously consolidated by position or column labels that match those in the
other ranges in the consolidation if you previously consolidated by category.
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 If the worksheet is in another workbook, click Browse to locate the file
and then click OK to close the Browse dialog box. The file path is entered
in the Reference box followed by an exclamation point.

 Type the name for the range and then click Add.

 Adjust the size or shape of a source range.

 Under All references, click the source range that you want to change.

 In the Reference box, edit the selected reference.

 Click on Add.

To Delete a Source Range from the Consolidation

 Under All references, click the source range that you want to delete.

 Click on Delete.

To Make the Consolidation Update Automatically

Select the check box if the worksheet is in another workbook. Once you select
this check box, you will not be able to change which cells and ranges are included
in the consolidation.

 Select the Create links to source data check box.

 To update the consolidation with the changes, click OK.

If the data to consolidate is in different cells on different worksheets, you need to
add, change or delete the cell references to other worksheets. For example, to
add a reference to cell G3 in a Facilities worksheet that you have inserted in the
following Marketing worksheet, you must edit the formula as shown in the screen.
The MS Excel 2007 sheet appears before as follows:

Once the multiple worksheets, such as ‘Sales’, ‘HR’, ‘Marketing’ and ‘Facilities’
are consolidated, the result appears as follows:

To add another worksheet to the consolidation, move the sheet into the range that
your formula refers to. For example, to add a reference to cell B3 in the Facilities
worksheet, move the Facilities worksheet between the ‘Sales’ and ‘HR’ sheets as
shown in the screen.
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Because, the formula contains a 3-D reference to a range of worksheet
names, ‘Sales:Marketing!B3’ as shown in the screen, all worksheets in the
range are included in the new calculation.

During a consolidation, MS Excel 2007 enables you to link the data in the
source areas specified in the ‘All references’ list box of the ‘Consolidate’ dialog
box to the destination area in the new worksheet. Thus any change that you make
to the values in the destination area of the consolidation worksheet is applied to all
references. To create links between the source worksheets and destination
worksheet, just select the ‘Create Links to Source Data’ check box to the
‘Consolidate’ dialog box prior to performing the consolidation. When you perform
a consolidation with linking, MS Excel 2007 creates the links between the source
areas and the destination area by outlining the destination area. Each outline level
created in the destination area holds rows or columns that contain the linking
formulas to the consolidated data.

Check Your Progress

22. Why a PivotTable report is used?

23. What is ‘3-D reference’ in consolidating data?

3.13 ANSWERS TO ‘CHECK YOUR PROGRESS’

1. In an office, the following software programs are required to fulfill its needs:
(i) Word processing
(ii) Spreadsheet package
(iii) Presentation package
(iv) Database
(iv) Scheduler

2. Ribbon is a panel that houses a fixed arrangement of few icons and command
buttons. This creates organizations for commands that form a set of tabs
that group every relevant command.

3. The function of a title bar is to display the title of the current document
which is in use.

4. Document formatting represents all the types of formatting parts which are
applied to a selected document for making suitable presentation.

5. Thesaurus allows you to view synonyms.

6. Web Layout view is a view of the document as it would appear in a web
browser.

7. Indention helps you to set the text within a paragraph at different margins.

8. Borders and shading are used to highlight information in a table. Thus it
enhances the appearance of the text in a table.
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9. Macros are used for the following reasons:
(i) To speed up routine editing and formatting.
(ii) To combine multiple commands, for example to insert a table with a

specific size and borders and with a specific number of rows and
columns.

10. A spreadsheet is an electronic document which saves various types of data
in columns and rows.

11. The advanced feature permits you to specify the options for editing, copying,
pasting, printing as well as displaying formulas, calculations and other general
settings.

12. You can edit a worksheet if any incorrect information has been entered into
a cell. To do so, click on the cell and enter the correct information. Typing
replaces whatever is in the cell. Editing a spreadsheet includes copy, cut,
paste, move, changing column width/row height, cell alignment and
formatting, font and number formatting, inserting and deleting cell(s)/row(s)/
column(s), insert/copy/move/rename/delete a worksheet.

13. In MS Excel 2007 spreadsheet, a cell address identifies the location of the
cell.

14. In MS Excel 2007, to move up or down one screen the keyboard shortcuts
used are Pg Up and Pg Dn keys.

15. The cell cursor is a black border that surrounds the active cell sometimes
called the current cell in a worksheet.

16. The cell address is a combination of column letter and row number of a cell,
such as C4 or D8.

17. A function computes the values provided and shows you the desired results;
e.g., a simple function SUM() automatically adds up all the values provided
either in a range or as individual values.

18. In MS Excel 2007, the FACT() function returns the factorial of a number.

19. In MS Excel 2007, the LEN() function returns the length of the specified
string.

20. Modifying fonts in MS Excel 2007 helps you to emphasize titles and
headings.

21. The Layout tab controls inserting pictures, shapes and text boxes, labels,
axes, background and analysis.

22. A PivotTable report is used to summarize, analyse, explore and present
summary data.

23. The term ‘3-D reference’ is a range that spans two or more worksheets in
a workbook while consolidating data.
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3.14 SUMMARY

 Office automation includes the various computer hardware and software
used in electronically creating, collecting, and storing and manipulating office
information.

 The basic activities of office automation are storage of raw data, electronically
transferring the data and electronically managing business information.

 When you explore Microsoft Word 2007, you will notice the new look of
the menu bar. Three new features help you to work with Word 2007, namely
the Microsoft Office Button, the Quick Access Toolbar and the Ribbon
which contain various functions.

 The Ribbon is positioned at the top of the screen of the Word window. It
includes seven tabs, namely Home, Insert, Page Layout, References,
Mailings, Review, View and Add-Ins.

 Document formatting represents all the types of formatting parts which are
applied to a selected document for making suitable presentation.

 Bulleted lists are represented using bullet points, numbered lists are
represented using numbers and outline lists combine together the numbers
and letters depending on the association of the list.

 Microsoft Word 2007 is a product of Microsoft Office 2007 or 2007
Microsoft Office System. It is the latest version of Windows of the Microsoft
Office System. It introduced the ‘Ribbon User Interface’ instead of the old
menu and toolbar which is a work oriented Graphical User Interface (GUI).

 Web Layout view enables you to see your document as it would appear in
a browser, such as Internet Explorer.

 The Reading Layout view formats your screen so that you can read the
document more comfortably.

 Align Right option is used to align the text with the right margin.

 In Microsoft Office Button, there are three buttons in Print option, which
are Print, Quick Print and Print Preview, which appear on the computer
screen to perform the printing of the document. In the ‘Preview mode’, you
can change margin setup, page size and orientation, print options and can
also opt for many other printing features.

 Styles are the predefined text formats that are available in MS Word 2007
to apply on text content.

 Indention is used to set the text content within a page or within a paragraph
at different margins.

 Tab is classified into left, center, right, decimal and bar tab.

 Content can be inserted from one document to another document by using
hyperlinks. A hyperlink can point an entire document or Web page or to
some specific section within your document. A hyperlink contains an anchor
which stores the destination location which the hyperlink can use to follow
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the destination document. The source document is the document that contains
hyperlinks.

 Tables organize data into rows and columns. They are used for the purpose
of displaying data in a tabular format. Selection within tables is prime
operation of Word table because it provides you to select and perform the
desired options, such as finding total marks of a specific student or merge
the headings, etc.

 MS Word 2007 provides Borders and Shading options that facilitate you
to enhance the appearance of the text information in a table.

 Microsoft Office Word generates a copy of the main document for item or
record in your data file.

 Queries can contain operators, quotation marks, wildcard characters and
parentheses to help focus your search, i.e., defined in the database.

 In Microsoft Office Word 2007, you can automate frequently used tasks
by creating macros. A macro is a series of commands and instructions that
you group together as a single command to accomplish a task automatically.

 The linked object in the destination file can be updated when the source file
is updated and embedded objects. Once embedded, the object becomes
part of the destination file. Changes you make to the embedded object are
displayed in the destination file.

 In MS Excel 2007, the columns are lettered A to Z and then continuing with
AA, AB, AC, and so on, and the rows are numbered from 1 to 1,048,576.

 MS Excel 2007 provides a wide range of customizable options that help
you to create an MS Excel 2007 workbook of required specifications.

 The Proofing feature permits you to personalize the options for correcting
words and formats of your text.

 If you hold down the CTRL key and then press the Home key, you move to
the beginning of the worksheet.

 If there is an error in a formula, an error message is displayed which will
begin with a # sign.

 The ROUND() function in MS Excel 2007 can be used when rounding
integers and decimal numbers to make them easier to work within your
spreadsheets.

 In MS Excel 2007, you can change any column width or row height in your
worksheets to improve the readability and appearance of data.

 Within the Format tab you can modify shape styles, word styles and size of
the chart.

 In a 3-D chart, the area is bounded by the axes, including the data series,
category names, tick mark labels and axis titles of the chart.

 To run a Macro from the keyboard shortcut, simply press the keys that you
have assigned to run the Macro. 
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 The PivotTable report is an interactive, cross tabulated MS Excel 2007
report that summarizes and analyses data, such as database records from
various sources including ones that are external to MS Excel 2007.

 The PivotTable make easy to arrange and summarize complicated data
based on details. When you create a PivotTable or PivotChart report, you
can use any of several different types of source data. The source data refers
to the list or table that is used to create a PivotTable or PivotChart report.

 To summarize and report results from separate worksheets, you can
consolidate data from each separate worksheet into a master worksheet.

3.15 KEY TERMS

 Draft View: A view used for the purpose of editing a document quickly.

 Paragraph Alignment: This option helps in organizing the text according
to the way you want it to appear.

 Justify:  An option which aligns the text to both the left and right margins.

 Data Source: A file that contains the information to be merged into a
document.

 Cell Address: The combination of a column coordinate and a row
coordinate.

 Operators: Symbols used to represent the various arithmetic and comparison
operations you can perform on the operands.

 NOW(): This function is used to add the current time and date to a
spreadsheet.

 LOWER(): This function converts all letters in the specified string to
lowercase.

 Level Buttons: Buttons that represents a level of organization in a
worksheet and clicking a level button hides all levels of detail below that of
the button you clicked.

 Print Area: Area refers to one or more ranges of cells that you designate
to print when you do not want to print the entire worksheet.

3.16 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. Why is LAN considered as significant part of office automation?

2. What is word processing?

3. What does Microsoft Office button menu provides?

4. How a blank page is inserted in a document?

5. Which button is selected if you want to check the margin, paper size and
orientation to print the Word document?
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6. How is a nested list created?

7. How new styles are created?

8. What is the significance of OLE DB?

9. Why ‘Print’ option is selected in mail merge operation?

10. Why macro is used?

11. How to edit a linked object?

12. What is Microsoft Excel 2007?

13. Write the steps to select data range.

14. Which string operator is used to concatenate the two text values?

15. Write the syntax of MOD() function.

16. Write the steps to cut and paste the formula.

17. How any chart type is changed in MS Excel 2007?

18. What are macros?

19. Why previewing worksheet is a required step before taking the printout?

20. How a PivotTable is created?

21. Why is PivotTable report used?

22. What happens when you consolidate data?

Long-Answer Questions

1. Explain the various activities associated with text processing software

2. Explain briefly the concept of ‘getting started’ and also name the various
ways in which a document can be viewed in MS Word 2007.

3. Explain the process to create and edit document with the help of examples.

4. Explain the steps required in formatting a document.

5. Explain the steps required in creating a custom dictionary with the help of
examples.

6. Explain the features of spelling and grammar tool with the help of examples.

7. Write the steps required to use a Print function in Microsoft Word 2007.

8. Write all the steps required to insert symbols in Word document.

9. Describe the styles with reference to advanced document formatting.

10. Explain all the operations that can be performed in MS Word table.

11. Explain the significance of macro with the help of examples.

12. What is the difference between linked objects and embedded objects?

13.  Describe the difference between worksheet, workbook and workspace
with the help of suitable examples.

14.  Explain the features of Microsoft Office button in MS Excel 2007.

15.  Describe the concept of selection in a worksheet.

16.  What are the categories of formulas in MS Excel 2007? Explain.

17.  Explain the syntax of text functions: LOWER(), UPPER(), PROPER(),
LEN(), LEFT()RIGHT(), MID(), REPT() and TRIM().
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18.  Explain briefly the concept of editing worksheet.

19.  What are the steps required in creating chart and embedded chart, moving
chart and formatting chart?

20. How a keyboard shortcut is assigned in creating and executing a macro?
Explain briefly.
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UNIT 4 PRESENTATION GRAPHICS
SOFTWARE: MS
POWERPOINT

Structure
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4.6.1 Normal View
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4.7.2 Automation of Slide Presentation
4.7.3 Inserting Animated Pictures
4.7.4 Inserting Recorded and In-built Sound Effects
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4.9.2 Customizing Slide Show
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4.12 Key Terms
4.13 Self-Assessment Questions and Exercises
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4.0 INTRODUCTION

In this unit, you will learn about the basics of Microsoft PowerPoint 2007. PowerPoint
presentations in Office 2007 are a way of attracting audience towards your views
and arguments. This software package provides various options for creating learning
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guidelines, corporate training session and marketing strategy. You will also learn to
create a variety of slides using different layouts, such as slide master layout, chart
slide layout, subtitle slide layout, table slide layout, picture slide layout, etc. You can
perform various operations, such as opening PowerPoint application, creating
presentation, adding objects to slides, inserting graphics, such as chart, organizational
chart, photo album, etc., to the PowerPoint slides. The presentations in PowerPoint
2007 can be saved both with a .ppt or the .pptx extension. Slide formatting allows
you to format the master slide for the AutoLayout area. You can change the font
type and size in PowerPoint 2007 slides. To apply a design template to all slides you
can select a suitable template. A design template is a file which contains the styles
in a presentation including the type and size of the bullets and fonts, background
design and fill color scheme. The view option in PowerPoint slide enables the
presentation to be viewed in different ways, such as normal view, notes view, handout
view, printout view, screen view, etc. You can adjust the line spacing in Paragraph
tab where options are given as Single, 1.5 lines, Double, Exactly and Multiple.
Animation is considered as the most interesting and effective feature of PowerPoint
presentation. You can change the slide transition effect from the animations tab.
You can set the transition speed, transition sound and can animate the slide transitions.
You can also set up text boxes, objects, images, etc. Finally, you will learn the concept
of slide master which is one of several master slides and is used in PowerPoint to
make global changes to all your slides at one time. Slide Show view is the view used
for presenting the presentation to an audience. Slide Show view can be accessed
from the View tab of the Ribbon or by pressing the F5 key on the keyboard.
PowerPoint can show your presentation on your computer’s own monitor, a projector
or an external monitor, such as a giant screen Plasma or LCD display.

4.1 OBJECTIVES

After going through this unit, you will be able to:

 Understand the utility of PowerPoint presentation
 Explain the significance of Ribbon and Quick Access Toolbar in PowerPoint
 Discuss the different views available in PowerPoint
 Create presentation using texts, objects, graphics, Clip Arts, tables, charts,

photo albums, organizational charts, etc.
 Understand the concept of slide formatting
 Apply design templates
 Change slide background color
 Apply themes
 Animate PowerPoint presentation
 Describe the significance of master slide
 Discuss the advanced features of PowerPoint presentation
 Save and print presentation
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4.2 UTILITY OF POWERPOINT
PRESENTATION

PowerPoint presentations in Office 2007 are a way of attracting audience towards
your views and arguments. It is one of the most helping factors behind success of
every meeting. There are various uses of PowerPoint presentations, some of them
are integrated. The prime utility of PowerPoint presentations in modern days are
learning, corporate training sessions, business and marketing meetings and sales
gatherings. They are as follows:

Learning Solutions

Microsoft PowerPoint 2007 thus allows for creation of professional, effective and
creative business presentations that can be used for corporate or sales presentations
and trainings. Each page in the presentation, termed as a slide in PowerPoint can be
customized according to business requirements. PowerPoint contains several easy-
to-use features, such as design templates, the capability to insert graphics and charts,
and various printing options that allow the user to create a business presentation.
Companies can develop their specific design theme containing their logo and design
template to give a uniform look to all their presentations.

Corporate Training Session

Companies often utilize PowerPoint to create a visual simplified platform to conduct
the training session for their employees. PowerPoint 2007 is considered as an essential
element of every corporate training session. Hence PowerPoint is frequently used
to develop training materials, such as orientations, computer system lessons, customer
service trainings and specific concept trainings. Top executives and managers
(marketing and sales) utilize this powerful tool to train their juniors or associates to
bestow them better, interactive and more proficient training. The PowerPoint slides
highlight key points on each slide by accommodating titles, bulleted text, photos and
graphics making the presentation easy to read and understandable.

Marketing Strategy

Powerful tools and options present in Microsoft PowerPoint makes it easier for
people in marketing, advertising and sales to make presentations for motivation of
their subordinates. Inclusion of different types of charts, images, Clip Arts and other
graphical structures makes PowerPoint 2007 presentation eye catchy. Animation
and sound effects add extra emphasis on these presentations making them more
interactive.

4.3 GETTING STARTED WITH MICROSOFT
POWERPOINT

PowerPoint helps in using  charts, diagrams, pictures and animations for the purpose
of creating effective presentation slides. The main feature that separates
PowerPoint 2007 from PowerPoint 2003 is that in PowerPoint 2007 file is saved
with a .ppt and .pptx extension. When the PowerPoint slides are saved as .pptx,
Windows 2003 is unable to open the file.
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Microsoft Office Button

The Microsoft Office Button performs all the functions of the ‘File’ menu of the
older versions of PowerPoint. It helps you to create a new presentation, open an
existing presentation, save a presentation, save a presentation with a new name
using the ‘Save As’ option, print a presentation, send a presentation and close a
presentation.

Ribbon

Ribbon refers to the strip of buttons that resides on top of the main Window. The
standard Ribbon includes the Home tab, the Insert tab, the Design tab, the
Animation tab, the Slide Show tab, the Review tab and the View tab.

Design

The Design option is accessed on the Ribbon. This option facilitates the choice of
colors, background styles, fonts, page setup, slide orientation, etc.

Home

The Home option is the most commonly used option which  by users. It helps in
creating new slides. The ‘slides’ option provides you to insert new slides. You can
adjust the layout of slides, reset and set default slides. The paragraphs can be aligned
and specified in form of bulleted or numbered lists. The drawing and editing tools
help in editing the text and figures.
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Insert

The insert option is available for the purpose of adding tables, illustrations, links, text
and media clips. WordArt, header, footer, text, movie and sound can also be inserted
in the slides. The tables can be inserted or imported from MS Excel. Illustrations
can be in form of Clip Art files, photo albums, pictures, Smart Art, shapes and
charts. You can insert a link using the hyperlink tool to navigate the corresponding
presentations. The ‘insert text box’ option provides the orientation and location of
the words along with the insertion of date, time, symbols, slide numbers and embedded
objects.

 

Animation

The animation option contains preview, custom animation and various transition settings
that can be applied to the specified or all slides in the presentation. The slide show
transition can be set  at mouse clicks or ‘automatically-after -seconds’ options. You
can preview the slide show to view the proper effect and the mode of presentations.
Various objects, such as images, text and embedded objects can be added on the
slides. The various transitions available for slide shows are wipes, fades and dissolve,
random, strips and bars, push and cover, etc.

 

Slide Show

The slide show option helps in setting up the start slide show (either from the starting
or from-and-to specific slide numbers) and to record narration. It also has the option
to monitor the screen resolution by providing separate views of the slide show.

 

Review

The content of the slides can be reviewed and modified by using the spell check,
research, adding comments, etc. This makes the presentation flawless.  Proofing
provides the facility of text proofing by scanning the online research references,
finding synonyms and converting the text to other languages  in totality. This option
provides the comment facility that enables the addition or modification of a comment
for a particular slide or the content of a slide. The protect option restricts usage by
unauthorized users. This option is helpful for slide show share with a network drive
if you collaborate with other users.
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View

The view option enables the presentation to be viewed in different ways, such as
normal view, notes view, handout view, printout view and screen view, show/hide
grid lines, rulers and tools, zoom in and zoom out facility and also includes the color/
grayscale view whether the slides should appear in color or black and white. The
window tab arranges the windows of the  current working slides and macros includes
complex tasks that get activated after clicking on the slides.

 

 
The format tab includes drawing tools and picture tools. The picture tool is a context
sensitive tab that appears on the Ribbon and allows the user to work with inserted
images, photos, Clip Art and pictures. It sets the brightness of images, crops the
picture, etc.

Navigation

Navigation through the slides can be accomplished using the Slide Navigation menu
on the left side of the screen.  An outline of slides appear on the left side that have
been entered in the presentation.  You need to click the outline tab to access the
outline of the presentation.

Mini Toolbar

A new feature in Office 2007 is the Mini Toolbar.  This is a floating toolbar that is
displayed when you select text or right click on the text.  It displays the common
formatting tools, such as bold, italics, fonts, font size and font color.

Table

This option includes adding borders, rows and columns, formatting of individual cell,
etc., to a table.  It helps in deciding the number of rows and columns that would
appear on the screen. The merge option combines the cells into a larger one and the
alignment option sets the alignment of the cell so that the text may fit better.
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Quick Access Toolbar

The quick access toolbar holds the commands which are issued by the user again
and again. The quick access toolbar can be easily customized using the command
button available on the Ribbon. This tool is displayed on the top most left corner of
the screen.

 

The drop-down list is customized on the quick access toolbar by selecting
the Customize Quick Access ToolbarMore CommandsCustomize.

You can add or remove the commands from the list. Once you make changes
and save them, the quick access toolbar gets updated. This toolbar is also known
as a customizable toolbar. You can add or delete the toolbar from the menu.
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Customize

Microsoft PowerPoint 2007 facilitates customizable options. For this, click on the
File menu. It  generates the option called ‘PowerPoint Options’ as follows:

 

 
 

By clicking on the PowerPoint Options leads to the Customize option.

 

The Popular option helps you to initialize the work environment, color
schemes and user name along with initials and accessing the Live Preview feature
which is useful for applying designs and changes.

The Proofing option provides auto correction settings and also helps in
finding errors through custom dictionaries.

 

The save option allows you to personalize the process of saving the
workbook.
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The Advance feature option provides the options to edit, copy, paste, print,
display slide show and for general settings.

 

The Customize option allows you to add or delete the toolbars in the quick
access toolbar. This option is very useful from the point of view of setting the
toolbars as per the user requirement.

4.4 CREATING, MANIPULATING AND
ENHANCING SLIDES

In Microsoft PowerPoint 2007 you can create, manipulate and enhance slides. The
presentation can be created by blank presentation, templates, from existing presentations
and word outline. The presentation slides can be manipulated by office themes, duplicate
selected slides or reuse slides. Microsoft PowerPoint 2007 provides various tools to
enhance slides. These all features are discussed as follows:

4.4.1 Creating Slides

The presentations can be created as follows:

New Presentation

You can create a new presentation from a blank slide, a template, existing presentations
or a Word outline.  To create a new presentation from a blank slide, the following



Presentation Graphics
Software: MS PowerPoint

NOTES

Self - Learning
228 Material

steps need to be performed:

 Click on the Microsoft Office Button.

 Click on New.

 Click on Blank Presentation.
 

 
 

To Create a New Presentation from a Template

To create a new presentation from a template, the following steps must be performed:

 Click on the Microsoft Office Button.

 Click on New.

 Click on Installed Templates or Browse through Microsoft Office
Online Templates.

 Click on the template you want.
 

 

To Create a New Presentation from an Existing Presentation

To create a new presentation from an existing presentation, the following steps
need to be performed:

 Click on the Microsoft Office Button.
 Click on New.
 Click on New from Existing.
 Browse and click to open the presentation.
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To Create a New Presentation from a Word Outline

To create a new presentation from a Word outline, the following steps need to be
performed:

 Click on the slide where you would like the outline to begin.
 Click on New Slide on the Home tab.
 Click on Slides from Outline.
 Browse and click on the Word document that contains the outline.

 

 

Saving a Presentation

You can save a presentation using the Save or the Save As command. To save a
document with Save command follow these steps:

 Click on the Microsoft Office Button.

 Click on Save.
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You can also use the Save As command to save a presentation with a different
name or to save it as an earlier version of PowerPoint. The older versions of
PowerPoint will not open the PowerPoint 2007 presentation unless you save it in the
PowerPoint 97-2003 format. To use the Save As command, follow these steps:

 Click on the Microsoft Office Button.
 Click on Save As.
 In the Save as box, choose PowerPoint 97-2003 Presentation.
 Type the name for the presentation.

  

4.4.2 Manipulating Slides

Adding Slides

There are various options available to add new slides to the presentation, such as
Office Themes, Duplicate Selected Slide or Reuse Slides.

To create a new slide from Office Themes, the steps that need to be
performed are as follows:

 Select the slide that is just BEFORE where you have to insert the new
slide.

 Click on the Home tab and then on the New Slide  Button.
 Click on the slide format of your choice.

To create a duplicate slide of a particular slide in the presentation, following
are the steps that need to be performed:

 Select the slide which you want to duplicate.

  Click on the Home tab and then click on the New Slide Button.

 Click on Duplicate Selected Slides.



Presentation Graphics
Software: MS PowerPoint

NOTES

Self - Learning
Material 231

To insert a slide from another presentation, the steps that need to be
performed are as follows:

 Select the slide that is just BEFORE where you have to insert the new slide

 Click on the New Slide Button on the Home Tab.

 Click on Reuse Slides.

 Click on Browse.

 Click on Browse File.

 Find the slide and click on the specific slide to import.

4.4.3 Enhancing Slides

Microsoft PowerPoint offers tool to enhance slides by creating informative, interesting
and dynamic presentation. You can create high-impact presentation by adding tables,
charts, etc. Adding visual components to your slides can enhance your presentation.
Clip Art images, Word Art, Internet images or scanned images can be added to your
PowerPoint slides. You can also add visual components by using Smart Art, Charts,
Photo Album, etc.

Entering Text

Following are the steps that must be performed to enter text in a slide:

 Select the slide where the text needs to be added.

 Click on the Text Box to add text.

Following are the steps that must be performed to add a text box:

 Select the slide in which you want to insert the text box.

 Click on the Insert Tab, then click on Text Box.

 Click on the slide and drag the cursor to enlarge the text box.

 Type the text in the text box.
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Copy and Paste

Following are the steps for copying and pasting any object or text in a slide:

 Select the object or text that you want to copy.

 On the Clipboard Group of the Home Tab, click on Copy.

 Select the location where you want to copy the object or text.

 On the Clipboard Group of the Home Tab, click on Paste.

              

Cut and Paste

Following are the steps to cut and paste any text or object in a slide:

 Select the text or object that you want to copy.

 On the Clipboard Group of the Home Tab, click on Cut.

 Select the location where you want to copy the text or object.

 On the Clipboard Group of the Home Tab, click on Paste.

      

Spell Check

The spell check option is useful if a text based PowerPoint presentation is to be
prepared. It underlines every wrong spelling by a red wavy line.

 

The spell check option can be used by pressing the right mouse button. It
generates a shortcut menu. You can correct the spelling by either using the Review
option or by pressing the function key [F7].
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The spelling dialog box provides a variety of buttons—Ignore, Change,
Options, AutoCorrect, etc., to the users. If you do not wish to make any changes
in the spelling, click on the Ignore button.

Once the spellings have been changed as required, it provides a dialog box
which says, ‘The spelling check is complete.’

Change Font Typeface and Size

The font typeface and size can be changed by selecting the specific tool in the
Home Tab of the Ribbon.

 

For this, you first select the text which needs to be changed to the desired
font size, color and style.

WordArt

WordArt is a gallery of text styles that you can add to your 2007 Microsoft Office
system documents to create decorative effects, such as shadowed or mirrored
(reflected) text. In Microsoft Office PowerPoint 2007, you can also convert existing
text into WordArt. You can use WordArt to add special text effects to your document.
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For example, you can stretch a title, skew text, make text fit a preset shape or apply
a gradient fill. On the Insert Tab, in the Text group, click WordArt and then click
the WordArt style that you want to add in your presentation.

 
You can use any of the styles of WordArt by choosing any one option from

the list to get the desired effect.

Paragraph Alignment

This option provides the various alignment options to change the indent setting of
text as Align Left (it aligns text to the left margin [CTRL+L]), Center (it centers
text [CTRL+E]), Align Right (it aligns text to the right margin [CTRL+R]) and
Justify (it justifies the text on left and right margins).

To see the effect, select the paragraph for which you have to set the indent.
The paragraph is indented when you click on the indent button to control the
indent style.

Text Direction

The text direction option is used to change the direction of the text. The options
available are  Horizontal, Rotate all text 90°, Rotate all text 270°, Stacked
and More Options.

Resize a Text Box

You can resize a text box by clicking on the Text Box Tool. You can resize the text
box by dragging the handles that appear around the typed text.
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Nested Lists

A nested list also known as a sublist that represents a list in another list. It has two
tools—Increase List Level (increases the indent level) and Decrease List Level
(decreases the indent level). For this, the tools ‘ ’ are used. The resultant
effect of Increase List Level would be as follows:

 

 

Formatting Texts

This option allows the text to be formatted by using Font optionin the Home
Tab. It helps you to make changes in the font size, style type and effects.

To change text attributes, open a presentation, select the text on a slide by
dragging the cursor over it. Right click on your selection and select Format Text
Effects as shown below.

Formatting Lists (Bulleted and Numbered)

Bulleted and numbered lists are useful for the purpose of highlighting the important
elements or key features of the specified heading. This can be done with the help
of Bullets and Numbering tool. For example, if you want to show the MS Office
2007 group/package in form of a numbered or bulleted list, you can add bullets as
follows:
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The dialog box for the Bullets and Numbering option appears as follows:

Table

Tables can be inserted along with text to show the statistical data on the slide. You
can insert a table by clicking on InsertTable option.

Enter Data

The data is entered in a tabular format. For example, if marks obtained by students
in a specific course module have to be displayed on the slide, you can add them as
shown in the screen.

Format Table

The table that has to be appeared on the slide can be formatted by using the Design
menu. You can also format the border and shading of the table as per your requirement.

Tables can be embedded from other applications too, such as Microsoft
Excel 2007 and Microsoft Word 2007. For this, you have to first open Microsoft
Excel 2007 and prepare a table. Then click on PowerPoint 2007 to add the
required chart/table.
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Chart

Microsoft Excel 2007 charts and tables can also be embedded to Microsoft
PowerPoint 2007. For this, you need to select InsertChart option.

After copying and pasting the chart on slide, you can get the desired chart
from Microsoft Excel 2007.

Adding Organizational Chart using SmartArt

Information can be communicated visually by using the SmartArt option. It provides
graphics, ranging from graphical list and process diagrams to more complex graphics.
For example, Venn diagrams and organization charts. The options available for the
purpose are List,  Process, Cycle, Hierarchy, Relationship, Matrix and
Pyramids. The SmartArt picture is added by clicking on InsertSmartArt option.



Presentation Graphics
Software: MS PowerPoint

NOTES

Self - Learning
238 Material

If you select the Pyramid option, it generates various options as shown in
screen.

Graphics

You can add a picture to your PowerPoint slide by selecting InsertPicture option.

Once you get a picture on your slide, you can move the picture around the
slide by dragging it with your mouse. You can also resize the photo by dragging the
corner handles and rotating using the little circles located at each corner.

Adding Clip Art

The Clip Art picture option helps in adding Clip Art to the slide. For this, select
InsertClip Art tool.
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Adding Photo Album

To create a photo album, click on ‘Insert’ menu and click on ‘Photo Album’ and
then select ‘New Photo Album’. A pop up Window then opens, select the photos
that you want to insert in the album. After adding the photos, you can rotate them or
even change their brightness/contrast. You can even add your own Photo Album
and can create it in form of a presentation.

Adding Shapes

The Adding Shapes option is available to the user by clicking on the Shapes tool
which generates a drop-down list.

You can add various types of shapes as per the text or presentation requirement.

 

Layering Art Objects

PowerPoint 2007 gives you the option of layering your images by controlling their
order and how they appear on the slide. As you add objects to your slides, you may
find that one object overlaps another or causes another object to disappear completely.
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For instance, you may add a Clip Art graphic to your slide and can draw a rectangle
around the graphic. However, when you draw the rectangle, you find that the graphic
has disappeared from the screen. PowerPoint layers objects in a stack that is, the
first object drawn or inserted is on the bottom of the stack, and the next object
appears on top of the previous object, and so on. You can order the images on the
slide so they appear behind the text or above it. PowerPoint’s formatting tool allows
you to organize the image objects on the slide by keeping track of the image’s
hierarchy.

Changing the Layering Order of Objects

 Select the graphical object that you wish to move.

 Click the Format Tab.

 To send an object backward or to the back of the stack, click the Send to
Back arrow on the Arrange group and choose either Send to Back or
Send Backward.

 To bring an object forward or to the front of the stack, click the Bring to
Front arrow on the Arrange group and choose either Bring to Front or
Bring Forward.

Check Your Progress

1. Name the prime utility of PowerPoint presentation.

2. Write the main feature of PowerPoint which separates PowerPoint 2007
from PowerPoint 2003.

3. What is the need of Insert option in the Ribbon?

4. What is the use of bulleted and numbered lists?

5. What is layering of objects?

4.5 SLIDE FORMATTING

The slide master controls the formatting for all slides with the specified layout.
Changes made to the slide master will affect all slides with that layout. Slide masters
are special slides that allow you to format basic information and apply it to every
slide in a presentation. Masters let you format the title, background, color, date, time
and slide number. By using the slide masters, you can add consistency to a
presentation, making it easier to follow and understand. Entering a title or other text
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is easy in PowerPoint. Simply click in the appropriate text box and type your text.
Click a slide in the Slides tab where you want to change some text formatting.

To format the Master Title you started on the previous page, highlight the
text that says ‘Click to edit Master title style’.

Once you have highlighted all the text (the parts in black in the image above),
click Format from the menu bar at the top of PowerPoint. From the Format
menu, select Font... where you can right click the highlighted text and select Font
from the context menu that appears.

You should now see the Font dialog box appear. Select Arial for the font
and 44 for the size. Click the color drop-down list and select the color as per your
choice.

Click OK. Your Master title should now look like as shown in screen.

Format the AutoLayout area

With the Master title set up, you can format the AutoLayout area (the one with the
bullets in it). You only need one slide with bullets in our presentation, so it makes
sense to delete these and just add some text instead. So, click inside the AutoLayout
area and select all the text.

With the text highlighted, locate the bullet tool on the PowerPoint toolbar at
the top. When you deactivate the bullets, your AutoLayout area look as shown in
screen.
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Press the delete key on your keyboard to get rid of this text and type out a
word or two of default text in its place.

Format the text like you did for the Master title. Choose Arial for the font
and keep the size 16. Leave it on black for the color.

Format the Footer

You can also enter defaults in the Footer area. Click on the word <footer>, as
shown in the screen.

Then type the text you want to appear on every slide. Or just leave it, if you
want this area blank. Leave the Date Area and Number Area as they are. Screen
below displays the footer.

If Arial for the font is chosen as size is 12 and the color is white then screen
above appears.

4.5.1 Formatting Text in a Slide: Font, Alignment and
Line Spacing

To change the font in PowerPoint 2007, you need to select the slide on which you
have to format the text. Select the text that you want to format. Select the font type
as shown in the screen.
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You can align the selected text as shown in the screen.

The line spacing is set with the tool as shown in the following screen.

You can adjust the line spacing in Paragraph Tab where options are given
as Single, 1.5 lines, Double, Exactly and Multiple as shown in the screen.

4.5.2 Changing Slide Background Color

The background is the area that covers the whole slide in PowerPoint 2007. It is
referred to as background because it stays in the back and it is positioned behind
anything else in the slide. If you assign or change a presentation’s design, a nicely
formatted background is applied to the slides. You can change and design a slide’s
background anytime or change the presentation’s design manually if none of the
designs suits your particular needs. To design a particular slides background, you
should be in the Slides tab of the Normal view.

 Click Background Styles, and then select Format Background, from
the Design Tab, in the Background group. The Format Background dialog
box will appear.
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 Select the desired options from the Fill section.

 To apply the changes only to the current slide and close the dialog box,
click Close.

 To apply the changes to all slides, click Apply to all.

4.5.3 Applying Themes

This option comprises certain buttons that help in the customization of colors, fonts
and effects. For this, you have to select the Design option.

 

If you click on Color drop-down list, you can get the available color scheme
and be able to see the preview by hovering the cursor over the color scheme. 
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The color schemes as specified are applied to all the slides in the presentation.
For example, the ‘Aspect’ option gives the following effect to the slides.

 

The new color theme option is created by selecting the Create New Theme
Colors option. You can save the color theme as MyCustomColor which in turn
would affect the current slide color.

  

The new font theme option is created by selecting the Create New Theme
Font option. You can save the custom font as MyCustomFont which would
change the current slide font.

 

 

 

The font can be used for Heading and body text. The theme is saved with a
.thmx file extension. The custom theme MyCustomFont is then available in the
theme gallery for further use.
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Undo and Redo

The Undo and Redo Buttons are located at the top most left side of the interface.
 

 

The two ways to use the Redo command are by either clicking on the
‘Redo Button’ or pressing the [CTRL+Y] key combination simultaneously.

 

The Undo command [CTRL+Z] reverses the last performed or the preceding
task, whereas the  ‘Redo Button’ is used for repeating the task. The Undo command
is useful if the text or figure is deleted accidentally. For example, ‘Modify Theme
Colour’ can be undone as shown in screen.

4.6 DIFFERENT VIEWS IN POWERPOINT

The view option enables the presentation to be viewed in different ways, such as
Normal view, Notes Page view, Handout Master view, Slide Sorter view, Slide show
view and Notes Master view, show/hide grid lines, rulers and tools, zoom in and
zoom out facility and also includes Color, Grayscale view and Pure Black and White.
The Window Tab arranges the Windows of the  current working slides and macros
includes complex tasks that get activated after clicking on the slides.

The Format Tab includes drawing tools and picture tools too. The picture
tool is a context sensitive tab that appears on the ribbon and allows one to work
with inserted images, photos and Clip Art pictures. It sets the brightness of images,
crops the picture, etc.

4.6.1 Normal View

Normal view in Microsoft PowerPoint is the main working Window in the
presentation. The slide is shown in full size on the screen. This view is more commonly
known as Slide view.
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4.6.2 Outline View

Outline view shows all the text of all slides in a list. No graphics are shown in
Outline view. This view is useful for editing purposes and can be exported out as a
Word document and used as a summary handout.

4.6.3 Slide View

The Slide view does not differ much from the Normal view, except in that the Slide
view does not display the presentation outline. The Slide view displays each slide on
the screen and is helpful for adding images, formatting text and adding background
styles.

4.6.4 Slide Sorter View

Slide Sorter view in PowerPoint 2007 is a Window that displays thumbnail versions
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of all your slides, arranged in horizontal rows. This view is useful to make global
changes to several slides at a time. Rearranging or deleting slides is easy to do in
Slide Sorter view. In order to apply the same transition to all of the PowerPoint
slides at one time, users switch their presentation to Slide Sorter view. Slide Sorter
view shows miniature versions of all the slides in horizontal rows. These miniature
versions of the slides are called thumbnails. A thumbnail is the term used to describe
a miniature version of a slide or picture. Slides can be easily deleted or rearranged
quickly in this view. Effects, such as transitions and sounds can be added to several
slides at the same time in Slide Sorter view.

4.6.5 Notes Page View

PowerPoint lets you create speaker notes to help you through your presentation.
You can write a complete script for your PowerPoint presentation or just jot down a
few key points to refresh your memory. Each slide can be created with its own
notes page. The user can print these pages and use as a reference while making the
presentation. Notes Page show the added notes at the bottom of the slide as shown
in the screenshot. These notes are not visible on the screen during the slide show or
presentation. The Notes pane is located just below the Slide pane. You can type
notes that you want to apply to the current slide. When you present your presentation,
you may need to refer to notes to elaborate on a slide’s material or to remind you to
point out some detail. In PowerPoint, you can write your speaker’s notes while
creating your slides. Simply go to the text box below the slide in the main window
area that says ‘Click to add notes’ and start writing. To work with Notes Page, click
on the View Tab. Under Presentation Views select the Notes Page Button. Type
your notes in the space that appears in the notes area in your slide.
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Check Your Progress

6. What is background area in PowerPoint 2007?

7. Write the extension of theme when saved.

8. What is Normal View in context of PowerPoint 2007?

4.7 ANIMATIONS AND SOUNDS

The animation option contains preview, custom animation and various transition settings
that can be applied to the specified slides. The Slide Show transition can be set  at
mouse clicks or ‘automatically-after-seconds’ options. You can preview the slide
show to view the proper effect and the mode of presentations. Various objects, such
as images, text and embedded objects can be added on the slides. The various
transitions available for slide shows are wipes, fades and dissolve, random, strips
and bars, push and cover, etc.

4.7.1 Slide Transition

Transition effects add movement to changes between the slides. The slides appear
as thumbnail diagrams on the Ribbon’s Animations Tab. The Normal view is generated
when the mouse is rolled over a thumbnail. PowerPoint 2007 applies the transition
effect to the slide when we  click on the thumbnail. Clicking on the slide in Normal
or Slide Sorter view highlights the thumbnail to which the slide transition effect
needs to be applied. To apply the transition effect to multiple slides, hold down the
CTRL key as you click on several slides and choose an animation. To insert a
transition between every slide in a presentation, click Apply to All button in the
Animations Tab. The transition effect comes after clicking on the Animations
Tab. You can even set the transition speed and transition sound as per requirement.

After setting the slide transition set, click on the Slide Show option as follows:
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The slide speed option can be set as fast, medium or slow.

4.7.2 Automation of Slide Presentation

PowerPoint 2007 presents an effect of slide presentation. You can include wipes,
zooms, pans, spins, reveals or hundreds of visually special effects at the time of
preparing presentation. Automation of slide presentation leads the concept of self
running presentations. It is a great way to communicate information without having
someone available to run a Slide Show presentation. For example, you might want
to set up a presentation to run unattended in a trade show or convention or send a
Compact Disk (CD) with a self running slide show to a client. You can make most
controls unavailable so that users cannot make changes to the presentation. A self
running presentation restarts when it has finished and also when it has been idle on
a manually advanced slide for longer than five minutes. When a self run presentation
is designed, the corresponding environment is kept in the mind, such as elements
you add to your presentation, how much control you give users and what steps you
need to take to prevent misuse. Options you might want to consider when designing
a self running presentation include:

 Automatic or Manual Timings: You can set up a presentation to run by
itself with automatic timings or you can set it so that users can move through
it at their own pace by using the mouse to click action buttons for navigation.
If you set up a slide show to be browsed at a kiosk, mouse clicks are
ignored unless they are on objects with hyperlinks or action buttons.

 Hyperlinks and Action buttons: You can use hyperlinks to move through
the presentation or to jump to other slides and programs. Action buttons
are predefined navigation buttons which can give your presentation the look
and familiarity of a Web page with buttons for Home, Help, Back, Next,
and so on.

 Voice Narration:  The recorded narration can be added to play with your
presentation.

 Capture User Input: You can use the ActiveX controls that come with
PowerPoint to create a response slide in your presentation. For example,
you can add a text box in which people can enter their names and addresses
to receive further information.

You can set timings for your slides manually or you can set them automatically
while you rehearse. You can set the exact amount of time each slide is viewed, for
example you can have the title slide appear for 10 seconds, the second slide for
two minutes, the third for 45 seconds, and so on. You may find it easiest to work
with the Slides Tab selected in Normal view so you can see miniatures of each
slide in your presentation. To set timings automatically while you rehearse, you
can use the buttons in the Rehearsal dialog box to pause between slides, restart a
slide and advance to the next slide. As you rehearse the presentation, PowerPoint
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tracks how long each slide appears and sets the timing accordingly. If you display
the same slide more than once, for example in a custom show the last timing will be
recorded by the PowerPoint.

4.7.3 Inserting Animated Pictures

You can use animation to focus on important points, to control the flow of information
and to increase viewer interest in your presentation. You can use the built-in animation
effects in Microsoft Office PowerPoint 2007 or you can create your own custom
effects. You can apply animation effects to individual slides, to the slide master or to
custom slide layouts.

Applying a Pre-Built Animation Effect to Text or Objects

For applying animation effects to objects in Office PowerPoint 2007, do the following:

 Select the text or object that you want to animate.

 On the Animations Tab, in the Animations group, select the animation
effect that you want from the Animate list.

Applying a Custom Animation Effect to Text or Objects

You create custom animations in the Custom Animation. The Custom Animation
task pane shows important information about an animation effect, including the type
of effect, the order of multiple effects in relation to each other and a portion of the
text of the effect.

 Select the text or object that you want to animate.
 On the Animations Tab, in the Animations group, click Custom

Animation.
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 In the Custom Animation task pane, click Add Effect and then do one or
more of the following:

 To make the text or object enter with an effect, point to Entrance and then
click an effect.

 To add an effect, such as a spin effect, to text or an object that is already
visible on the slide, point to Emphasis and then click an effect.

 To add an effect that makes text or an object leave the slide at some point,
point to Exit and then click an effect.

 To add an effect that makes text or an object move in a specified pattern,
point to Motion Paths and then click a path.

 To specify how the effect is applied to your text or object, right click the
custom animation effect in the Custom Animation list and then click Effect
Options on the shortcut menu.

Inserting GIF Files

 Click on the slide where you want the GIF video file to appear. Click on the
Insert Tab and then click on the Movie option from the Media Clips
group.

 For inserting image from file, click on the Movie from File option and then
locate the folder on your computer where the GIF video file is stored. Click
on the video file and then click on the Open Button.

 For inserting image from clip organizer, Click Movie from Clip Organizer,
scroll to find the clip that you want in the Clip Art task pane and then click
it to add it to the slide.

 The video is automatically inserted and a dialog box appears.

 Click on the Automatically option if you want the video to play automatically
when the slide is shown or click on the When Clicked option to have the
animation play when you click on it.

You can animate the slide transitions. You can also set up text boxes, objects, images,
etc. Custom animation buttons control the effect on mouse clicks.
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PowerPoint 2007 includes triangles, spirals, bounces, etc. This option also
helps in  customizing the animation, for example move, size and close.

Animation Preview

Click on the Slide Show menu and then click on the Custom Animation Button.
To preview animations in the slides, click on the Play Button in the  custom animation
task pane. The slide show can also be viewed with the help of the Slide Show tool.

The Animation Preview option is a very useful feature in Slide Show.

Slide Show Options

The Slide Show option can be accessed by clicking on the slide show tool. You can
set the slide show according to the requirement, that is either for All option or the
From: and To: drop-down list. From the Set Up Show dialog box as displayed,
under the Show type section, choose any of the following show type options:

 Presented by a speaker: To run a full screen slide show.

 Browsed by an individual: To run a slide show in a window and allow
access to some PowerPoint commands.

 Browsed at a kiosk: To create a self running, unattended slide show for a
booth or kiosk.

Under the Set-Up Show options section, check or clear the following check boxes:

 Loop continuously until ‘Esc’: Check to replay the slide show again until
you stop it.
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 Show without narration: Select if you do not want the narration to play.

 Show without animation: Select if you do not  want the animation to play.

Under the Show slides section, select any one of the following options:

 All: All the slides will show during the slide show.

 From: Enter the first and last slide numbers of the range that you want to
show.

Under the Advanced slides section, select the Manually or Using timings, if
present option, which would you use to advance the slides manually or automatically.

 Slide Show Resolution: The drop-down list allows you to select the display
resolution that you want.

 Click on the OK button.

4.7.4 Inserting Recorded and In-built Sound Effects

Incorporating sound clips into PowerPoint is an effective way to capture your
audience’s attention and communicate information in diverse ways. Sound clips are
not restricted to pre-installed sound effects. They may also include music and voice
recordings.

To insert recorded and inbuilt sound effects to PowerPoint slide do the
following:

 Select the slide to which you wish to add a sound.

 In the Insert Tab, under the Media Clips group, click the arrow on
the Sound button.

 For adding in-built sound, choose Sound From Clip Organizer... to
bring up the Clip Art task pane for built-in sound effects. Click the
sound to insert it or hover your mouse over it first, click on the menu
arrow that appears and choose Insert.

 For adding recorded sound file, choose Sound From File... to bring
up the Insert Sound dialog box. Find the sound file on your computer
using the “Look in” drop-down list. Select the file and click OK.

 A pop-up box will appear asking you how you would like the sound to
start in the presentation. Choose automatically if you want the video
to play automatically when the slide is shown or click on the When
Clicked option to have the animation play when you click on it.

 A sound icon appears on your slide.



Presentation Graphics
Software: MS PowerPoint

NOTES

Self - Learning
Material 255

4.8 UTILITY OF MASTER SLIDE

The slide master is one of several master slides that are used in PowerPoint to make
global changes to all your slides at one time. Using the slide master allows you to:

 Change font colors and styles for every slide.

 Add a Clip Art or picture to every slide.

 Add a footer or date to every slide.

Following steps are required to access the Slide Master:

 Click on the View Tab of the Ribbon.

 Click on the Slide Master Button as shown in the screen.

4.8.1 Inserting Date/Time/Slide Number into Master
Slide

On the slide, position the insertion point in the placeholder. The placeholders are
boxes with dotted or hatch marked borders that are part of most slide layouts. These
boxes hold title and body text or objects, such as charts, tables and pictures or text
box. A text box is a movable and resizable container for text or graphics. Use text
boxes to position several blocks of text on a page or to give text a different orientation
from other text in the document that you want to add the date and time or slide
number to. On the Insert menu, click either Slide Number or Date and Time.
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4.8.2 Inserting Common Objects to All Slides

You can insert the standard objects, text caption, rollover caption, rollover image
and highlight box to a master slide. All other standard objects are disabled. You can
also insert the text animation, widget, image, animation and Flash Video (FLV)/F4V
files. You cannot add audio to a master slide. To add objects to a Master Slide,
following steps are required:

 Select the Master Slide in the Master Slide strip.

 Add objects in the same way as you do in the slides in your project.

4.8.3 Applying Common Title/Text Format to All Slides

A PowerPoint Slide Master is an element of the design template that stores
information about the template including font styles, placeholder sizes and positions,
background design and color scheme information. They also allow you to insert
common elements on every slide, such as a common footer, slide number, copyright
line, logo or even pictures. If you want all of the slides in your presentation to use
similar fonts, formatting, colors and graphics then this is the best way to do this. You
can create a new Master instead of editing the existing one if you want to apply the
master changes only to selected slides or if you only plan to use it temporarily. You
can also create a new Slide Master and then apply it to the Main Slide Master once
you are sure of how you want it to look.

Check Your Progress

9. What does animation option contain?

10. What is slide master?

11. What are placeholders?

4.9 SOME ADVANCED FEATURES OF
POWERPOINT PRESENTATION

Following are the advanced features of PowerPoint 2007:

 It provides to achieve consistency with Master Slides.

 It supports background, such as the plain white background on all slides is
something your clients will insist that you change. You can set backgrounds
individually on every slide.
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 Office 2007 provides about 25 preset textures to use.

 You can use a bitmap as a background as well as gradient fills.

 PowerPoint 2007 allows you to select the gradient fills interactively.
 It supports animations which are special effects, such as visual and audio

that highlight important elements in a slide. Some animation effects that
PowerPoint supports are objects flying in from the edge (choose your edge),
text appearing letter-by-letter and sound files playing. These animations
can be timed to happen sequentially or all at once. They can happen
automatically or in response to mouse clicks.

 PowerPoint 2007 allows specific actions to be taken when the mouse is
moved over or clicked on a shape.Actions include jumping to a specific
slide in the Slide Show, running another slide show, running a separate
program, playing a sound, as well as a few others.

 In this world of high tech movies and video games, multimedia in business
presentations is almost expected. Multimedia has the power to enhance a
presentation, making it more interesting to watch and easier for the viewer
to retain what was presented. While you are developing automated
presentations, be sure that your program can handle scaling to the wide
variety of hardware available for presentations.

4.9.1 Hide/Unhide in Slide Show

A good way to hide and unhide slides is in Slide Sorter view because an indicator
appears below each slide to show whether it is hidden. This way, you can easily
determine which slides is part of the main presentation. In the slide thumbnail pane
in Normal view, hidden slides appear ghosted out. Follow these steps to hide a slide:

 Switch to Slide Sorter view.

 Select the slide or slides that you want to hide. Remember, to select more
than one slide, hold down the CTRL key as you click the ones that you
want.

 Click the Hide Slide Button on the Slide Show toolbar. A gray box appears
around the slide number and a diagonal line crosses through it, indicating
that it is hidden.

To unhide a slide, select the slide and click the Hide Slide Button again. The slide’s
number returns to normal. You can also right click a slide and choose Hide Slide or
Unhide Slide to toggle the hidden attribute on and off.

4.9.2 Customizing Slide Show

There are two kinds of custom shows known as basic and hyperlinked. A basic
custom show is a separate presentation or a presentation that includes some of the
slides of the original. A hyperlinked custom show is a quick way to navigate to one
or more separate presentations.

Basic Custom Shows

Use a basic custom show to give separate presentations to different groups in your
organization. For example, if your presentation contains a total of five slides, you
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can create a custom show named ‘Site 1’ that includes just slides 1, 3 and 5. You can
create a second custom show named ‘Site 2’ that includes slides 1, 2, 4 and 5. When
you create a custom show from a presentation, you can always run the entire
presentation in its original sequential order.

In the above screen 1 represents the slides for Site 1 and 2 represents the
slides for Site 2.

Hyperlinked Custom Shows

Use a hyperlinked custom show to organize content in a presentation. For example,
if you create a primary custom show about your company’s new overall organization,
you can then create a custom show for each department within the organization and
link to these shows from the primary presentation.

In the shown screen, 1 represents slide with hyperlinks, 2 and 3 represents
the custom shows. On the Slide Show Tab, in the Start Slide Show group, click
the arrow next to Custom Slide Show and then click Custom Shows.

 In the Custom Shows dialog box, click New.

 Under Slides in presentation, click the slides that you want to include in the
custom show and then click Add.

To select multiple sequential slides, click the first slide and then hold down
SHIFT while you click the last slide that you want to select. To select multiple
non-sequential slides, hold down CTRL while you click each slide that you want
to select. To change the order in which slides appear, under Slides in custom
show, click a slide and then click one of the arrows to move the slide up or down
in the list. Type a name in the Slide Show name box and then click OK. To create
additional custom shows with any slides in your presentation, repeat above steps.
To preview a custom show, click the name of the show in the Custom Shows
dialog box and then click Show.

4.9.3 Applying Rehearse Timings for Slide Show

The Rehearse Timing  option provides you the option to make the presentation
within a certain time frame. It is also used to present  the slides with audio.
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The Rehearsal tool presents the following options for setting the toolbar:

Once the Rehearsal toolbar appears, the Slide Time box begins to time
the presentation.

The Rehearsal toolbar’s five labels can be described as follows:

Next (advance to next slide)

Pause

Slide Time

Repeat

Total time for presentation

After completing the rehearse timing of the slides as set, following dialog
box appears. Click on Yes to save the changes.

4.9.4 Saving Presentation

By default a presentation is saved with a .pptx file extension name. To save the first
time of the presentation, you need to perform the following tasks:

 Choose FileSave As from File menu. The following dialog box will be
appeared. Type the name of the presentation in ‘File name:’ bar. You can
select the folder name in ‘Save in’ drop-down list where you want to save
the file.

Click the Save Button. In case you wish to save the file into another directory,
specify the correct path and directory. Once you save the file by a name, you need
to click on Save as option. The modification and further changes can be saved
either by pressing CTRL+S keys together or by choosing FileSave menu. If
you choose Save as option again, the following dialog box will appear on the
screen.
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4.9.5 Printing Presentation

Printing a PowerPoint presentation provides three options to the user—Print, Quick
Print and Print Preview.

The Print option selects a printer, the number of copies to be printed and
the other options for printing, whereas Quick Print sends the presentation direct
to the default printer without making changes. The Print Preview option previews
and provides options to make changes to the pages before they are printed.

 

To access the Print settings in the Advanced Tab dialog box, click on the

Microsoft Office Button  , click on PowerPoint Options, click on Advanced

and then scroll down to Print. The Printer Name option can also be accessed
through this dialog box.  If you click on the Print option, you can access a lot of
options,for example, All, Current slide or Slides number as per your requirement.
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Check Your Progress

12. What is the characteristic of hyperlinked custom show in Slide Show
option?

13. Write one of the features of Rehearse Timing option in PowerPoint
2007.

4.10 ANSWERS TO ‘CHECK YOUR PROGRESS’

1. The prime utility of PowerPoint presentations in modern days are learning,
corporate training sessions, business and marketing meetings and sales
gatherings.

2. The main feature that separates PowerPoint 2007 from PowerPoint 2003
is that in PowerPoint 2007 file is saved with a .ppt and .pptx extension.

3. The insert option is available for the purpose of adding tables, illustrations,
links, text and media clips.

4. Bulleted and numbered lists are useful for the purpose of highlighting the
important elements or key features of the specified heading.

5. Layering of objects is controlling the appearance and order of objects on a
slide.

6. The background is the area that covers the whole slide in PowerPoint 2007.

7. The theme is saved with a .thmx file extension.

8. Normal View in Microsoft PowerPoint is the main working Window in the
presentation.

9. The animation option contains preview, custom animation and various
transition settings that can be applied to the specified slides.

10. The slide master is one of several master slides that are used in PowerPoint
to make global changes to all your slides at one time.

11. The placeholders are boxes with dotted or hatch marked borders that are
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part of most slide layouts.

12. A hyperlinked custom show is a quick way to navigate to one or more
separate presentations.

13. The Rehearse Timing  option provides you the option to make the
presentation within a certain time frame.

4.11 SUMMARY

 PowerPoint Presentations in Office 2007 are a way of attracting audience
towards views and arguments.

 The Microsoft Office Button performs all the functions of the ‘File’ menu of
the older versions of PowerPoint which helps you to create a new
presentation, open an existing presentation, save a presentation, save a
presentation with a new name using the ‘Save As’ option, print a presentation,
send a presentation  and close a presentation.

 Task pane is a Window within an Office program that provides commonly
used commands. Its location and small size allow you to use these commands
while still working on your files.

 Presentation can be created from a blank slide, a template, existing
presentation or a word Outline.

 Spell check underlines every wrong spelling by a red wavy line.

 Charts and tables from Microsoft Excel 2007 can also be embedded to
Microsoft PowerPoint 2007 by selecting InsertChart option.

 The options that are available for creating Organizational Chart are Process,
Cycle, Hierarchy, Relationship, Matrix and Pyramids.

 The background is the area that covers the whole slide. It is referred to as
background because it stays in the back and it is positioned behind anything
else in the PowerPoint slide.

 Applying a new theme changes the major details of your presentation. Word
Art effects are applied to titles in Office PowerPoint 2007. Tables, charts,
SmartArt graphics, shapes, and other objects are updated to complement
one another.

 The picture tool sets the brightness of images, crops the picture, etc.

 Slide Sorter View shows miniature versions of all the slides in horizontal
rows.

 Outline View is useful for editing purposes and slides can be exported as a
Word document to use as a summary handout.

 The transition effects are applied to the PowerPoint slide by clicking on the
thumbnail of the slide.

 Automation of slide presentations with timings, hyperlinks, voice narration
and user input leads the concept of self running presentation.
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 The Animation option contains preview, custom animation and various
transition settings that can be applied either to all or the specified slides in a
presentation.

 Animation scheme adds preset visual effects to text and objects on slides.

 The movie clip is usually in the animated .gif format or the .avi format.

 Video clips will get dull if used over and over again in PowerPoint slide.

 The slide master is one of several master slides that are used in PowerPoint
to make global changes to all your slides at one time.

 The Rehearse Timing option provides the option to make the presentation
within a certain time frame.

4.12 KEY TERMS

 Ribbon: It refers to the strip of buttons that resides on top of the main
Window.

 Design Option: This option facilitates the choice of colors, background
styles, fonts, page setup, slide orientation, etc.

 SmartArt: This option provides graphics, ranging from graphical list and
process diagrams to more complex graphics.

 Picture Tool: This tool is a context sensitive tab that appears on the ribbon
and allows one to work with inserted images, photos and clip art pictures.

 Slide View: This view displays each slide on the screen and is helpful for
adding images, formatting text and adding background styles.

 PowerPoint Slide Master: This type of slide allows you to insert common
elements on every slide, such as a common footer, slide number, copyright
line, logo or even pictures.

 Basic Custom Show: It is a separate presentation that includes some of
the slides of the original.

4.13 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What are PowerPoint presentations?

2. What is Ribbon in PowerPoint 2007?

3. Write steps to format the footer.

4. Write one use of picture tab.

5. Why transition effects are used?

6. What do you understand by slide view?
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7. How can you preview animations?

8. Name the file extension name in which a presentation is saved.

Long-Answer Questions

1. Describe the utility of PowerPoint presentation with the help of suitable
examples.

2. Explain the steps to insert text, graphics, clip art, table, chart, organizational
chart and photo album.

3. Describe the concept of formatting the AutoLayout area.

4. Explain various types of views of slide presentation.

5. Explain the concept and option used in automation of slide presentation.

6. Write and explain all the steps required in adding animated pictures in slides.

7. Briefly explain how to insert date, time, slide numbers and common objects
into the slides.

8. Write all the steps required to add sound effects in slides.
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5.0 INTRODUCTION

Today, innovations in information technology are having wide-ranging effects across
numerous domains of society, and policy makers are acting on issues involving
economic productivity, intellectual property rights, privacy protection, and
affordability of and access to information. Technology affects the way individuals
communicate, learn, and think. It helps society and determines how people interact
with each other on a daily basis. Technology plays an important role in society
today.

The Internet, IT and computers are having, an enormous effect on everyone.
These computers and the Internet have become one of the most important changes
to modern society. They bring transformations to human daily life. The Internet has
transformed the reality of distances and has made individual self-operating
information collection machines that get immediate and easily access to information
and communication.

Internet provides effective communication using emailing and instant
messaging services to any part of the world. It improves business interactions and
transactions, saving on vital time. Banking and shopping online have made life less
complicated. One can access the latest news from any part of the world without
depending on the TV or newspaper. Education has received a huge boost as
uncountable books and journals are available online from libraries across the world.
This has made research easier. Students can now opt for online courses using the
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internet. Application for jobs has also become easier as most vacancies are
advertised online with online applications becoming the norm. Professionals can
now exchange information and materials online, thus enhancing research.

In this unit, you learn about the basic of internet, working of internet, TCP,
internet applications, computer networks and application of technology in society.

5.1 OBJECTIVES

After going through this unit, you will be able to:

 Discuss the features of internet

 Understand the working of internet

 Explain the significance of TCP/IP

 Discuss the internet applications

 Define the computer networks

 Describe the components of a network

 Know about the MAN and WAN

 Explain the MODEM

 Analyze the application of technology in Society

5.2 THE INTERNET: BASICS

The Internet is a ‘Network of Networks’ that links computer systems around the
world. It allows communication across networks, i.e., communication can take place
between one network and another. This allows people to have access to information
from different Web sites, locations and machines. It virtually makes accessible a sea
of information and a nearly worldwide audience at the click of a button.

It was the Sputnik’s launch and the subsequent cold war, space race and
the development of ARPANET (Advanced Research Projects Agency Network)
in 1950 that led to the establishment of the Internet. However, it actually gained
momentum in the 1980s when ARPANET was used by  the National Science
Foundation to connect the five supercomputers at its regional centres. Thus emerged
a high-speed Internet service that enabled access to many universities, networks,
bulletin board systems, commercial online services and institutions. The decade
closed with the coming into being of the World Wide Web (WWW), which
proclaimed the emergence of an independent platform of communication that was
further augmented by a relatively easy-to-use and pleasant graphical interface.

Important Features
Some of the facilities that are available on the Internet are:

 World Wide Web: The Internet application that is currently drawing
maximum attention is the World Wide Web. It has dramatically influenced
the online world and continues to grow in popularity.
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 Direct Communication: Through e-mail (electronic mail), messages can
be sent to or received from any part of the world within a few minutes.

 Round-the-Clock Availability: Information on the Internet is available to
users 24 hours a day.

 Central Repository of Data: The Internet is like a huge central warehouse
of data that people from all over the world can access.

 Search Engines: These are like directories which help get any kind of
information from the world over within a few seconds.

 Advertisement: A company can advertise its products/services through
the Internet.

 E-Commerce: The Internet is increasingly being used for conducting
monetary transactions. Through the Internet, you can shop and pay through
your credit card or ask your bank to transfer your money to a different
account, without even leaving your desk.

 Distance Learning: Several online distance learning courses are now being
offered by Indian and foreign universities on the Internet.

 BBS and New Services: The Internet is perhaps the cheapest medium for
online help. BBS services are available on the Internet through which you
can ask questions and get immediate troubleshooting assistance.

 Wide Area Networks: Using the Internet, organizations can collect and
compile information from offices spread over large geographical areas.

 Shareware Software: The Internet is also a great medium for downloading
free software. You can get a truckload of free games, utilities and trial versions
of software through the Internet.

Types of Connections and Internet Protocols

You can use following options for connecting to the Internet.

Direct Connection
Through a direct connection, a machine is directly connected to the Internet backbone
and acts as a gateway. Though a direct connection provides complete access to all
Internet services, it is very expensive to implement and maintain. Direct connections
are suitable only for very large organizations or companies.

Through Internet Service Provider (ISP)
You can also connect to the Internet through the gateways provided by ISPs. The
range of Internet services varies depending on the ISPs. Therefore, you should use
the Internet services of the ISP that is best suitable for your requirements. You can
connect to your ISP using two methods:

Remote Dial-Up Connection

A dial-up connection (Refer Figure 5.1) enables you to connect to your ISP using
a modem. A modem converts the computer bits or digital signals to modulated or
analogue signals that the phone lines can transmit and vice versa. Dial-up
connections user either SLIP (Serial Line Internet Protocol) or PPP (Point-to-
Point Protocol) for transferring information over the Internet.
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User’s
Computer

Modem Modem
Internet Backbone

Fig. 5.1  Remote Dial-Up Connection

For dial-up connections, regular telephone lines are used. Therefore, the
quality of the connection may not always be very good.

Permanent Dedicated Connection

You can also have a dedicated Internet connection that typically connects you to
ISP through a dedicated phone line. A dedicated Internet connection is a permanent
telephone connection between two points. Computer networks that are physically
separated are often connected using leased or dedicated lines. These lines are
preferred because they are always open for communication traffic unlike the regular
telephone lines that require a dialling sequence to be activated. Often, this line is an
ISDN (Integrated Services Digital Network) line that allows transmission of data,
voice, video and graphics at very high speeds. ISDN applications have revolutionized
the way businesses communicate. ISDN lines support upward scalability, which
means that you can transparently add more lines to get faster speeds,  going up to
1.28 Mbps (Million bits per second).

T1 and T3 are the two other types of commonly used dedicated line types
for The Internet connections. Dedicated lines are becoming popular because of
their faster data transfer rates. Dedicated lines are cost-effective for businesses
that use Internet services extensively.

A Web browser, commonly known as a browser, is a computer application that
creates requests for HTML pages or Web pages and displays the processed HTML
page. Web browsers use HTTP (HyperText Transfer Protocol) to request for
information from Web servers. The two most commonly used Web browsers are:

  Mozilla Firefox

  Microsoft Internet Explorer

Other examples of Web browsers include Mosaic, Cello, Lynx and Netscape
Navigator.

Having knowledge of the basic features of browsers can be helpful in using
them easily.

Toolbar of the Internet Explorer

The toolbar consists of various icons that can be used to execute functions. In fact,
most of the options available through the menu bar are also available through the
icons on the toolbar. Some commonly used icons are:
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Back: The Back button allows you to navigate to the Web page you viewed
last.

Forward: The Forward button on the toolbar navigates to the next Web
page that was accessed previously. To view a list of the last few Web pages
visited, you can click the down arrow button beside the Back and Forward buttons.

Stop: The Stop button can be used to terminate the current Web page
request. This is usually used when you type the wrong URL by mistake and want
to stop the request for the Web page or if the Web page takes too long to download.

Refresh: The Refresh or the Reload button is used to load the current Web
page again. In other words, it refreshes the contents of the current page by fetching
a new copy of it.

Search: The Search button allows you to find information on the Web. You
can find information by clicking on the Search button on the toolbar. This activates
the search text box as shown. You can then type in a word or phrase and click the
‘search’ button to start the search.

Favorites: The Favorites button is used to record the addresses of frequently
visited Web sites. Once a wWeb site or a Web page is added to the favorites list,
it can be revisited by simply clicking on the link in the list. This saves the effort of
typing the URL each time the user wishes to visit the same site.

History: The History button is used to view the list of all the Web pages
visited in the last few days, hours or minutes. To revisit any one of them, simply
click on the address.

Print: The Print button is used to print the contents of the current Web
page.

Net Surfing
Net surfing, Internet browsing or exploring a network on the World Wide Web is
associated with visiting different Web sites on the Internet. It is typically finding
places of interest at the click of a mouse. It is analogous to surfing TV channels
with a remote control.

Searching
Searching is one of the most common uses of the Internet. You can search for any
topic or information on the Internet. This is possible by using websites that provide
a search engine.

Search Engines
A search engine is a software system that enables users to search for information
on the Web using keywords. It is designed to help the Internet users locate the
Internet resources, such as Web pages, documents, programs and images using a
keyword search mechanism. Search engines typically use databases that contain
references to a host of resources. The users interact with a search engine using an
interface. There are many search engines available with different appearances and
search mechanisms. Some commonly used search engines are: Google, Yahoo,
MSN, Altavista, AOL, Ask Jeeves, Lycos, Excite and HotBot.
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Google (http://www.google.com) Yahoo (http://www.yahoo.com)

 
Information is collected by programs; called ‘spiders’ or ‘robots’; following which,
the search engine indexes them. ‘Directories’ also provide similar services by
maintaining a systematic list of Web sites. Search engines function as card catalogues
for the Internet. They try to index and locate the requested information by looking
for the keywords specified by the user. They usually maintain indices of Web
resources, from which the necessary information is retrieved by querying for the
keywords that the user enters.

5.3 WORKING OF INTERNET

TCP/IP

TCP/IP stands for Transmission Control Protocol/Internet Protocol. It was
developed with the objective to specify a suite of protocols capable of providing
transparent communications interoperability services between computers of all
sizes, regardless of the hardware or operating system platforms supporting them.
Over the years, TCP/IP has become the most widespread among today’s protocols.
One reason for TCP/IP’s popularity is the public availability of its protocols’
specifications. In this sense, TCP/IP can justifiably be considered an open system.
Most users rely on TCP/IP for the purpose of file transfers, electronic mail
(E-mail), and remote login services.

LAN standards define physical transmission media and the usability of these
media. These standards conform to the protocols defined in the physical and data
link layers of the OSI reference model as shown in Figure 5.2. Among the protocols
defined in the layers above the data link layer, TCP/IP, IPX/SPX and NetBIOS
are well known. Of these protocols, TCP/IP is the most popular and is employed
for UNIX and the Internet. IPX/SPX is used for Novel’s NetWare. NetBIOS
was developed by IBM for small size LANs and is employed in the Windows 95
or Windows NT environment.
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Fig. 5.2  LAN Standards in Physical and Data Link Layers

Network Architectures

Network architecture defines the communications products and services, which
ensure that various components work together. In the early days of data
communication systems, the majority of communications were between the DTE
and the host computer. Therefore, transmission control procedures were alone
enough as communication protocols. However, recent computer systems link with
other systems to form a network which result in a situation where different protocols
serving for different purposes is required. Hence, the network architecture
represents a systemization of the various kinds of protocols needed to build a
network.

Computer manufacturers have developed different protocols as needed.
This means that each type of computer needed to support different protocols.
This necessitated large development and maintenance costs. All computer
manufacturers,  Table 5.1, worked together to standardize and systemize protocols
to link their models and reduce the development and maintenance costs thereby.
This was how each manufacturer built his own network architecture.

Since the concept of the network architecture was first introduced,
connecting computers of the same manufacturer has become easier. However,
from a user’s perspective, the ideal form of network architecture is one which
enables machines of all manufacturers to connect to each other. Therefore, the
need of standardization of network architecture arose.

Table 5.1  Network Architecture by Vendor

   Manufacturer Network Architecture

   IBM System Network Architecture (SNA)
   DEC Digital Network Architecture (DEC)

   Borroughs Borroughs Network Architecture (BNA)

   UNIV AC Distributed Communication Architecture (DCA)

   Toshiba Advanced Network System Architecture (ANSA)

   NEC Distributed Information Processing Architecture (DINA)

   Honeywell Distributed System Environment (DSE)
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The following are ways to achieve connection between different
manufacturers:

 Protocol converters:  These are devices that translate from one native
protocol into another, for example, from ASCII to IBM SNA/SDLC

 Gateways: These are hardware/software combinations that connect
devices running different native protocols. In addition to protocol
conversion, gateways provide a gateway connection between
incompatible networks. Examples include Ethernet-to-Token Ring
gateways, X.25-to-Frame Relay gateways, and T-carrier-to-E-Carrier
International Gateway Facilities (IGFs).

In addition to the above, Protocol Analyzers are available as diagnostic
tools for displaying and analysing communications protocols. Analysers allow
technicians, engineers and managers to test the performance of the network to
ensure that the systems and the network are functioning according to specifications.
LAN managers, for instance, use protocol analysers to perform network
maintenance and troubleshooting and to plan network upgrades and expansions.

Example of TCP/IP Operations

TCP/IP Layers and Protocols

TCP/IP defines a suite of communications and applications protocols in layer
structure, with each layer handling distinct communication services. TCP/IP defines
a four-layer model as shown in Figure 5.3 consisting of Application, host-to-host,
Internet, and Network Access layers. This architecture is based on three sets of
interdependent processes, namely, application-specific processes, host-specific
processes, and network-specific processes.

Application Layer
(application-specific processes)

Host to Host Layer
(Host-specific processes)

Internet Layer
(routing processes)

Network Access Layer
(network-specific processes)

Fig. 5.3  TCP/IP Communication Architecture

The following are examples of concerns that each of these processes should
handle:

Application-specific processes: TCP/IP defines the External Data
Representation  (XDR) protocol to provide an agreement between the data syntax
running between the different platforms.

Host-specific processes: It is the responsibility of the host-specific process
to establish, maintain, and release a connection on behalf of an application without
losing track of other logical connections on multiuser/multitasking operating systems.
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Therefore, it ensures that data integrity is maintained without confusing the identity
of the communicating applications.

Network-specific processes: These are processes that concerns with the
delivery of data to the transmission medium and route data across networks until
it reaches its ultimate destination.

The correspondence between the TCP/IP and OSI model is shown in Figure
5.2. From Figure 5.3, the relationship between the two figures may be established.
Layer 5, 6 and 7 corresponds to application layer (4th layer) of TCP/IP
communication architecture. In a similar manner layer 4 and 3 of OSI can be
related with the host-to-host layer and Internet layer of TCP/IP suite, respectively.
The physical layer and data link layer of OSI is similar to the network layer of
TCP/IP.

5.3.1  TCP/IP

Transfer Control Protocol (TCP) standard is defined in Request for Comment
(RFC). Its document number is 793 which is given by Internet Engineering Task
Force (IETF). The original specification was written in 1981 and experimented
by Advanced Research Projects Agency Network (ARPANET) for guaranteed
delivery. It’s sliding window protocol facilitates handling for timeouts and
retransmission.

Structure of TCP

TCP connects two endpoints by full duplex virtual connection. Each endpoint
contains an IP address and a TCP port number. The byte stream is moved in
segments. The number of bytes of data sent prior to acknowledgement of the
receiver is determined by the window size. TCP includes ‘Post-it-Note’ process
in its header which has two steps:

Step I

When application requests to send data for remote location, TCP arranges the
initial segment to set up the socket interface between two systems. No data is sent
until and unless TCP gets a message from the receiving system that a socket is
placed for receiving data.

Step II

Once the sockets are ready, TCP starts sending data within segments. It then asks
TCP to acknowledge the arrived data segments. TCP retransmits the segments if
acknowledgement is not received.

TCP Header

TCP header is required for every TCP segment. The header segment is same for
the TCP segment. There are six flag bits in the header namely URG, ACK, PSH,
RST, SYN and FIN. TCP header consists of eleven fields.
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Fig.5.4  TCP Header

Figure 5.4 shows the eleven fields which are in the TCP header. The source port
and destination port contain 16 bits. The sequence number tells the position of
the sequence of the segment’s first data byte. The acknowledgement number
tells the value of the next sequence number (Refer Figure 5.5). Data offset contains
4 bits and indicates the beginning of data section. Reserved contains 6 bits which
is reserved for future use.

Explicit Congestion Notification (ECN) contains 3 bits. Control bits
returns 106 URG for urgent pointer field, 107 ACK for acknowledgement number,
108 PSH for push function, 109 RST to reset the connection, 110 SYN to
synchronize the sequence numbers and 111 FIN to close the connection. Window
size contains 16 bits which contains the maximum size of data that sender receives.
Checksum contains 16 bits which are used for error detection and does not
perform error correction. Urgent pointer also contains 16 bits and indicates a
number of positive offset from the sequence number of last byte for the urgent
data segment. Options padding ensures that TCP header ends. Options occupied
at the end of the TCP header are included in checksum.

Fig. 5.5  Sequence and Acknowledgement Numbers over TCP
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TCP Segment

Fig. 5.6  TCP Segment

Fig. 5.7  TCP Segment Headers

Figure 5.6 and 5.7 show the TCP header format containing the TCP header and
TCP in one packet called a TCP segment. The size of the header without options
is 20 bytes.

TCP Switching

TCP switching is a network architecture which creates a circuit for TCP connection.
It directly controls the creation/destruction of the circuits. It is optimized to 90 per
cent of network traffic. TCP switching is done to increase bandwidth efficiency
and robustness because sometimes network connections should change the routing
table to recover from its failure.

Fig. 5.8  TCP Switching

Figure 4.38 illustrate TCP switching containing established fast and lightweight
circuits triggered by application level data flow. In Figure 5.8, TCP switching inside
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the cloud works as packet switching. Circuit switches makes the core of circuit
switching cloud. Boundary routers work as a gateway between packet switching
and circuit switching.

TCP Protocol

TCP protocol contains a set of rules and communicates applications securely and
independently from the lower level. Data in terms of datagram is concerned with
transport layers. The original machine is called clients which request for the
connection and the recipient machine is called the server which provides the
requested information to the client. Therefore, TCP connection is called a Clinet–
Server connection.

Fig. 5.9  TCP Protocol Layers

Figure 5.9 shows how a TCP protocol works in different layers. It works in four
layers with reference to the TCP model. They are as follows:

 Application layer: In this layer, TCP provides network services such as
http, ftp and telnet.

 Transport layer: In this layer, TCP manages transferring data using
connection oriented (TCP itself) and connectionless (UDP) transport
protocols and also makes connection between networked applications.

 Internet layers: TCP addresses data packets and delivers packets over
network. It manages fragment packets.

 Network interface layer: TCP delivers data via physical links and provides
error detection and packet framing.

The main characteristics of TCP protocol are as follows:

 TCP enables data flow for monitoring.

 It avoids network saturation.

 It makes data to contain variable length segment which returns to the IP
protocol.

 It makes data multiplex where information coming from distinct sources can
be circulated.
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 It enables successful communication between the client and server .

TCP is layered over the following functionality:

 Streams: TCP data is like a file which is organized as a stream of bytes. IT
contains an urgent pointer which lets flagged data out.

 Reliable delivery: It contains sequence numbers of the transmitted and
received data.

 Network  adaptation: It delays the characteristics of network and
maximizes the throughput without overloading the network.

 Flow control: TCP protocol manages data buffers and maintains traffic so
that the buffer don’t overflow.

 Full duplex operation: TCP provides full duplex data transfer mechanism.
For example, application level data is transferred between two hosts such
as process on host A and process on host B in both directions. TCP makes
connection in such a way that application level data can flow from A to B
and B to A at the same time. TCP connection related to multicasting which
is used as point-to-point means of single sender and single receiver.

Fig. 5.10  TCP Send Buffer and Receive Buffer

Figure 5.10 shows how segments are passed down to the network layer. When
TCP sends data from one end, it is known as send buffer and when it receives a
segment which is placed in TCP connections it is known as receive buffer.

TCP—Three-Way Handshake

TCP uses a three-way handshake connection to send and receive data between
hosts based on three phases. They are connection establishment, data transfer
and connection termination. Telnet (Telecommunication network), FTP (File
Transfers), HTTP Hypertext Transfer Protocol (Web request), POP3 (Post Office
Protocol), SMTP (Simple Mail Transfer Protocol) for emails, SSH (Secure Shell)
uses three way handshake protocol when connection takes place. These days,
TCP rides on top of IP which is called TCP/IP (TCP over IP) in which IP facilitates
addressing and routing but TCP handles the actual communication between hosts.

The steps that make the three-way handshake connections over TCP

Step I : Host A sends TCP Synchronize packet to Host B (SYN)

Step II : Host B receives SYN of A (SYN)

Step III : Host B sends Synchronize-Acknowledge (SYN-ACK)

Step IV : Host A receives SYN-ACK (SYN-ACK)

Step V : Host A sends Acknowledge (ACK)

Step VI : Host B receives Acknowledge (ACK)

Step VII : TCP connection is established
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Fig. 5.11  TCP Three-Way Handshake

Figure 5.11 illustrate how the three-way handshake connection is established in
which segment is exchanged.

Fig. 5.12  Sequence of TCP Visited by Client TCP

Figure 5.12 shows how the server side TCP connections are established and shut
down.

Fig. 5.13  Sequence of TCP Visited by Server–Side TCP

Figure 5.13 shows the TCP congestion control is established in server application
which creates a listen sockets.

Security Aspects of TCP
Secure Socket Layer (SSL) provides security services between TCP and
applications. These days, SSL comes in a new version as TLS. SSL/TSL provides
confidentiality using symmetric encryption and message integrity using MAC
(Message Authentication Code) over TCP network setting. This security layer
includes protocol mechanism to enable two TCP users to determine the security
mechanism and services. TCP security mechanism is arranged in different layers
as is shown in Figure 5.14.
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 S/MIME PGP SET 
Kerberos SMTP HTTP 

UDP            TCP 
IP 

Fig. 5.14  Application Level

Note: TCP has the option of forcing IP NOT to transmit packets but implement it
because it can cause security problems where different network technologies are
concerned with TCP.

SSL is intended to utilize TCP to provide an end-to-end security services which is
secure and reliable since World Wide Web is a client/sever application running
over the network and TCP/IP intranets. Therefore, SSI contains a record protocol
which provides confidentiality and message integrity.

Confidentiality is the handshake protocol where three- way handshake
protocol is used in reference to TCP. A shared secret key is used for conventional
encryption of SSL payloads. Message integrity defines a shared secret key which
is also the handshake protocol. This forms a message authentication code (MAC).
They transmit the fragment of data into manageable blocks. MAC encrypts and a
TCP header format is added and the resulting unit is transmitted in a TCP segment.

Fig. 5.15  Proxy Server is Used between TCP and SSL

Figure 5.15 shows how proxy server handles requests to standard TCP
communication with protected SSL security services. It further protects the lack
of authentication of IP packets with TCP.
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Major Features of TCP

The prominent TCP features provide two popular options TCP SACK and TCP
Windows scaling. The primary advantage of TCP Window scaling is to control
congested data. Network connections consist of the host at both ends and the
actual connections, such as telecommunication telephony or satellite worked
together. TCP Window then keeps sending speed smoothly where congestion and
data loss do not occur. It provides confidential and reliable data delivery over
network. It is needed for efficient transfer of data when the bandwidth delay is
greater than 64 K, whereas timestamps are used to avail two mechanisms such as
Round Trip Time Measurement (RTTM) and Protect against Wrapped Sequences
(PAWS). TCP SACK option provides the list of missed packets. For example, if
a server checks an acknowledgement with ACK no 101, TCP SACK checks
that missed packet is 5201-5202; the result goes with SACK option. Iptable
firewall then checks it and generates a reject message.

The major features of TCP are as follows:

 TCP is a connection based protocol which first prepares a setup before
transferring data.

 It facilitates acknowledgements which performs safe receipt of packets.

 TCP detects duplicate/missing/corrupted packets. It has a good relative
throughput on modem and LAN.

 It maintains sequence numbers which reassembles the data packets in which
they sent earlier.

 TCP data packets follow the stream from the application side.

 TCP is used for Telnet (Telecommunication Network), FTP (File Transfer
Protocol), HTTP (Hypertext Transfer Protocol), and SMTP (Simple Mail
Transfer Protocol).

 TCP maintains data order, it means if 5 data packets are sent to destination
then data packet 1 is received before data packet 2.

 Routers always take notice of TCP packets. If they are not transmitted in
an order and without duplication, TCP buffers and retransmits them.

 It has few socket options which tolerate the built-in control. However, it
has no block boundaries and cannot be used in broadcast or multicast
transmission. It transfers servers which maintain a separate socket and
separate thread for each client.

 It uses four algorithms which provide congestion control, congestion
avoidance and slow start, fast retransmit and fast recovery. Losing packets
indicates congestion. It checks the availability of bandwidth and changes
the delays on the link which solves the loopholes with the help of algorithms.

 TCP issues a process for the web browser. In the process, the browser
sends data such as URL to a destination host such as the web server. TCP
creates an initial segment which connects the sender (browser) and receiver
(server). They change the IP address and port numbers to create a socket
interface and set sup flow control and sequencing methods.
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Features of TCP Security

The key features of TCP security includes as follows:

 Only inbound packets are blocked.

 Outbound traffic and response and response of inbound traffic are not
affected.

 ICMP (Internet Control Message Protocol) packet flowing is not controlled
using TCP security filters.

 TCP latency is introduced as acknowledgements where VPNs (Virtual
Private Networks) are built on top of other protocols for performance
reasons. There is also significant overhead in each packet to accommodate
all the TCP/IP metadata.

Passive and Active Operation

Active and passive data operations are supported in network data operations.

A passive operation responds to external activity such as request for data
on the network. For example, data packets calculate checksum operation with
those data which pass through it. This operates passive operation because the
data packets are executed only when another network entity gives data. Data is
easily accessed through this operation.

An active operation over network is an important device which recognizes
its data into efficient structure during congesting period. It actively pushes data
into the level of memory hierarchy.

Active and passive operation updates an existing operation such as data
packet duplication/corruption and network database through servers and node
clients.

Transmission Control Block (TCB)

Data Transmission by TCP and Ethernet

TCP/IP encapsulate upper layers using headers for the purpose of exchanging
control and status information about the progress of the communication because
its protocols also engage in peer talk by encapsulating data with protocol headers
before submitting it to the underlying layer for subsequent delivery to the network.
Figure 5.19 represents the data communication using TCP/IP and Ethernet as it is
passed down the layers by an application on node X to node Y across the network. 

A header is added to the data at each layer before being sent to the receiving
node. The same header is removed at the receiving end in the reverse order as
shown in Figure 5.16. In Figure 5.17, when a node wishes to transmit a data, the
application layer of TCP/IP architecture adds a header as TCP header which is
again complemented by IP header and Ethernet header in the lower layers.
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Fig. 5.16  TCP/IP Data Encapsulation

Figure 5.17 shows the configuration of each header. The addresses included
in the TCP, IP and Ethernet headers are port numbers, IP addresses, and MAC
addresses, respectively.

At the transport layer, the header includes destination and source port
numbers. For example, port number 25 identifies a SMTP session, whereas port
number 80 HTTP session. Therefore, upon receiving data from the Internet layer,
the transport layer fetches its own header for the destination port number to identify
the application that it is supposed to deliver the data to. This mechanism helps the
transport layer establish connections on behalf of multiple applications without
confusing the data exchange process. The protocol data unit thus formed at this
layer is normally referred to as a data segment.

At the Internet layer, the header contains information to identify the IP
addresses of the ultimate communicating hosts and intervening routers.

At the network access layer, the header includes the MAC addresses of the
source and destination devices communicating on the same physical network. A
frame check sequence is also included to assist the network access layer in checking
the integrity of the received data. The protocol data unit thus formed at this layer is
normally referred to as a data frame.

Fig. 5.17  Configuration of TCP, IP and Ethernet Header
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Route Discovery Protocol and its Examples

Route Discovery Protocol (RDP) is a standard protocol which is used to inform
the router on which they send packets. It also used wiretapping routing protocols
such as RIP which is configured as default routes in hosts. It has two portions; one
is the server portion which runs on routers and the client portion which runs on
hosts.

The RDP Server

The RDP servers run on routers. They are based on multicasting or broadcasting
on which the router advertisements are enabled over each interface. Then, the
host sends a router solicitation which requests an advertisement. Once the
advertisement is sent, all host multicasts are addressed as 224.0.0.1 and an interface
is configured as limited broadcast address 255. 255. 255. 255. If the whole
process takes place then the net or subnet address is included in the advertisement.

The RDP Client

The RDP client runs on hosts. It only hears those router advertisements which
have all host mutilicast addresses 224.0.0.1 and interfaces on broadcast address.
When RDP client receives a router advertisement, the host installs a default route
to each of the addresses listed in the advertisement, as can be seen in Figure 5.18.

Router

lan0

Host A Host B

RDP
Client

RDP
Client

RDP
Server

Fig. 5.18 RDP Server and Clients

Application Layer Protocols

TCP/IP Services and Application Protocols

This section presents an overview of the most common protocols used for TCP/
IP communication. The discussion focusses on the nature of these applications
and the purpose they serve.

The Client/Server Model

TCP/IP applications operate at the application or process layer of the TCP/IP
hierarchy as discussed in the preceding sections. TCP/IP protocol splits an
application into server and client components. Figure 5.19 illustrates that the server
component is a service provider that controls commonly shared resources
pertaining to a particular application on the network. The server normally runs on
a remote, high-powered computer to which only authorized users have an access.
The client component is the service user, by which to this piece of software engages
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with the serve. It is done in a sequence of request-response datagrams fulfilling
certain user-specified demands or requirements.

The client/server computing model (as illustrated in Figure 5.19) has the
following attributes:

 Flexible deployment:  This can be easily customized.

 Low computer cost:  Reduced processing requirement at the client
end. In most cases, the client has to deal with lesser details of the
application compared to the server. This, in turn, means cheaper hardware
on the client machine (less CPU power, memory, disk space, and so
on).  On the other hand, the server must be powerful enough and well-
outfitted to make it respond satisfactorily to the user demands on its
services.

Fig. 5.19 The Client–Server Computing Model

 Increased network management costs:  Reduced loss of bandwidth
from unnecessary data traffic, due to the exchange of data on an as-
needed basis. In the case of an Ethernet LAN, this also contributes to
reduced collisions and therefore, better networks availability.

 Lower transmission facility costs.

Telnet

Telnet is a program that allows a user with remote login capabilities to use the
computing resources and services available on the host. Telnet can also be used to
connect other ports serving user defined as well as well-known services. The
telnet program requires two arguments that is the name of a computer on which
the server runs and the protocol port number of the server. Telnet service is unique
since it is not platform-specific like other TCP/IP services. A DOS user running
Telnet, for example, can connect to a UNIX host or a mainframe computer. The
down side of using Telnet, however, is that unless the user is familiar with the
operating system running on the remote platform, he or she cannot use the desired
resources easily.

File Transfer Protocol (FTP)

File Transfer protocol is among the oldest protocols still used in the internet. FTP
is widely available on almost all-computing platforms, including DOS, OS/2, UNIX,
and up to the mainframe level. FTP is a file server access protocol that enables a
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user to transfer files between two hosts across the network or Internet. This is also
established through TCP. Accessing FTP sites over the Internet requires that the
user must have the knowledge of the location and the name of the desired files.

Unlike Telnet, FTP does not require any familiarity with the remote operating
system. The user is still required, however, to be familiar with the FTP command
set built into the protocol itself so that he or she can productively manage the
session.

Modern FTP servers known as ftpd support two modes, the classic normal
mode and more security conscious passive mode or PASV mode.

Trivial File Transfer Protocol (TFTP)

TFTP, like FTP, is also an Internet service intended for the transfer of files between
hosts. Unlike FTP, however, TFTP does not rely on TCP for transport services.
Instead, TFTP uses UDP to shuttle the requested file to the TFTP client.

Simple Mail Transfer Protocol (SMTP)

The Simple Mail Transfer Protocol is an electronic mail (E-mail) service provider.
It is intended for the transfer of E-mail messages across the network. SMTP uses
TCP transport for the reliable delivery of mail messages.  When there is an outgoing
mail, the SMTP client will connect to the SMTP server and sends the mail to the
remote server.

Network File System (NFS)

Network file system service enables hosts across the network to share file system
resources transparently among themselves. Although it all started on UNIX
platforms, NFS can be implemented on any platform, including DOS, NetWare,
and Windows NT.

Simple Network Management Protocol (SNMP)

Using the Simple Network Management Protocol, LAN administrators can monitor
and tune the performance of TCP/IP (as well as non-TCP/IP) networks. Using
SNMP, all kinds of information about network performance can be gathered,
including statistics, routing tables, and configuration-related parameters. The
information and configuration gathering capabilities of SNMP make it an ideal tool
for network troubleshooting and performance tuning.

Domain Name System (DNS)

Due to Internet explosion, it is not practical to keep an exhaustive host file for
every host because of the sheer volume of listing as well as addition, deletion and
updating of new, old and current hosts. Therefore, DNS is used to provide host-
to-IP address mapping of remote hosts to the local hosts and vice versa.

You know that each device connected directly to the network must have an
IP address that is uniquely assigned to it. The address takes the form of a dotted
decimal notation such as 128.45.6.89 (to be explained later on) to make a machine
connected on the network and consequently accept connections as well as request
them. The addresses in the form of dotted notations are very difficult to remember
for a large number of services residing on the network. DNS enables system
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administrators solve this problem by facilitating a kind of directory that associates
IP addresses with names that can be both friendly and meaningful to the user. If
you enter www.hotmail.com, DNS resolves the name to its associated IP address
on behalf of the client.

What does the address www.hotmail.com mean? The answer lies in the
DNS system. DNS is hierarchical system, which organizes host names in hierarchy
of domain names. The name uniqueness problem is also solved as host name to be
unique within its domain. Moreover, large domains can also be split into sub-
domains. For example, www.hotmail.com can be split into www.rag.hotmail.com
and www.bbt.hotmail.com.

5.3.2 Internet Applications

The Internet has made things simpler. It can serve the following purposes :

 Direct Communication: You can send messages to family and friends,
business associates and acquaintances using the electronic mail facility. Using
electronic mail, you can send and receive messages within a few seconds
anywhere in the world. Using Internet Relay Chat (IRC), you can
communicate online with people over the Internet. You can log into a chat
room and converse with others by typing messages that are instantly
delivered. With the improvement of network technologies and increase in
broadband, not only can you use text messages but also graphics, audio
and video for communication with other people.

 Online Shopping: Logically, the Internet has removed all barriers of distance
and nationality. You can shop for products and services across the world
by logging on to a Web portal. You can also pay your bills online using
credit and debit cards. You can also transfer money between different
accounts with the click of a mouse.

 Distance Education: The Internet provides a perfect medium for
knowledge sharing and information dissemination. Courses are available
on the Internet. You can register and pay online, and complete a course on
different interest areas. You can also pursue specialized higher studies now
in the comfort of your own office or home.

 Knowledge Base: The Internet provides a rich information base that people
from across the globe can access. In fact, it is one of the richest information
bases that can be accessed at the click of a mouse. Using search engines,
you can search for detailed information on any topic of your interest.

 Banking: Banks are using information technology to provide online banking
facilities to their customers. Using the Internet, you can now view your
account details, get drafts made, request for chequebooks and transfer
money from one account to another. The use of ATMs has shifted the
mundane back-office work to the customer himself. Instead of hiring an
army of bank clerks, banks can now uses ATMs to considerably reduce
time and operational costs.

 Travel: Using the Internet, travel agencies can publish their services on the
Web along with the latest discounts, packages and availability details, so
that customers can compare rates, make online bookings and avail discounts
without having to run around multiple offices.
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 Bill Payments: The government sector has also realized the benefits of IT.
Now you can make online payments for public utilities such as water,
electricity and phones, using credit cards as the payment medium.

5.4 COMPUTER NETWORKS

In the mainframe and minicomputer environment, each user is connected to the
main system through a dumb terminal that is unable to perform any of its own
processing tasks. In this computing environment, processing and memory are
centralized. However, this type of computerization has its merits but the major
disadvantage is that the system could get easily overloaded as the number of
users, and consequently, terminals increase. Second, most of the information is
centralized to one group of people, the systems professionals rather than the end-
users. This type of centralized processing system differs from the distributed
processing system used by LANs. In a distributed processing system, most of the
processing is done in the memory of the individual PCs or workstations besides
sharing expensive computer resources like software, disk files, printers and plotters,
etc.

There may arise a question why PCs cannot be connected together in a
point-to-point manner. The point-to-point scheme provides separate
communication channels for each pair of computers. When more than two
computers need to communicate with one another, the number of connections
grow quickly as the number of computers increase. Figure 5.20 illustrates that
two computers need only one connection, three computers need three connections
and four computers need six connections.

Figure 5.20 illustrates that the total number of connections grow more rapidly
than the total number of computers. Mathematically, the number of connections
needed for N computers is proportional to the square of N:

Point-to-point connections required = (N2–N)/2

Figure 5.20 (a), (b), (c) Number of Connections for 2, 3, 4 Computers, Respectively

Adding the Nth computer requires N–1 new connections, which becomes
a very expensive option. Moreover, many connections may follow the same physical
path. Figure 5.21 shows a point-to-point connection for five computers located at
two different locations, say, ground and first floor of a building.
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Fig. 5.21 Five PCs at Two Different Locations

As there are five PCs, total ten connections will be required for point-to-
point connection. Out of these ten connections, six pass through the same location
thereby making point-to-point connection an expensive one. By increasing the PC
by one in the above configuration, at location 2 as shown in Figure 5.21, will
increase the total number of connections to fifteen. Out of these connections, eight
connections will pass through the same area.

LAN: Definition

Networks that are privately owned offer consistent fast paced communication
channels which are optimized to connect information processing tools in a restricted
geographical area. These are known as Local Area Networks (LANs).

A shared, local (restricted-distance) packet network for computer
communication is a form of LAN. A common medium is used by LAN to  link
peripherals and computers  so that the user can share access to databases, files,
host computers, peripherals and applications.

LANs in addition to linking the computer equipment available in a particular
premises also provides a connection to other networks either through a computer,
which is attached to both networks, or through a dedicated device called a gateway.
The main users of LANs include business organizations, research and development
groups in science and engineering, industry and educational institution. The
electronic or paperless office concept is possible with LANs.

LANs offer raw bandwidth of 1 Mbps to 100 Mbps or more, although
actual throughput often is much less. LANs are limited to a maximum distance of
only a few miles or kilometers, although they may be extended through the use of
bridges, routers, and other devices. Data is transmitted in packet format, with
packet sizes ranging up to 1500 bytes and more. Mostly, IEEE develops LAN
specifications, although ANSI and other standards bodies are also involved.

Advantages of Networks

LANs are used almost exclusively for data communication over relatively short
distances such as within an office, office building or campus environment. LANs
allow multiple workstations to share access to multiple host computers, other
workstations, printers and other peripherals, and connections to other networks.
LANs are also being utilized for imaging applications. They are being used for
video and voice communication as well, although currently on a very limited basis.

LAN applications include communication between the workstation and host
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computers, other workstations and servers. The servers may allow sharing of
resources. Resources could be information, data files, e-mail, voice mail, software,
hardware (hard disk, printer, fax, etc.) and other networks.

LAN benefits include the fact that a high-speed transmission system can be
shared among multiple devices in support of large number of active terminals and
a  large number of active applications in the form of a multi-user, multi-tasking
computer network. LAN-connected workstations realize the benefit of
decentralized access to very substantial centralized processors, perhaps in the
form of mainframe host computer and storage capabilities (information repositories).
Additionally, the current technology allows multiple LANs to be inter-networked
through the use of LAN switches, routers, etc.

Disadvantages of LANs include concern for security of files and accounts.

Broadband versus Baseband

There exist two LAN transmission options, Baseband and Broadband. Baseband
LANs, which is the most prevalent by far, is a single-channel system that supports
a single transmission at any given time. Broadband LANs, which are most unusual,
support multiple transmissions via multiple frequency channels.

Baseband May Use UTP, Coaxial or Fibre

Broadband Using Coaxial Cable

Channel

1 

2 

3 

Fig. 5.22 Broadband versus Baseband

Broadband LANs

Broadband LANs are multichannel, analogue LANs as shown in Figure 5.22.
They are typically based on coaxial cable as the transmission medium, although
fibre optic cable  is also used. Individual channels offer bandwidth of 1 to 5 Mbps,
with 20 to 30 channels typically supported. Aggregate bandwidth is as much as
500 MHz. Its characteristics are:

 Stations connected via RF modems, i.e. radio modems accomplish the digital-
to-analogue conversion process, providing the transmitting device access
to an analogue channel.
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 Digital signal modulated onto RF carrier (analogue).

 Channel allocation based on FDM.

 Head-End for bidirectional transmission.

Advantages

 Greater bandwidth

 Data, voice and video can be accommodated on broadband channel

 Greater distances

Disadvantages

 High cost, requires modems

 Lack of well-developed standards

 Cable design

 Alignment and maintenance

Some broadband LANs are referred to as 10Broadband36 where 10 stands
for 10 Mbps, Broadband for multichannel and 36 for 3600 metres maximum
separation between devices.

Baseband LANs

Baseband LAN is a single channel, supporting a single communication at a time as
shown in Figure 5.22. They are digital in nature. Total bandwidth of 1 to 100
Mbps is provided over coaxial cable, UTP, STP, or fibre optic cable. Distance
limitations depend on the medium employed and the specifics of the LAN protocol.
Baseband LAN physical topologies include the ring, bus, tree, and star topologies.

Baseband LANs are by far the most popular and the most highly standardized.
Ethernet, Token Passing, Token Ring and FDDI LANs are all baseband. They
are intended only for data, as data communication is, after all, the primary reason
for the existence of LANs. The characteristics of this system may be summarized
as follows:

 No need of modems – low cost installation

 Bidirectional propagation of signal

 Unmodulated digital signal

 Single channel

 Stations connected via T connectors

Advantages

 Simplicity

 Low cost

 Ease of installation and maintenance

 High  rates

Disadvantages

 Limited distances

 Data and voice only
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 Communication Media

1. Bounded Media

Bounded media or wired transmission systems employ physical media which are
tangible. Also known as conducted systems, wired media generally employ a metallic
or glass conductor which serves to conduct a few types of electromagnetic energy.
For example, a copper medium is employed to conduct electrical energy by a
twisted pair and coaxial cable system. Fibre optic systems conduct light or optical
energy, generally using a glass conductor. The term bounded or guided media
refers to the fact that the signal is contained within an enclosed physical path.
Finally, bounded media refers to the fact that some form of shield, cladding, and/
or insulation is employed to bind the signal within the core medium, thereby
improving signal strength over a distance and enhancing the performance of the
transmission system in the process. Twisted pair (both unshielded and shielded),
coaxial and fibre optic cable systems fall into this category.

Twisted Pair (Copper Conductors)

Figure 5.23 shows a pair of copper wires which are twisted together and wrapped
with a plastic coating as a twisted pair and which has a diameter of 0.4-0.8.The
error rate of transmission and the electrical noise is reduced by the twisting. Each
conductor is separately insulated by some low-smoke and fires retardant substance.
Polyethylene, polyvinyl chloride, flouropolymer resin and Teflon(r) are some of
the substances that are used for insulation purposes.

Fig. 5.23 Two Wires Open Lines

Twisting process serves to improve the performance of the medium by
containing the electromagnetic field within the pair. Thereby, the radiation of
electromagnetic energy is reduced and the strength of the signal within the wire is
improved over a distance. This reduction of radiated energy also serves to minimize
the impact on adjacent pairs in a multiple cable configuration. This is especially
important in high-bandwidth applications as higher frequency signals tend to lose
power more rapidly over distance. Additionally, the radiated electromagnetic field
tends to be greater at higher frequencies, impacting adjacent pairs to a greater extent.
Generally, the more the twists per foot, the better the performance of the wire.

These are popular for telephone network. The energy flow is in guided
media. Metallic wires were used almost exclusively in telecommunication networks
for the last 80 years, until the development of microwave and satellite radio
communications systems. The copper wire has developed into an established
technology which is strong and cost effective. In certain applications, copper-
covered steel, copper alloy, nickel- and/(or) gold-plated copper and even aluminum
metallic conductors are employed.

The maximum transmission speed is limited in this case. The copper conductor
that carries analogue data can be used to carry digital data also in association with
modem. Modem is a device that changes analogue signals into digital signals and
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vice versa. In this category, data rate is restricted to approximately 28 kbit/s.The
use of better modulation and coding schemes led to the introduction of Integrated
Services Digital Network (ISDN) along with an increased data rate of 128 kbit/s.
Local Area Networks (LANs) also use twisted pairs. These networks also
upgraded to support for high bit rate real time multimedia. In Asymmetric Digital
Subscriber Lines (ADSL) technology, there has been a new progress which
intended to use two cooper loops at a data rate of 1.544 Mbps. This data rate is
developed towards the user direction in the network and data rates upto
600 kbit/s from the user to network.

The twisted pair cable may be defined in two categories based upon the
shielding and without shielding.

In Figure 5.24, Unshielded twisted pair (UTP) is shown as a copper medium
which has come from telephony which is being utilized more and more for data
rates. It is fast becoming a practice for horizontal wiring. It states the link between
the end in the communication closet and the outlet which is further restricted to 90
metres. Communication closet is universal to every application working over the
media and is independent of the type of media.

Additionally, in the work area, there is a grant for 3 meters and for cross
connecting in the closet for a whole of 99 metres, it is 6 metres.

The suggested connectors and media for horizontal wiring are discussed as
follows:

 150 ohms Shielded Twisted Pair (STP) contains 2 pairs (IBM connector
or RJ45).

 100-ohm UTP contains 4 pairs and 8-pin modular connector (ISDN).

 62.5/125 contains multi-mode fibre.

 50ohm coax (thin)-IEEE10BASE2, standardBNC connector.

A UTP cable contains 2 to 4200 twisted pairs. Flexibility, cost-effective
media and usability of both data communications and voice are the biggest
advantages of UTP. On the other hand, the major disadvantage of UTP is the fact
that the bandwidth is limited. This limits long distance transmission with low error
rates.

Single pair

Fig. 5.24  Unshielded Twisted Pair (UTP)
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Shielded Copper or STP

Shielded twisted pair (STP) differs from UTP in the metallic shield or screen which
surrounds the pairs, which may or may not be twisted. As illustrated in Figure
5.25, the pairs can be individually shielded. A single shield can surround a cable
containing multiple pairs or both techniques can be employed in tandem. The shield
itself is made of aluminium, steel, or copper. The shield is in the form of a metallic
foil or woven meshes and is electrically grounded. Although less effective, the
shield sometimes is in the form of nickel and/(or) gold plating of the individual
conductors.

Figure 5.25  Shielded Twisted Pair (STP) Configuration

Shielded copper offers the advantage of enhanced performance for reasons
of reduced emissions and reduction of electromagnetic interference. Reduction of
emissions offers the advantage of maintaining the strength of the signal through the
confinement of the electromagnetic field within the conductor. In other words,
signal loss is reduced. An additional benefit of this reduction of emissions is that
high-frequency signals do not cause interference in adjacent pairs or cables.
Immunity from interference is realized through the shielding process, which reflects
electromagnetic noise from outside sources, such as electric motors, other cables
and wires and radio systems.

Shielded twisted pair, on the other hand, has several disadvantages. First,
the raw cost of acquisition is greater as the medium is more expensive to produce.
Second, the cost of deployment is greater as the additional weight of the shield
makes it more difficult to deploy. Additionally, the electrical grounding of the shield
requires more time and effort.

General Properties of Twisted Pair

Gauge: Gauge is a measure of the thickness of the conductor. The thicker the wire,
the less the resistance, the stronger the signal over a given distance, and the better
the performance of the medium. Thicker wires offer the advantage of greater break
strength. The gauge numbers are retrogressive. In other words, the larger the number,
the smaller the conductor.

Configuration: In a single pair configuration, the pair of wires is enclosed in a
sheath or jacket, made of polyethylene, polyvinyl chloride or Teflon. Usually, multiple
pairs are so bundled as to minimize deployment costs associated with connecting
multiple devices (e.g., electronic PBX or KTS telephone sets, data terminals, and
modems) at a single workstation.
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Bandwidth: The effective capacity of twisted pair cable depends on several factors,
including the gauge of the conductor, the length of the circuit and the spacing of the
amplifiers (repeaters). One must also recognize that a high-bandwidth (high
frequency) application may cause interference with other signals on other pairs in
close proximity.

Error performance: Signal quality is always important, especially relative to data
transmission. Twisted pair is susceptible to the impacts of outside interference, as
the lightly insulated wire act as antennae and, thereby, absorbs such errant signals.
Potential sources of Electromagnetic Interference (EMI) include electric motors,
radio transmissions and fluorescent light boxes. As transmission frequency increases,
the error performance of copper degrades significantly with signal attenuation
increasing approximately as the square root of frequency.

Distance: Twisted pair is distance limited. As distance between network element
increases, attenuation (signal loss) increases and quality decreases at a given
frequency. As bandwidth increases, the carrier frequency increases, attenuation
becomes more of a issue, and amplifiers (repeaters) must be spaced more closely.

Security: Twisted pair is inherently an insecure transmission medium. It is relatively
simple to place physical taps on UTP. Additionally, the radiated energy is easily
intercepted through the use of antennae or inductive coils, without the requirement
for placement of a physical tap.

Cost: The acquisition, deployment and rearrangement costs of UTP are very low,
at least in inside wire applications. In, high-capacity, long distance applications, such
as interoffice trunking, however, the relative cost is very high, due to the requirements
for trenching or boring, conduit placement, and splicing of large, multipair cables.
Additionally, there are finite limits to the capacity and other performance
characteristics of UTP, regardless of the inventiveness of technologists. Hence, the
popularity of alternatives such as microwave and fiber-optic cable.

Applications: UTP’s low cost including recently developed methods of improving
its performance has increased its application in short-haul distribution systems or
inside wire applications. Current and continuing applications include the local loop,
inside wire and cable and terminal-to-LAN. UTP no longer is deployed in long haul
or outside the premises transmission systems.

The additional cost of shielded copper limits its application to inside wire
applications. Specifically, it is generally limited to application in high-noise
environments. It is also deployed where high frequency signals are transmitted and
there is concern about either distance performance or interference with adjacent
pairs. Examples include LANs and image transmission.

Coaxial Cable

The core factor that limits a twisted pair cable is due to the skin effect. The flow of
the current in the wires is likely to flow only on the wire's outer surface as the
frequency of the transmitted signal raises, thus, less of the available cross-section
is used. The electrical resistance of the wires is increased for signals of higher
frequency which leads to higher attenuation. Further, significant signal power is
lost due to the effects of radiation at higher frequencies. Thus, another kind of
transmission medium can be used for applications that require higher frequencies.
Both these effects are minimized by coaxial cable.
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Coaxial cable as shown in Figure 5.26 is a robust shielded copper wire
two-conductor cable in which a solid center conductor runs concentrically (coaxial)
inside a solid outer circular conductor. This forms an electromagnetic shield around
the former that serves to greatly improve signal strength and integrity. The two
conductors are separated by insulation. A layer of dielectric (nonconductive)
material, such as PVC or Teflon, protects the entire cable.

The coaxial cable comes under the category of a bounded media and is still
an effective medium to use in data communication. For better performance, coaxial
cable contains shields which make it costly. Cable television uses coaxial cables.
LANs functions over coaxial cable to the 10Base5, 10Base2 and 10BaseT
specifications.Generally, coaxial cable allows longer distance transmission instead
of twisted pair cable at a higher data rate. This is however, costly.

There are two types of coaxial cables.

Baseband: It transmits a single signal at a time at very high speed. The
signal on baseband cable must be amplified at a specified distances. It is
used for local area networks.

Broadband: It can transmit many simultaneous signals using different
frequencies.

Centre

Fig. 5.26  Coaxial Cable Configuration

General Properties of Coaxial Cable

Gauge: The gauge of coaxial cable is thicker than the twisted pair. While this
increases the available bandwidth and increases the distance of transmission, it also
increases the cost. Traditional coaxial cable is quite thick, heavy and bulky of which
Ethernet LAN 10Base5 is an example. Ethernet LAN 10Base2 is of much lesser
dimensions but offers less in terms of performance.

Configuration: Coaxial cables comprise of a two-conductor wire which is single,
with an outer shield (conductor) made of solid metal and a centre conductor. At
times, stranded or braided metal is employed. Twin axial cables contain two such
configurations within a single cable sheath. The centre conductor carries the carrier
signal and the outer conductor generally is used for electrical grounding. Coaxial
cable connectivity can be extended through the use of twisted pair with a BALUN
(Balanced/Unbalanced) connector serving to accomplish the interface.

Bandwidth: The effective capacity of coaxial cable depends on several factors,
including the gauge of the center conductor, the length of the circuit, and the spacing
of amplifiers and other intermediate devices.  The available bandwidth over coaxial
cable is very significant, hence it is used in high capacity applications, such as data
and image transmission.
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Error performance: Coaxial cable performs exceptionally well due to the outer
shielding. As a result, it is often used in data applications.

Distance: Coaxial cable is not so limited as UTP, although amplifiers or other
intermediate devices must be used to extend high frequency transmissions over
distances of any significance.

Security: Coaxial cable is inherently quite secure. It is relatively difficult to place
physical taps on coaxial cable. Radiation of energy is also minimal hence interception
of it is not easy.

Cost: The acquisition, deployment, and rearrangement costs of coaxial cables are
very high, compared with UTP.  In high capacity data applications, however, that
cost is often outweighed by its positive performance characteristics.

Applications: Coaxial cable’s superior performance characteristics make it the
favoured medium in many short hauls, bandwidth-intensive data applications. Current
and continuing applications include LAN backbone, host-to-host, host-to-peripheral
and CATV.

Optical Fibre

We have seen in the previous section that the geometry of coaxial cable significantly
reduces the various limiting effects, the maximum signal frequency, and hence the
information rate that can be transmitted using a solid conductor, although very
high, is limited. This is also the case for twisted lines. Optical fibre is different from
the transmission media. The transmitted information is carried through a beam of
light which is fluctuating in a glass fibre instead of a wire or an electrical signal. This
type of transmission has become strong support for digital network owing to its
high capacity and other factors favourable for digital communication.

Fibre optic transmission systems are opto-electric in nature. In other words,
a combination of optical and electrical electromagnetic energy is involved. The
signal originates as an electrical signal, which is translated into an optical signal, the
optical signal subsequently is reconverted into an electrical signal at the receiving
end. Figure 5.27 shows a clean, thin glass fibre reflecting light internally as the
transmission carries light with encoded data. Fibres can bend without breaking
with the help of plastic jacket. Light Emitting Diode (LED) or laser injected light
for transmission into the fibre. Receivers that are light sensitive translate light back
into data at the other end.

Fig. 5.27  Optical Fibre Cable — General View

The optical fibre consists of a number of substructures as shown in Figure
5.28. In this case, a core made of glass, In this case, the glass core carrying the



Information Technology
and Society

NOTES

Self - Learning
Material 297

light is encircled by a glass cladding which has lower refractive index. Thus, blending
the light and confining it to the core. A substrate layer of glass encircled the core
thus, adding to the diameter and the power of the fibre.This layer of glass, however,
doesn’t carry light. The mechanical protections cover the secondary buffer coating
and primary buffer coating.

Fig. 5.28  Glass Optical Fibre Cable Side View and Cross-Section

The light pulse travels down the center core of the glass fibre. Surrounding
the inner core is a layer of glass cladding, with a slightly different refractive index.
The cladding serves to reflect the light waves back into the inner core. Surrounding
the cladding is a layer of protective plastic coating that seals the cable and provides
mechanical protection. This is shown in Figure 5.28. Typically, multiple fibres are
housed in a single sheath, which may be heavily armored.

Light propagates along the optical fibre core in one of the following ways as
given below depending on the type and width of core material used.

Multimode fibre: Compared to the wavelength of light, the diameter of the core
is relatively large. This is known as multimode fibre. In comparism to the wavelength
of light, which is about 1 µm, core diameter ranges from 50 micrometers (µm) to
1,000 µm.It is therefore, called multimode, because light can travel through the
fibres in various ray paths. In multimode, light spreads through the fibre in various
modes or paths of rays.

Multimode fibre is less expensive to produce and inferior in performance
because of the larger diameter of the inner core. When the light rays travel down
the fibre, they spread out due to a phenomenon known as modal dispersion.
Although reflected back into the inner core by the cladding, they travel different
distances and, therefore, arrive at different times. The received signal thus has a
wider pulse width than the input signal with a corresponding decrease in the speed
of transmission. As a result, multimode fibre is relegated to applications involving
relatively short distances and lower speeds of transmission, for example, LANs
and campus environments.

Two types of multimode fibres exist. The old and simple sort is the ‘step
index’ fibre. Here, the refraction index, which is the capability of an object to bend
light, is similar across the fibre core.

Step Index Multimode Fibre

Step index multimode fibre is shown in Figure 5.29. With various means of
propagation or ray paths, diverse rays traverse various distances, and varied periods
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of time for the fibre length to transit are taken. Therefore, in a fibre, if a small pulse
of light is infused, the different rays that emanate from the short pulse will come at
the other side of the fibre at various times, and the input pulse  will be of  a shorter
period of time than the output pulse. This is known as ‘Modal Dispersion’ (pulse
spreading) which restricts the amount of pulses per second that transmits down
the fibre and is recognized as separate pulses at the different end. Therefore, a
bandwidth or bit rate of a multimode fibre is limited. When a bandwidth is around
20 to 30 MHz over one kilometer of a fibre, stated as ‘MHz - km’, there is no
effort to compensate for modal dispersion in case of step index fibres.

Input
Pulse 

High-order
Mode Dispersion 

Multimode Step Index 
Low-Order

Mode 

Output
Pulse 

Refractive
Index Profile 

r 

r 

h2 

h

h1 

 

Fig. 5.29  Step Index Multimode Fibre

Graded index multimode fibre: The refraction index across the core is altered
slowly from the highest at the centre to the lowest near the edges; therefore, it is
termed as the graded index. This proves the fact that light passes through rapidly
in a low-index-of-refraction material than a high-index material. In the graded
index fibre, a short pulse of light is launched which spreads during its transit of the
fibre. Therefore, dispersion can be reduced using a core material that has a variable
refractive index. In such multimode graded index fibre light is refracted by an
increasing amount as it moves away from the core as shown in Figure 5.30. This
results in the narrowing of the pulse width of the received signal in comparison
with stepped index fibre. This enables a corresponding increase in the transmission
speed. Therefore, they are capable of supporting a much higher bandwidth or bit
rate. Usually, bandwidths of graded index fibres are between 100 MHz-km to
well over 1 GHz-km. The bandwidth is dependant on two things. One on the
extent a specific index profile of the fibre reduces modal dispersion, and second
on the light's wavelength introduced into the fibre.
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Fig. 5.30  Light Propagation in Graded Index Multimode Fibre
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Monomode/singlemode fibre: This has a thinner inner core. The core diameter
which is approximately 9 µm is much nearer in size to the light's wavelength which
is spread by around 1.3 µm. The transmission of light is thus, limited to one ray or
mode of light which propagates down the fibre core as shown in Figure 5.31.
Hence, effects of multimode or a multiple-mode are reduced. However, the
mechanism of one pulse-spreading continues. ‘Chromatic Dispersion’ is a
phenomenon where many wavelengths of light move at various speeds. This causes
small pulses of light, like in the case of multimode fibres, to spread as they travel.

Fig. 5.31 Light Propagation in Single Mode Step Index Fibre

At higher transmission rates, single mode fibre is a better performer in case
of long distances, than multimode fibre. All the light that is emitted is propagated
along a single path, because of the core diameter which is reduced. The input
signal is of a comparable width to the received signal. Though it proves to be more
expensive, monomode fibre has its advantages especially in applications with high
bandwidth.

Single-mode fibres have broad bandwidth, cost-effective and low reduction
of strength of any existing optical fibre. They are commonly used in cable television
applications and long-distance telephony.

The advantages of optical fibres are as follows:
 Weight is light and the size is small
 Immunity to crosstalk and electromagnetic interference
 Bandwidth is large
  No problems  of short circuit or electrical ground loop
 It is safe in combustible areas (no arching)
 It is immune to lightning and electrical discharges
 Long cables run between repeaters
 High strength and flexibility
 Potential high temperature operation
 It is safe and secure against signal leakage and interference
 When cut or damaged, there is no electrical hazard

General Properties of Optical Fibre Cable

Configuration: Fibre optic systems consist of light sources, cables and light detectors,
as depicted in Figure 5.32. In a simple configuration, one of each is used. In a more
complex configuration over longer distances, many such sets of elements are
employed. Much as is the case in other transmission systems, long haul optical
communications involve a number of regenerative repeaters. In a fibre optic system,
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repeaters are opto-electric devices. On the incoming side of the repeater, a light
detector receives the optical signal, converts it into an electrical signal, boosts it,
converts it into an optical signal, and places it onto a fibre, and so on. There may be
many such optical repeaters in a long haul transmission system, although typically
far fewer than would be required using other transmission media.

Fig. 5.32  Fibre Optic System

Bandwidth: Fibre offers by far the greatest bandwidth of any transmission system,
often in excess of 2 Gbps in long haul carrier networks. Systems with 40 Gbps have
been tested successfully on numerous occasions. The theoretical capacity of fibre is
in the terabit (Tbps) range, with current monomode fibre capacity being expandable
to that level.

Error performance: Fibre being a dielectric (a nonconductor of direct electric
current), it is not susceptible to Electromagnetic Interference/Radio Frequency
Interference (EMI/RFI). This also does not emit EMI/RFI. The light signal will
suffer from attenuation, although lesser than other media. Scattering of the optical
signal, bending in the fibre cable, translation of light energy to heat, and splices in the
cable system can cause such optical attenuation.

Distance: Monomode fibre optic systems routinely are capable of transmitting signals
over distances in excess of 325 km. Therefore, relatively few optical repeaters are
required in a long-haul system. This will reduce costs, and eliminating points of
potential failure.

Security: Fibre is intrinsically secure, as it is virtually impossible to place a physical
tap without detection because no light is radiated outside the cable. Therefore,
interception of signal is almost impossible. Additionally, the fibre system supports
such a high volume of traffic that it is difficult to intercept and distinguish a single
transmission from the tens of thousands of other transmissions that might ride the
same cable system. The digital nature of most fibres, coupled with encryption
techniques frequently used to protect transmission from interception, make fibres
highly secure.

Cost: While the acquisition, deployment, and rearrangement costs of fibre are
relatively high, the immense bandwidth can outweigh that cost in bandwidth-intensive
applications. At Gbps speeds, a single set of fibres can carry huge volumes of digital
transmissions over longer distances than alternative systems, thereby lowering the
transport cost per bit and cost per conversation to fractions of a penny per minute.
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Applications: Applications for fibre optic transmission systems are bandwidth
intensive. Such applications include backbone carrier networks, international
submarine cables, backbone LANs (FDDI), interoffice trunking, computer-to-
computer distribution networks (CATV and Information Superhighway) and fibre to
the desktop (Computer Aided Design).

Bounded Media Comparison Chart (Table 5.2)

Table 5.2  Bounded Media Comparison Chart

Media Advantages Disadvantages 

Twisted pair cable Inexpensive, well established, easy to 
add nodes 

Sensitive to noise, short distances, 
limited bandwidth, security 
hazard because of easy 
interception 

Coaxial cable High bandwidth, long distances, noise 
immunity 

Physical dimensions,  security is 
better in comparison to twisted 
pair cable 

Optical fibre cable Very high bandwidth, noise  immunity, 
long distances, high security, small size 

Connections, cost 

2. Unbounded Media

Wireless transmission systems do not make use of a physical conductor, or guide,
to bind the signal. In this case, data are transmitted using electromagnetic waves.
Therefore, they are also known as unguided or unbounded systems. Energy travels
through the air rather than copper or glass. Hence, the term ‘Radiated’ often is
applied to wireless transmission. Finally, such systems employ electromagnetic
energy in the form of radio or light waves that are transmitted and received across
space, and are referred to as airwave systems. The transmission systems addressed
under this category include microwave, satellite and infrared. There are different
techniques to convert the data suitable for this mode of communication. Theoretically,
radio waves travel through a building and through walls just like in the case of a
radio, cellular phone and TV. They commute longer distances through satellite
communication and use wireless communication to travel shorter distances. This
technology can be used to deliver time applications like multimedia
material.However; it has to be carefully treated since radio links are vulnerable to
interference, fading and random delays. Non-real time usage of this technology
performs as good as the present Ethernet LANs.

5.4.1 Components of a Network
In general, a computer network is composed of one or more servers, workstations,
network interface cards, active and passive hub, routers, bridges, gateways,
modem, software components like network operating systems, and other application
software. The following components are widely used for the construction of
networks.

Server

It is the most powerful computer of the network. In a local area network, usually
a powerful microcomputer or a super microcomputer with the power of a
minicomputer is used as a server. There are two types of servers normally employed
in a local area network. They are dedicated servers and non-dedicated servers.
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In a dedicated server, the server computer performs functions and services
of the whole network. It helps to efficiently run user applications and increases the
overall system cost. Users cannot run their applications directly in a dedicated
server. It provides e-mail service, sharing of multiple hard disks, and sharing of
other resources and faster response time. For larger networks with heavy load,
dedicated servers are usually employed.

In a non-dedicated server, apart from the role of a network controller, a
server also acts as an individual workstation. The server is equipped with large
memory. Network operations demand only a portion of server memory. The
remaining portion of the memory may be used for the user applications. Under
light load conditions, it is advisable to use a non-dedicated server. Some servers
can operate on both modes, according to the requirement of the user.

File Server
The primary goal of a computer network is to share data among several users.
They also make their attached disk drives, printers, modems, and unique
communication links available to the various client stations. Providing one computer
with one or more hard disks facilitates this.  All client stations share these hard
disks. Clients can make their requests to access any of the shared facility to the
server. The file server is a powerful computer, which runs special software. It
provides the files and other shared resources to different users in the network. It
provides facilities like user authentication, security to various user programs, and
data. It can be accessed through network operating system (NOS). Typical
configurations of a server are Pentium 4 machine with 128 MB or higher capacity
RAM, 40 GB or higher capacity hard disk, to serve upto 10 nodes or workstations.

All activities of a file server can be monitored and controlled from the monitor
called console. The network administrators are given special privileges. They are
given supervisory passwords. They perform the network administration operation
for the entire network. Any user of the network needs to get a new network
service, they have to contact the network administrator and make a request for
the specific service they need. The file server has a large memory, which is used
for caching directories, and files and hashing directories. Novell Netware and
Windows NT are the two network operating systems that run on a server machine.

Workstation
Another important component of a network is the workstation or a client.  A
workstation is an individual computer with capabilities to communicate with other
machines. It must be equipped with the hardware and software necessary to
connect to a LAN. Usually a Network Interface Card (NIC) or an Ethernet card
or an Arcnet card is used for this purpose. Part of the network operating system is
also available in the workstation. A workstation can communicate with other
workstations or to the server. The hardware requirement for a workstation depends
on the application and the size of the network. In a typical LAN of a university
computer center, a Pentium III system with 64 MB RAM and 4 to 8 GB hard disk
capacity, with necessary network interface card can be used for a typical
workstation. In general, the memory and hard disk capacity of a workstation is
much less than that of the server.
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Network Interface Unit

Every computer on the network needs one add on card called Network Interface
Card (NIC) or Ethernet Adapter or Network Interface Adapter. The role of NIC
is to move the serial signals on the network cables, or media into parallel data
stream inside the PC. In some cases, two or more such NICs are used in the
server to split the load. These interface units also have the important jobs of
controlling access to the media. This includes activities known as carrier sense
(listen before transmit), sequential station number, and token passing, which are
discussed in the later chapters. The above activities are known as Media Access
Control.

Transmission Media

The data signal travels through this medium. There are two general categories.
They are bounded (guided) and unbounded (unguided) medium. Twisted pair,
coaxial cable, and fibre optic cables are all bounded media. The data signals
travel within the boundaries of the transmission media. On the other hand, microwave
and satellite transmissions, both travel through the air, which has no boundaries,
hence called un-bounded transmission.

Hub

The network hub is a centralized distribution point for all data transmission in a
network. Hub may also be referred to as a concentrator Data packet from a NIC
arrives at the hub. The hub receives and rebroadcasts them to other computers
connected to it. In general, the hub network is a passive device. It does not know
the destination of a received data packet. Hence, it is required to send copies to
all the hub connections. Hubs can be classified into the following three categories.

 Stackable and non-stackable hubs
 Active and passive hubs
 Intelligent and non-intelligent hubs

Stackable hubs are hubs that can be stacked or interconnected to make a
single hub appearance. They are useful for venders to make hubs of size suitable
to customer requirement. Non-stackable hubs cannot be interconnected. They
are always provided only a fixed number of connections.

The hubs that connect to the network backbone are known as active hubs.
The hubs, which connect only to active hubs, are known as passive hubs.

Intelligent hubs contain a special firmware that can be accessed by remote
workstations. The firmware is known as Simple Network Management Protocol
(SNMP). Network performance and network status data are read from SNMP.

Repeater

A repeater is a communication device that connects between two segments of the
network cable. It retimes, regenerates, strengthens the digital data, and sends
them on their way again. Repeaters are often used to extend the cable length to
enlarge LANs. Wide area network contain many repeaters. Ethernet also frequently
uses repeaters to extend the length of the bus.
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Bridge

A bridge interconnects two networks using same technology (such as Ethernet or
Arcnet). Bridge is more sophisticated than a repeater. A modern bridge reads the
destination address of the received packet and determines whether the address is
on the same segment of the network cables of the originating station. If the
destination is on the other side of the bridge, the bridge transmits the packet into
the traffic on that cable segment. Local bridges are used to connect two segments
of a same LAN. Remote bridges are used to link local LAN cables to thin long
distance cables to link two physically separated networks. Network administrators
often use bridges to split the big networks into number of small networks. Bridges
are easy to install. They provide an easy way to perform network management
functions.

Router

A router transfers data between networks. It is also possible for a router to transfer
data between different compatible network technologies such as Ethernet and
IBM token ring. Since Internet consists of thousands of different network
technologies, routers are an integral part of the Internet. A router has the address
on the network. A bridge does not have an address. Hence, a router can act as an
intermediate destination. In other words, a computer can send a data packet to
the router of another network. The router will transfer the packet to the other
network. On the other hand, the bridge must examine all the packets to determine
which packets to transmit between networks. As such, computers never send
packets directly to a bridge. A router examines a packet only if it contains the
router’s address.

A router also can act as a bridge. Such a router is known as a brouter. The
brouter receives the packet and examines whether it supports the protocol used
by the packet. If not, it simply drops the packet. The packet is bridged using the
physical address information.

Gateway

Two dissimilar networks can be connected by means of a gateway. For example,
a mainframe can be connected and accessible to a PC network by means of a
gateway. Unlike routers, a gateway converts the format of the data sent between
two networks. A router adds only addressing information to the data packet.
Routers never change the content of the message. A gateway has to identify the
protocols used in the networks, and recognise the data format and convert the
message format into suitable format to be accepted by the other network. Wide
area networks often use gateways because there is a large number of dissimilar
networks present in a WAN. Gateways provide good connectivity to different
kinds of networks on the Internet.

Modem

Another significant network component is modem. The term Modem is the
shortened version of the name modulator–demodulator.  Modem provides two-
way communication facility between a computer network and telephone network.
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As Wide Area Network uses the existing telephone network to connect to a distant
network, it always uses a modem to dial-up the telephone network. Modem
converts the digital data from the computer into useful analogue signals that can be
transmitted through a telephone network. Similarly, signals from the telephone
channels are converted back into digital data suitable for a computer.

5.4.2 MAN and WAN

Metropolitan Area Network (MAN)

A Metropolitan Area Network (MAN) covers large geographic areas such as
towns, cities or districts. By linking or interconnecting smaller networks within a
large geographic area, information is conveniently distributed throughout the
network. Local libraries and government agencies often use a MAN to establish a
link with private industries and citizens. It may also connect MANs together within
a larger area than a LAN. The geographical limit of a MAN may span a city.
Figure 5.33 depicts how a MAN may be available within a city.

Fig. 5.33  Metropolitan Area Network (MAN)

In MAN, different LANs are connected through a local telephone exchange.
Some of the widely used protocols for MAN are RS-232, X.25, Frame Relay,
Asynchronous Transfer Mode (ATM), ISDN (Integrated Services Digital
Network), OC-3 lines (155 Mbps), ADSL (Asymmetrical Digital Subscriber Line)
etc. These protocols are quite different from those used for LANs.

Wide Area Network (WAN)

This technology connects sites that are in diverse locations. Wide Area Networks
(WANs) connect larger geographic areas, such as New Delhi, India, or the world.
The geographical limit of WAN is unlimited. Dedicated transoceanic cabling or
satellite uplinks may be used to connect this type of network. Hence, a WAN may
be defined as a data communications network covering a relatively broad
geographical area to connect LANs together between different cities with the help
of transmission facilities provided by common carriers, such as telephone companies.
WAN technologies operate at the lower three layers of the OSI reference model.
These are the physical data link and network layers.

Figure 5.34 explains the WAN, which connects many LAN together. It also
uses switching technology provided by local exchange and long distance carrier.
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Fig. 5.34  Wide Area Network (WAN)

Packet switching technologies such as Asynchronous Transfer Mode (ATM),
Switched Multimegabit Data Service (SMDS), Frame Relay and X.25 are used
to implement WAN along with statistical multiplexing to allow devices to use and
share these circuits.

The difference between MAN and WAN may be understood only from the
services being used by them. WAN uses both the local and long distance carrier
while MAN uses only local carrier. Hardware and protocols are same as in case
of MAN.

There is a lot of confusion between LAN technology and WAN technology.
The answer lies in how data is switched. Switching techniques are described
subsequently in this chapter. It is the LAN/(WAN) integration that makes the
network work. After all, people and machines not only need to be accessible
locally, but from different sites as well.

A network is formed and completed using the following basic components:

(i) Hardware

(ii) Applications (useful software).

Each of these actually comprises several layers. An important concept in
networking as well as computer designs is the concept of layers. Each layer provides
protection to the layer above from the layer below so that one layer can change
without affecting the upper layers too much. In some cases, the protection provided
is so good that an application may never become aware that it is functioning on
different hardware. Seven layers are defined by the OSI reference model.

The role of computer networks in development has many facets. Computers
along with the necessary networking infrastructure required have to be connected
with either LAN or WAN or Internet or all based on the needs and playing a
greater role in e-governance, telemedicine, e-education, e-business, etc. A computer
with Internet (internetworking) has become a potent tool for education, productivity
and enlightenment. The Internet can improve life at a relatively low cost. The
Government of India has set up ERNET in 1986 to provide TCP/IP connections
for education and research communities in India. ERNET has established first
TCP/IP computer network in India and it offers services like e-mail, surfing Internet,
FTP, Telnet, and database access, gopher, Archie, WAIS and WWW.
Subsequently, the Government of India has liberalized the policies relating with
Internet and its backbone. The liberalized policies initiated by government
encouraged many private players like DISHNET, Mantra online,  JAIN TV etc.
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and other government organizations like NIC, VSNL and MTNL to enter in this
field to bring the Internet to common people.

The major network infrastructure available in the country has two types of
WAN:

 Terrestrial WAN

 VSAT WAN.

Following are different options for setting up their Intranet, education portal
or e-commerce etc.:

 Leased line

 Dialup connection

 VSAT

 RADIO LINK.

The role of Internet can be seen in the area of education, economic
productivity, healthcare, democracy and human rights and quality of life etc. There
are several more areas where Internet can contribute largely. In the area of
education, this can contribute by way of shared databases, organization of
conferences, circulation of papers and discussion, collaborative research and writing
undertaken, web-based registration, online digital library privileges, other online
learning facilities like virtual classrooms and information regarding courses and so
forth. Economic productivity may be enhanced as an Internet run over telephone
infrastructure at relatively marginal cost, provides more economic advantage.
Internet enables global communication with suppliers and customers etc. This can
lead to opening global markets to the developing countries. In this manner, Internet
has facilitated the opening of e-commerce. Internet is being effectively utilized in
health sector. The rapid growth of Internet and related areas like switched leased
lines, terrestrial and satellite packet radio and videoconferencing etc, has lead to
the development of telemedicine. The Internet is expected to encourage democracy
by providing those suffering dictatorship with external information and new ideas.
This exposure to information allows people to share ideas and coordinate political
activity within their countries. Internet may force transparency in the administration
and therefore, may be considered as a catalyst to encourage human rights in a
wider sense. The environment is under a lot of presure everywhere. We have
pollution and there are limited resources for energy. The Internet may enable us to
substitute communication for transportation and therefore, will reduce pollution
and save energy and time both in the larger interest of mankind.

5.4.3 Modem

The square waves or digital signals are composed of wide spectrum and are prone
to attenuation in the signal strength and distortion due to different frequency
components of the signal. These signal impairment effects are not suitable for
baseband (DC) signalling for higher speed and long distances. They are suitable
only for slow speeds and over short distances. The data communication also seeks
to communicate over large distances. Hence, another technique called AC signalling
is employed in which a continuous wave called sine wave is used. A sine wave is
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characterised by frequency, amplitude and phase. Any one of the characteristics
of a sine wave is modulated in accordance with the information so that the
information can be transmitted over large distances in which sine wave acts as a
carrier for information.

A device that accomplishes the above function in which it accepts a series
of bits in the form of 0 and 1 as input and produces a modulated carrier as output
at the transmitting end and a reverse operation at the receiving end is called a
modem. In other words, a modem is an electrical component that can connect
another modem over an analogue telephony network. When two modems are
connected, they can send each other a two-way stream of digital bits. A computer
sends information to another computer located at a remote location using modem.
The modem receives digital information from the computer, translates it to an
analogue signal using digital-to-analogue converter unit (DAC) and sends the
analogue information to the PSTN. On the other side, when receiving data from
the network, an analogue-to-digital converter (ADC) unit is being used to retrieve
the data. It is important to know that DAC/ADC units are noisy units and are thus
limitations on the performance of the modem.

The data communication techniques were developed based on the existing
telephone network so that no extra expenditure may be incurred on infrastructure.
It was the voice communication that had necessitated the communication between
remote computers and computing devices using the existing telephone network
for voice communication. Most of the telephone lines were installed for voice
communication and therefore, they were able to transmit only analogue information.
On the other hand, the computers and related computing devices were based on
digital signal in the form of pulses or 0 and 1. Therefore, to use the existing telephone
lines or the analogue medium, a device that may convert digital signal into analogue
and vice versa was needed. This device is known as the MODEM and stands for
Modulator Demodulator. It performs the function of modulating and demodulating
a signal.

A modem therefore receives serial binary data as its input. It modulates
some of the characteristics of a sine wave like amplitude, frequency or phase
generated by it in accordance with the input signal so that the binary signal may be
transmitted over large distances. A reverse procedure takes place at the receiving
end where the received signal is demodulated to retrieve the binary signal as the
output of the modem which can be inputted to the digital device at the receiving
end for further processing. In other words, the modem changes the analogue
information into digital pulses at the computer or the digital device at the receiving
side of the communication link or channel.

Conventionally, modems were devised for communication between a host
computer and data terminals. Subsequently, they were also deployed to
communicate between remote computers and computing devices. As they were
used to communicate between remote digital devices, their data transmission rates
were also subjected to increase from 300 bps to 28.8 kbit/s. The modem
technologies were also upgraded to involve data compression techniques.
However, they increase the additional burden of error detection and error correction
to maintain reliability.
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Therefore, the modem can be considered as a peripheral device for
computers to enable two remote computers to communicate over standard
telephone lines. Modems are developed in different shapes and sizes for various
types of applications and needs. The word modem stands for modulator/
demodulator and performs the conversion of digital signals to analogue signals
(modulation) and vice versa (demodulation), as shown in Figure 5.35.

In order to establish interoperability among different types of modems from
different manufacturers, standards for modem interface were developed. Modems
are deployed to perform various types of functions. Some of them are used in
voice and text mail systems, facsimiles, etc., and others are attached or assimilated
into mobile phones or laptops making data transmission possible from any location
to any other. In future, modems may be utilized for other types of applications.
Modem speeds are still around 28/56 kbit/s and further increase in speed will be
possible only on digital phone technology, like ISDN and fibre optic lines. Some
of the new applications are videophones in which simultaneous communication of
voice and data are performed.

Fig. 5.35  Connecting Two Computers via Modem

Modems continuously generate a carrier signal to send information so that
the information may be delivered from one location to another remote location.
The information to be transmitted is superimposed on the carrier signal. In this
manner, the transmitted information varies or modulates this carrier signal. The
terms baud and bps to measure the data rate are very popular with this technology
and continually used interchangeably. However, they are not the same at all.

The number of pulses transmitted in a second characterizes the carrier signal
in which each pulse is called a baud. The bps stands for bits per second and
indicates the number of bits that can be transmitted during one pulse (one baud).
Similarly, kbit/s stands for kilo bits per second.

Therefore, bps = baud × number of bits per baud.

The baud and bps often create confusion because early modems were based
on 1 bit per baud and used to transmit only 1 bit per baud. In such a case, for
example, a 2400 baud modem will also transmit 2400 bps. However, because of
the need of higher speeds, modems are designed to have more number of bits per
baud.

The difference between baud and bps can be understood from this analoguey.
Bit rate means the number of bits (0 or 1) transmitted during 1 second of time. The
number of changes in signal per unit of time to represent the bits is called the



Information Technology
and Society

NOTES

Self - Learning
310 Material

modem's data rate. This rate is expressed in terms of  baud. A signal unit may have
1 or more than 1 bits. Therefore, baud signifies the number of times per second
the line condition can switch from 1 to 0. Baud rate and bit rate, which are expressed
in bits per second, are not similar, as number of bits may be transmitted by the
modem through the channel in each signal change (some bits can be send as one
symbol).  The relation between bit rate and baud is that bit rate is equal to baud
rate multiplied by the number of bits representing each signal unit. Bit rate is always
more than or equal to baud rate because baud rate determines the bandwidth
required to transmit the signal. The signal may be in the form of pieces or block
that may contain bits. A fewer bandwidth is required to move these signal units
with large bits for an efficient system. To understand the relation between bit and
baud rate, we consider an analoguey of car, passengers and highway with signal
units, bits and bandwidth respectively.

A car has a capacity of carrying a maximum of five passengers at a time.
Suppose a highway may support only 1000 cars per unit time without congestion.
When each car on the highway carries five passengers, it is considered that the
highway is capable of providing services without congestion. Thus highways services
are treated efficient. Consider another case, when all these 5000 passengers wish
to go in separate cars, they require 5000 cars and the highway can only support
1000 cars at a time. The services offered get deteriorated because the highway's
capacity is meant only for 1000 cars. It does not bother as to whether these 1000
cars are carrying 1000 passengers or 5000 passengers or more. To support more
cars, the highway needs to be widened. Similarly, the number of bauds determines
the bandwidth.

Concepts of Modulation

Modulation is the technique that is used to translate low-frequency (base band)
signal like audio, music, video and data to a higher frequency. In other words, it
may be said that modulation/ demodulation is a non-linear process where two
different sinusoids are multiplied.

The modulation process involves a high-frequency sinusoidal carrier f
c
. Some

characteristics of this signal like amplitude, frequency and phase change in direct
proportion to the instantaneous amplitude of the base band signal f

m
 as shown in

Figure 5.36.

Let us assume the two sinusoids (as shown in Figure 5.36)  f
m
 and f

c
 as base

band signal and carrier respectively and are represented as:

f
m
 = A sin 

m
t + 

1
(5.1)

and

f
c
 = B sin 

c
t + 

2
(5.2)

In equation (5.2), we may change either amplitude B or angular frequency


c
 in accordance with equation (5.1) and thus produce either amplitude modulation

or frequency modulation or phase modulation, respectively. Angular frequency is
defined as twice of the frequency of carrier signal.
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Fig. 5.36  Two Different Sinusoids

In other words, modulation is used to superimpose a message (voice, image,
data, etc.) on to a carrier wave for transmission. The frequencies that comprise
the message (base band) is translated to a higher range of frequencies. The
frequencies that comprise the message is preserved, that is, every frequency in
that message is scaled by a constant value as explained above. Modulation is
necessary for data communication because of several reasons. Modulation translates
two or more base band signals to different frequencies and thus enables the
simultaneous transmission of those signals.

It also reduces the size of the antenna for higher frequencies with greater
efficiency. Inter-modulation is a special case in which two (or more) sinusoids
affect one another to produce undesired products, that is, unwanted frequencies
(noise). This can occur only when both waves share the same nonlinear device.
The nonlinearity results in several even or odd harmonics. Harmonics are the
multiples of the fundamental frequency, that is, the message frequency.

The modulating index is the ratio of the peak of the modulating signal to the
peak of the carrier in case of amplitude modulation. In angular modulation, the
modulating index is measured as the ratio between the deviation of frequency of
the modulated signal and the frequency of a sinusoidal modulating signal.  In phase
modulation, the index of modulation is equal to the phase deviation in radians.

Amplitude Modulation

Amplitude Modulation (AM) involves the modulation of the amplitude of the carrier
as analogue sine wave, as depicted in Figure 5.36 as f

c
. It occurs when a signal to

be modulated is applied to a carrier frequency. The carrier frequency may be a
radio wave or light wave. The amplitude of carrier frequency changes in accordance
with the modulated signal, while the frequency of the carrier does not change and
we get a complex wave as shown in Figure 5.37. Basically, it is the sum of three
sinusoids of different frequencies. These are f

c 
 – f

m
, f

c
, and f

c
 +  f

m
. The sinusoid

with frequency f
c
 has the same amplitude as the unmodulated carrier. The other

two waves are called as lower and upper side band with frequency f
c
 –  f

m
, and

 f
c
 +  f

m
 respectively and have equal amplitudes, which are proportional to the

amplitude of the modulating signal. It is clear from the above that the bandwidth is
equal to 2f

m
.

The AM signals resulting from the combination comprises of the carrier
frequency and the lower and upper side bands. This is shown in Figure 5.37.
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Fig. 5.37  Amplitude Modulation of a Carrier Wave

At a comparatively low level, carrier frequency is either suppressed or
transmitted. For demodulation, it needs the carrier frequency to be generated, or
derived at the receiving location. This transmission is called Double Side Band-
Suppressed Carrier (DSB-SC).

Transmission of a single side band is also possible. To transmit the signal,
reduced analogue bandwidth is needed. This proves to be an advantage.
Modulation of this type is called Single Side Band-Suppressed Carrier (SSB-
SC). It is perfect for frequency division multiplexing (FDM).

One more kind of analogue modulation is called Vestigial Side Band
modulation. It is similar to a single side band apart from the carrier frequency
which is protected. In addition, one of the side bands is removed by filtering.
Vestigial side band transmission is usually found in television broadcasting. Amplitude
modulation is rarely used individually as it is highly sensitive to the impacts of
attenuation and line noise.

The modulating index is given as:

m = E
max

 – E
c
/ E

c
(5.3)

From Figure 5.37 and equation (5.3) we may derive the following equation
for modulating index m.

max min

max min

E E
m

E E (5.4)

Angle Modulation

It is described in equation (5.2) as a carrier which is being reproduced as follows:

f
c
 = B sin 

c
t + 

2

In the equation, there is an argument of sin as 2 tc  which can be varied
in accordance with equation 1 and thus producing either frequency or phase
modulation. In either case, the amplitude of the carrier remains unchanged with
incremental change in 2 tc .

Frequency Modulation

Frequency Modulation involves the modulation of the frequency of the analogue
sine wave as shown in Figure 5.38. Where the instantaneous frequency of the
carrier is deviated in proportion to the deviation of the modulated carrier with
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respect to the frequency of the instantaneous amplitude of the modulating signal. It
may be said in a simple word that it occurs when the frequency of a carrier is
changed based upon the amplitude of input signal.

Unlike AM, the amplitude of the carrier signal is unchanged in FM. This
leads to FM modulation becoming further resistant to noise compared to AM and
thus, improving the complete signal-to-noise proportion of the communication
system. Power output differs from the varying AM power output. The total analogue
bandwidth required to transmit FM signal is superior to AM, a limiting constraint
for some systems.

The modulating index for FM is given as follows:
 = f

p 
/
 
f
m

where

 = Modulation index
f

m
= frequency of the modulating signal, and

f
p

= peak frequency deviation.

Fig. 5.38  Frequency Modulation

It is understood from Figure 5.38, that amplitude of the modulated signal
stays constant, in spite of the frequency and amplitude of the modulating signal. It
means that the modulating signal adds no power to the carrier in FM unlike the AM.
FM produces an infinite number of side bands spaced by the modulation frequency,
fm unlike AM. Therefore, AM considered a linear process whereas FM as a nonlinear
process. It is necessary to transmit all side bands to reproduce a distortion free
signal.  Ideally, the bandwidth of the modulated signal is infinite in this case. In general,
the determination of the frequency content of a FM waveform is complicated (but
when it is small, the bandwidth of the FM signal is 2f

m
). On the other hand, when it

is large, the bandwidth is determined (empirically) as 2f
m
 (1 + b).
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Phase Modulation
Phase Modulation (PM) is similar to frequency modulation. In FM, the frequency
of the carrier wave changes, whereas in PM the phase of the carrier wave changes.
In PM the phase of the carrier is made proportional to the instantaneous amplitude
of the modulating signal.

Modulating index for PM is given as:
 = 

where

 is the peak phase deviation in radians.

As in the case of angular modulation argument of sinusoidal is varied and
therefore, we will  have the same resultant signal properties for frequency and
phase modulation. A distinction in this case can be made only by direct comparison
of the signal with the modulating signal wave, as shown in Figure 5.39.

Fig. 5.39  Phase Modulation

Phase modulation and frequency modulation are interchangeable by selecting
the frequency response of the modulator. Hence, its output voltage will be
proportional to integration and differentiation of the modulating signal, respectively.
Bandwidth and power issues are same as that of the frequency modulation.

Check Your Progress

1. What is internet?

3. Define the term network architectures.

3. What do you understand by TCP/IP?

4. Define the term LAN.

5. Write the advantages and disadvantages of broadband LANs.

5.5 APPLICATION OF TECHNOLOGY IN
SOCIETY

Information technology (or IT as it is popularly called) has dramatically changed
the way of our life. After the discovery of electricity, the computer ranks as one of
the most important breakthroughs of the modern era. Like electricity, IT has
impacted all facets of  life and in fact its usage is so ubiquitous that it is hard for
today’s generation to even visualize as to how our ancestors lived without
computers. From medicine to transportation, from banking to the entertainment
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industry there is hardly any industry or sector that does not deploy IT in a
fundamental manner to achieve one of the three goals:

(a) Reducing cost of operations by increasing operational efficiency and staff
productivity

(b) Improving revenues and bottom lines by helping  management in informed
decision-making and focusing on priority areas

(c) Improving customer satisfaction by providing better, faster and value-added
services

IT has opened up several allied industries and  employment opportunities
which never  existed before. Whether it is Business Process Outsourcing (remote
data processing) or Web-enabled services (medical transcription, call centres etc.),
IT has opened up new avenues for jobs.

1. Airlines

The air travel industry is one of the biggest users of information technology. There
is hardly any aspect of the airline business in which computer systems have not
been deployed for increasing revenues, reducing costs and enhancing customer
satisfaction.

It is now almost inconceivable to book a ticket or get a seat confirmed
across multiple sales counters (airline offices, travel agents, etc.) spread over
numerous cities, without using computerized databases and e- networking. Like
most other industries, the use of computerized systems in the air travel industry
started with the front office and sales desk with back-office operations playing a
oracial role in delivering a quality experience to consumers. What typically started
as airlines intranet systems have now blossomed into vast web-based online
systems which can be accessed by anybody from anywhere in the world.

Some of the interesting areas where IT has been used successfully are:

 Online ticket reservation through the Internet: Today, most  leading
airlines like United Airlines, Delta, British Airways, etc. sell tickets through
their websites. You can book the ticket through the Internet, pay online
by giving your international credit card details and then collect the ticket
(on the day of journey), and boarding pass from  e-ticket kiosks at the
airport by simply furnishing your booking reference details.

 Flight and seats availability: If you wish to travel from New Delhi to
New York and do not know what your flight options are, simply log
onto the airline site (or better still a travel site like ‘msn’ which offers
information and tickets from many airlines and can therefore give you
more options than a single airline’s website), specify the cities of travel
origin and destination along with preferred journey dates and the database
would yield all the possible options. Once you have selected the flights,
you could even go a step further (possible in case of a few airlines) and
book a specific seat number in that flight along with the choice of meal.
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 Last minute deals and auctions: A seat is a perishable commodity.
An unsold seat means a revenue opportunity lost forever. Therefore,
most airlines, including Indian Airlines (and some specialized ticket
auction sites like Razorfinish.com) have now started a facility on their
website where potential customers can bid for last minute tickets in
online auctions. Cases of people buying a ticket worth $1000 for as
low as $100 are not uncommon. This is a case of win-win by effective
use of IT – the passenger is happy at getting the ticket at a fraction of it’s
normal cost, and the airline is able to recover something from what might
otherwise have been an unsold seat.

All these facilities/opportunities would have been impossible without an
integrated online computer systems.

2. Telephone Exchanges

The first telephone service invented by Alexander Graham Bell was strictly ‘point-
to-point’, i.e., each user had to be physically wired to every other user. There was
no ‘telephone exchange’. Needless to say, Bell immediately realized the need for
an exchange, and made one. In this first exchange each subscriber had to be wired
only up to his local exchange. An operator sitting in the exchange connected him to
other subscribers upon request (earlier phones did not have dialing facility) by
physically connecting the caller’s wire to the recipient subscriber’s telephone by
using a hand-actuated circuit switch. One does not need to stretch one’s imagination
to appreciate the fact that operator-controlled exchanges were not only extremely
labour intensive but also highly error prone.

Now compare this to the digital, computerized telephone exchanges used
today. These are electronic systems that do the switching operation based upon a
‘stored program control’. The rules defined in the software assess which destination
the caller is trying to reach, plot the most optimal path, intimate the called party,
inform the caller about his call status and then if the called party accepts the call,
establish the circuit. The call is monitored during its progress and the circuit
disconnected once the call is terminated. Computerized exchanges improved and
enhanced call-processing capacity, thereby lowering the cost of operations. They
also opened up a dazzling array of IT-enabled services for subscribers that have
made modern telephony an indispensable service.

Bharat Sanchar Nigam Limited (BSNL), one of the main providers of
telephony services extensively uses a product called Infotel for managing their
telephone exchanges. This product provides:–

 Provision of facilities: Activation, deactivation and modification of
subscriber facilities, such as ISD, STD, call waiting, call transfer,
computer-generated bills etc.

 Fault booking and restoration service: Maintenance of a database
of complaint calls either through an IVRS (Interactive Voice Response
System) or  a customer service cell. The system automatically creates
the complaint docket and generates a range of statistical and exception
reports.
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 Line data maintenance: The system provides online data on cable
codes, cable pair numbers, cabinet number, pillar numbers, etc. for all
subscriber connections to facilitate and expedite line repair and
maintenance.

 Directory enquiry: The computerized subscriber database also allows
extensive online or voice-based directory enquiry based upon subscriber
name, location, telephone number etc.

3. Mobile Phones

Statistically, major portions of the populations of any developing country still do
not possess a telephone. Making a simple call to anybody requires locating the
nearest telephone booth, waiting for ones’ turn in the queue, and then paying for a
short chat on (most often) a disturbed line.

In the developing countries the penetration of landline phones has been low
largely due to the hassles of laying cables across long distances. Especially in the
case of remote areas, the cost of connecting a few phones to the mainland mass
becomes disproportionately high. Maintaining these telephone cables across
inhospitable terrain also poses a major challenge to network expansion planners
and engineers.

It sometimes pays to be late! Thanks to the advances made in the
telecommunications industry in the last two decades, mobile phones provide an
excellent cost-effective and efficient alternative to the land phones for developing
countries like India.

A cellular phone (as mobile phones are also known) is primarily a radio—
a very sophisticated variant of a radio telephone. The genius of a cellular system is
the division of the city into small cells (hexagons on a big hexagonal grid). Each
cell has a base station that consists of a tower and a small building containing the
radio equipment. Wireless communication is possible within and across cells
allowing a user complete mobility and making communication much easier and
less time-consuming. Through switching devices in landline telephone exchanges,
mobile phone users can also access the global landline network, effectively bringing
everyone within speaking distance.

The mobile phone industry owes its growth to information technology which
is in fact central and pivotal in any mobile system. Technologies like PCS, TDMA,
CDMA, GSM are often associated with mobile phones.

PCS (Personal Communications Services) is a wireless phone service
somewhat similar to a cellular telephone service but emphasizing on personal service
and extended mobility. It is sometimes referred to as digital cellular (although cellular
systems can also be digital). Like cellular, PCS is for mobile users and requires a
number of antennas to blanket an area of coverage. As a user moves around, the
user’s phone signal is picked up by the nearest antenna and then forwarded to a
base station that connects to the wired network.

TDMA (Time Division Multiple Access) is a technology used in digital cellular
telephone communication that divides each cellular channel into three time slots in
order to increase the amount of data that can be carried.
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CDMA employs analogue-to-digital conversion (ADC) in combination with
spread spectrum technology. Audio input is first digitized into binary elements.
The frequency of the transmitted signal is then made to vary according to a defined
pattern (code), so that it can be intercepted only by a receiver whose frequency
response is programmed with the same code, and so it follows the transmitter
frequency exactly. There are trillions of possible frequency-sequencing codes; this
enhances privacy and makes cloning difficult.

GSM (Global System for Mobile communication) is a digital mobile
telephone system that is widely used in Europe and other parts of the world. GSM
uses a variation of time division multiple access (TDMA) and is the most widely
used of the three digital wireless telephone technologies (TDMA, GSM, and
CDMA). GSM digitizes and compresses data, then sends it down a channel with
two other streams of user data, each in its own time slot. GSM is in fact the de
facto wireless telephone standard in Europe.

Today, mobile phones are proliferating as handsets are getting cheaper and
call rates are declining, bringing them within the reach of the common man. They
provide an array of functions (some very simple and others very sophisticated).
Some of the popular functions which are based upon IT are:

 SMS (short messaging service): Small text messages can be
exchanged between people who do not believe in long verbal
conversations over communication channels. In fact today SMS has
gained popularity as a medium for sending and forwarding messages.

 Address Book: It is a store of contact information maintained on the
mobile handset or the central server. It does away with the usual problem
of maintaining an usual address book and allows the phone user to dial
numbers without having to bother about carrying a bulky file-o-fax or
telephone diary along.

 Schedules or to-do lists: You can store a list of important tasks that
you wish to accomplish. Most mobile phones software also provide for
appointments and reminders associated with these tasks.

 Send or receive e-mail: Thanks to WAP technology it is now possible
to access your e-mails using your mobile phone. Popular portals like
Yahoo and Rediff offer a facility whereby users get automatic alerts on
their mobile phones as soon as any new mail arrives. You can also use
your mobile phone for chatting using your MSN or ICQ account.

 Get information updates: All mobile service providers now provide
add-on facilities for their subscribers to receive regular updates on news,
entertainment, stock market prices. This is done by integrating web-
based databases with the mobile users’ database. Service providers
also use this capability to advertise for new products, services and schemes.

As you can appreciate, all the above facilities are based upon the usage of
electronic databases and intelligent software available on the mobile phone. Due
to the global trend of convergence the dividing line between information technology
and telecommunications technology is getting increasingly blurred. Today’s
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computers combine phone, fax, television, VCD/DVD drives, stereo—all in one
seamless bundle.

4. Video Games

Games have been one of the most popular uses of computers. In fact, organizations
like Attari, Nintendo, and Sony who were developers of video games have been
instrumental in the improvements in the multimedia capabilities of desktop
computers. Till about a decade ago when personal computers had severe limitations
of disk storage, processing speed, and memory size, only very simple uni-
dimensional video games were possible. With the development of much faster
Pentium series of CPUs with inbuilt multimedia capabilities coupled with
improvement in digital storage and acoustics, today’s games are limited only by
their creators’ imagination and not by any technological hindrances. Today’s games
like Doom, Pokeman, PlayStation, Galaxian, Defender, etc. use very sophisticated
graphic and sound techniques to create three dimensional games.

Some of the interesting developments in this area have been:

 Virtual reality

 Improvements in specialized input devices like joysticks

 Special game cards and enhanced graphic capability of CPU

 Web games (Casinos)

5. Special Effects in Movies

Special effects in movies have come a long way since the early 20th century.
During the early years of movie making, special effects were limited to time-lapse
cinematography where hand-controlled dummies were brought to life by stop
motion filming which meant manually moving the animated model a fraction of an
inch and taking a snapshot.  For example, the1933 classic King Kong involved
tedious photography of a life-size dummy model moved laboriously inch-by-inch
between takes by a team of assistants.

Similarly, the early animation movies (popularly called cartoon films) involved
a team of artists and painters who would painstakingly draw and paint each sketch
frame by frame. The photography team would then click shots of these sketches
at the rate of twenty four frames a second of film and edit them into a story.

Cut to the 21st century. If another version of King Kong were to be made
in 2004 (and it has) what you would get is a completely authentic-looking Gorilla
(made fiercer by digitally created and enhanced sound effects) walking in a lush
green forest (once again created by a clever mix of amazon rainforest pictures and
computer techniques commonly known as digital compositing). Not only would
the ape look and behave completely naturally but would be able to perform stunts
(like 360 degree flips or making 100 metre jumps) that would just not have been
possible with any physical model.

Some of the interesting techniques used for creating special effects are:

 Digital compositing: Typically done through a process called
‘Bluescreen’ where the actors perform the scene in a studio in front of a
large blue screen. A separate team of computer designers and artists
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create a virtual background (by mixing multiple photographs and
computer-generated images). Later the actors’ footage is superimposed
on the top of the background to create a seamless ‘composite picture’.

 Time slicing: In this technique a series of cameras are placed around
the object of concern. All these cameras shoot pictures at precisely the
same time. When these pictures are played together it appears as if
there is one camera moving around the object. Coupled with other special
tricks (such as slow motion photography as used in the Matrix series)
this creates an ethereal effect.

 Computer-generated imaging (CGI): CGI techniques are used to
create scenes which are either not possible in real life or would be too
expensive or dangerous to film. To gather a crowd, for instance of
150,000 people in a colosseum to shoot a Gladiator fight sequence
would cost an enormous amount of money besides creating nightmarish
logistical problems. Doing the same though CGI would not only cost a
fraction of the money, but also save precious time.

None of the above developments would have been possible without the
fantastic developments in Information Technology.

6. Business

Like banking, the insurance sector has also to contend with a lot of routine paperwork
insurance policies, claims filed, survey or investigation reports, payment receipts etc.
IT provides a perfect opportunity to reduce costs and processing times.

According to Insurance Journal:

Eighty-eight per cent of insurers think that IT will become more
important in driving efficiencies and cost-reductions in future,
according to new research released by RebusIS, an insurance
technology solutions provider. A further 55 per cent of respondents
to the survey argued that IT is currently playing an ‘important’ role in
driving efficiencies and cost-reductions, with 43 per cent contesting
that IT is ‘essential’ to business efficiency.

Typically, insurance companies use computerized databases to keep track
of all insurance policies, generating premium due statements, premium received
receipts, lodging claims for insurance recovery, etc. Basically all kind of transactions
are recorded and processed through computerized systems. This not only enables
insurance companies to provide quicker and more efficient service to their clients,
it also allows them to minimize their risks and maximize their profits by enabling
complex financial, economic and demographic analyses of their customers. Using
sophisticated computer programs, an insurance company can determine which
customer segments are growing the fastest, which are most profitable, and which
are more risky than others.

Although a lot of processes have been automated, things like insurance
claims etc. are still filed on paper forms first. The volumes involved are quite
intimidating prompting some insurance companies in the US and Europe to
outsource the entire data entry process to specialized offshore firms—many of
them in India!
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This is how the typical process works: an insurance agent or the insured
party fills up a paper form somewhere in the US. These forms are collected from
multiple locations at one location – let’s say the insurance company’s head office.
A team of professionals from the data entry agency (working in the Insurance
company’s head office) scans these forms through high-speed scanners, generates
image files for all the forms and then at the end of the day, using the Internet,
transmits all these images to their data processing facility, let’s say in New Delhi.
Due to time difference, by the time this transmission is done at the end of day in the
US, it is morning in India. A team of trained data entry operators, using specialized
software, views these forms (as images) on one portion of their screen and then
types the same data in a database. Once the data has been properly verified and
validated the database is then uploaded back to the US within a few hours. This
means that the images that were sent from the US the previous night could be
available in the US the next morning in the form of a computerized database! Of
course, other than the effective use of IT, the time difference between the US and
India has helped tremendously to make this ‘zero time lag’ system a great success!
This system of outsourcing one of the business functions is called ‘BPO’ or Business
Process Outsourcing.

Another more sophisticated alternative to this is OCR—Optical Character
Recognition—where the images are run through OCR software that automatically
converts these into text. OCR is only feasible where the text quality is very (typically
typed or computer printed matter) high. Since OCR operations still produce only
90 to 95 per cent accurate text, human intervention is still required to correct the
mistakes made by OCR systems. In course of time, however, technological
advancements will bring 100 per cent reliability and further change the face of
remote-processing arrangements.

7. Financial Accounting

Financial accounting was one of the first business functions for which software
applications were developed. The importance of financial accounting and
management for any business cannot be overemphasized, but the scale of
transactions, the repetitive and structured nature of the data and the sheer volumes
involved in the case of large corporates makes for an ideal case for computerization.
Computerizing accounts also takes the drudgery out of bookkeeping, which means
that accountants can now concentrate more on analysing information rather than
devoting countless hours merely in filling out vouchers and updating registers and
ledgers.

Typically this is how a computerized accounting system works–the
accounting clerk makes the voucher directly on the computer using a financial
accounting software package. The voucher on the screen looks very similar to a
regular paper voucher and is in fact much simpler to fill because things like current
date and voucher number are generated automatically. The appropriate account
names that have to be debited or credited need not be typed but simply selected
by the click of a mouse from a list of all ledger accounts. Appropriate checks and
validations are also built into the accounting software which reduces the chances
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of errors. Unless, for example, the total of all debit accounts equals to the total of
all credit accounts, the software will not allow the voucher to be saved.

Once the basic data has been entered into the computer voucher, the
accountant can print out as many copies as required. Unlike a manual accounting
system where a the voucher, once prepared, has to be entered into the daybook
and then posted in the relevant ledger account, the computer software does this
automatically. In fact the moment the voucher is entered and saved it is not only
automatically posted to all the relevant daybooks and ledger but also up-to-date
trial balance, profit and loss account and balance sheet can be generated instantly
showing the downstream effects on each one of them. Since there is no time lag
between voucher preparation and posting, the accounting software always shows
up-to-date statement and final account.

Depending upon the size of the organization and the complexity of its
operation, different software packages are readily available in the market. At the
bottom end are popular and inexpensive software such as Tally and EX which are
quite sufficient for most small and medium scale-organizations. Tally provides an
excellent user-friendly interface through which all accounting transactions can be
entered or modified easily and the user can  see the effects of each transaction in
all financial statements.

At the top end of the market is ERP (Enterprise Resource Planning) software
like Oracle Financials, Baan, SAP etc. which cater to the financial accounting and
management needs of huge multi-location, multi-currency, multi-operations
organizations like Nestlé, Pepsi, Coca Cola, Procter & Gamble etc. Such software
is called ERP software, since it provides completely integrated solutions for all
functions of a business like financial accounting, inventory, payroll, production
planning and control, etc. Despite the fact that ERP solutions typically cost millions
of rupees and are relatively much more complex to implement, they provide an
excellent platform for ensuring that the company’s system and procedure are
uniformly followed across multiple locations (or even countries). Such systems
also make it very easy to consolidate huge amounts of information from different
profit centres and locations.Thus, effective, near real-time management information
can be generated to assist apex level decision making.

8. Hotel Management

The hotel industry is an integral part of the tourism industry, which is a vital source
of revenue and foreign exchange for a country’s economy. A vibrant hotel industry
means greater employment generation. However, since this industry relies on easy
and quick availability of information, the role of IT in its development and growth
cannot be over-stressed. In fact, IT has revolutionized the hotel and tourism industry.
This is because of the instant availability of information about tourist spots, hotel
infrastructure, room availability, tariff details, online Booking, etc. at the click of  a
button. IT is playing a critical role in improving performance because of its potential
of creating customer relationships and the flow of information between the people
and customers.
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There are numerous instances of use of IT in hotel industry. Some of these
include:

 Today’s hotel management software means that the moment a guest
expresses interest in staying at the hotel, till the time he checks out, all
transactions with him (room charges, food and laundry bills, business
centre, heath centre, hiring cars etc.) are recorded electronically, making
information available at the click of a button.

 Many leading hotels offer online booking facility for tourists and guests.
This makes it very easy for the tourist as he has beforehand knowledge
of room availability and charges. There are several websites wholly
devoted to this. Microsoft’s MSN has a traveller’s section where one
can search for hotel accommodation based on criteria like city, location,
budget etc.  A tourist, for example, can specify the city and his budget.
Based on this information, the search facility throws up a complete list
of hotels available. Moreover, the tourist can even specify his preferred
location. Once the hotel is identified, booking can be made online using
an internationally valid credit card.

 Most of the hotels have computerized their records. It is very easy to
know details of room availability at a particular time. The information
about the occupant is also available instantly. This computerized system
typically integrates all hotel MIS functions into one system. Cendant
Corporation has successfully implemented this practice in its chain of
hotels. The Barbizon Hotel and Empire Hotel, New York has eliminated
logbooks and standardized recordkeeping by the use of customized
software. Carlson Hospitality Worldwide has the most efficient and
productive reservation system in the US. IMPAC Hotel Group has lobby
kiosk touch screen guest-tracking system. Inter-Continental Hotels &
Resorts use a global strategic marketing database. All these are examples
of use of IT in hotel industry, which have significantly transformed
operations and profitability.

 Hotel Information Systems help users to access guest database
information and use the information to create attractive one-to-one
reservation confirmations, e-mail marketing and sales messages, custom
reports and e-mail comment cards to reinforce guest relationships. The
Balsams Grand Resort Hotel has a comprehensive guest history program
that it has used successfully for productive purposes. Courtyard by
Marriott has an Intranet system by which it has replaced manuals and
printed material.

 Information technology is being used increasingly by international hotel
chains to formulate and align their corporate strategies. Marriott
International is a successful example of alignment of information
technology with corporate strategy.
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9. Education

Teaching has traditionally been associated with classroom instructions on a
blackboard with the instructor dependent almost entirely on his/her oratory and
presentation skills for holding the attention of the class. From a student’s perspective,
he had to keep pace with the instructor’s pace, which meant that the slower (though
not necessarily less intelligent) student was at a natural disadvantage. Similarly
some students were more interested in a more in-depth study than the others.
Since access to information was neither easy nor inexpensive, these variables had
always posed a major barrier to learning.

Ever since the advent of information technology, the scenario has changed
dramatically. Today, the instructor has a repertoire of information technologies. To
make the lecture not only more interesting but also more informative, there are
advanced electronic teaching tools available. These vary from simple slide
presentations to full- blown multimedia presentations which have video clippings,
sound effects, animation and graphics to explain even the most abstruse subjects
in a simple and easy-to-understand manner. As an example, a medical student
does not have to pore over boring textbooks to understand lets say, the human
anatomy. Simple computer packages like ‘Body Works’ are available which explain
the same using photographs, images and graphics that make in-depth learning fun
rather than a chore. Moreover, learning is not only faster but is retained longer
when test is supported by visuals and sound clips. Multimedia has transformed
both classroom as well as online (distance) and packaged (CDs, VCDs, DVDs
etc.) education, in terms of both content as well as interactivity.

Some of the interesting developments in IT for the education sector can be
seen  in:

 Computer-based training (CBT): In most of the progressive institutes
today, classroom sessions are complemented by CBTs. CBT typically
comprises user-friendly software in which the course syllabi is broken
up into a series of interactive sessions. These sessions involve imparting
a slice of knowledge to the student and then quizzing him to reinforce his
understanding.  Students have the option of going through these sessions
at a time most convenient to them and a pace best suited to them. CBTs
also provide an excellent medium for the student to learn by exploration
and discovery rather than by rote. However, Education software is often
positioned as ‘enriching’ the learning process and not as a potential
substitute for traditional teacher-based methods.

 Internet: Thanks to the Internet, any and every type of information is
available at the click of a mouse. No longer have students to trudge long
distances to visit a library and spend valuable time plodding through
library catalogues to find the right information. Using a search engine,
one can easily access the desired information. Also, knowledge is no
longer restricted within the academic fraternity alone. Thanks to our
networked world (Intranet / Internet) information dissemination is faster
and widespread.
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 Distance learning: Information technology has also made distance
learning a reality. You need not be physically present in a Business School
to do a management course from there. By innovative use of information
technology, educational institutes have reached out to students who would
otherwise never have been able to enroll with them.

 Computerization of administrative tasks: Most academic institutes
use computerized systems for student enrollment, fee management,
examination, administration, etc.  Enrollment forms, for instance, are
now available on institutional websites, and examination results are usually
available on the Internet. Some schools have also started collecting fees
through the Internet by using credit cards.

10. Weather Forecasting

Predicting the condition or state of the atmosphere after a period of time and over
a certain region(s) is known as weather forecasting. The professionals involved in
the study and prediction of weather are called meteorologists. The state of the
atmosphere is governed by various factors, such as temperature, humidity, wind
speed etc.

A few decades ago, man depended on the close observation of natural
phenomenon and changes in atmosphere such as cloud formation, sky colour, wind
speed, temperature, animal  and insect behaviour to make weather predictions. Human
senses and knowledge used to be the main driving factor behind these early predictions,
which were limited to short-term forecasting and had low accuracy levels.

With the development in information technology, weather forecasting has
become a science rather than an art. Weather forecasting requires processing and
analysing huge amount of data very quickly. This makes it an ideal field for the
application of information technology. The volume of data to be processed and
the complexity of calculations that must be made in order to forecast weather with
a certain degree of accuracy can be gauged by the fact that this task can only be
performed by super-computers which work at phenomenally high speeds and can
crunch huge amount of data very quickly.

The software and hardware tools provided by IT help in making accurate
weather forecasts over longer time intervals. Large amounts of data are collected
by weather balloons, satellites, sensors and radar instruments and fed into
computers with huge processing power and data storage for quantitative analysis
and weather modelling (Refer Figure 5.40). Some examples of software used in
this process would be Digital Atmosphere, Forecast Laboratory and RAOB.
Accurate assessments of the condition of weather over a period of three to six
days can be made using hydrological forecasts and warnings of extreme events
can be issued over a lead time of five to ten days.

There is still a huge scope of development in the field of weather forecasting
and information technology is driving it by developing better software for computer
modelling, building and designing weather monitoring sensors for data collection,
analysis and growing channels of weather forecasting services and making systems
with huge computing power and storage space available.
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Fig. 5.40 METLAB Classic — Weather Forecasting Software

11. Remote Sensing

The retrieval of data and information regarding an object or phenomena without
coming into physical contact with it is known as remote sensing. The devices used
for recording such data are known as sensors and depending upon the method of
retrieval there can be either recording or real-time sensors. The technique of remote
sensing determines if it’s active remote sensing or passive remote sensing.

In active remote sensing, artificial radiation is bombarded over a particular
region of interest and the reflected rays are detected by the sensors to collect data
and relevant information. An example of active remote sensing is the radar technology.

Passive remote sensing only detects natural radiations of an object or the one
reflected from its surrounding area. The remote sensors do not emit radiation for
measuring values of the object. A remote camera setup to observe wildlife and natural
phenomenon is a good example of passive remote sensing (Refer Figure 5.41).

In earlier times, our forefathers used to find high ground or climb treetops to
map the surrounding landscapes for information. Later in the year 1858 balloonist G.
Tournachon took photographs of Paris from his hot air balloon. Then with the help
of IT remote sensors, computer systems and software were developed to precisely
monitor and collect geographic or spatially-referenced data. The above-mentioned
traditional drawbacks have been successfully overcome with the help of IT.

The various applications of IT in the field of remote sensing are:

1. Software: Embedded software’s are used to process data from
remote sensors and turn it into relevant information. They also control
the functions of a remote sensor by judging the data returned from it.
Image enhancement and grouping applications, for example, help in
clearing interference from raw images (captured images from camera
with minimally-processed data and huge detail) and can be used to
transform multiple images into one high resolution continuous image.
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2. Hardware: IT helps in designing customized hardware components
for the purpose of remote sensing. The capabilities of a sensor can be
optimized if they are redesigned for each application.

3. Telecommunication: Advancements in the communications between
the sensor and the base station have helped in increasing the remote
distance. Global environmental mapping, for example, would not have
been possible without worldwide telecommunication

Fig. 5.41 Remote Sensing

12. Planning

Planning in organizations—public and private—concerns both the organizational
process of creating and maintaining a plan and the psychological process of thinking
about the activities required to create a desired future on some scale. As such, it is
a fundamental property of intelligent behaviour. The thought process is essential to
the creation and refinement of a plan, or integration of it with other plans, that is, it
combines forecasting of developments with the preparation of scenarios of how
to react to them.

The term is also used to describe the formal procedures used in such an
endeavour, such as the creation of documents, diagrams, or meetings to discuss
the important issues to be addressed, the objectives to be met, and the strategy to
be followed.

Planning is a crucial aspect of an individual, organization and economy. It is
done to attain growth, development and competitive advantage in a firm. Information
technology tools have been a growing contributor to planning over the years.

It is a commonly acknowledged fact that with the right knowledge at the
right time a firm can become the market leader of its products and services and
continue to make profits for further growth. Therefore planning helps an organization
in facing and beating competition. Second, the daily operations of an organization
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are becoming increasingly dependent on telecommunication and distributed
networking processes.

Information and Communications Technology (ICT) tools greatly assist the
planning process since they allow large amount of historical data to be processed
and analysed which form the major requirement for the future planning process.
Also by using sophisticated scenario analysis tools, Decision Support Systems
allow the managers to know the repercussions of making long term or policy
decisions such as entering a new market, or introducing a new product, or increasing
the prices of goods and services being offered. These packages, by using a
combination of  complex algorithms, mathematical calculations, statistical analysis,
etc. allow the managers to predict the outcome of such policy changes and therefore
enable them to plan better.

So whether it a case of a small grocery store deciding what to order (from
its suppliers) for the coming week’s sales, or a large multinational working in many
countries trying to do inventory forecasting for its thousands of stores, IT tools can
be used to automate the basic number crunching (data collation and compilation)
and make better decisions regarding the future.

13. E-Commerce

E-commerce is the exchange of goods and services involving financial transaction
over an electronic medium by utilizing information and communication technologies,
such as Electronic Data Interchange (EDI), Electronic Funds Transfer (EFT), Online
shopping portal, etc.

An e-commerce system replaces almost all the paperwork in an organization
with inexpensive and more efficient electronic exchange of data which is reliable
and secure. The general way of doing business in e-commerce and traditional
commerce is the same–a buyer and seller indulge in swapping products and/or
services for money. Instead of shops and stores, mail order catalogue or telephone,
e-commerce is conducted over a network, such as the internet. Information
technology tools, such as networking, software development, data mining, data
warehousing and enterprise resource planning (ERP) have provided sellers a way
to conduct business without the need of building physical infrastructure, printing
advertisement pamphlets or recruiting a large number of staff. Additionally,
automation of billing and tracking systems has further cut labour costs and time.
For distribution of digital content the distribution channels and delivery time have
been minimized as they can be readily downloaded after payment through online
payment gateways. Due to the World Wide Web sellers aren’t restricted to local
markets. They can target customers across the world and provide the same quality
of service irrespective of distance and country.

E-commerce by a combination of facilitates, such as online payment
gateways, customer analysis and report generation, advertisement channels and
security-coded access to goods and services, provides a sales and distribution
channel which is extremely customer-friendly.
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The internet revolution and availability of cheap computers and Internet
bandwidth have been the main reason for proliferation of e-commerce as a viable
alternative to the ‘brick-and-mortar’ businesses.

‘Brick and Mortar’ is a term used since the development of e-commerce to
refer to a traditional model of a business that is based at a commercial address
made up of brick and mortar. Before the advent of the Internet and e-commerce,
a commercial address or shop front was required for any business that wanted to
sell goods directly to the public.

A brick and mortar business can offer some things that an e-commerce
business cannot. They are:

 Customer security: Many people feel more comfortable buying goods
or services from a business with a real world presence rather than a
virtual business where the customer cannot visit in person should they
wish.

 Increased customer relations: A business operating at a commercial
address with sales staff can offer a more personal experience to the
customer, increasing satisfaction and the possibility of repeat business.

 Many businesses simply require a physical location in order to provide
services. Such businesses could include healthcare services or a motor
vehicle repair shop.

A brick and mortar business also has disadvantages compared to businesses
that operate only online.

 Increased cost: The costs of setting up and running a brick and mortar
business far outweigh those in e-commerce. The basic reason behind
this is the cost of operating in a commercial property. Property cost,
maintenance charges, tax, insurance and employees are all costs that e-
commerce can avoid but a brick and mortar business cannot.

 Smaller customer base: A brick and mortar business with no online
presence has a customer base limited by geography and local population.
An online store has no such limitations.

Therefore many brick and mortar businesses now recognize the potential
for business expansion through E-commerce and so simultaneously run online and
shop front operations. So it is no longer a case of one against another, both business
can harmoniously co-exist and complement each other. So for every example of
‘Pure’ online stores (like E-Bay.com and Amazon.com; see Figures 5.42 and
5.43) which sell ONLY on the Web, there are many examples of standard businesses
using the online business to complement its  brick and mortar operation (like HP
and Sony).
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Fig. 5.42  E-Bay.com

Now buyers can visit and compare the prices of different goods and services
from multiple vendors across the world and then select and buy goods and services,
without having to step outside the comfort of their home or office. E-commerce
has given a whole new meaning to the word ‘window-shopping’ by offering goods
and services from all over the world right on your window screen.

Fig. 5.43 Amazon.com

14. Web Publishing

Traditionally, when we talk about the term publishing then printers, paper,
distribution, expensive infrastructure and static content comes to the mind. The
drawbacks of these are that they require a huge amount of investment, the
productivity is low as several manual and machinery work is involved, the content
published cannot be changed easily and the scope of marketing the product is
very limited. All these drawbacks have been overcome by the development of
web publishing.

Web publishing is the umbrella term for putting content on the World Wide
Web and includes all support arrangements required for it. It includes custom web
designs for web development, website hosting and e-commerce. Originally, web
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publishing simply meant putting selected content on paper into HTML over a
website for public access, this is also known as ipaper. This method of publishing
is not widely used anymore as professional web publishers now use modern
software, such as content management systems for rearranging the structure of a
website and making its content dynamically modifiable.

The most important tool of information technology used in the process of
web publishing is the World Wide Web. This makes content available twenty-four
hours a day, seven days a week, to anybody in the world who is connected to the
Internet. The only requirement for publishing and viewing the content online is a
computer or a handheld device which has an Internet connection and a web
browser. The scope of web publishing in terms of penetration is very high with an
estimated 1.5 billion Internet users worldwide, as of 2007. The relative low cost
of buying a domain name and hosting a website is another major driver behind the
large amount of online data available over websites.

15. Management Information Systems

Management Information Systems (MIS) consist of people, technology and
procedures to collect, process, store and disseminate data and information required
by a business organization for planning, controlling, monitoring, decision making
and other functions of management (Refer Figure 5.44).

Fig. 5.44 MIS

Some of the most commonly used applications of management information
systems are: accounting,  financial management, production planning and control,
sales and marketing, human resource management, project management, etc.

The two most important components of an MIS system are database
management system and software which allows users to work on these databases
for performing the various business functions like sales, accounting, etc. The first
component is typically covered by a Relational Database Management Systems
also called a RDBMS and second by Enterprise Resource Planning also called
ERP.

Although MIS systems need not always be based on standard ERP software,
since businesses can use custom-built MIS software to serve one or more specific
areas of a business, such as inventory control or human resource management.
However, the use of standard Commercial Off-the-Shelf (COTS) packages, such
as ERP packages are increasing and gaining market share.
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Before the advent of computers and computerized MIS, it was very difficult
and cumbersome to manage vast databases of customers, suppliers, shareholder
etc. Since these databases could not be maintained and managed properly, the
data therein could not be analysed easily. This meant that the managers had to
make decisions on either partial data or rely more on ‘hunch’ or ‘gut feel’ rather
than on facts and figures.

Nowadays large Relational Database Management Systems like Oracle and
Ingress along with Enterprise Resource Planning packages (which are sophisticated
MIS packages covering the entire gamut of functions of an organization) like Oracle,
SAP and Baan, my-SQL help organizations to manage vast databases more efficiently,
accurately, quickly and easily compared to past methods of manual data base
management. The use of these sophisticated databases and packages has meant that
managers can now be better informed and base their decisions on factual analysis
rather than guesstimates. While nobody can still deny the role of ‘gut-feel’ and intuitive
decision making, these when complemented by hard facts and figures provide the
basis for making better decisions.

The use of the Internet and web-based management information systems
have made MIS  much more simpler and faster making it possible to get data and
information instantly on the click of a mouse from anywhere across the globe.

16. Decision Support Systems

Decision support systems (DSS) is a computerized information system that supports
organizational and business decision-making tasks (Refer Figure 5.45). It is basically
an interactive computer software developed to enable decision makers to compile
information from basic data, documents, knowledge and business models to enhance
the ability to make decisions. A DSS may present information graphically and may
support or may be complemented by an artificial intelligence (AI) or an expert system.

A decision support application mainly collects and presents the following
information

 Inventory of all your present information assets like data warehouses,
data marts etc.

 Comparison of your periodic data, e.g. inventory for this month with
last months

 Projected data based on assumptions, e.g. projected sales figures based
on sales assumptions

 Consequences of different decision alternatives based on past experience
in a context that is described

The decision support systems can be classified into the following five types:

 Communication-driven DSS

 Data-driven DSS

 Document-driven DSS

 Knowledge-driven DSS

 Model-driven DSS
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Fig. 5.45 Decision Support Systems

DSSs have many applications and can be developed for any knowledge
domain. They can be used in any field where organization is necessary. Clinical
decision support systems for medical diagnosis, bank loan officer verifying the credit
of a loan applicant, deciding which area or field to market your product, decision
making on the stock market are a few examples where DSS can be applied.

DSSs are extensively used in business and management. For faster decision
making, identification of negative business trends and better allocation of business
resources, business performance software’s like Executive dashboard, MS Data
Analyser, MS Excel solver are available.

A DSS has the following advantages:
1. Increases productivity and is time saving
2. Expedites problem solving and enhances effectiveness
3. Improves interpersonal communication
4. Promotes learning or training
5. Increases organizational control
6. Generates new evidence in support of a decision
7. Creates a competitive advantage
8. Encourages exploration and discovery on the part of the decision maker
9. Reveals new approaches to thinking about the problem space

17. Inventory Control

For any manufacturing firm, managing inventory is crucial. High inventory results in
money being locked up unnecessarily, thereby reducing liquidity and indirectly
profitability (if you offer immediate payment, most suppliers would be willing to
offer you better rates). On the other hand, lower inventory of finished goods may
lead to lost sales, or lower inventory of raw material may lead to disruption in
production line. Optimum stock levels optimize operational efficiency.

Most large manufacturing units typically need hundreds (if not thousands)
of raw material components and produce many products. Managing optimal
inventory of such a large number of items is a difficult task. It is here that information
technology again plays a very useful role. Inventory management software provides
facility for specifying (and determining) the maximum, minimum and reorder levels
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for each item, so that appropriate levels of inventory can be maintained keeping in
mind lead times and Just-in-time JIT systems (if any) for component suppliers.

Basically this is how a typical computerized inventory system works–a list
of all the inventory items is prepared along with the maximum, minimum, reorder
and current levels (quantity in hand as on a fixed date) for each item. This list is fed
into the inventory software. Thereafter, all incomings (materials purchased or
produced) and outgoings (sales or issues to production floor) are recorded through
the inventory package. Since the computer knows all the ins and outs for each
item, it can track the exact quantity in hand for each. The package also generates
reports for all the fresh stocks that need to be procured (based upon the levels
specified). A variety of other useful MIS reports like aging analysis, goods movement
analysis, slow and fast-moving stock report, valuation report, etc. can also be
generated which assists the storekeeper and the accountants.

Some of the more sophisticated inventory packages (or inventory modules
of ERP packages like Oracle financials, Baan, SAP etc.) automatically generate
purchase orders (as soon as minimum level of any item is reached), provide
automatic posting of accounting entries (as soon as any purchase or sale is carried
out) and generate analytical reports which show the previous and future trends in
inventory consumption.

Some interesting innovations in usage of IT for better inventory management
are:

 Use of barcoding system: Bar coding is a technique which allows
data to be encoded in the form of a series of parallel and adjacent bars
and spaces which represent a string of characters (Refer Figure 5.46).
A bar code printer encodes any data into these spaces and bars and
then a bar code reader is used to decode the bar codes by scanning a
light source across the bar code and measuring the intensity of light
reflected back by the white spaces. Bar coding provides an excellent
and fast method for identifying items, their batch numbers, expiry dates,
etc. without having to manually type or read the data.
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Fig. 5.46  Barcode

 Use of Hand Held Terminals (HHTs): HHTs are simple devices used
to communicate with any type of microprocessor-based device. The
standard input device is the keyboard (typically more akin to the calculator,
rather than the computer keyboard) and a small LCD display for the
output. HHTs are compact, simple and rugged devices designed for
outdoor applications like collecting information about inventory from
large warehouses, recording movement of goods in and out etc.

 Internet and Intranets: Many organizations (specially those following
‘Just-in -Time’ techniques) now have a system whereby the moment
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they receive an order or a request for an item (which is not in stock or
whose stock is low), the inventory package automatically generates a
purchase or supply order electronically and mails it to the preferred
supplier – all this without any human intervention!

18. Medical Science

The medical science is a branch of science that treats injuries and prevents and
cures diseases by prescribing medicines or boosting the immune system of patients.
Information technology has completely transformed the way modern medical
systems work from storing information about a patient’s history to developing
new ways of diagnosing patients and educating students in medicine. IT has become
such an integral part of the modern medical system that nowadays it is inconceivable
to think how this industry worked without the aid of ICT.

Developments in medicine due to information technology have offered
significant benefits to patients and healthcare systems. Research in Hi-Tech
medicine, such as genetic research, DNA modification, hospital infrastructure,
rapid ambulance services, etc. have been facilitated by IT. Medical scientists can
now use computers to check the effectiveness of a drug against a disease by
modeling their genetic structure on computer- based software and using high-
speed processors to simulate the process.

The storage and rapid access to electronic medical records and its instant
transmission over the Internet in large amounts is called teleconsulting where
practitioners share patients’ data across the world to diagnose patients cooperatively
without experiencing their medical history. Videoconferencing between surgeons
allows the sharing of expertise so that complicated procedures can be carried out
by sharing knowledge in real time. This allows doctors to develop expertise without
the need for supervising surgeons to travel. Operations can be performed in areas
in which they would not ordinarily be accessible, potentially saving or improving
many lives, with the help of IT.

Medical images are sometimes so complicated that they cannot be effectively
analysed without using computers. They can not only improve the image quality but
also adapt images to fit in accordance to the doctor’s wish (Refer Figure 5.47).

Medical Industry

Fig. 5.47 Medical Imaging
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19. Industrial Control

Industrial Control Systems (ICS) are remote systems which continuously monitor
local machine operations in an industrial factory. Based on the data/feedback
collected, automated or operator-driven commands are given to remote-control
devices to change the current state and work of machinery and other devices.
They consist of Supervisory Control and Data Acquisition (SCADA), Distributed
Control Systems (DCS) and Programmable Logic Controllers (PLC) among other
small control systems.

Using machine-automated controls and monitoring systems, organizations
can capitalize on higher efficiency, reliability and flexibility. Information technology
links ICS to supervisors and corporate offices and provides user-friendly software
for real-time monitoring and controlling of machinery. This has helped in reducing
cost of manufacturing and greatly increased product quality by ensuring
standardization and quality control.

ICSs are used to lab test a product before final deployment into the production
line of factory to check on the safety, quality and reliability of the automation and
control. Computer-based simulations help in saving time and provide a prototype
testing environment for all the aspects of an ICS (Refer Figure 5.48).

Fig. 5.48 Industrial Control Systems

20. Banks

In the 1960s and 1970s the banking industry—as fiercely competitive as ever—
was losing the battle of providing good customer services due to impossibly heavy
workloads. All major banks already had branches in most major locations and
they simply had to recruit more and more staff to cope with the increasing number
of customers. The accepted wisdom was that cost was the main basis for
competition and so the banks were making strenuous efforts to reduce operational
costs, kicking off the process by computerizing customer accounts. Computerization
did lead to cost reductions by saving a lot of back office work, but banks still
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needed to employ large number of front office staff to deal with customers. To
overcome this problem, one of the UK banks adopted a radical solution. Why not
get the customers to do the clerical work? This idea—not unlike that behind the
airline reservation systems—led to the development of Automatic Teller Machines
(ATMs) which allowed customers to take advantage of specific banking services
twenty-four hours a day, seven days a week, without entering the bank. ATMs
made it easy to deposit and withdraw money, check balances, request statements,
etc. and coupled with the added advantage of round the clock availability, they
not only reduced staff workloads but also gave customers a new experience of
hassle-free banking.

The banking sector has come a long way since then. It is now one of the
largest users of information technology. Some of the areas where banks typically
use IT are:

 Back office computerization: Nowadays, almost all Indian and
international banks run on fully integrated and online systems where all
back office operations like accounts posting, reconciliation, clearing
house operations, etc. are completely automated.

 Front office computerization: All banks provide facilities like instant
account statement, making fixed deposits, electronic funds transfer, direct
debit facility, etc. to their customers. None of these would be possible
without the low transaction costs and efficiency offered by computerized
systems.

 Automatic teller machines (ATMs): These computerized machines
enable customers to do their regular bank transactions (depositing and
withdrawing money, ascertaining current account balance, etc.) without
visiting a bank branch. ATMs considerably reduce costs for banks
(employee cost, space cost, etc.) and provide better level of service to
customers (by enabling twenty-four hour banking access at numerous
locations).

 Internet banking: Most banks like HSBC, Standard Chartered,
HDFC, ICICI, etc. have extremely user-friendly websites where the
typical banking transactions making request for cash and cheque pickup,
cash delivery, generating account statements, requests for cheque books
and drafts, etc.) can be carried out online without visiting the bank. This
innovative use of IT means that effectively, customers have no need to
physically visit the bank for most routine banking transactions, which is
an enormous convenience.

 Credit card operations: In a typical credit card operation, you purchase
an article or a service and give your credit card to the vendor/service
provider at the time of clearing the bill. The vendor (called ‘merchant’ in
banking language) swipes your credit card on a Point of Sale (POS)
machine that instantly dials into the bank database to verify the authenticity
and credit worthiness of the card. If both are satisfactory (in other words
the transaction is covered by your credit card limit agreed between you
and the bank) the POS prints an authentication receipt that authorizes
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the merchant to collect the transaction amount from the bank instead
from the customers. Credit cards obviate the necessity of having to carry
huge amounts of cash, and an option of spending more than one’s current
cash status. On the other hand, banks earn money by charging a
transaction fee from the merchant and interest on the credit facility. This
entire operation is critically dependent on IT and would not have been
possible otherwise.

21. Railways

The railways is an important driver for a country’s economic growth. An efficient
rail network means transportation of goods and people at low cost and in time and
thereby facilitating economic growth. However the size and complexity of problems,
which the railways face, are also unique. Let us consider, for instance, the Indian
Railways, which is one of the largest rail networks in the world. It runs around
11,000 trains everyday, out of which 7000 are passenger trains. It has over 7500
locomotives, 37,000 coaches and over 2 lakh freight wagons. It operates from
over 6800 railway stations and employs over 1.5 million people. The sheer scale
of their operations poses numerous management and operational problems.
Fortunately the key decision makers in railways saw the tremendous potential of
IT in solving some of these problems and embarked upon a major computerization
initiative. Some of these are:

 Centralized reservations system:  One of the most successful
examples of computerization in the country is the all-India computerised
reservation system which means that anybody, even in a small town,
can book tickets for any destination.

 Internet booking: IRCTC has launched online ticketing facility which
can be accessed through the website irctc.co.in. Currently these facilities
are available at 758 locations in the country. Computerized reservation-
related enquiries about passenger status, train schedule, trains between
pairs of stations, etc., are also provided on this site. Anybody with a
credit card can book a ticket on any train through this website. The site
levies a small service fee and delivers the ticket to the passenger’s home
through courier within twenty-four hours. Timetables, network maps,
freight information, fares and tariff are also available on the Indian
Railways home page.

 Computerized unreserved ticketing: Nearly 12 million  unreserved
passengers travel everyday by Indian Railways. To cater to this huge
segment, computerized ticketing systems has been recently launched.
Unreserved tickets can now be issued even from locations other than
the boarding station,  reducing long queues at booking offices and
stations.

 Pilot projects: A pilot project for issuing monthly and quarterly season
tickets through Automated Teller Machines (ATMs) has been
successfully launched in Mumbai recently. Another pilot project for
purchasing tickets (including monthly and quarterly season tickets)
through Smart Cards has also been launched. 
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 National train enquiry system: It has been introduced in order to
provide upgraded passenger information and enquiries. This system
provides  train running position in real time—through various output
devices, such as terminals in the station enquiries and Interactive Voice
Response System (IVRS)—at important railway stations.  This project
has been implemented at ninety-eight stations so far. 

 Railnet: Railways have established their own Intranet called ‘Railnet’.
It provides networking between the Railway Board, zonal headquarters,
divisional headquarters, production units, training centres, etc. to facilitate
inter and intra-departmental communication and coordination.

Check Your Progress

6. What is MAN?

7. What is the main function of a modem?

8. How does IT assist in the use of mobile phones?

9. How can IT help in forecasting the weather?

5.6 ANSWERS TO ‘CHECK YOUR PROGRESS’

1. The Internet is a ‘Network of Networks’ that links computer systems around
the world.

3. Network architecture defines the communications products and services,
which ensure that various components work together. In the early days of
data communication systems, the majority of communications were between
the DTE and the host computer.

3. TCP/IP stands for Transmission Control Protocol/Internet Protocol. It was
developed with the objective to specify a suite of protocols capable of
providing transparent communications interoperability services between
computers of all sizes, regardless of the hardware or operating system
platforms supporting them.

4. Networks that are privately owned offer consistent fast paced communication
channels which are optimized to connect information processing tools in a
restricted geographical area. These are known as Local Area Networks
(LANs).

5. Advantages: Greater bandwidth, data, voice and video can be
accommodated, greater distances.

Disadvantages: High cost, lack of well-developed standards, cable design,
alignment and maintenance.

6. A Metropolitan Area Network (MAN) covers large geographic areas such
as towns, cities or districts. By linking or interconnecting smaller networks
within a large geographic area, information is conveniently distributed
throughout the network.
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7. A modem, which is the shortened version of modulator–demodulator,
provides a two-way communication facility between a computer network
and telephone network. It converts analogue signals to digital signals and
vice versa.

8. Some of the popular functions that are based on IT are: SMS, Address
book, To-do lists, send or receive e-mails.

9. Large amounts of data are collected by weather balloons, satellites and
sensors and fed into computers with huge processing power and data storage
for quantitative analysis and weather modelling. This task can only be
performed by supercomputers which can crunch a large amount of data
very quickly.

5.7 SUMMARY

 The Internet is a ‘Network of Networks’ that links computer systems around
the world.

  The Internet application that is currently drawing maximum attention is the
World Wide Web. It has dramatically influenced the online world and
continues to grow in popularity.

 The Internet provides a perfect medium for knowledge sharing and
information dissemination. Courses are available on the Internet.

 Through a direct connection, a computer is directly connected to the Internet
backbone and acts as a gateway.

 Net surfing, Internet browsing or exploring a network on the World Wide
Web is associated with visiting different Web sites on the internet.

 Searching is one of the most common uses of the Internet. You can search
for any topic or information on the Internet. This is possible by using websites
that provide a search engine.

 A search engine is a software system that enables users to search for
information on the Web using keywords. It is designed to help the Internet
users locate the Internet resources, such as Web pages, documents,
programs and images using a keyword search mechanism.

 Network architecture defines the communications products and services,
which ensure that various components work together. In the early days of
data communication systems, the majority of communications were between
the DTE and the host computer.

 TCP/IP defines a suite of communications and applications protocols in
layer structure, with each layer handling distinct communication services.

 TCP switching is a network architecture which creates a circuit for TCP
connection. It directly controls the creation/destruction of the circuits.

 The prominent TCP features provide two popular options TCP SACK and
TCP Windows scaling.
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 The primary advantage of TCP Window scaling is to control congested
data.

 Route Discovery Protocol (RDP) is a standard protocol which is used to
inform the router on which they send packets. It also used wiretapping
routing protocols such as RIP which is configured as default routes in hosts.

 Networks that are privately owned offer consistent fast paced communication
channels which are optimized to connect information processing tools in a
restricted geographical area. These are known as Local Area Networks
(LANs).

 Shielded twisted pair, on the other hand, has several disadvantages. First,
the raw cost of acquisition is greater as the medium is more expensive to
produce.

 The core factor that limits a twisted pair cable is due to the skin effect. The
flow of the current in the wires is likely to flow only on the wire’s outer
surface as the frequency of the transmitted signal raises, thus, less of the
available cross-section is used.

 A Metropolitan Area Network (MAN) covers large geographic areas such
as towns, cities or districts. By linking or interconnecting smaller networks
within a large geographic area, information is conveniently distributed
throughout the network.

 Wide Area Networks (WANs) connect larger geographic areas, such as
New Delhi, India, or the world.

 The geographical limit of WAN is unlimited. Dedicated transoceanic cabling
or satellite uplinks may be used to connect this type of network. Hence, a
WAN may be defined as a data communications network covering a relatively
broad geographical area to connect LANs together between different cities
with the help of transmission facilities provided by common carriers, such
as telephone companies.

 A modem, which is the shortened version of modulator–demodulator,
provides a two-way communication facility between a computer network
and telephone network. It converts analogue signals to digital signals and
vice versa.

 Phase Modulation (PM) is similar to frequency modulation. In FM, the
frequency of the carrier wave changes, whereas in PM the phase of the
carrier wave changes.

 Some of the popular functions that are based on IT are: SMS, Address
book, To-do lists, send or receive e-mails.

 Digital compositing, time slicing and computer-generated imaging.

 Large amounts of data are collected by weather balloons, satellites and
sensors and fed into computers with huge processing power and data storage
for quantitative analysis and weather modelling. This task can only be
performed by supercomputers which can crunch a large amount of data
very quickly.
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5.8 KEY TERMS

 Internet: It is a ‘Network of Networks’ that links computer systems around
the world.

 DNS (Domain Name System):  It is a hierarchical system which organizes
host names in hierarchy of domain names.

 Baseband: A type of coaxial cable that transmits a single signal at a time at
high speeds.

 Optical Fibre: A type of transmission media in which information is carried
through a beam of light.

 Hub: It is a centralized distribution point for all data transmission in a network.

 Remote Sensing: It is the process of retrieval of data and information
regarding a phenomenon or object without coming into physical contact
with it.

 E-Commerce: The exchange of goods and services involving financial
transactions over an electronic medium by using communication and
information technologies.

5.9 SELF-ASSESSMENT QUESTIONS AND
EXERCISES

Short-Answer Questions

1. What is a direct connection?

2. What do you understand by FTP?

3. Write the applications of internet.

4. What are the advantages of networks?

5. Differentiate between broadband versus baseband.

6. How LAN, MAN and WAN are different from each other?

7. What is amplitude modulation?

8. What are the various application areas of IT?

9. State the use of IT in financial accounting.

Long-Answer Questions

1. Briefly explain the various purposes served by the internet.

2. Explain the TCP/IP layers and protocols with appropriate diagram.

3. Describe briefly TCP and its features with the help of appropriate examples.

4. Briefly explain the structure of data communication networks with the help
of example.

5. What are the different transmission/communication media? Explain.
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6. Describe the various components of network.

7. Differentiate between MAN and WAN with the help of diagram.

8. Explain the concepts of modulation giving appropriate example.

9. IT has dramatically changed the way of our life. Explain in detail.
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